Thank You for Choosing Ross

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.

Our mission is to:

1. Provide a Superior Customer Experience
   • offer the best product quality and support
2. Make Cool Practical Technology
   • develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a special group. Our employees truly care about doing a great job and delivering a high quality customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our behavior:

1. We will always act in our customers' best interest.
2. We will do our best to understand our customers' requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and it's our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. *If there's no one to authorize the required action in times of company or customer crisis - do what you know in your heart is right. (You may rent helicopters if necessary.)*
Copyright

©2022 Ross Video Limited, Ross®, and any related marks are trademarks or registered trademarks of Ross Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained herein.

Patents


Notice

The material in this manual is furnished for informational use only. It is subject to change without notice and should not be construed as commitment by Ross Video Limited. Ross Video Limited assumes no responsibility or liability for errors or inaccuracies that may appear in this manual.

Third Party Licenses

XPression INcoder makes use of FFmpeg licensed under the LGPLv2.1 and its source can be downloaded here. FFmpeg was configured with the following options:

```
--pkg-config=pkg-config --pkg-config-flags=static
--extra-version=ffmpeg-windows-build-helpers
--disable-debug --disable-w32threads --arch=x86 --target-os=mingw32
--cross-prefix=/root/src/sandbox/bin/x86/ffmpeg
--enable-gray --enable-libopus --enable-libsnappy --enable-libsoxr --enable-libtheora
--enable-libvorbis --enable-libwebp --enable-libzimg --enable-libopenjpeg
--enable-libopenh264 --enable-libxml2 --enable-libdav1d --enable-cuda-llvm
--enable-libvpx --enable-mfx --enable-avresample --extra-cflags='-mtune=generic'
--extra-cflags=-O3 --enable-shared --disable-static
--prefix=/root/src/sandbox/win32/ffmpeg_git_lgpl
```

A patch of changes to FFmpeg 4.3.2 is available in the downloaded source as xpvc_win.patch.
End User Software License Agreement

This End User Software License Agreement is a legal agreement between you (the “Licensee”) and Ross Video Limited (“Ross Video”) specifying the terms and conditions of your installation and use of the Software and all Documentation (as those terms are defined herein).

IMPORTANT:

BY DOWNLOADING, ACCESSING, INSTALLING OR USING THE SOFTWARE AND/OR DOCUMENTATION LICENSEE AGREES TO THE TERMS OF THIS AGREEMENT AND THE LICENSE GRANTED HEREUNDER SHALL BE EFFECTIVE AS OF AND FROM SUCH DATE. IF YOU DO NOT WISH TO ACCEPT THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT DOWNLOAD, ACCESS, INSTALL, REFER TO OR OTHERWISE USE THE SOFTWARE AND/OR DOCUMENTATION.

1. INTERPRETATION. In this Agreement, (a) words signifying the singular number include the plural and vice versa, and words signifying gender include all genders; (b) every use of the words "herein", "hereof", "hereto" "hereunder" and similar words shall be construed to refer to this Agreement in its entirety and not to any particular provision hereof; (c) reference to any agreement or other document herein will be construed as referring to such agreement or other document as from time to time amended, modified or supplemented (subject to any restrictions on such amendment, modification or supplement set forth therein); (d) every use of the words "including" or "includes" is to be construed as meaning "including, without limitation" or "includes, without limitation", respectively; and (e) references to an Article or a Section are to be construed as references to an Article or Section of or to this Agreement unless otherwise specified.

2. DEFINITIONS. In this Agreement, in addition to the terms defined elsewhere in this Agreement, the following terms have the meanings set out below:

“Affiliate” means, with respect to any Person, any other Person who directly or indirectly controls, is controlled by, or is under direct or indirect common control with, such Person. A Person shall be deemed to control a Person if such Person possesses, directly or indirectly, the power to direct or cause the direction of the management and policies of such Person, whether through the ownership of voting securities, by contract or otherwise; and the term “controlled” and “controlling” shall have a similar meaning.

“Agreement” means this End User Software License Agreement including the recitals hereto, as the same may be amended from time to time in accordance with the provisions hereof.

“Backup System” means the secondary piece of Designated Equipment upon which the Software is installed and mirrored for the sole purpose of replacing a Primary System in the event such Primary System is not available or functioning properly for any reason.

“Change of Control” means (a) the direct or indirect sale, transfer or exchange by the shareholders of a Party of more than fifty percent (50%) of the voting securities of such Party, (b) a merger or amalgamation or reorganization or other transaction to which a Party is party after which the shareholders of such Party immediately prior to such transaction hold less than fifty percent (50%) of the voting securities of the surviving entity, (c) the sale, exchange, or transfer of all or substantially all of the assets of a Party.

“Confidential Information” means all data and information relating to the business and management of either Party, including the Software, trade secrets and other technology to which access is obtained or granted hereunder by the other Party, and any materials provided by Ross Video to Licensee; provided, however, that Confidential Information shall not include any data or information which:

(i) is or becomes publicly available through no fault of the other Party;

(ii) is already in the rightful possession of the other Party prior to its receipt from the other Party;
(iii) is already known to the receiving Party at the time of its disclosure to the receiving Party by the disclosing Party and is not the subject of an obligation of confidence of any kind;

(iv) is independently developed by the other Party;

(v) is rightfully obtained by the other Party from a third party; or

(vi) is disclosed with the written consent of the Party whose information it is.

“Designated Equipment” shall mean (a) the hardware products sold by Ross Video to Licensee on which the Software is installed and licensed for use, as the same may be replaced from time to time by Ross Video; or (b) in the case of Software sold on a stand-alone basis, the equipment of Licensee on which the Software is to be installed and meets the minimum specifications set out in the Documentation.

“Documentation” shall mean manuals, instruction guides, user documentation and other related materials of any kind pertaining to the Software (whether in electronic, hard-copy or other media format) that are furnished to Licensee by or on behalf of Ross Video in relation to the Software.

“Governmental Authority” means (a) and federal, provincial, state, local, municipal, regional, territorial, aboriginal, or other government, governmental or public department, branch, ministry, or court, domestic or foreign, including any district, agency, commission, board, arbitration panel or authority and any subdivision of any of them exercising or entitled to exercise any administrative, executive, judicial, ministerial, prerogative, legislative, regulatory, or taxing authority or power of any nature; and (b) any quasi-governmental or private body exercising any regulatory, expropriation or taxing authority under or for the account of any of them, and any subdivision of any of them.

“Improvements” means all inventions, works, discoveries, improvements and innovations of or in connection with the Software, including error corrections, bug fixes, patches and other updates in Object Code form to the extent made available to Licensee in accordance with Ross Video’s release schedule.

“License Fee” means the fee(s) payable in respect of the Software in accordance with the relevant invoice(s) or other purchase documents delivered in connection with this Agreement.

“License Period” means the period of time that Licensee will have the rights granted under this Agreement, as may be specified in a Quote.

“Maintenance Fee” means the yearly maintenance fee(s) payable by Licensee to Ross Video, as determined by Ross Video, for the support, maintenance and update of the Software after the expiry of the Maintenance Period as set forth in this Agreement.

“Maintenance Period” means, in connection with the Software, the maintenance period of one (1) year from the date of shipment unless otherwise specified in the table below:

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Software Maintenance Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switchers</td>
<td>For the life of the Designated Equipment</td>
</tr>
<tr>
<td>Routers (excluding Ultrix)</td>
<td>For the life of the Designated Equipment</td>
</tr>
<tr>
<td>Master Control System Software (DashBoard)</td>
<td>For the life of the Designated Equipment</td>
</tr>
<tr>
<td>Gear</td>
<td>For the life of the Designated Equipment</td>
</tr>
<tr>
<td>Neilsen Encoders</td>
<td>For the life of the Designated Equipment</td>
</tr>
<tr>
<td>Sports Analysis</td>
<td>For the License Period</td>
</tr>
</tbody>
</table>

“Modifications” means any enhancements, changes, corrections, translations, adaptations, revisions, developments, upgrades or updates thereto; and “Modify” shall mean the creation of any of the foregoing.

“Object Code” means the machine readable executable form of a computer software program.
“Parties” means both Ross Video and Licensee and “Party” means either one of them as the context requires.

“Person” will be broadly interpreted and includes (a) a natural person, whether acting in his or her own capacity, or in his or her capacity as executor, administrator, estate trustee, trustee or personal or legal representative; (b) a corporation or a company of any kind, a partnership of any kind, a sole proprietorship, a trust, a joint venture, as association, an unincorporated association, an unincorporated syndicate, an unincorporated organization or any other association, organization or entity of any kind; and (c) a Governmental Authority.

“Primary System” means the Designated Equipment upon which the Software is installed and executed to deliver its intended functionality.

“Quote” means the document provided by Ross Video to Licensee detailing the Ross Video products contemplated for purchase, the corresponding fees and any License Period that may apply to the Software.

“Software” shall mean the version of the Object Code sold and delivered to Licensee by Ross Video concurrently with delivery of this Agreement and any subsequent error corrections, updates, Modifications or Improvements provided to Licensee by Ross Video pursuant to this Agreement, but specifically excluding any features or plug-ins that may be purchased by you directly from third parties as upgrades or enhancements to the Software.

“Source Code” means the human readable form of a computer software program, all tools and documentation necessary for a reasonably computer programmer to understand, maintain and Modify the Software.

“Third Party Software” means those portions of the Software, if any, which are owned or controlled by third parties and licensed to Ross Video pursuant to certain license agreements or arrangements with such third parties, including the NewTek NDI™ software (http://NDI.NewTek.com/)

“Use” means to execute, run, display, store, copy, make, use, sell, merge, network, Modify, translate, host, outsource, or integrate with Licensee’s products or other third party software;

3. LICENSE. Subject to the terms and conditions of this Agreement, upon payment of the applicable License Fee by Licensee, Ross Video hereby grants to Licensee a non-transferable and non-exclusive right to Use the Software and Documentation solely for the internal use of Licensee (the “License”), during the License Period. In the event that a License Period is not identified on the Quote, such License Period shall be deemed to be perpetual, subject to Section 7 D of this Agreement. The Software shall only be used in connection with or installed on the Designated Equipment and, where applicable, shall only be used on the Primary System, provided such Primary System is operating properly. If the Primary System is not operating properly for any reason, the Software may be used on the designated Backup System for that Primary System until such time that the Primary System begins operating properly. The Software and Documentation are provided to Licensee for the exclusive use by Licensee’s organization for its ordinary business purposes and shall not be used by any third party for any purposes. Licensee may make copies of the Software as required for internal backup and archival purposes. To the extent permitted hereunder, Licensee may distribute copies of the Software and/or Documentation to members of its organization, provided (a) this Agreement is included with each copy, (b) any member of its organization who uses the Software and/or Documentation accepts and agrees to be bound by the terms of this Agreement and by any other license agreements or other agreement incorporated by reference into this Agreement, and (c) Licensee has paid any applicable additional License Fees in respect of copying and redistributing the Software. To the extent Licensee is permitted to make copies of the Software under this Agreement, Licensee agrees to reproduce and include on any copy made or portion merged into another work, all Ross Video proprietary notices, including any notices with respect to copyrights, trademarks and this License. With the exception of copying the Software for backup or archival purposes, Licensee agrees to keep a record of the number and location of all
such copies and will make such record available at Ross Video’s request. The Software may include mechanisms to limit or inhibit copying.

4. **LICENSE RESTRICTIONS.** Except as otherwise provided in section 2 above, Licensee shall not:
   (1) copy any Software or Documentation, or part thereof, which is provided to Licensee by Ross Video pursuant to this Agreement, in Object Code form, Source Code form or other human or machine readable form, including written or printed documents, without the prior written consent of Ross Video; (2) in any way market, distribute, export, translate, transmit, merge, modify, transfer, adapt, loan, rent, lease, assign, share, sub-license, sell, make available for download on any website or make available to another Person, the Software and/or Documentation, in whole or in part, provided that Licensee shall not be prohibited from renting or leasing the Software if Ross Video has consented, in writing, to Licensee engaging in such activities in respect of the Software; (3) reverse engineer, decompile or disassemble the Software or electronically transfer it into another computer language; or (4) otherwise Use the Software or Documentation in a manner that is inconsistent with the License granted hereunder or that will result in a breach of this Agreement. Licensee agrees to take all reasonable precautions to prevent third parties from using the Software and/or Documentation in any way that would constitute a breach of this Agreement, including such precautions Licensee would ordinarily take to protect its own proprietary software, hardware or information.

5. **DELIVERY.** Ross Video shall deliver to Licensee one (1) master copy of the Software in compiled binary (executable) form suitable for reproduction in electronic files only and Ross Video shall deliver to Licensee a minimum of one copy of the Documentation.

6. **IMPROVEMENTS.** Licensee may from time to time request Ross Video to incorporate certain Improvements into the Software. Ross Video may, in its sole discretion, undertake to incorporate and provide such Improvements to Licensee with or without payment of a fee to be negotiated at the time of such request. All Improvements, whether recommended and developed by Ross Video or Licensee, shall be considered the sole property of Ross Video and shall be used by Licensee pursuant to the terms of the License granted under this Agreement.

7. **LIMITED REPRESENTATIONS AND WARRANTIES.**
   (A) **Software Warranties**
   Ross Video represents and warrants that:
   (i) During the Maintenance Period the Software is warranted to be free from material defects under normal use;
   (ii) Ross Video has the authority to enter into this Agreement, is the owner or licensee of the Software and Documentation and has the right to grant all of the license rights herein;
   (iii) Except as expressly stated herein, no disabling mechanism or protection feature designed to prevent the Software’s Use, including any computer virus, worm, lock, drop dead device, Trojan-horse routine, trap door, time bomb or any other codes or instructions that may be used to access, modify, delete, damage or disable the Software or any other hardware or computer system, will be used or activated by Ross Video in respect of Software that is delivered to Licensee under a valid License; and
   (iv) The Software, if properly installed and used with Designated Equipment, will perform substantially as described in Ross Video’s then current Documentation for such Software for the Maintenance Period.
   (B) **Warranty Exclusions and Inclusions**
   Notwithstanding the above, all of Ross Video’s obligations with respect to the warranties set out in 7(A) above shall be contingent on Licensee’s use of the Software in accordance with the terms and conditions of this Agreement and Ross Video’s instructions as provided in the Documentation. Ross Video shall have no warranty obligations where any Software failure occurs as a result of misuse, neglect, accident, abuse, misapplication, improper installation, unauthorized modification,
extreme power surge or extreme electromagnetic field or other Act of God. Ross Video shall pass through to Licensee the benefit of all warranties from third party manufacturers and suppliers.

(C) Remedy

If the Software becomes defective, and a valid claim is received by Ross Video during the Maintenance Period, Ross Video will, at its sole option and sole discretion, either (1) repair the defective Software at no charge, or (2) exchange the defective Software for a comparable product at no charge. The remedies set forth in this Section shall be the exclusive remedies available to Licensee in connection with a breach of the limited warranties set out above.

(D) Maintenance Charges

Technical support for the Software by telephone and email contact with Ross Video is provided by Ross Video to Licensee at no extra charge for the life of the product. During the Maintenance Period, Ross Video shall supply downloadable Software Modifications upon request of Licensee, when available, at no extra charge to Licensee. Notwithstanding the foregoing, Ross Video shall be under no legal obligation to create or release Software Modifications at any time or in accordance with a fixed schedule. Upon expiry of the Maintenance Period, where applicable, Licensee may purchase Software maintenance, including downloadable Software upgrades in one (1) year increments at the then applicable extended Maintenance Fee rates offered by Ross Video, in which case the warranties granted by this Agreement shall survive and remain in full force and effect during each such one (1) year term.

8. OWNERSHIP. The Parties acknowledge and agree that, as between the Parties, Ross Video shall be the owner of all intellectual property rights in the Software, Documentation and all related Modifications and Improvements, written materials, logos, trademarks, trade names, copyright, patents, trade secret and moral rights, registered or unregistered. No proprietary interest or title in or to the intellectual property in the Software, Documentation or any Improvements or Modifications is transferred to Licensee by this Agreement. Ross Video reserves all rights not expressly licensed to Licensee under section 3.

9. THIRD PARTY SOFTWARE. Licensee acknowledges that the Third Party Software is not owned by Ross Video. Notwithstanding any other provision of this Agreement, Ross Video, to the extent permitted by applicable law, offers no warranties (whether express, implied, statutory or by course of communication or dealing with Licensee, or otherwise) with respect to the Third Party Software. Ross Video may pass through to Licensee, if and to the extent permitted by applicable law, any warranties expressly provided by such third parties to Ross Video for such Third Party Software.

10. INTELLECTUAL PROPERTY INDEMNITY. Ross Video agrees to defend, indemnify and hold harmless Licensee from final damages awarded by a court of competent jurisdiction (hereinafter referred to as the “Losses”), which Licensee, or any of its officers or directors, may incur, suffer or become liable for as a result of, or in connection with, any third party claim asserted against Licensee to the extent such claim is based on a contention that the Software, Documentation or any portion thereof, infringes any valid, registered, enforceable patents, copyrights, trade secrets, trademarks or other intellectual property rights of any third party, provided that (a) the allegedly infringing Software or Documentation has been used within the scope of and in accordance with the terms of this Agreement, and (b) Licensee notifies Ross Video in writing of such claim within ten (10) days of a responsible officer of Licensee becoming aware of such claim. If the Software, Documentation or any portion thereof is held to constitute an infringement of a third party’s intellectual property rights, and use thereof is enjoined, Ross Video shall, at its election and expense, either (i) procure the right to use the infringing element of the Software or Documentation; or (ii) replace or modify the element of the Software or Documentation so that the infringing portion is no longer infringing and still performs the same function without any material loss of functionality. Ross Video shall make every reasonable effort to correct the situation with minimal effect upon the operations of Licensee.
Notwithstanding the above, Ross Video reserves the right to terminate this Agreement and the License granted hereunder on immediate notice to Licensee, and without liability to Licensee, in the event that the Software or Documentation constitutes or may, in Ross Video’s determination, constitute, an infringement of the rights of a third party that Ross Video, in its sole discretion, does not consider to be affordably remediable.

Either party may terminate this Agreement immediately should any Software become, or in either party’s opinion be likely to become, the subject of a claim of infringement of any intellectual property right and, in such event, there shall be no claim by either Licensee or Ross Video against the other arising out of such termination, provided that the foregoing shall not apply to a claim for infringement by Ross Video against Licensee in the event that Licensee is alleged to have infringed Ross Video’s intellectual property rights, in which case Licensee shall remain liable for all outstanding License Fees and other amounts owing to Ross Video.

Notwithstanding the foregoing, Ross Video shall have no liability for any claim of infringement based on use of other than a current, unaltered release of the Software and/or Documentation available from Ross Video if such infringement would have been avoided by the use of a current, unaltered release of the Software and/or Documentation provided that such current, unaltered release performs substantially in conformance with the specifications set out in the Documentation and was provided, at no additional cost by Ross Video, to those subscribing for maintenance services for the Software or Documentation.

11. CONFIDENTIALITY. Each Party shall maintain in confidence all Confidential Information of the other Party, shall use such Confidential Information only for the purpose of exercising its rights and fulfilling its obligations under this Agreement, and shall not disclose any Confidential Information of the disclosing Party to any third party except as expressly permitted hereunder or make any unauthorized use thereof. Each Party shall disclose the Confidential Information only to those of its employees, consultants, advisors, and/or subcontractors who have a need to know the Confidential Information. Each Party shall, prior to disclosing the Confidential Information to such employees, consultants, advisors and/or subcontractors, obtain their agreement to receive and use the Confidential Information on a confidential basis on the same terms and conditions contained in this Agreement. The receiving Party shall treat the Confidential Information of the disclosing Party with the same degree of care against disclosure and/or unauthorized use as it affords to its own information of a similar nature, or a reasonable degree of care, whichever is greater. The receiving Party further agrees not to remove or destroy any proprietary or confidential legends or markings placed upon any documents or other materials of the disclosing Party. The obligations of confidence set forth in this Agreement shall extend to any Affiliates that have received Confidential Information of the disclosing Party and shall also cover Confidential Information disclosed by any Affiliate. The receiving Party shall be responsible for any actions or omissions of its Affiliates as if such actions or omissions were its own.

Either party may disclose certain Confidential Information if it is expressly required to do so pursuant to legal, judicial, or administrative proceedings, or otherwise required by law, provided that (i) such Party provides the other Party with reasonable written notice prior to such disclosure; (ii) such Party seeks confidential treatment for such Confidential Information; (iii) the extent of such disclosure is only to the extent expressly required by law or under the applicable court order; and (iv) such Party complies with any applicable protective or equivalent order.

Each of Ross Video and Licensee (the “Indemnifying Party”, as applicable) agree to indemnify the other (the “Indemnified Party”, as applicable) for all Losses incurred by the Indemnified Party as a result of a failure of the Indemnifying Party to comply with its obligations under this Section 11 provided that the Indemnified Party has given prompt notice of any such claim and, to the extent that a claim may lie against a third party for the unauthorized disclosure of such Confidential Information, the right to control and direct the investigation, preparation, action and settlement of each such claim and, further, provided that the Indemnified Party reasonably co-operates with the Indemnifying Party in connection with the foregoing and provides the Indemnifying Party with all
information in the Indemnified Party’s possession related to such claim and such further assistance as reasonably requested by the Indemnifying Party.

The Parties acknowledge and agree that any breach of the confidentiality provisions of this Agreement by one Party may cause significant and irreparable injury to the other Party that is not compensable monetarily, as well as damages that may be difficult to ascertain, and agrees that, in addition to such other remedies that may be available at law or in equity, the other Party shall be entitled to seek injunctive relief (including temporary restraining orders, interim injunctions and permanent injunctions) in a court of competent jurisdiction in the event of the breach or threatened breach by such party of any of the confidentiality provisions of this Agreement. The relief contemplated in this Section shall be available to each Party without the necessity of having to prove actual damages and without the necessity of having to post any bond or other security. Each Party further agrees to notify the other Party in the event that it learns of or has reason to believe that any Person has breached the confidentiality provisions of this Agreement.

12. LIMITATION OF LIABILITY. The limitation of liability provisions of this Agreement reflect an informed voluntary allocation of the risks (known and unknown) that may exist in connection with the licensing of the Software or Documentation hereunder by Ross Video, and that voluntary risk allocation represents a material part of the Agreement reached between Ross Video and Licensee. Should Ross Video be in breach of any obligation, Licensee agrees that Licensee’s remedies will be limited to those set forth in this Agreement. No action, regardless of form, arising out of this Agreement may be brought by Licensee more than twelve (12) months after the facts giving rise to the cause of action have occurred, regardless of whether those facts by that time are known to, or reasonably ought to have been discovered by, Licensee.

(A) EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT, THE SOFTWARE AND DOCUMENTATION ARE PROVIDED “AS IS” AND ROSS VIDEO (I) MAKES NO OTHER REPRESENTATIONS, AND PROVIDES NO WARRANTIES OR CONDITIONS OF ANY KIND, EXPRESS OR IMPLIED, STATUTORY, BY USAGE OF TRADE CUSTOM OF DEALING, OR OTHERWISE, AND (II) SPECIFICALLY DISCLAIMS ALL IMPLIED WARRANTIES INCLUDING ANY IMPLIED WARRANTY OF UNINTERRUPTED OR ERROR FREE OPERATION, MERCHANTABILITY, QUALITY OR FITNESS FOR A PARTICULAR PURPOSE. ROSS VIDEO DOES NOT REPRESENT OR WARRANT THAT THE SOFTWARE WILL MEET ANY OR ALL OF LICENSEE’S PARTICULAR REQUIREMENTS, THAT THE USE AND OPERATION OF THE SOFTWARE WILL OPERATE ERROR-FREE OR UNINTERRUPTED, THAT ALL PROGRAMMING ERRORS IN THE SOFTWARE CAN BE FOUND IN ORDER TO BE CORRECTED, OR THAT THE SOFTWARE WILL BE COMPATIBLE WITH OTHER PROGRAMS, SYSTEMS, AND HARDWARE.

(B) IN NO EVENT SHALL ROSS VIDEO, ITS AFFILIATES AND LICENSORS, AND THEIR RESPECTIVE DIRECTORS, OFFICERS, EMPLOYEES AND AGENTS, BE LIABLE FOR ANY CLAIM FOR INDIRECT, CONSEQUENTIAL, SPECIAL, INCIDENTAL, PUNITIVE, EXEMPLARY, AGGRAVATED DAMAGES; LOST PROFITS, OR LOST REVENUE ARISING FROM OR IN CONNECTION WITH THIS AGREEMENT, REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT, OR IN TORT, EVEN IF THE PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

(C) IN ANY EVENT THE AGGREGATE LIABILITY OF ROSS VIDEO, ITS AFFILIATES AND LICENSORS, AND THEIR RESPECTIVE DIRECTORS, OFFICERS, EMPLOYEES AND AGENTS, FOR ANY CLAIM FOR DIRECT DAMAGES WITH RESPECT TO THE SUBJECT MATTER OF THIS AGREEMENT SHALL NOT EXCEED THE AMOUNT OF THE PURCHASE PRICE PAID TO ROSS VIDEO UNDER THIS AGREEMENT.

13. TERM AND TERMINATION.

(1) Unless terminated earlier in accordance with the terms of this Agreement, the term of this Agreement shall commence upon Licensee’s first download, access, installation, or other use of the Software or Documentation and continues until, in the case of Software sold with Designated
Equipment provided by Ross Video, the earliest of (a) the end of the License Period, or (b) if the Designated Equipment is assigned or transferred in accordance with this Agreement, the date on which the Designated Equipment is no longer owned by Licensee;

(2) Either Party shall have the right to terminate this Agreement on notice to the other Party if:

(a) the other Party fails to pay any fees or other amounts when due hereunder or under any other agreement between the Parties (or any Affiliates of the Parties, as applicable) in connection with the Software and/or Designated Equipment and such breach is not cured within thirty (30) days after written notice of such failure to pay is given to the defaulting Party by the non-defaulting Party;

(b) the other Party shall file a voluntary petition in bankruptcy or insolvency or shall petition for reorganization under any bankruptcy law, consent to an involuntary petition in bankruptcy, or if a receiving order is given against it under the Bankruptcy and Insolvency Act (Canada) or the comparable law of any other jurisdiction (and such is not dismissed within ten (10) days);

(c) there shall be entered an order, judgment or decree by a court of competent jurisdiction, upon the application of a creditor, approving a petition seeking reorganization or appointing a receiver, trustee or liquidator of all or a substantial part of the other Party’s assets and such order, judgment or decree continues in effect for a period of thirty (30) consecutive days; or

(d) the other Party shall fail to perform any of the other material obligations set forth in this Agreement and such default, in the case of a default which is remediable, continues for a period of thirty (30) days after written notice of such failure has been given by the non-defaulting Party or, in the case of a non-remediable default, immediately upon notice.

(3) Notwithstanding any to the contrary contained in this Agreement:

(a) Ross Video may forthwith terminate this Agreement if Licensee is in breach of any of sections 3, 4 or 11 of this Agreement. For greater certainty, in such instances Ross Video shall provide written notice of such termination as soon as practicable but written notice shall not be a necessary prerequisite to such termination; and

(b) in the event of a Change of Control of Licensee, Ross Video shall have the rights to terminate this Agreement and the License granted hereunder upon thirty (30) days' prior written notice to Licensee. For greater certainty, Ross Video's right to terminate in the event of a Change of Control of Licensee shall continue for a period of six (6) months from the date Licensee delivers notice of such Change of Control to Ross Video.

(c) Ross Video may terminate the License immediately on the date on which it provides notice to Licensee, if its agreements for Third Party Software are terminated.

(4) Upon the termination or expiry of this Agreement:

(a) Licensee shall immediately cease and desist all use of the Software and Documentation;

(b) Licensee shall immediately deliver to Ross Video any of Ross Video’s Confidential Information provided hereunder (including the Software and Documentation) then in its possession or control, if any, and shall deliver a certificate of an officer of Licensee certifying the completeness of same;

(c) Licensee shall refrain from further use of such Confidential Information; and

(d) Licensee shall forthwith pay all amounts owing to Ross Video or any of its Affiliates hereunder.

14. SURVIVAL. The provisions of sections 1, 2, 4, 6, 8, 9, 11, 12, 13, 14, 17 and 19 herein shall survive the expiry or termination of this Agreement.

15. FORCE MAJEURE. Dates and times by which Ross Video is required to render performance under this Agreement shall be automatically postponed to the extent and for the period that Ross Video is prevented from meeting them by reason of events of force majeure or any cause beyond
its reasonable control provided Ross Video notifies Licensee of the commencement and nature of such cause and uses its reasonable efforts to render performance in a timely manner.

16. ASSIGNMENT. Ross Video may assign this Agreement, or any of its rights or obligations hereunder, in whole or in part, upon notice to Licensee. Licensee shall not assign this Agreement, or any of its rights or obligations hereunder, in whole or in part, without the prior written consent of Ross Video, which consent may not be unreasonably withheld. This Agreement enures to the benefit of and is binding upon each of the Parties and their respective successors and permitted assigns.

17. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the laws of the Province of Ontario and federal laws of Canada applicable therein and shall be treated, in all respects, as an Ontario contract. Each Party irrevocably and unconditionally submits and attorns to the exclusive jurisdiction of the courts of the Province of Ontario to determine all issues, whether at law or in equity, arising from this Agreement.

18. LANGUAGE. The Parties have expressly required that this Agreement and all documents relating thereto be drawn-up in English. Les parties ont expressément exigé que cette convention ainsi que tous les documents qui s’y rattachent soient rédigés en anglais.

19. GOVERNMENT CONTRACTS. If the Software and/or Documentation to be furnished to Licensee hereunder are to be used in the performance of a government contract or subcontract, the Software and/or Documentation shall be provided on a "restricted rights" basis only and Licensee shall place a legend, in addition to applicable copyright notices, in the form provided under the applicable governmental regulations. For greater certainty, Ross Video shall not be subject to any flowdown provisions required by any customers of Licensee that are a Governmental Authority unless Ross Video expressly agrees to be bound by such flowdown provisions in writing.

20. EXPORT AND IMPORT LAWS. Licensee acknowledges and agrees that the Software (including any technical data and related technology) may be subject to the export control laws, rules, regulations, restrictions and national security controls of the United States and other applicable countries (the "Export Controls") and agrees not export, re-export, import or allow the export, re-export or import of such export-controlled Software (including any technical data and related technology) or any copy, portion or direct product of the foregoing in violation of the Export Controls. Licensee hereby represents that it is not an entity or person to whom provision of the Software (including any technical data and related technology) is restricted or prohibited by the Export Controls. Licensee agrees that it has the sole responsibility to obtain any authorization to export, re-export, or import the Software (including any technical data and related technology), as may be required. Licensee will defend, indemnify and hold Ross Video harmless from any and all claims, losses, liabilities, damages, fines, penalties, costs and expenses (including attorney’s fees) arising from or relating to any breach by Licensee of its obligations under this Section.

21. AMENDMENT AND WAIVER. No amendment, discharge, modification, restatement, supplement, termination or waiver of this Agreement or any Section of this Agreement is binding unless it is in writing and executed by the Party to be bound. No waiver of, failure to exercise or delay in exercising, any Section of this Agreement constitutes a waiver of any other Section (whether or not similar) nor does any waiver constitute a continuing waiver unless otherwise expressly provided.

22. SEVERABILITY. Each Section of this Agreement is distinct and severable. If any Section of this Agreement, in whole or in part, is or becomes illegal, invalid, void, voidable or unenforceable in any jurisdiction by any court of competent jurisdiction, the illegality, invalidity or unenforceability of that Section, in whole or in part, will not affect (a) the legality, validity or enforceability of the remaining Sections of this Agreement, in whole or in part; or (b) the legality, validity or enforceability of that Section, in whole or in part, in any other jurisdiction.

23. ENTIRE AGREEMENT. This Agreement, and any other documents referred to herein, constitutes the entire agreement between the Parties relating to the subject matter of this Agreement and supersedes all prior written or oral agreements, representations and other communications between the Parties.
Warranty and Repair Policy

Ross Video Limited (Ross) warrants its XPression systems to be free from defects under normal use and service for the following time periods from the date of shipment:

- **XPression Server** — 12 months
- **XPression Software Upgrades** — 12 months free of charge
- **System and Media hard drives** — 12 months

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard warranty period by one year increments. For more information about an extended warranty for your XPression system, contact your regional sales manager.
Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.
<table>
<thead>
<tr>
<th>Company Address</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ross Video Limited</strong></td>
</tr>
<tr>
<td>8 John Street</td>
</tr>
<tr>
<td>Iroquois, Ontario</td>
</tr>
<tr>
<td>Canada, K0E 1K0</td>
</tr>
</tbody>
</table>

| General Business Office: | (+1) 613 • 652 • 4886 |
| Fax: | (+1) 613 • 652 • 4425 |

| Toll Free Technical Support: | 1-844-652-0645 (North America) |
| | +800 1005 0100 (International) |

Alternately, you can contact:

| Technical Support: | (+1) 613 • 652 • 4886 |
| After Hours Emergency: | (+1) 613 • 349 • 0006 |

| E-mail for Technical Support: | techsupport@rossvideo.com |
| E-mail for General Information: | solutions@rossvideo.com |
| Website: | http://www.rossvideo.com |
Contents

Introduction 1
About This Guide 1-1
Documentation Conventions 1-1
Getting Help 1-2
Contacting Technical Support 1-2

User Interface Overview 2
The Layout Interface 2-2
The Sequencer Interface 2-3

System Setup 3
Set Preferences 3-2
Configure an AJA NTV2 Video FrameBuffer 3-19
Configure an AJA Video FrameBuffer (Legacy) 3-32
Configure a Blackmagic Design FrameBuffer 3-36
Configure a Blackmagic Design FrameBuffer (Legacy) 3-40
Configure a Graphite FrameBuffer 3-43
Configure a Matrox DSX, X.mio3 and X.mio5 FrameBuffer 3-46
Configure a Matrox Video X.mio2 FrameBuffer 3-70
NewTek™ Network Device Interface (NDI™) 3-75
Configure an XPression AVI Recorder 3-78
Configure an XPression Desktop Preview Client 3-79
Configure an XPression DirectShow Capture Source 3-81
Configure an XPression RossLinq Connector 3-82
Configure the XPression Tile Mapper 3-84
Configure an XPression Virtual Input 3-86
Configure an XPression Virtual Output 3-87
Change the Order of Video Inputs / Outputs 3-89
Delete a Video Input / Output 3-90
Configure an Audio Device 3-91
Delete an Audio Device 3-93
Add a Timecode Source 3-94
Configure Video Preview and Audio Monitor 3-97
Configure RS232 CTS/DSR GPI for Contact Closures 3-99
Configure a 25-Pin GPIO Port 3-101
Configure a SeaLevel GPIO Board 3-103
Configure Smart GPI / RossTalk 3-105
Configure PBus Interface and PBus Recalls 3-107
Configure Camera Tracking 3-109
Setup OpenMAM 3-111
Set Up Server Channels 3-116
Configure XPression for XPression Clip Store 3-118

PBus Interface 4
Overview 4-1
PBus Triggers 4-2
PBus LEARN Commands 4-4
PBus Mapping 4-5
Using PBus from a Switcher to Recall Items 4-14
Using PBus for Clips 4-15

Scenes 5
Create a Project 5-2
Create a Scene 5-4
Create a Custom Size Scene 5-5
Duplicate a Scene 5-7
Delete a Scene 5-8
Create a Scene Group 5-9
Duplicate a Scene Group 5-11
Delete a Scene Group 5-13
Create a Roll/Crawl from a Scene Group 5-14
Customize a Scene Group Roll/Crawl 5-17
Using Transition Logic 5-20
Import From Project 5-31
Creating Global Macros 5-35

Base Objects 6
Create a Text Object 6-2
Use Tabs in a Text Object 6-4
Align Text Objects to Build a Table 6-6
Apply a Material to a Text Object 6-10
Apply Word Wrap to a Text Object 6-12
Apply Texture Mapping to a Text Object 6-14
Applying Underline, Superscript, and Subscript to a Text Object in the Main Viewport 6-17
Applying Underline, Superscript, and Subscript to a Text Object in the Take Inspector 6-19
Create a Background Object 6-23

Mesh Objects 7
Import a 3D, FBX, or OBJ Model into a Scene 7-2
Add a 3D Model to a Scene Director 7-5

Primitives 8
Create a Quad Object 8-2
Create a Sphere Object 8-5
Create a Cube Object 8-8
Set the Culling Mode for a Cube Object 8-11
Create a Cylinder Object 8-12
Create a Torus Object 8-15
Create a Slab Object 8-18
Set the Culling Mode for a Slab Object 8-21
Create a Lines Object 8-22
Lights 9
- Add a Directional Light Source to a Scene 9-2
- Add a Point Light Source to a Scene 9-4
- Add a Spot Light Source to a Scene 9-7

Cameras 10
- Add a Perspective Camera to a Scene 10-2
- Add an Orthographic Camera to a Scene 10-6

Layers 11
- Add a Layer Object to a Scene 11-2
- Add a Camera Layer Object to a Scene 11-4

Markers 12
- Add an Event Marker to a Scene 12-2

Miscellaneous Objects 13
- Group Scene Objects 13-2
- Position an Object 13-3
- Publish Template Links 13-5

Materials 14
- Create a Texture Material 14-2
- Create a Video Material 14-4
- Create a Server Channel Shader 14-7
- Create a Live Source Material 14-9
- Create a Low Latency Scaler Live Source Material 14-11
- Create a Window Capture Material 14-13

Fonts 15
- Add a Private Font to a Project 15-2
- Apply a Material to a Font 15-8

Animations 16
- Add Continuous Animation to an Object 16-2
- Add Key Frame Animation to an Object 16-5
- Move Key Frames in Animation Controller Timeline 16-7
- Trigger Clips and Audio 16-9
- Create Animation with Multiple Controllers 16-12
- Copy Keyframes to Animate an Object 16-14
- Copy and Paste Animation Controllers 16-18
- Scale an Active Animation Controller 16-20

Stagger Animations 17
- Add Stagger Animation to a Text or Group Object 17-2

Widgets 18
- Add a Realtime Clock Display to a Scene 18-2
- Customize the Time Format of a Widget 18-4
- Rename a Widget 18-6
- Add a Timer Display to a Scene 18-7
- Add a Counter Display to a Scene 18-11
- Customize the Counter Format of a Widget 18-13
- Add a Text List to a Scene 18-16

Effects 19
- Add an Effect or Transition to an Object or Scene 19-2

DataLinq™ 20
- Start the DataLinq Server 20-3
- Connect XPression to a DataLinq Server 20-36
- Link a Text Object to a DataLinq Data Source 20-37
- Link a Background Object to a DataLinq Source 20-39
- Link a Quad Object to a DataLinq Source 20-41
- Link a Sphere Object to a DataLinq Source 20-43
- Link a Cube Object to a DataLinq Source 20-45
- Link a Cylinder Object to a DataLinq Source 20-47
- Link a Torus Object to a DataLinq Source 20-49
- Link a Slab Object to a DataLinq Source 20-51
- Using DataLinq Keys with an ADO DB DataLinq 20-53
- Using DataLinq Keys with an XML DataLinq 20-56
- Using SQL Queries 20-59
- Using a Macro with a DataLinq Key 20-62
- Create a Data Page 20-64
- Using a Static URL 20-67
- Using a Dynamic URL 20-69
- Using Default URL Macros 20-72
- Using Table Presets 20-73

Sequences 21
- Create a Sequence 21-2
- Modify Template Content 21-3
- Control Sequence Playout 21-5
- Playout a Sequence in Manual Mode 21-7
- Playout a Sequence in Automatic Mode 21-8
- Create a Roll/Crawl from a Take Item Group 21-10
- Customize a Take Item Group Roll/Crawl 21-12
- Playout a Take Item or Take Item Group Using Timecode 21-14
- Render Take Items to Video 21-16

Record Client 22
- Recording a Video from an Input 22-2
- Capturing a Still Image from an Input 22-5
- Using Multiple Records Clients 22-8
- Using Fill/Key Simultaneously 22-9
- Create a Material from a Video or Image 22-10
- Send a Video or Image to Clip Store 22-12
Output 23
Preview Output in a Virtual Output 23-2
Render Output to an AVI File 23-3

Project Server 24
Setup Project Server 24-2
Publish a Project to Project Server 24-3
Deploy a Project from Project Server 24-7

Keyboard and GPI Mapping 25
Create a Custom Keyboard Map 25-2
Assign a Project Shortcut 25-3
Assign a Global Shortcut 25-4
Assign a Local Shortcut 25-10
Create a Custom GPI Map 25-11
Use the Quick Menu 25-14

Project Manager 26
Create a Category 26-2
Add a Scene or Scene Group to a Category 26-3
Delete a Category 26-5
Open Multiple Projects in the Project Manager 26-6
Activate a Project from a Project Group 26-7
Remove a Project from a Project Group 26-8

Clips 27
XPression Clips Playback Overview 27-2
Opening the Server Channels 27-3
Loading a Clip in the Server Channels 27-4
Opening the Clip Browser 27-6
Using the Clip Browser 27-7
Using the Server Channels 27-9
Edit Clip/Add Sub Clip 27-11
Updating the Thumbnail in the Clip Browser 27-15
Creating a 4-Point Loop 27-17
Creating a 3-Point Loop 27-19

Visual Logic 28
Opening the Visual Logic Editor 28-2
Objects and Function Blocks 28-3
Connecting Object and Function Blocks 28-5
Selecting Multiple Object and Function Blocks 28-7
Copying and Pasting Object and Function Blocks 28-8
Assigning and Pasting a Copied Object Attribute 28-9
Deleting Object and Function Blocks 28-11
Adding a New Visual Logic Tab 28-12
Deleting a Visual Logic Tab 28-13
Saving and Opening Visual Logic Files 28-14

XPression Tessera 29
User Interface Overview 29-2
XPression Tessera Setup 29-4
Tessera Playback 29-29

Appendix A: Keyboard Shortcuts A
Menu Shortcuts A-2
Toolbar Shortcuts A-2
Scene Manager Shortcuts A-3
Object Manager Shortcuts A-3
Object Inspector Shortcuts A-3
Text Objects Shortcuts A-4
Keyframe Editor Shortcuts A-4
Sequencer Shortcuts A-5
Material Manager Shortcuts A-6
Main Viewport Shortcuts A-6
Clip Browser A-6
Server Channels A-6
Visual Logic A-6
Introduction

XPression is a full featured broadcast graphics application with the necessary tools to create stunning graphics and animations that will meet the requirements set by today's graphics and animation designers.

About This Guide

This user guide describes the two main sections of XPression: an editor section and a sequencer section. The toolbar contains two buttons to switch between these sections. The layout section serves to create scenes with graphics and animations. The sequence section serves to set scenes in a sequence list and to play out the scenes. Both sections contain a number of dockable and non-dockable windows; to be used in the process of creating scenes, templates, and animations.

If, at any time, you have a question pertaining to the installation or operation of XPression, please contact us at the numbers listed in the section “Contacting Technical Support” on page 1–2. Our technical staff are always available for consultation, training or service.

For More Information on...

- XPression system hardware, refer to the Maintenance Guide.

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a sequence of menus and submenus that must be followed to reach a particular command.

**Bold text**

Bold text is used to identify a user interface element such as a dialog box, menu item, or button.

For example:

In the **3D Model Files** section, use the **Mode** list to select the folder used to store 3D model files.

**Courier text**

Courier text is used to identify text that a user must enter.

For example:

Enter *localhost* when the DataLinq server is running on the same computer as XPression.

> Menu arrows are used in procedures to identify a sequence of menu items that you must follow.

For example, if a step reads “**Display > Widgets**,” you would click the **Display** menu and then click **Widgets**.
Getting Help

The XPression Online Help system is accessed by selecting Help Topics from the Help menu in any component of XPression. Online Help opens in a Help Viewer window.

The Online Help system contains the following navigation tabs to locate information contained in Online Help topics and the User Guide:

- **Contents** — table of contents
- **Index** — keyword reference
- **Search** — full text search
- **Favorites** — preferred information storage and access

The XPression Online Help system displays, by default, the Contents pane. To access the Index or Search panes, click the Index or Search button on the top toolbar in the Online Help system.

The XPression Maintenance Guide and XPression User Guide are also supplied as print-ready PDF files. Locate the guides in the C:\Archive folder to open a guide PDF in Adobe® Reader® for viewing or printing.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support is provided directly by Ross Video personnel. During business hours (eastern time), technical support personnel are available by telephone any time. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support person who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

- **Technical Support:**
  - 1-844-652-0645 (North America)
  - +800 1005 0100 (International)
- **After Hours Emergency:** (+1) 613-349-0006
- **E-mail:** techsupport@rossvideo.com
- **Website:** http://www.rossvideo.com
User Interface Overview

The XPression interface is made up of two sections: a layout section, and a sequencer section. Both sections contain specific windows, as well as common windows. The layout section is the interface used to create and edit graphics and animations. The sequencer section is used to output graphics and animations placed on a sequence list.

The following topics are discussed in this section:
• The Layout Interface
• The Sequencer Interface
The Layout Interface

The following screen capture displays the main elements of the XPression Layout section user interface. Descriptions of individual elements are contained in the legend below the diagram.

1) **Menu Bar** — use this menu bar to access the File, Edit, Windows, Projects, Animation, Display, Tools, and Help menus.

2) **Toolbar** — use this toolbar to quickly access XPression tools.

3) **Position** — this section displays various position values related to the Main viewport.

4) **Project Manager** — use this window to view and manage the projects and project groups.

5) **Scene Manager** — use this window to view and manage the scenes and scene groups contained in a project.

6) **Main Viewport** — use this window as an editor to design scenes using objects from the Object Library.

7) **Material Manager** — use this window to view, apply, and manage the materials in a project.

8) **Object Library** — use this window to select the objects with which to build scenes.

9) **Scene Director** — use this window to create and manage tracks for animation controllers and audio files.

10) **Output Monitors** — use this window to select the output framebuffer. Each output framebuffer contains an infinite number of layers, and each layer can contain a scene. The hierarchical order for scene visibility runs from +# to -#, with positive layers being the top layers and negative layers being the lower layers.

11) **Object Manager** — use this window to view and manage the objects contained in a scene.

12) **Object Inspector** — use this window to edit the properties of a selected object. The tabs displayed in this window depend on the type of object selected.

13) **Animation Controller** — use the controller in this window to playback individual animations.
The Sequencer Interface

The following screen capture displays the main elements of the XPression Sequence section user interface. Descriptions of individual elements are contained in the legend below the diagram.

1) **Menu Bar** — use this menu bar to access the File, Edit, Windows, Projects, Animation, Display, Tools, and Help menus.
2) **Toolbar** — use this toolbar to quickly access XPression tools.
3) **Position** — this section displays various position values related to the Main viewport.
4) **Project Manager** — use this window to view and manage the projects and project groups.
5) **Scene Manager** — use this window to view and manage the scenes and scene groups contained in a project.
6) **Sequencer** — use this window to view and control a list of scenes or scene groups to be played in the order from top to bottom. A list is built by adding scenes from the Scene Manager.
7) **Sequencer Playlist** — use this window to view a list of all scenes and/or scene groups in the sequencer.
8) **Output Monitors** — use this window to select the output framebuffer. Each output framebuffer contains an infinite number of layers, and each layer can contain a scene. The hierarchical order for scene visibility runs from +# to -#, with positive layers being the top layers and negative layers being the lower layers.
9) **Take Inspector** — use this window to edit the properties of a selected group or take item.
10) **Preview** — use this window to preview a selected take item from the sequencer.
System Setup

Before you start using XPression to create projects, XPression needs to be configured for your environment. In addition to describing how to set preferences for XPression, this section also describes how to configure GPIs, video framebuffers, audio devices, video preview, and audio monitors.

🌟 A backup copy of the preferences and hardware setup are created when changes in the Preferences and Hardware Setup dialog box are made and OK is clicked, or when XPression is exited.

The following topics are discussed in this section:

- Set Preferences
- Configure an AJA NTV2 Video FrameBuffer
- Configure an AJA Video FrameBuffer (Legacy)
- Configure a Blackmagic Design FrameBuffer
- Configure a Blackmagic Design FrameBuffer (Legacy)
- Configure a Graphite FrameBuffer
- Configure a Matrox DSX, X.mio3 and X.mio5 FrameBuffer
- Configure a Matrox Video X.mio2 FrameBuffer
- NewTek™ Network Device Interface (NDI™)
- Configure an XPression AVI Recorder
- Configure an XPression Desktop Preview Client
- Configure an XPression DirectShow Capture Source
- Configure an XPression RossLinq Connector
- Configure the XPression Tile Mapper
- Configure an XPression Virtual Input
- Configure an XPression Virtual Output
- Change the Order of Video Inputs / Outputs
- Delete a Video Input / Output
- Configure an Audio Device
- Delete an Audio Device
- Add a Timecode Source
- Configure Video Preview and Audio Monitor
- Configure RS232 CTS/DSR GPI for Contact Closures
- Configure a 25-Pin GPIO Port
- Configure a SeaLevel GPIO Board
- Configure Smart GPI / RossTalk
- Configure PBus Interface and PBus Recalls
- Configure Camera Tracking
- Setup OpenMAM
- Set Up Server Channels
- Configure XPression for XPression Clip Store
Set Preferences

1. In XPression, use the Edit menu to select Preferences.
   The Preferences dialog box opens.

2. Click the Editor panel to set project preferences for the Editor section of XPression.

   ![Preferences dialog box](image)

   a. In the On Startup section, select the Load Most Recent Project check box to automatically load the last opened project after starting XPression.

   b. Select the Switch To Sequencer Mode check box to automatically display the Sequencer layout after starting XPression.

   c. Select the Do Not Create Untitled Project check box to avoid creating a new project when launching XPression. This is useful for MOS workflows.

   d. In the Confirmation section, select the On Object Deletion check box to display a Confirmation dialog box and request confirmation when deleting an object from a project.

   e. Select the On Object Has Children check box to display a Confirmation dialog box and request confirmation when child objects belong to the object selected for deletion.

   Deleting an object also deletes any related child objects.

   f. In the Settings section, use the Default Animation Controller Length box to enter or select the default frame length of the animation controller.

   g. Use the Default Text Object Rendering Priority list to set the default rendering priority for text objects. The available options are as follows:
      - Normal — new text objects display in front of other objects.
      - Text On Top — text objects always display in front of other objects.

   h. Use the Default Continuous Animation Sync list to select the default method used to start a continuous animation track. The available options are as follows:
      - Reset — start a continuous animation track at the starting point of the animation.
      - Clock — base the start of a continuous animation track on the clock. Select this method to synchronize a continuous animation track with previous animations. When using XPression Tessera, this setting is based on the Tessera clock.
i. Use the **Default Keyframe Interpolation** list to select the default method used for keyframe interpolations in the Keyframe Editor. The available options are:

- **TCB Spline** — use a TCB spline between keyframes.
- **Bezier Spline** — use a Bezier spline between keyframes.
- **Simple Bezier** — use a standard Bezier interpolation between keyframes.
- **Linear** — use a straight line between keyframes.
- **Hold** — no action is performed until one frame before the selected keyframe.

j. Select the **Include new scenes and objects in As Run by default** check box to include all newly created scenes and objects in the As Run Log by default.

3. Click the **Hardware Renderer** panel to select the graphics device used by XPression to render scenes to output framebuffers.

   a. Use the **Adapter** list to select the graphics device installed in the XPression computer.

   b. Use the **Anti-Alias** list to select the Multi-sampling value used to control the visual quality of rendered output.

      The higher the multi-sampling value, the smoother the rendered graphic edges. The <none> option is equal to 1x multi-sampling. For most situations, set the multi-sampling value according to the best quality/performance ratio, usually around 8x.

   c. In the **GPU Optimizations** section, select the **Optimize NVIDIA settings on startup** check box to optimize the NVIDIA global settings on startup to disable options like Anti-aliasing Gamma Correction. This option is selected by default.
4. Click the **Viewports** panel to set the visual quality of scenes rendered to XPression viewports.

![Viewports panel](image)

a. Select the **Render Using Anti-Alias** check box to use the multi-sampling value selected from the **Anti Alias** list in the **Hardware Renderer** panel to control the visual quality of scenes rendered to viewports. The higher the Multi-sampling value, the smoother graphic edges are rendered in a viewport.

   This check box is only available when the multi-sampling value set in the Hardware Renderer panel is higher than <none>.

5. Click the **Path Persistence** panel to set the folder locations used by XPression to search for and store XPression resources and files.

![Path Persistence panel](image)

a. In the **Project Files** section, use the **Mode** list to select the folder to open after selecting **Open** from the **File** menu. The available options are as follows:

   - **Last Used** — open the folder last used to save an XPression project file.
   - **Fixed** — open the folder specified in **Fixed** box.

   Enter the full path to the project folder in the **Fixed** box, or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the project folder.
b. In the **Image Files** section, use the **Mode** list to select the folder used to store image files. The available options are as follows:

- **Project | Last Used** — first search for image files in the folder set as the project folder, and if no image files are found, then look in the folder last used by XPression.
- **Last Used** — search for image files in the folder that was last used by XPression.
- **Fixed** — search for image files in the folder specified in **Fixed** box.
  
  Enter the full path to the image folder in the **Fixed** box, or click **Browse (…)** to the right of the box to use the **Browse for Folder** dialog box to select the image folder.
- **Project** — always return to the project folder for image files.
  
  Enter the full path to the image folder in the **Fixed** box, or click **Browse (…)** to the right of the box to use the **Browse for Folder** dialog box to select the image folder.

c. In the **Video Files** section, use the **Mode** list to select the folder used to store video files. The available options are as follows:

- **Project | Last Used** — first search for video files in the folder set as the project folder, and if no video files are found, then look in the folder last used by XPression.
- **Last Used** — search for video files in the folder that was last used by XPression.
- **Fixed** — search for video files in specified in **Fixed** box.
  
  Enter the full path to the video folder in the **Fixed** box, or click **Browse (…)** to the right of the box to use the **Browse for Folder** dialog box to select the video folder.
- **Project** — always return to the project folder for video files.

d. In the **Audio Files** section, use the **Mode** list to select the folder used to store audio files. The available options are as follows:

- **Project | Last Used** — first search for audio files in the folder set as the project folder, and if no audio files are found, then look in the folder last used by XPression.
- **Last Used** — search for audio files in the folder that was last used by XPression.
- **Fixed** — open the folder specified in **Fixed** box.
  
  Enter the full path to the audio folder in the **Fixed** box, or click **Browse (…)** to the right of the box to use the **Browse for Folder** dialog box to select the audio folder.
- **Project** — always return to the project folder for audio files.

e. In the **3D Model Files** section, use the **Mode** list to select the folder used to store 3D model files. The available options are as follows:

- **Project | Last Used** — first search for 3D model files in the folder set as the project folder, and if no 3D model files are found, then look in the folder last used by XPression.
- **Last Used** — search for 3D model files in the folder that was last used by XPression.
- **Fixed** — open the folder specified in **Fixed** box.
  
  Enter the full path to the 3D model folder in the **Fixed** box, or click **Browse (…)** to the right of the box to use the **Browse for Folder** dialog box to select the 3D model folder.
- **Project** — always return to the project folder for 3D model files.
6. Click the **Import** panel to configure the import settings.

   ![Import panel](image)

   a. In the **Default Import Actions** section, use the **Scenes** list to select the default import setting for scenes. The options are:
      - **Import New Scene** — import a scene into a project as a new scene if it has a scene name that exists in the open project in XPression.
      - **Replace Scene** — replace a scene in an open project in XPression with the same name as the imported scene.

   b. Use the **Materials** list to select the default import setting for materials. The options are:
      - **Use Existing Material** — use the existing material in a project open in XPression.
      - **Replace Material** — replace the material in an open project in XPression with the same name as the imported material.
      - **Create New Material** — create a new material in the project open in XPression with the imported material.

7. Click the **Folders** panel to set the folder used by XPression to store files created by the Input Grabber and Record Client.

   ![Folders panel](image)
a. In the **Default Grab Folder** section, enter the full path to the folder in which to save files created using the Input Grabber in the **Path** box, or click **Browse (…)** to the right of the box to use the **Browse for Folder** dialog box to select the grab folder.

b. In the **Record Folder** section, use the **Mode** list to select the mode of folder management to use to store files created by the Record Client. The options are:
   - **Project | Last Used** — save the files to the last folder used in a project folder for saving a file.
   - **Last Used** — save the files to the last folder used for saving a file.
   - **Fixed** — always save the files to the folder file path entered or selected in the **Path** box.
   - **Project** — always save the files to the last project folder used for saving a file.

   If using the fixed folder mode, use the **Path** box to enter the full path to the folder in which to save files created using the Record Client, or click **Browse (…)** to the right of this box to select a folder.

8. Click the **Texture & Image Cache** panel to set the texture and image cache settings.

   ![Texture & Image Cache panel](image)

a. In the **Texture & Image Cache** section, select the **Limit allocated memory pool** check box to limit the total size of texture and image files stored in the cache folder.

   Use the **MB** box to enter or select the size limit in MB for the total of all the cache files stored in the cache folder.

   Use the **Items** box to enter or select the size limit according to item amount in case of a high count of small images and/or textures.

b. Select the **Start caching on project load** check box to start caching texture and image files when a project starts loading.

c. Select the **Reload textures when file’s last modified time has changed** check box to reload cached textures that have been changed on disk.

d. In the **XMP Metadata** section, select the **Parse XMP metadata from image files** check box to parse the XMP metadata from image files in a project. It is enabled by default. Disabling this function will increase the loading speed of image files. Individual image file types can be enabled or disabled for parsing as follows:
   - **PNG** — select this check box to enable XMP metadata parsing of PNG image files when the **Parse XMP metadata from image files** check box is enabled.
   - **JPG** — select this check box to enable XMP metadata parsing of JPG image files when the **Parse XMP metadata from image files** check box is enabled.
   - **PSD** — select this check box to enable XMP metadata parsing of PSD image files when the **Parse XMP metadata from image files** check box is enabled.
   - **TIFF** — select this check box to enable XMP metadata parsing of TIFF image files when the **Parse XMP metadata from image files** check box is enabled.
e. In the **Alpha Channel Interpretation** section, use the **PNG**, **TIFF**, **TGA**, and **PSD** lists to select how the alpha channel will interpret the respective image files. The options are:

- **<autodetect>** — interpret the image file according to the source file.
- **Shaped / Premultiplied** — the image file uses a shaped key, where the key alpha cuts a hole based on the monochrome value of the alpha. Shades of gray are translated into either white or black, giving the key a hard edge.
- **Unshaped / Straight** — the image file uses an unshaped key, where the key alpha cuts a hole based on the gradient values of the alpha. Shades of gray are translated into transparency levels, giving the key a soft edge.

9. Click the **On Disk Cache** panel to set the folder locations used by XPression to store cache files on disk.

```
a. In the **Shader Objects** section, use the **Path** box to enter the full path to the folder in which to cache shader object files or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the cache folder.

b. In the **Max Size** box, enter or select the size limit in MB for the total of all the cache files stored in the cache folder.

c. In the **MipMap Objects** section, use the **Path** box to enter the full path to the folder in which to cache MipMap object files or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the cache folder.

d. Select the **Limit Size** check box to limit the total size of MipMap object files stored in the cache folder. In the **Max Size** box, enter or select the size limit in MB for the total of all the cache files stored in the cache folder.

e. In the **Script Engine** section, use the **Path** box to enter the full path to the folder in which to cache script engine files or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the cache folder.

f. In the **Max Size** box, enter or select the size limit in MB for the total of all the cache files stored in the cache folder.

g. In the **HTTP Download Cache** section, use the **Path** box to enter the full path to the folder in which to cache files from HTTP downloads or click **Browse (...)** to the right of the box to use the **Browse for Folder** dialog box to select the cache folder.

h. In the **Max Size** box, enter or select the size limit in MB for the total of all the cache files stored in the cache folder.
```
10. Click the **Sequencer** panel to control sequence lists.

   ![Sequencer panel](image)

   a. In the **Take Item List** section, select the **Loop at end** check box to automatically loop a sequence list when the end is reached manually.

   b. Select the **Center online in view** check box to position the active scene in a sequence list in the middle of the view, provided the sequence list extends the size of the view.

   c. Select the **Enable sorting by clicking column headers** check box to sort the information in the columns of the sequencer by heading.

   d. Select the **Assign new Take IDs starting from the Scene's ID** check box to assign newly created take items an ID starting from the ID of the template scene.

   e. Select the **Tab key advances through template data fields** check box to enable the use of the Tab key to cycle through template data fields in the sequencer.

   f. Select the **Shift+Tab should loop at beginning of published fields** check box to use the Shift+Tab keyboard command to loop to the end of the published object list when it reaches the top of the list in the take item inspector.

   g. Select the **Allow disabled items to be put online manually** check box to allow disabled items in the sequencer to go on air when triggered manually.

   h. Select the **Advance after taking item offline using minus key** check box to advance the sequence when taking an item off air using the `- / Take Offline` key on the number pad.

   i. In the **Fast Recall** section, select the **Fast Recall enabled on startup** check box to automatically enable fast recall in the sequencer on startup.

   j. Select the **Disable Fast Recall Input Timeout** check box to turn off the user entered input timeout for Take IDs in the sequencer.

   k. Select the **Expand sequence groups when selecting an item with Fast Recall** check box to expand the parent group of an item when it is selected using Fast Recall.

   l. In the **Pauses** section, select the **Pause events can be resumed before they have been reached** check box to resume play of pause events before the take item has reached the pause.

   m. Select the **Don’t move to the next take item until all pause events are taken** check box to play all pause events before moving to the next take item in the sequencer.
11. Click the **Sequencer (cont.)** panel for more options to control sequence lists.

![Sequencer Panel](image)

a. In the **Cueing** section, select the **Cue should re-cue take items already on air** check box to re-cue on air take items when the cue button is pressed.

b. Select the **Cue should re-cue server channels already playing** check box to re-cue on air server channels when the cue button is pressed.

c. Select the **All cued items on a framebuffer should be put on-air when any one of them are taken** check box to take all cued items on a framebuffer on air when one of them is taken online.

d. In the **Advanced** section, select the **Disable saving of take item thumbnails to project** check box to save projects without take item thumbnails. This results in faster saving, but the thumbnails might need to be regenerated upon loading of the project.

e. In the **Preview** section, select the **Show transparency in sequencer preview** check box to display transparency when previewing a take item in the sequencer preview window. This option can also be applied by right-clicking in the sequencer Preview window and selecting **Show Transparency** from the shortcut menu.

f. Select the **Use Asterisk (*) key to play animated preview** check box to enable the display of a live moving preview in the sequence mode when the asterisk key (*) is pressed on the number pad.

g. Select the **Render previews even when preview window is closed** check box to allow for external previews to be updated or for logic in OnPreviewRender scripts to be executed even when the preview window is closed.
12. Click the **MOS Settings** panel to configure the XPression settings when using XPression within a MOS workflow.

![MOS Settings panel]

a. In the **MOS Settings** section, select the **Disable thumbnail rendering for take items created by automation** check box to disable displaying scene thumbnails in the Sequencer Playlist for MOS items.

b. Select the **Save MOS created items to the project** check box to save MOS items in the sequencer.

c. Select the **Take IDs in loaded projects have precedence over MOS Take IDs** check box to give priority to the take IDs of take items from a subsequently loaded project over those from MOS.

d. Use the **Maximum length for Content string** box to enter or select a maximum character length for the take item content string in the sequencer.

e. Use the **Starting Take ID for MOS created items** box to enter or select a take ID number at which to start the MOS take IDs in the sequencer.

f. In the **Advanced** section, use the **MOS Preview Threads** box to enter or select the amount of simultaneous MOS previews that can be rendered at a time.

13. Click the **XML Take Item List** panel to configure the path and settings for XML Take Items.

![XML Take Item List panel]
a. In the XML Take Item List Watch Folder section, select the Enabled check box to use XML Take Items from a folder.

b. Select the Delete source file after parsing check box to delete XML Take Items after they are parsed from the selected folder.

c. Enter the full path to the folder in the Folder box, or click Browse (…) to the right of the box to use the Browse for Folder dialog box to select the folder.

d. In the XML Take Item List Importer section, select the Allow deletion of online items check box to enable the removal of take items that are currently active on an output.

e. Use the After import sort items on list to sort the imported take items. The available options are as follows:
   - <do not sort> — do not sort the take items.
   - take item id — sort the take items by ID.
   - take item state — sort the take items by state.
   - take item scene name — sort the take items by scene name.
   - take item name — sort the take items by name.
   - take item layer — sort the take items by layer.
   - take item framebuffer — sort the take items by framebuffer.

f. Select the Include groups when sorting check box to import the XML Take Items according to the groups that the items have been assigned.

14. Click the Fonts panel to control gamma correction, sharpness correction, and anti-aliasing for fonts.

![Fonts panel](image)

a. Select the Gamma Correction check box to apply gamma correction when changing the font factor.

   Gamma correction influences the degree of transparency used to anti-alias font edge steps. Changes to this factor are visible after re-rendering characters (e.g. changing font size).

b. In the Factor box, enter or select the gamma correction value.

c. Select the Sharpness Correction check box to apply sharpness correction when changing the font sharpness level.

   The sharpness correction value influences the degree of the combination between the resolution and acutance of the font. Changes to this factor are visible after re-rendering characters (e.g. changing font size).

d. In the Level box, enter or select the sharpness correction level.

e. In the Anti-Aliasing section, use the Steps list to select the anti-alias size step to use when rendering fonts.

   An anti-alias step size of 256 is the recommended setting.

f. In the Options section, select the Alternative font cache for East Asian languages to enable font cache optimizations for East Asian languages. This setting uses increased memory and is not recommended for Latin languages.
15. Click the Remote Server panel to configure the TCP server settings.

![Remote Server panel]

a. In the TCP Server section, enter or select the port number for the remote server.

This is the port number on which XPression will listen for incoming connections from other applications such as the MOS Gateway, CII gateway, and Media Control Gateway.

b. In the Automation section, select the Show Automation / OpenMAM Properties Tab in Object Inspector check box to display the Automation tab in the Object Inspector when a scene or scene group is selected in the Object Manager and/or the OpenMAM tab in the Object Inspector when a background, quad, sphere, cube, cylinder, torus, or slab object is selected in the Object Manager.

For information on using the OpenMAM tab in a distributed workflow, refer to the XPression Distributed Workflow User Guide.

c. In the DashBoard RPC Control Server section, use the Port box to enter or select the port number that specifies the TCP port used by the DashBoard API control protocol.

16. Click the CII panel to configure the CII settings.

![CII panel]

a. In the CII Page Recall section, select the Use Unique Gateway ID instead of Take Item ID check box to recall CII pages using a Unique Gateway ID.

b. Select the Process UPNEXT command even if no Preview Output is defined check box to process UPNEXT commands from OverDrive when no preview output has been defined in the hardware setup.
c. In the **Sequence Settings** section, select the **Create All Take Items in Group** check box to create the CII Take Items in a specific group.

d. Enter a group name for the CII Take Items in the **Group Name** box.

e. Use the **After create sort items by** list to sort the imported take items. The available options are as follows:
   - **<do not sort>** — do not sort the take items.
   - **take item id** — sort the take items by ID.
   - **take item state** — sort the take items by state.
   - **take item scene name** — sort the take items by scene name.
   - **take item name** — sort the take items by name.
   - **take item layer** — sort the take items by layer.
   - **take item framebuffer** — sort the take items by framebuffer.

f. Select the **Set Take Items Offline when Overwritten** check box to take the original take item offline when it is overwritten.

g. Select the **Move Sequencer Focus to Recalled Item** check box to move the sequencer focus to a recalled graphic when the graphic is recalled through CII.

h. In the **External Data Updates (X\ commands)** section, select the **Enable External Data Updates** check box to query for updates to data from external devices that support the workflow.

i. Select the **Update only on Manual Update Request** check box to disable the automatic CII X\ requests when cueing an item.

j. Use the **Number of digits in Field Number** box to enter or select a number of digits for the CII external update command field numbers.

17. Click the **RossTalk** panel to configure the RossTalk settings for XPression.

   ![RossTalk Panel](image)

   a. In the **RossTalk Settings** section, select the **Ignore TAKE / SEQI commands for items already online** check box to ignore TAKE and SEQI RossTalk commands for an item if it is already in the online state.

   b. Select the **Apply template data changes to items already on-air** check box to allow RossTalk TEMPLATEDATA commands to update published fields in sequencer items that are already on-air. It is selected by default.
18. Click the Video Engine panel to configure the cache size and select the CPU core of the video clients.

   ![Video Engine panel](image)

   a. In the Maximum Cache Size Per Video Client section, select the Cache Clips on GPU instead of Host Memory check box to cache directly on the GPU to improve playback performance.
   
   b. Use the Size box to enter or select the maximum cache size in MB per video client.
   
   c. In the Video Decoder Engine CPU Affinity section, select the CPU core of the video client.
   
   d. In the Record Settings, use the Input Cache Size box to enter or select a total amount of frames to cache when recording with the Record Client.

19. Click the ClipStore panel to configure the ClipStore options for XPression.

   ![ClipStore panel](image)

   a. In the ClipStore Options section, select the Use texture shader for playing back stills from ClipStore check box to assign ClipStore stills to published material using a texture shader instead of a video shader.
20. Click the OpenMAM panel to configure the cache settings for items retrieved from remote asset management systems.

   ![Cache Settings Panel]

   a. In the Local Cache Settings section, enter the full path to the folder in the Path box, or click Browse (...) to the right of the box to use the Browse for Folder dialog box to select the folder.

   b. In the Max Size box, enter or select the maximum size limit in MB for the total of all the cache files stored in the cache folder.

21. Click the As Run Log panel to configure the file settings and format for the XPression As Run Log.

   The As Run Log can be located in the C:\ drive under Program Files > XPressionStudio > logs > AsRun.

   ![As Run Log Settings Panel]

   a. In the File Settings section, use the Log Rotation list to select the frequency that the logging takes place. The available options are:

      • Daily
      • Weekly
      • Monthly

   b. Use the Limit number of logs to box to enter or select the maximum amount of log files to keep.

   ✴ XPression needs to be restarted for any changes to the file settings to take effect.

   c. In the Format section, select the Use Standard As Run Log Formatter Layout check box to set the As Run Log format to the standard layout required by the (external) XPression As Run Log formatter.
d. Use the text box to enter a tag string for the items you want to log. Use the example string and output to assist in constructing the format using the available tags.

e. Use the **Maximum length for Take Item Content string** box to enter or select a maximum character length for the take item content string logged in the As Run Log.

22. Click the **Advanced** panel to manage screen settings.

![](image.png)

a. In the **XPression Process** section, use the **Priority** list to select the CPU usage priority for XPression. The available CPU usage priorities are as follows:

- **Normal** — evenly distribute the CPU time between system processes with the similar priority.
- **High** — give XPression preference and allocate the majority of the CPU time to XPression.
- **Real-Time** — allocate all CPU time to XPression.

> Use the Real-Time CPU usage priority with caution, as this priority may cause other applications running on the XPression computer to freeze.

b. Select the **Allow Monitor Power Saving** check box to allow the monitor to run into sleep mode.

c. Select the **Allow Screen Saver** check box to allow the screen saver to run. A screen saver may compromise output performance. For maximum performance, clear this check box to stop the screen saver from running on the XPression computer.

d. Select the **Disable Initialization of Human Interface Devices** check box to ignore a 3Dconnexion 3D mouse connected to an XPression system.

e. In the **Scripting** section, select the **Enable debug monitor for scripting** check box to display errors and warnings from the scripting engine.

f. Select the **Execute OnPreviewRender for NLE and Exports (pre-9.0 behavior)** check box to allow OnPreviewRender scripts to be run in NLE workflows and when exporting to images/video.

g. In the **Video Export Settings** section, use the **Path to FFMPEG.exe** box to enter the absolute path to an FFMPEG executable or click **Browse (...)** to the right of the box to use a file navigator to locate the executable if using XPression 64-bit.

> XPression 64-bit editions cannot use QuickTime for export, so it is necessary to use a user-supplied FFMPEG version to perform a .MOV export.
23. Click the **Localization** panel to configure regional language settings.

![Localization panel](image)

a. In the **Locale** section, use the **Override User Locale** list to select a place to override the local settings.

b. In the **Unicode Font Handling** section, select the **Use advanced character shaping engine** to enable optimal support for languages with diacritic marks and character shaping.

c. Select the **Use Right To Left Reading Order** check box to default certain XPression components to right-to-left mode for Arabic language users.

d. Select the **Enable EUDC Character Lookups** check box to enable end user defined character lookups.

e. Select the **Use Windows Regional Settings for Digit Substitution** check box to enable the use of Windows settings for digit substitution (for example, Arabic and Persian languages).

f. In the **Text Entry** section, select the **Use standard edit controls for layout mode text entry** check box to enable use of the text tab for text entry in layout mode when not using right to left languages.

24. Click **OK**.

The **Preferences** dialog box closes.
Configure an AJA NTV2 Video FrameBuffer

1. **In XPression**, use the **Edit** menu to select **Hardware Setup**.
   The **Hardware Setup** dialog box opens.
2. **Click** the **Inputs / Outputs** tab.

   ![Hardware Setup Dialog Box](image)

3. **Click** Add.
   The **Add New FrameBuffer Board** dialog box opens.

   ![Add New FrameBuffer Board](image)

4. **Select** AJA NTV2 Video from the Brand list.
5. **Click OK**.
   The **AJA NTV2 Video - Framebuffer Setup** dialog box opens.
6. Click the Board tab to configure hardware settings, genlock settings, and the input and output configuration.

   a. In the Hardware section, use the Board list to select the installed board. This menu is automatically populated based on installed hardware (such as Corvid22, Corvid88, Kona IP).

   b. In the GenLock section, use the Source list to select the source of the genlock signal with which to synchronize XPression. The available genlock signal sources are as follows:
      - External Reference — Synchronize with a genlock signal received from an external application through the GenLock In port of the XPression computer. Ross Video recommends using an external reference for the genlock signal source.
      - Input 1 — Sync to Video In 1 source signal.
      - Input 2 — Sync to Video In 2 source signal.
      - Input 3 — Sync to Video In 3 source signal.
      - Input 4 — Sync to Video In 4 source signal.
      - Input 5 — Sync to Video In 5 source signal.
      - Input 6 — Sync to Video In 6 source signal.
      - Input 7 — Sync to Video In 7 source signal.
      - Input 8 — Sync to Video In 8 source signal.
      - Free Running — Do not synchronize XPression with an external source.

   * The availability of inputs depends on the output board of the XPression system. For example: up to two inputs with the Corvid22 or up to eight inputs with the Corvid88.

   * If the output keying mode is set to Internal in the Output tab, it is recommended that the GenLock source be set to an SDI input.

   c. In the I/O Configuration section, click Add to add an input or output channel. The Select I/O Type dialog box opens.
d. Use the **Type** list to select an input/output type. The options are:
   - **<none>** (this option is not applicable)
   - **Fill-Only Output** (1 output, no input) (requires a separate license or the XPression Clips option)
   - **Fill/Key Outputs** (2 outputs, no input)
   - **Fill Input** (1 input, no output)
   - **Internal Keyer** (1 input, 1 output)

   If the installed card does not have bidirectional I/Os, adding the output channels before the input channels is recommended.

e. Click **OK**.

   The input/output assignment is added to the **I/O Configuration** list.

   Repeat steps c to e for as many channels as necessary.

   ![I/O Configuration](image)

   SDI channel assignments are automatic and any channels beyond the number of channels supported by the graphics card will be listed as **N/A**.
Click an **Output** tab to configure output settings.

![Output tab configuration](image)

**a.** In the **Video Mode** section, use the **Standard** list to select the video format in which to output an XPression project. Depending on the graphics card, the available video formats are as follows:

- **<from project>** — automatically switch to the output video format to the video format of the currently loaded project.

  The project video format is ignored when a specific output video format is selected, and the selected video format is used to playout scenes.

- **PAL, 720x576, 25 frames/second**
- **NTSC, 720x486, 29.97 frames/second**
- **HD 1080i, 1920x1080, 25 frames/second**
- **HD 1080i, 1920x1080, 29.97 frames/second**
- **HD 1080p, 1920x1080, 23.976 frames/second**
- **HD 1080p, 1920x1080, 29.97 frames/second**
- **HD 1080p, 1920x1080, 50 frames/second**
- **HD 1080p, 1920x1080, 59.94 frames/second**
- **HD 1080p, 1920x1080, 60 frames/second**
- **HD 720p, 1280x720, 50 frames/second**
- **HD 720p, 1280x720, 59.94 frames/second**
- **HD 720p, 1280x720, 60 frames/second**
- **HD 1080psf, 1920x1080 23.976 frames/second**
- **HD 1080psf, 1920x1080 24 frames/second**
- **HD 1080psf, 1920x1080 25 frames/second**
- **HD 1080psf, 1920x1080 29.97 frames/second**
- **HD 1080psf, 1920x1080 30 frames/second**
- **UHD 2160p (Quad), 3840x2160, 29.97 frames/second**
- **UHD 2160p (Quad), 3840x2160, 50 frames/second**
- **UHD 2160p (Quad), 3840x2160, 59.94 frames/second**
- **UHD 2160p (2SI), 3840x2160, 29.97 frames/second**
- **UHD 2160p (2SI), 3840x2160, 50 frames/second**
- **UHD 2160p (2SI), 3840x2160, 59.94 frames/second**
- **UHD 2160psf (Quad), 3840x2160, 23.976 frames/second**
• UHD 2160psf (Quad), 3840x2160, 24 frames/second
• UHD 2160psf (Quad), 3840x2160, 25 frames/second

UHD formats only available on cards that support UHD.

b. In the Keying section, use the Mode list to select how graphics are output to a video stream. The available modes are as follows:
   • Off (Fill Only) — output a video signal with no key.
   • External — output the key and fill graphics as separate video signals. Graphics mixing occurs in an external keyer/mixer.
   • Internal — key and fill graphics are mixed internally and output as a single video signal from the framebuffer. In this mode the framebuffer functions as the keyer/mixer.

Selecting external or internal keying will change the number of inputs/outputs required and the I/O assignments in the Board tab.

If the output keying mode is set to Internal, it is recommended that the GenLock source in the Board tab be set to an SDI input.

c. When External is selected in the Mode list, use the Fill list to select the method used to process fill graphics before output. The available processing methods are as follows:
   • Shaped (premultiplied) — multiply/shape the fill signal color information by the luminance information in the key signal.
   • Unshaped — output fill and key signals “as is”.

d. In the Hardware Buffers section, use the Queue Size box to enter or select the number of frames to buffer in memory before sending to the output.

Use this setting to avoid buffer under runs, which may cause frame skipping. Larger queue sizes ensure smooth playout of generated graphics, but add delay to the output.

e. Use the Pre Queue box to enter or select the number of frames to buffer for the pre-queue. The pre-queue size can be between 1 and 8.

f. In the Audio section, select the Audio Loop Through check box to enable embedded audio loop through. This option applies to internal keyer only.

In the Ancillary Data section, select the Pass Ancillary Data From check box and use the list to select an input from which to pass the vertical ancillary data from a live source. The functionality of this feature is based on the availability of an ancillary input that is determined by the installed output board.

h. In the Misc section, select the Output Super Black and Super White to output using the full super black to super white range.
8. Click the **Input** tab to configure input settings.

   a. In the **Video Mode** section, use the **Standard** list to select the video format in which to receive video.

   b. In the **Hardware Buffers** section, use the **Queue Size** box to enter or select the number of frames to buffer in memory before sending to XPression.

   c. In the **Input to Output Latency** section, use the **Latency** box to enter or select a fixed delay, in frames, between the input and output. To remain fixed, the delay must be large enough to accommodate the **Queue Size** and **Pre Queue** values in the **Hardware Buffers** section.
9. Click the Misc tab to configure analog, HDMI output, digital output timing offset, startup, and shutdown settings.

- Analog output and HDMI output are only available on cards that provide them.
  
  a. In the Analog Output Mode section, use the Mode list to select the video format in which to output an analog video signal.
  
  b. In the HDMI Output Mode section, use the Color Space list to select the specific organization of colors for the HDMI output. The options are:
     - YCbCr
     - RGB
  
  c. Use the Range list to select the color range for the selected color space. The options are:
     - SMPTE Range
     - Full Range
  
  d. Use the Bit Depth list to select the number of bits used for a pixel. The options are:
     - 8-bit
     - 10-bit
  
  e. Use the Audio Channels list to select the number of audio channels to output. The options are:
     - 2 channels
     - 8 channels
  
  f. In the Digital Output Timing Offset section, use the Horizontal box to enter or select the horizontal delay timing offset with regards to an external reference. This setting is for external reference only.
  
  g. In the Vertical box, enter or select the number of lines for vertical delay timing offset with regards to an external reference. This setting is for external reference only.
  
  h. In the Finalization section, use the Shutdown list to select the video state at shutdown. The available states are as follows:
     - Retain Current State — do not clear the content of the framebuffers on shutdown.
     - Clear Framebuffers — clear all framebuffers from the output framebuffer.
10. If the installed card provides up/down conversion, click the **Conversion** tab to enable or disable output conversion to a predefined signal.

![Conversion tab](image)

a. In the **Up/Down Conversion** section, use the **Conversion** list to select the video mode for the conversion.

b. Use the **Up** list to select a format for the up converted output. The available output formats are:
   - **Anamorphic** — display a full-screen image.
   - **Pillar box 4:3** — display a 4:3 image in the center of the screen with black sidebars.
   - **Zoom 14:9** — display a 4:3 image zoomed to fill a 14:9 image with black sidebars.
   - **Letterbox** — display an image zoomed to fill letterbox displays or display a reduced image with black bars added to top and bottom of the image area with aspect ratio preserved.
   - **Zoom Wide** — display an image zoomed and horizontally stretched to fill full screen.

c. Use the **Down** list to select a format for the down converted output. The available output formats are:
   - **Letterbox** — display a reduce image with black bars added to the top and bottom of the image area with the aspect ratio preserved.
   - **Crop** — crop the image to fit the new screen size.
   - **Anamorphic** — display a 16:9 image in a 4:3 box.

d. In the **Conversion Path** section, select the check box or check boxes of the outputs to use to display the converted video:
   - **SDI Output (Channel 1)**
   - **Analog Output**
   - **HDMI Output**

11. If configuring a Kona IP card, select the **IP** tab to configure the **SFP** settings.

   Depending on the card firmware configuration, the settings can be available according to 1-SFP and 2-SFP, where:
   - with 1-SFP, the primary streams will be on the top SFP module. If 1-SFP is enabled with 2022-7 protocol, the bottom SFP module will be used for the redundant streams.
   - with 2-SFP, the some primary streams will be on the top SFP module and others on the bottom SFP module. Specifically:
     - output streams 1 and 2 on the bottom
     - output streams 3 and 4 on the top
     - input streams 1 and 2 on the top
     - input streams 3 and 4 on the bottom
If the Kona IP card is configured for 1-SFP, the IP tab is displayed.

a. Use the **SFP Top** and **SFP Bottom** tabs in the **Network** section to configure the local IP address of the location to connect the small form-factor pluggable transceiver using the **Local IP Address** box.

b. Use the **Subnet Mask** box to enter the subnet mask of the location to connect the small form-factor pluggable transceiver.

c. Use the **Gateway Address** box to enter the IP address of the location to connect the small form-factor pluggable transceiver.

d. Select an output stream in the **Output Streams** section and click **Configure**.

   The **AJA NTV2 - IP Output Stream Setup** dialog box opens.

   e. In the **Primary Output Stream - SFP Top / Bottom** section configure the following settings:
      - **Source Port** — use this box to enter or select the port number of the primary output stream source.
      - **Remote IP Addr** — use this box to enter the remote IP address of the primary output stream.
      - **Remote Port** — use this box to enter or select the remote port number for the primary output stream.

   f. Click **OK**.

   The **AJA NTV2 - IP Output Stream Setup** dialog box closes and the settings are added to the selected output stream.

   g. Repeat steps d to f for any other output streams.
h. In the **Input Streams** section, select an input stream and click **Configure**. The **AJA NTV2 - IP Input Stream Setup** dialog box opens.

![AJA NTV2 - IP Input Stream Setup dialog box]

i. In the **Primary Input Stream - SFP Top / Bottom** section configure the following settings:
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary video input stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary video input stream.
   - **Match Port** — select this check box to enable that the remote IP address and remote port must match. When not selected, only the remote IP address needs to match and the remote port is ignored.

j. Click **OK**. The **AJA NTV2 - IP Input Stream Setup** dialog box closes and the settings are added to the selected input stream.

k. Repeat steps h to j for any other input streams.

1-SFP 2022-7 Protocol Enabled

If the Kona IP card is configured for 1-SFP, the IP tab is displayed.

a. In the **Network** section, select the **Enable 2022-7** check box to use the 2022-7 standard to enable redundancy for the SFP module connection. If enabling redundancy, the output streams will include both a primary and secondary output stream.

![Network section]

b. Use the **SFP Top** and **SFP Bottom** tabs to configure the local IP address of the location to connect the small form-factor pluggable transceiver using the **Local IP Address** box.

c. Use the **Subnet Mask** box to enter the subnet mask of the location to connect the small form-factor pluggable transceiver.
c. Use the **Gateway Address** box to enter the IP address of the location to connect the small form-factor pluggable transceiver.

d. Select an output stream in the **Output Streams** section and click **Configure**.

The **AJA NTV2 - IP Output Stream Setup** dialog box opens.

![Output Stream Setup Dialog](image)

**Primary Output Stream - SFP Top**

- **Source Port** — use this box to enter or select the port number of the primary output stream source.
- **Remote IP Addr** — use this box to enter the remote IP address of the primary output stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary output stream.

e. In the **Primary Output Stream - SFP Top** section configure the following settings:

f. In the **Secondary Output Stream - SFP Bottom** section configure the following settings:

- **Source Port** — use this box to enter or select the port number of the secondary output stream source.
- **Remote IP Addr** — use this box to enter the remote IP address of the secondary output stream.
- **Remote Port** — use this box to enter or select the remote port number for the secondary output stream.

g. Click **OK**.

The **AJA NTV2 - IP Output Stream Setup** dialog box closes and the settings are added to the selected output stream.

h. Repeat steps d to g for any other output streams.

i. In the **Input Streams** section, select an input stream and click **Configure**.

The **AJA NTV2 - IP Input Stream Setup** dialog box opens.

![Input Stream Setup Dialog](image)

**Primary Input Stream - SFP Top**

- **Remote IP Addr** — use this box to enter the remote IP address of the primary video input stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary video input stream.
- **Match Port** — select this check box to enable that the remote IP address and remote port must match. When not selected, only the remote IP address needs to match and the remote port is ignored.

j. In the **Primary Input Stream - SFP Top** section configure the following settings:

k. In the **Secondary Input Stream - SFP Bottom** section configure the following settings:

- **Remote IP Addr** — use this box to enter the remote IP address of the secondary video input stream.
- **Remote Port** — use this box to enter or select the remote port number for the secondary video input stream.
- **Match Port** — select this check box to enable that the remote IP address and remote port must match. When not selected, only the remote IP address needs to match and the remote port is ignored.

l. Click **OK**.

The **AJA NTV2 - IP Input Stream Setup** dialog box closes and the settings are added to the selected input stream.

m. Repeat steps i to l for any other input streams.
2-SFP

If the Kona IP card is configured for 2-SFP, the IP tab is displayed.

![IP tab screenshot]

a. Use the SFP Top and SFP Bottom tabs in the Network section to configure the local IP address of the location to connect the small form-factor pluggable transceiver using the Local IP Address box.

b. Use the Subnet Mask box to enter the subnet mask of the location to connect the small form-factor pluggable transceiver.

c. Use the Gateway Address box to enter the IP address of the location to connect the small form-factor pluggable transceiver.

d. In the Output Streams section, select an output stream and click Configure.

   The AJA NTV2 - IP Output Stream Setup dialog box opens.

![Output Streams setup]

e. In the Primary Output Stream - SFP Top / Bottom section configure the following settings:
   • Source Port — use this box to enter or select the port number of the primary output stream source.
   • Remote IP Addr — use this box to enter the remote IP address of the primary output stream.
   • Remote Port — use this box to enter or select the remote port number for the primary output stream.

f. Click OK.

   The AJA NTV2 - IP Output Stream Setup dialog box closes and the settings are added to the selected output stream.

g. Repeat steps d to f for any other output streams.
h. In the **Input Streams** section, select an input stream and click **Configure**.

The **AJA NTV2 - IP Input Stream Setup** dialog box opens.

![AJA NTV2 - IP Input Stream Setup dialog box](image)

i. In the **Primary Input Stream - SFP Top / Bottom** section configure the following settings:

- **Remote IP Addr** — use this box to enter the remote IP address of the primary video input stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary video input stream.
- **Match Port** — select this check box to enable that the remote IP address and remote port must match. When not selected, only the remote IP address needs to match and the remote port is ignored.

j. Click **OK**.

The **AJA NTV2 - IP Input Stream Setup** dialog box closes and the settings are added to the selected input stream.

k. Repeat steps h to j for any other input streams.

12. Click **OK**.

The configured AJA Video framebuffer board is added to the **Inputs / Outputs** tab of the **Hardware Setup** dialog box.

13. In the **Hardware Setup** dialog box, click **Close**.

The **Hardware Setup** dialog box closes.
Configure an AJA Video FrameBuffer (Legacy)

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.
   
   ![Hardware Setup dialog box](image)

3. Click Add.
   The Add New FrameBuffer Board dialog box opens.

4. Select AJA Video (legacy) from the Brand list.
5. Click OK.
   The AJA Video (Legacy) - Framebuffer Setup dialog box opens.
6. Click the Board tab to configure hardware and genlock settings.
   
   ![Board tab](image)

   a. In the Hardware section, use the Board list to select the installed board.
      This menu is automatically populated based on installed hardware.
b. In the GenLock section, use the Source list to select the source of the genlock signal with which to synchronize XPression. The available genlock signal sources are as follows:

- **External Reference** — Synchronize with a genlock signal received from an external application through the GenLock In port of the XPression computer. Ross Video recommends using an external reference for the genlock signal source.
- **Input 1** — Sync to Video In 1 source signal.
- **Input 2** — Sync to Video In 2 source signal.
- **Free Running** — Do not synchronize XPression with an external source.

🌟 If the output keying mode is set to Internal in the Output tab, the GenLock source needs to be set to an SDI input.

7. Click the Output tab to configure output settings.

![Output Settings](image)

a. In the Video Mode section, use the Standard list to select the video format in which to output an XPression project. The available video formats are as follows:

- **<from project>** — automatically switch to the output video format to the video format of the currently loaded project.
  
  The project video format is ignored when a specific output video format is selected, and the selected video format is used to playout scenes.
- **PAL, 720x576, 25 frames/second**
- **NTSC, 720x486, 29.97 frames/second**
- **HD 1080i, 1920x1080, 25 frames/second**
- **HD 1080i, 1920x1080, 29.97 frames/second**
- **HD 1080p, 1920x1080, 23.976 frames/second**
- **HD 1080p, 1920x1080, 50 frames/second**
- **HD 1080p, 1920x1080, 59.94 frames/second**
- **HD 720p, 1280x720, 50 frames/second**
- **HD 720p, 1280x720, 59.94 frames/second**

b. In the Keying section, use the Mode list to select how graphics are output to a video stream. The available modes are as follows:

- **External** — Output the key and fill graphics as separate video signals. Graphics mixing occurs in an external keyer/mixer.
- **Internal** — Key and fill graphics are mixed internally and output as a single video signal from the framebuffer. In this mode the framebuffer functions as the keyer/mixer.
c. When **External** is selected in the **Mode** list, use the **Fill** list to select the method used to process fill graphics before output. The available processing methods are as follows:

- **Shaped (premultiplied)** — Multiply/shape the fill signal color information by the luminance information in the key signal.
- **Unshaped** — Output fill and key signals “as is”.

d. In the **Hardware Buffers** section, use the **Queue Size** box to enter or select the number of frames to buffer in memory before sending to the output.

Use this setting to avoid buffer under runs, which may cause frame skipping. Larger queue sizes ensure smooth playout of generated graphics, but add delay to the output.

e. In the **Up/Down Conversion** section, use the **Conversion** list to enable or disable output conversion to a predefined signal.

f. Use the **Path** list to select the source display on the output.

g. Use the **Up** list to select the format for up converted output. The available output formats are as follows:

- **Anamorphic** — Display a full-screen image.
- **Pillar box 4:3** — Display a 4:3 image in the center of the screen with black sidebars.
- **Zoom 14:9** — Display a 4:3 image zoomed to fill a 14:9 image with black sidebars.
- **Letterbox** — Display an image zoomed to fill full screen.
- **Zoom Wide** — Display an image zoomed and horizontally stretched to fill full screen.

h. Use the **Down** list to select the format for down converted output. The available output formats are as follows:

- **Letterbox** — Display a reduce image with black bars added to the top and bottom of the image area with the aspect ratio preserved.
- **Crop** — Crop the image to fit the new screen size.
- **Anamorphic** — Display a 16:9 image in a 4:3 box.

8. Click the **Input** tab to configure input settings.

   ![Input Tab](image)

   a. In the **Video Mode** section, use the **Standard** list to select the analog video format in which to receive video.

   b. In the **Hardware Buffers** section, use the **Queue Size** box to enter or select the number of frames to buffer in memory before sending to XPression.
9. Click the Misc tab to configure analog, timing, startup, shutdown, and audio settings.

![Misc tab configuration](image)

a. In the Analog Output Mode section, use the Mode list to select the video format in which to output an analog video signal.

b. In the Digital Output Timing Offset section, use the Horizontal box to enter or select the number of lines for horizontal delay timing offset with regards to an external reference.

c. In the Vertical box, enter or select the number of lines for vertical delay timing offset with regards to an external reference.

d. In the Initialization / Finalization section, use the Startup list to select the video state at startup. The available states are as follows:
   - Retain Current State — Retain resources to use once again.
   - Clear Framebuffers — Clear all framebuffers from the output framebuffer.

e. Use the Shutdown list to select the video state at shutdown. The available states are as follows:
   - Retain Current State — Retain resources to use once again.
   - Clear Framebuffers — Clear all framebuffers from the output framebuffer.

f. In the Audio section, select the Audio Loop Through check box to enable embedded audio loop through.

10. Click OK.

The configured AJA Video framebuffer board is added to the Inputs / Outputs tab of the Hardware Setup dialog box.

11. In the Hardware Setup dialog box, click Close.

The Hardware Setup dialog box closes.
Configure a Blackmagic Design FrameBuffer

1. In XPression, use the Edit menu to select Hardware Setup. The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

![Hardware Setup dialog box]

3. Click Add. The Add New FrameBuffer Board dialog box opens.

![Add New FrameBuffer Board dialog box]

4. Select Blackmagic Design from the Brand list.
5. Click OK.

The Blackmagic Design - Framebuffer Setup dialog box opens.
6. Click the **Board** tab to configure hardware settings.

![Board tab screenshot]

a. In the **Hardware** section, use the **Board** list to select the installed Blackmagic Design card to configure.

b. In the **GenLock** section, use the **Source** list to select the source of the genlock signal with which to synchronize XPression. The available genlock signal sources are as follows:

   - **External Reference** — Synchronize with a genlock signal received from an external application through the GenLock In port of the XPression computer. Ross Video recommends using an external reference for the genlock signal source.
   - **Free Running** — Do not synchronize XPression with an external source.

c. In the **I/O Configuration** section, click **Add** to add an input or output channel.

   The **Select I/O Type** dialog box opens.

![Select I/O Type dialog box]

d. Use the **Type** list to select an input/output type. The options are:

   - **<none>** (this option is not applicable)
   - **Fill-Only Output** (uses 1 output) (requires a separate license or the XPression Clips option)
   - **Fill/Key Output** (uses 2 outputs)
   - **Fill Input** (uses 1 input)
   - **Internal Keyer** (uses 1 input, 1 output)
e. Click **OK**.

The input/output assignment is added to the **I/O Configuration** list.

Depending on the I/O configuration, repeat steps c to e for as many channels as necessary.

![I/O Configuration](image)

* SDI channel assignments are automatic and any channels beyond the number of channels supported by the graphics card will be listed as **Exceeds device capacity**.

7. Click the **Output** tab to configure output settings.

![Output Settings](image)

a. In the **Video Mode** section, use the **Standard** list to select the video format in which to output an XPression project.
b. In the **Keying** section, use the **Mode** list to select how graphics are output to a video stream. The modes are as follows:

- **Off (Fill Only)** — Only output a video signal. In this mode, graphics are excluded from the output.
- **External** — Output the key and fill as separate video signals. Graphics and video mixing occurs in an external keyer/mixer.
- **Internal** — Key and fill are mixed internally. Graphics and video input are outputted as a single video signal from the framebuffer. In this mode the framebuffer functions as the keyer/mixer.

c. When **External** is selected in the **Mode** list, use the **Fill** list to select the method used to process fill graphics before output. The available processing methods are as follows:

- **Shaped (premultiplied)** — Multiply/shape the fill signal color information by the luminance information in the key signal.
- **Unshaped** — Output fill and key signals “as is”.

d. In the **Misc** section, use the **Queue Size** box to enter or select the number of frames to buffer in memory before sending to the output.

Use this setting to avoid buffer under runs, which may cause frame skipping. Larger queue sizes ensure smooth playout of generated graphics, but add delay to the output.

e. Use the **Pre Queue** box to enter or select the number of frames to buffer for the pre-queue. The pre-queue size can be between 1 and 8.

8. Click the **Input** tab to configure input settings.

   ![Input Tab Configuration](image)

a. In the **Video Mode** section, use the **Standard** list to select the analog video format in which to receive video. The only option currently available is **<auto detect>**.

b. In the **Input to Output Latency** section, use the **Latency** box to enter or select a fixed delay, in frames, between the input and output. To remain fixed, the delay must be large enough to accommodate the **Queue Size** and **Pre Queue** values in the **Hardware Buffers** section of the corresponding **Output** tab.

9. Click **Apply**.

The changes to the Blackmagic Design framebuffer board are applied.

10. Click **OK**.

The configured Blackmagic Design framebuffer board is added to the **Inputs / Outputs** tab of the **Hardware Setup** dialog box.

11. In the **Hardware Setup** dialog box, click **Close**.

The **Hardware Setup** dialog box closes.
Configure a Blackmagic Design FrameBuffer (Legacy)

1. In Xpression, use the Edit menu to select Hardware Setup.
The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

3. Click Add.
The Add New FrameBuffer Board dialog box opens.

4. Select Blackmagic Design (Legacy) from the Brand list.
5. Click OK.
The Blackmagic Design (Legacy) - Framebuffer Setup dialog box opens.
6. Click the Board tab to configure hardware settings.

   a. In the Hardware section, use the Board list to select the installed DeckLink Studio card to configure.
b. In the **Input / Output Options** section, use the **Output** list to select when to activate video output from the Blackmagic Design framebuffer. The options are as follows:

- **Always active** — Always output video.
- **Active on use only** — Only output video when the card is in use.

c. Use the **Input** list to select when to activate video input through the Blackmagic Design framebuffer. The available options are as follows:

- **Will deactivate the output when activated** — automatically deactivate the output when the input is activated.
- **Can only be activated when the output is not active** — input can only be activated when the output is not active.
- **Always disabled** — disable the input.
- **Always enabled (output will always be disabled)** — enable the input and disable the output at all times.

* Input grabbing may compromise output performance.

7. Click the **Output** tab to configure output settings.

![Output tab configuration](image)

a. In the **Video Mode** section, use the **Standard** list to select the video format in which to output an XPression project.

b. In the **Keying** section, use the **Mode** list to select how graphics are output to a video stream. The modes are as follows:

- **External** — Output the key and fill as separate video signals. Graphics and video mixing occurs in an external keyer/mixer.
- **Internal** — Key and fill are mixed internally. Graphics and video are output as a single video signal from the framebuffer. In this mode the framebuffer functions as the keyer/mixer.
- **Off** — Only output a video signal. In this mode, graphics are excluded from the output.

c. When **External** is selected in the **Mode** list, use the **Fill** list to select the method used to process fill graphics before output. The available processing methods are as follows:

- **Shaped (premultiplied)** — Multiply/shape the fill signal color information by the luminance information in the key signal.
- **Unshaped** — Output fill and key signals “as is”.

d. In the **Software Buffers** section, use the **Queue Size** box to enter or select the number of frames to buffer in memory before sending to the output.

Use this setting to avoid buffer underruns, which may cause frame skipping. Larger queue sizes ensure smooth playout of generated graphics, but add delay to the output.

e. Use the **Audio Delay Offset** box to enter or select an amount of frames as a buffer.
f. In the **Analog Output** section, use the **Mode** list to select the type of analog video signal to output. The available output video signals are as follows:

   - **Composite** — output a single video signal that combines luminance and chroma.
   - **Component** — output three channels (Y, R-Y, and B-Y).
   - **S-Video** — output a video signal that carries the video data as two separate signals (brightness and color), unlike composite video which carries the entire set of signals through a signal line.


g. When **Component** is selected in the **Mode** list, use the **Component Level** list to select the output component analog level. The available levels are as follows:

   - **SMPTE** — use this level for monitoring component analog video.
   - **Betacam** — use this level for output to Sony Betacam SP decks.

h. Use the **Black Level** list to select the default black level analog video signal. The available levels are as follows:

   - **7.5 IRE (USA)** — standard black level for all NTSC countries except Japan.
   - **0.0 IRE (Japan)** — standard black level for Japan.

8. Click the **Input** tab to configure input settings.

   ![Input Tab](image)

a. In the **Video Mode** section, use the **Standard** list to select the analog video format in which to receive video.

b. In the **Audio Mode** section, use the **Channels** list to select the channel inputs in which to receive the embedded audio. The options available are:

   - 2 channel
   - 4 channel
   - 6 channel
   - 8 channel
   - 10 channel
   - 12 channel
   - 16 channel

9. Click **OK**.

   The configured Blackmagic Design framebuffer board is added to the **Inputs / Outputs** tab of the **Hardware Setup** dialog box.

10. In the **Hardware Setup** dialog box, click **Close**.

    The **Hardware Setup** dialog box closes.
Configure a Graphite FrameBuffer

1. In XPression, use the Edit menu to select Hardware Setup. The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

3. Click Add. The Add New FrameBuffer Board dialog box opens.

4. Select Graphite from the Brand list, if not already selected.
5. Click OK. The Graphite - Framebuffer Setup dialog box opens.
6. Select the **Board** tab to choose and configure an installed card.
   This menu is automatically populated based on installed hardware.

7. In the **Hardware** section, use the **Board** list to select a Graphite card to configure, if not already selected.
   The **I/O Configuration** list will be populated according to the type of XPression system:
   - XPression Graphite and XPression Studio SCE:
     - 3 Fill/Key Outputs
     - 1 Fill/Key Input
   - XPression Studio:
     - 4 Fill/Key Outputs
     - 4 Fill/Key Inputs

8. Click an **Output Chan** (Output Channel) tab to configure an output channel.

   ![Output Channel Configuration](image)

   a. In the **Hardware Buffers** section, use the **Queue Size** box to enter or select the number of frames to buffer in memory before sending to the output.
      Use this setting to avoid buffer under runs, which may cause frame skipping. Larger queue sizes ensure smooth playout of generated graphics, but add delay to the output.

   b. Use the **Pre Queue** box to enter or select the number of frames to buffer for the pre-queue. The pre-queue size can be between 1 and 8.

   c. In the **Misc** section, select the **Use GPU Color Space Conversion** to use the GPU to perform the color space conversion on the outputs. This option provides optimal performance.
9. Click an **Input Chan** (Input Channel) tab to configure an input channel.

   ![Input Channel Configuration](image)

   **a.** In the **Input to Output Latency** section, use the **Latency** box to enter or select a fixed delay, in frames, between the input and output. To remain fixed, the delay must be large enough to accommodate the **Queue Size** and **Pre Queue** values in the **Hardware Buffers** section of the corresponding **Output** tab.

   **b.** In the **Settings** section, select the **Use Alpha Channel when Input used in Live Source Shader** check box to use the alpha channel when the selected input is used in a live source shader.

   Repeat steps 8 to 9 for as many channels as necessary.

10. Click **OK**.

    The input/output assignment is added to the **I/O Configuration** list.
Configure a Matrox DSX, X.mio3 and X.mio5 FrameBuffer

Use the following procedure to configure a Matrox DSX LE4, DSX LE5 D25, X.mio3, or X.mio5 framebuffer board.

No 2SI support with XPression 10.5 combined with Matrox driver version 10.0.3. Matrox driver 10.1 is required.

1. **In XPression**, use the **Edit** menu to select **Hardware Setup**.
   The **Hardware Setup** dialog box opens.
2. Click the **Inputs / Outputs** tab.

![Hardware Setup Dialog Box](image)

3. Click **Add**.
   The **Add New FrameBuffer Board** dialog box opens.

![Add New FrameBuffer Board Dialog Box](image)

4. Select **Matrox DSX** from the **Brand** list.
5. Click OK.

The Matrox DSX - Framebuffer Setup dialog box opens.

6. Select the Board tab to choose and configure an installed DSX LE4, DSX LE5 D25, or X.mio3 card.

   a. In the Hardware section, use the Board list to select the installed DSX LE4, DSX LE5 D25, or X.mio3 card to configure.

      The read-only I/O Mode displays the input and output configuration for the card. These options vary based on the card and in what configuration it was flashed. The defaults are:

      - **2 IN / 6 Out** (for DSX LE4/8/100 and X.mio3/6/100)
      - **4 IN / 4 Out** (for DSX LE IP and X.mio3 IP)
      - **8 IN / 8 OUT, 2 IN / 2 OUT** for UHD (for DSX LE5 D25)

      Depending on the XPression software version, extra fill outputs on the DSX LE4, DSX LE5 D25, and X.mio3 can be used for preview purposes. Contact a Ross representative for details.
b. In the **GenLock** section, use the **Source** list to select the source of the GenLock signal with which to synchronize XPression. The available GenLock signal sources vary based on the card and card configuration. Examples include:

- **External Reference** — Synchronize with a genlock signal received from an external application through the GenLock In port of the XPression computer. Ross Video recommends using an external reference for the GenLock signal source.
- **SDI IN #** — sync to an available SDI Input source signal. The SDI input numbers will vary based on the card and how it was flashed.
- **IP Reference (SMPTE ST 2059-2)**
- **SFP A (SMPTE ST 2059-2)**
- **SFP B (SMPTE ST 2059-2)**
- **Free Running** — do not synchronize XPression with an external source.

c. Use the **Standard** list to select the format of the incoming GenLock signal.

d. Use the **Clock Domain** box to enter or select the PTP clock domain when using an IP GenLock (SMPTE ST-2059). This option is only available on cards supporting IP.

e. Use the **Announce Timeout** box to enter or select the number of announce messages that can be missed before triggering the Best Master Clock Algorithm (BMCA) to find a new Grand Master (GM).

f. In the **I/O Configuration** section, click **Add** to add an input or output channel.

The **Select I/O Type** dialog box opens.

![Select I/O Type dialog box](image)

- **Type** list to select an input/output type. The options are:
  - **<none>** (this option is not applicable)
  - **Fill-Only Output** (uses 1 output) (requires a separate license or the XPression Clips option)
  - **Fill/Key Outputs** (uses 2 outputs)
  - **Fill Input** (uses 1 input)
  - **Fill/Key Inputs** (uses 2 inputs)
  - **Internal Keyer** (uses 1 input, 1 output)

*For DSXLE4, when adding three fill/key and one fill, the one fill must be on the bottom of list. If not, one fill/key will show as exceeding device capacity and will be removed from the hardware setup I/O list.*

h. Click **OK**.
7. Select an **Output** tab to configure the parameters of the selected output.

   ![Output tab configuration](image)

   a. In the **Video Mode** section, use the **Standard** list to select the video format for the output.

   b. Use the **Colorimetry** list to select the range of colors that can be represented in the color space:
      - `<from project>` (appears only when `<from project>` is selected in the Standard list)
      - ITU-R BT.709 (HD)
      - ITU-R BT.2020 (WCG)

   c. Use the **Transfer Function** list to select the dynamic range standard to use on the output. The options are:
      - `<from project>` (appears only when `<from project>` is selected in the Standard list)
      - ITU-R BT.1886 (SDR)
      - ITU-R BT.2100 (HLG)

   d. In the **Keying** section, use the **Mode** list to select a keying mode for the output. The available modes are as follows:
      - **Off (Fill-Only)** — select to only output a video signal. In this mode, key is excluded from the output.
      - **External** — select to output video and alpha channels.
      - **Internal** — select to key XPression scenes to the associated input.

      ![Keying modes](image)

      - If the output mode is set to **Internal**, the GenLock **Source** in the **Board** tab needs to be set to an SDI input.

   e. Use the **Fill** list to select the fill mode. The available fill options are as follows:
      - **Shaped (premultiplied)** — select to use an additive key to cut precise holes for the fill.
      - **Unshaped** — select to use a multiplicative key based on the gradient values of the alpha.

   f. In the **Watchdog** section, select the **Route Input To Output On Application Failure & System Reboot** check box to route the input to an output in the event of application failure or a system reboot.

   g. Use the **Key Channel** list to select a transparent or opaque key channel. The available key channels are as follows:
      - **On Failure Set to 0% Key** (transparent) — currently always set at 0%.

   h. In the **Hardware Frame Buffer Queue** section, use the **Queue Size** box to enter or select the framebuffer queue size. The framebuffer queue size can be between two and seven.
i. Use the **Pre Queue** box to enter or select the pre-queue size. The pre-queue size can be between one and six.

j. In the **Horizontal Timing Offset (ns)** section, use the **Fill Offset** box to enter or select the offset of the fill.

k. Use the **Key Offset** box to enter or select the offset of the key.

l. In the **Misc** section, select the **Clip Chroma Levels** check box to limit the chroma levels in the output.

m. Select the **Enable Full Range Output** check box to output using the full super black to super white range.

n. Select the **Use GPU Color Space Conversion** check box to use the GPU to perform the fastest possible color space conversion on the output. It is selected by default.

o. If using the HLG transfer function, the **Use GPU Color Space Conversion** check box should always be selected.

p. Select the **Enable On-Board Compositing** check box to allow use of the low latency material scaler with a Live Source material.

q. In the **Ancillary Data** section, use the **VANC Output** list to set the vertical ancillary data output. The options are:
   - **None** — do not set a vertical ancillary data output.
   - **Input** — pass the vertical ancillary data from an input to the selected output.
   - **Video Shader (Closed Captioning)** — select this option to output 608 closed caption (in a 708 CDP) when a video shader is playing back a file with embedded captioning.

   When the XPression INcoder is set to a target folder, it will extract 608 closed captioning from an MOV file. The INcoder will transcode the MOV file to an XPression AVI file as well as an XMD file that contains the closed caption metadata. When the AVI file is played back from XPression, XPression will look for the XMD file and play out with the AVI file.

   Files played back from the Clip Store do not support Closed Captioning.

r. Select the **Send payload ID (SMPTE ST 352)** check box to send the video payload ID (SMPTE ST 352) in the ancillary data.

s. Select the **Embedded Audio** check box to include embedded audio in the ancillary data.

In the **Audio** section, use the **Channels** list to select the number of audio channels to output in the IP audio stream. The options available are:

- 2 channel
- 4 channel
- 8 channel

The output audio channels are only available when using the DSX LE4 IP, DSX LE5 D25, or X.mio3 IP board in SMPTE 2110 mode.
8. Select an **Input** tab to configure the parameters of the selected input.

![Input tab configuration interface](image)

a. In the **Video Mode** section, use the **Standard** list to select the video format for the input.

b. Use the **Colorimetry** list to select the range of colors that can be represented in the color space:
   - <from project> (appears only when <from project> is selected in the Standard list)
   - ITU-R BT.709 (HD)
   - ITU-R BT.2020 (WCG)

c. Use the **Transfer Function** list to select the dynamic range standard to use on the output. The options are:
   - <from project> (appears only when <from project> is selected in the Standard list)
   - ITU-R BT.1886 (SDR)
   - ITU-R BT.2100 (HLG)

d. In the **Input To Output Latency** section, use the **Latency** box to enter or select a time interval offset, in frames, between the input and output.

e. In the **Key Options** section, use the **Sources** list to select the keying options for the input. The options are:
   - None (Fill Only)
   - Paired Input (Fill/Key)

f. In the **Audio Channel Mapping** section, use the **Capture** list to select the audio type for the input.

g. In the **AES/EBU Pair Mapping** area, use the **Pair** lists to define the mapping of the AES/EBU inputs.

h. In the **Misc** section, select the **Use GPU Color Space Conversion** check box to use the GPU to perform the fastest possible color space conversion on the input.
The AES/EBU pair mapping is only available on cards that support AES audio.

9. Select the **Misc** tab to configure the horizontal and vertical offsets.

![Screenshot of the Misc tab configuration](image)

a. In the **Timing Offset** section, use the **Horizontal** box to enter or select a horizontal delay timing offset (in nanoseconds) with regards to an external reference. This setting is for external reference only.

b. Use the **Vertical** box to enter or select a vertical delay timing offset (in nanoseconds) with regards to an external reference. This setting is for external reference only.

c. In the **Finalization** section, use the **Shutdown** list to select one of the following options for the outputs on shutdown:
   • **Retain Outputs Topology** — retain the output topology when XPression is closed.
   • **Clear Outputs Topology** — clear the output topology when XPression is closed so that NMOS senders are no longer reported after XPression closes.

d. In the **AES/EBU Output Mapping** section, use the **Pair** lists for **Group A** and **Group B** to define the mapping of the AES/EBU outputs.

   The default settings are framebuffer one to AES Group A and framebuffer two to AES Group B.

The AES/EBU output mapping is only available if using the DSX LE4 FH card.

10. If configuring a DSX LE4 IP, DSX LE5 D25, X.mio3 or X.mio5 IP card, select the **IP** tab to configure the **SFP** settings.

   Depending on the card configuration, the settings can be available according to SMPTE 2110 or SMPTE 2022-6 protocols. The Matrox DSXLE5 D25 and X.mio5 Q25 only support 2110 protocol and not 2022-6.
SMPTE 2110

If the IP card is configured for SMPTE 2110 protocol, the IP tab is displayed as follows:

a. Use the SFP A and SFP B tabs in the Network section to configure the IP address of the small form-factor pluggable transceiver using the Local IP Address box (Matrox DSXLE4 and X.mio3 only).

Select the Enable 2022-7 check box to use the 2022-7 standard to enable redundancy for the SFP module connection. If using 2022-7 redundancy, see SMPTE 2110 with 2022-7 below for more information.
To configure the SFPs for the Matrox DSXLE5 and X.mio5, open **Network Connections** in Windows. Depending on the configuration, there can be up to four SFPs (SFP A, SFP B, SFP C, and SFP D).

Right-click on the **Matrox Ethernet Adapter** and select **Properties**.

The **Ethernet Properties** window opens.

Select **Internet Protocol Version 4 (TCP/IPv4)** and click **Properties**.

Configure the properties as necessary.

Repeat this procedure for any remaining Matrox Ethernet Adapters.

b. In NMOS section, select the Accept IS-05 connection requests check box to accept connection requests to use IS-05 via NMOS.
c. In the **Output Streams** section, select an output stream and click **Configure**.

The **Matrox DSX - IP Output Stream Setup** dialog box opens.

d. In the **Primary Video Output Stream** section configure the following settings:

- **Source Port** — use this box to enter or select the local port number of the primary video output stream source.
- **Enable Stream** — select this check box to enable the primary video output stream.
- **Remote IP Addr** — use this box to enter the remote IP address of the primary video output stream.
- **DSCP** — use this box to enter or select the differentiated services code point of the primary video output stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary video output stream.
- **RTP Payload ID** — use this box to enter or select the dynamic payload type chosen in the range of 96 through 127, signaled as specified in section 6 of IETF RFC 4566, unless a fixed payload type designation exists for that RTP stream within the IETF standard which specifies it.
e. In the **Primary Audio Output Stream** section configure the following settings:
   - **Source Port** — use this box to enter or select the local port number of the primary audio output stream source.
   - **Enable Stream** — select this check box to enable the primary audio output stream.
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary audio output stream.
   - **DSCP** — use this box to enter or select the differentiated services code point of the primary audio output stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary audio output stream.
   - **RTP Payload ID** — use this box to enter or select the dynamic payload type chosen in the range of 96 through 127, signaled as specified in section 6 of IETF RFC 4566, unless a fixed payload type designation exists for that RTP stream within the IETF standard which specifies it.
   - **Packet Duration** — use this box to enter a packet duration in microseconds for the audio information packets.

Repeat step e for any other primary audio output streams.

f. In the **Primary Ancillary Output Stream** section configure the following settings:
   - **Source Port** — use this box to enter or select the local port number of the primary ancillary output stream source.
   - **Enable Stream** — select this check box to enable the primary ancillary output stream.
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary ancillary output stream.
   - **DSCP** — use this box to enter or select the differentiated services code point of the primary ancillary output stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary ancillary output stream.
   - **RTP Payload ID** — use this box to enter or select the dynamic payload type chosen in the range of 96 through 127, signaled as specified in section 6 of IETF RFC 4566, unless a fixed payload type designation exists for that RTP stream within the IETF standard which specifies it.

Click **OK**.

The **Matrox DSX - IP Output Stream Setup** dialog box closes and the settings are added to the selected output stream.

h. Repeat steps c to g for any other output streams.
i. In the **Input Streams** section, select an input stream and click **Configure**. The **Matrox DSX - IP Input Stream Setup** dialog box opens.
j. In the **Primary Video Input Stream** section configure the following settings:
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary video input stream.
   - **Enable Stream** — select this check box to enable the primary video input stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary video input stream.
   - **Multicast Join** — use this list to select an internet group management protocol for joining an IP multicast for the primary video input stream. The options are:
     - **None** — select this option if not using IP multicast. This is the default setting.
     - **IGMP v2** — select this option to use internet group management protocol version 2.
     - **IGMP v3** — select this option to use internet group management protocol version 3.
   - **Source Filter** — click this button to configure IP multicast source filtering if using multicast.
     The **Matrox DSX - IGMP Multicast Source Filter** dialog box opens.

   ![Matrox DSX - IGMP Multicast Source Filter](image1)

   Use the **Filter Type** list to select one of the following filtering options:
   - **Exclude** — select this to exclude specific source addresses from the IP multicast.
   - **Only Include** — select this to only include specific source addresses from the IP multicast.

   Click **Add** to add and enter a source address to either exclude or only include (depending on the filter type selected). Once any necessary addresses have been added click **OK**.

k. In the **Primary Audio Input Stream** section configure the following settings:
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary audio input stream.
   - **Enable Stream** — select this check box to enable the primary audio input stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary audio input stream.
   - **Multicast Join** — use this list to select an internet group management protocol for joining an IP multicast for the primary audio input stream. The options are:
     - **None** — select this option if not using IP multicast. This is the default setting.
     - **IGMP v2** — select this option to use internet group management protocol version 2.
     - **IGMP v3** — select this option to use internet group management protocol version 3.
   - **Source Filter** — click this button to configure IP multicast source filtering if using multicast.
     The **Matrox DSX - IGMP Multicast Source Filter** dialog box opens.

   ![Matrox DSX - IGMP Multicast Source Filter](image2)
Use the **Filter Type** list to select one of the following filtering options:

- **Exclude** — select this to exclude specific source addresses from the IP multicast.
- **Only Include** — select this to only include specific source addresses from the IP multicast.

Click **Add** to add and enter a source address to either exclude or only include (depending on the filter type selected). Once any necessary addresses have been added click **OK**.

Repeat step k for any other primary audio input streams.

### Primary Ancillary Input Stream Section Configuration

1. In the **Primary Ancillary Input Stream** section configure the following settings:
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary ancillary input stream.
   - **Enable Stream** — select this check box to enable the primary ancillary input stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary ancillary input stream.
   - **Multicast Join** — use this list to select an internet group management protocol for joining an IP multicast for the primary ancillary input stream. The options are:
     - **None** — select this option if not using IP multicast. This is the default setting.
     - **IGMP v2** — select this option to use internet group management protocol version 2.
     - **IGMP v3** — select this option to use internet group management protocol version 3.
   - **Source Filter** — click this button to configure IP multicast source filtering if using multicast.

   The **Matrox DSX - IGMP Multicast Source Filter** dialog box opens.

   Use the **Filter Type** list to select one of the following filtering options:
   - **Exclude** — select this to exclude specific source addresses from the IP multicast.
   - **Only Include** — select this to only include specific source addresses from the IP multicast.

   Click **Add** to add and enter a source address to either exclude or only include (depending on the filter type selected). Once any necessary addresses have been added click **OK**.

2. **Click OK**.

   The **Matrox DSX - IP Input Stream Setup** dialog box closes and the settings are added to the selected input stream.

3. **Repeat steps i to m** for any other input streams.

4. If using the DSX LE4 IP, DSX LE5 D25, X.mio3 IP, or X.mio5 Q25, in the **Input Clean Switch** section, select the **Pair inputs to allow remote clean switch** check box to create pairs of inputs (effectively dividing the number of available inputs by two) so that when doing a switch, the ‘inactive’ input is prepared with the new multicast settings first, then made active when ready.

   If selected, configure the following settings:
   - **Clean switch prepare delay** — enter or select an amount of frames to prepare the delay for the IP clean switch option.
   - **Group NMOS requests received within** — enter or select an amount of time in seconds to configure a delay to collect any NMOS connection requests (video/audio/ancillary) received for an input within that time period before applying the IP clean switch.
SMPTE 2110 with 2022-7

If the IP card is configured for SMPTE 2110 protocol and the Enable 2022-7 check box is selected, the IP tab is displayed as follows:
a. In the **Output Streams** section, select an output stream and click **Configure**.

The **Matrox DSX - IP Output Stream Setup** dialog box opens.

b. In the **Primary Video Output Stream - SFP A** section configure the following settings:

- **Source Port** — use this box to enter or select the local port number of the primary video output stream source.
- **Enable Stream** — select this check box to enable the primary video output stream.
- **Remote IP Addr** — use this box to enter the remote IP address of the primary video output stream.
- **DSCP** — use this box to enter or select the differentiated services code point of the primary video output stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary video output stream.
- **RTP Payload ID** — use this box to enter or select the dynamic payload type chosen in the range of 96 through 127, signaled as specified in section 6 of IETF RFC 4566, unless a fixed payload type designation exists for that RTP stream within the IETF standard which specifies it.
c. In the **Primary Audio Output Stream - SFP A** section configure the following settings:

- **Source Port** — use this box to enter or select the local port number of the primary audio output stream source.
- **Enable Stream** — select this check box to enable the primary audio output stream.
- **Remote IP Addr** — use this box to enter the remote IP address of the primary audio output stream.
- **DSCP** — use this box to enter or select the differentiated services code point of the primary audio output stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary audio output stream.
- **RTP Payload ID** — use this box to enter or select the dynamic payload type chosen in the range of 96 through 127, signaled as specified in section 6 of IETF RFC 4566, unless a fixed payload type designation exists for that RTP stream within the IETF standard which specifies it.
- **Packet Duration** — use this list to select a packet duration in microseconds for the audio information packets.

Repeat step c for any other audio output streams.

d. In the **Primary Ancillary Output Stream - SFP A** section configure the following settings:

- **Source Port** — use this box to enter or select the local port number of the primary ancillary output stream source.
- **Enable Stream** — select this check box to enable the primary ancillary output stream.
- **Remote IP Addr** — use this box to enter the remote IP address of the primary ancillary output stream.
- **DSCP** — use this box to enter or select the differentiated services code point of the primary ancillary output stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary ancillary output stream.
- **RTP Payload ID** — use this box to enter or select the dynamic payload type chosen in the range of 96 through 127, signaled as specified in section 6 of IETF RFC 4566, unless a fixed payload type designation exists for that RTP stream within the IETF standard which specifies it.

e. In the **Secondary Video Output Stream - SFP B** section configure the following settings:

- **Source Port** — use this box to enter or select the local port number of the primary video output stream source.
- **Enable Stream** — select this check box to enable the secondary video output stream.
- **Remote IP Addr** — use this box to enter the remote IP address of the primary video output stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary video output stream.

f. In the **Secondary Audio Output Stream - SFP B** section configure the following settings:

- **Source Port** — use this box to enter or select the local port number of the primary audio output stream source.
- **Enable Stream** — select this check box to enable the secondary audio output stream.
- **Remote IP Addr** — use this box to enter the remote IP address of the primary audio output stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary audio output stream.

Repeat step f for any other secondary audio output streams.

g. In the **Secondary Ancillary Output Stream - SFP B** section configure the following settings:

- **Source Port** — use this box to enter or select the local port number of the primary ancillary output stream source.
- **Enable Stream** — select this check box to enable the secondary ancillary output stream.
- **Remote IP Addr** — use this box to enter the remote IP address of the primary ancillary output stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary ancillary output stream.

h. Click **OK**.

The **Matrox DSX - IP Output Stream Setup** dialog box closes and the settings are added to the selected output stream.
i. Repeat steps a to h for any other output streams.

j. In the Input Streams section, select an input stream and click Configure.

The Matrox DSX - IP Input Stream Setup dialog box opens.

![Matrox DSX - IP Input Stream Setup dialog box]

k. In the Primary Video Input Stream - SFP A section configure the following settings:
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary video input stream.
   - **Enable Stream** — select this check box to enable the primary video input stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary video input stream.
   - **Multicast Join** — use this list to select an internet group management protocol for joining an IP multicast for the primary video input stream. The options are:
     - **None** — select this option if not using IP multicast. This is the default setting.
     - **IGMP v2** — select this option to use internet group management protocol version 2.
     - **IGMP v3** — select this option to use internet group management protocol version 3.

l. In the Primary Audio Input Stream - SFP A section configure the following settings:
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary audio input stream.
   - **Enable Stream** — select this check box to enable the primary audio input stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary audio input stream.
   - **Multicast Join** — use this list to select an internet group management protocol for joining an IP multicast for the primary audio input stream. The options are:
     - **None** — select this option if not using IP multicast. This is the default setting.
     - **IGMP v2** — select this option to use internet group management protocol version 2.
     - **IGMP v3** — select this option to use internet group management protocol version 3.

Repeat step l for any other primary audio input streams.
m. In the **Primary Ancillary Input Stream - SFP A** section configure the following settings:

- **Remote IP Addr** — use this box to enter the remote IP address of the primary ancillary input stream.
- **Enable Stream** — select this check box to enable the primary ancillary input stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary ancillary input stream.
- **Multicast Join** — use this list to select an internet group management protocol for joining an IP multicast for the primary ancillary input stream. The options are:
  - **None** — select this option if not using IP multicast. This is the default setting.
  - **IGMP v2** — select this option to use internet group management protocol version 2.
  - **IGMP v3** — select this option to use internet group management protocol version 3.

n. In the **Secondary Video Input Stream - SFP B** section configure the following settings:

- **Remote IP Addr** — use this box to enter the remote IP address of the primary video input stream.
- **Enable Stream** — select this check box to enable the secondary video input stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary video input stream.

o. In the **Secondary Audio Input Stream - SFP B** section configure the following settings:

- **Remote IP Addr** — use this box to enter the remote IP address of the primary audio input stream.
- **Enable Stream** — select this check box to enable the secondary audio input stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary audio input stream.

Repeat step o for any other primary audio input stream.

p. In the **Secondary Ancillary Input Stream - SFP B** section configure the following settings:

- **Remote IP Addr** — use this box to enter the remote IP address of the primary ancillary input stream.
- **Enable Stream** — select this check box to enable the secondary ancillary input stream.
- **Remote Port** — use this box to enter or select the remote port number for the primary ancillary input stream.

q. Click **OK**.

The **Matrox DSX - IP Input Stream Setup** dialog box closes and the settings are added to the selected input stream.

r. Repeat steps j to q for any other input streams.
SMPTE 2022-6

Not supported on the Matrox DSXLE5 D25 and X.mio5 Q25.

If the IP card is configured for SMPTE 2022-6 protocol, the IP tab is displayed as follows:

- Use the SFP A and SFP B tabs in the Network section to configure the IP address the small form-factor pluggable transceiver using the Local IP Address box.

  Select the Enable 2022-7 check box to use the 2022-7 standard to enable redundancy for the SFP module connection. If using 2022-7 redundancy, see SMPTE 2022-6 with 2022-7 below for more information.

- In the Output Streams section, select an output stream and click Configure.

  The Matrox DSX - IP Output Stream Setup dialog box opens.
c. In the **Primary Output Stream - SFP A** section configure the following settings:
   
   - **Source Port** — use this box to enter or select the local port number of the primary video output stream source.
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary video output stream.
   - **DSCP** — use this box to enter or select the differentiated services code point of the primary video output stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary video output stream.
   - **RTP Payload ID** — use this box to enter or select the dynamic payload type chosen in the range of 96 through 127, signaled as specified in section 6 of IETF RFC 4566, unless a fixed payload type designation exists for that RTP stream within the IETF standard which specifies it.

d. Repeat steps b to c for any other output streams.

e. In the **Input Streams** section, select an input stream and click **Configure**.
   
   The **Matrox DSX - IP Input Stream Setup** dialog box opens.

   ![Matrox DSX - IP Input Stream Setup dialog box](image)

f. In the **Primary Input Stream - SFP A** section configure the following settings:
   
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary video input stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary video input stream.
   - **Multicast Join** — use this list to select an internet group management protocol for joining an IP multicast for the primary video input stream. The options are:
     - **None** — select this option if not using IP multicast. This is the default setting.
     - **IGMP v2** — select this option to use internet group management protocol version 2.
     - **IGMP v3** — select this option to use internet group management protocol version 3.

g. Click **OK**.
   
   The **Matrox DSX - IP Input Stream Setup** dialog box closes and the settings are added to the selected input stream.

h. Repeat steps e to g for any other input streams.
SMPTE 2022-6 with 2022-7

If the IP card is configured for SMPTE 2022-6 protocol and the Enable 2022-7 check box is selected, the IP tab is displayed as follows:

![IP Tab Diagram](image)

a. Use the **SFP A** and **SFP B** tabs in the **Network** section to configure the IP address the small form-factor pluggable transceiver using the **Local IP Address** box.

b. In the **Output Streams** section, select an output stream and click **Configure**.

The **Matrox DSX - IP Output Stream Setup** dialog box opens.

c. In the **Primary Output Stream - SFP A** section configure the following settings:
   - **Source Port** — use this box to enter or select the local port number of the primary video output stream source.
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary video output stream.
   - **DSCP** — use this box to enter or select the differentiated services code point of the primary video output stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary video output stream.
   - **RTP Payload ID** — use this box to enter or select the dynamic payload type chosen in the range of 96 through 127, signaled as specified in section 6 of IETF RFC 4566, unless a fixed payload type designation exists for that RTP stream within the IETF standard which specifies it.
d. In the **Secondary Output Stream - SFP B** section configure the following settings:
   - **Source Port** — use this box to enter or select the local port number of the primary video output stream source.
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary video output stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary video output stream.

e. Click OK.
   The **Matrox DSX - IP Output Stream Setup** dialog box closes and the settings are added to the selected output stream.

f. Repeat steps b to e for any other output streams.

g. In the **Input Streams** section, select an input stream and click **Configure**.
   The **Matrox DSX - IP Input Stream Setup** dialog box opens.

![Matrox DSX - IP Input Stream Setup dialog box](image)

h. In the **Primary Input Stream - SFP A** section configure the following settings:
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary video input stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary video input stream.
   - **Multicast Join** — use this list to select an internet group management protocol for joining an IP multicast for the primary video input stream. The options are:
     › **None** — select this option if not using IP multicast. This is the default setting.
     › **IGMP v2** — select this option to use internet group management protocol version 2.
     › **IGMP v3** — select this option to use internet group management protocol version 3.

i. In the **Secondary Input Stream - SFP B** section configure the following settings:
   - **Remote IP Addr** — use this box to enter the remote IP address of the primary video input stream.
   - **Remote Port** — use this box to enter or select the remote port number for the primary video input stream.

j. Click OK.
   The **Matrox DSX - IP Input Stream Setup** dialog box closes and the settings are added to the selected input stream.

k. Repeat steps g to j for any other input streams.

11. Click **Apply** to implement the settings.

12. Click **OK**.
   The configured Matrox framebuffer board is added to the **Inputs / Outputs** tab of the **Hardware Setup** dialog box.

13. In the **Hardware Setup** dialog box, click **Close**.
   The **Hardware Setup** dialog box closes.
Configure a Matrox Video X.mio2 FrameBuffer

* If using Matrox X.mio2 and upgrading to XPression 64-bit, Matrox driver 9.4.2.9297 must be installed.

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

3. Click Add.
   The Add New FrameBuffer Board dialog box opens.

4. Select Matrox Video X.mio2 from the Brand list.
5. Click OK.

The Matrox XMIO - Framebuffer Setup dialog box opens.

![Matrox XMIO - Framebuffer Setup dialog box](image)

6. Select the Board tab to choose and configure an installed XMIO card.
   
a. In the Hardware section, use the Board list to select the installed XMIO card to configure.

b. Use the Output Mode list to select the output configuration for the card:
   
   • 2 Fill/Key Outputs
     The AES outputs will be mapped as follows:
     › Output 1: AES Output A 1-16
     › Output 2: AES Output B 1-16
   
   • 1 Fill/Key + 2 Fill Outputs
     The AES outputs will be mapped as follows:
     › Output 1 Fill/Key: AES Output A 1-16
     › Output 2 Fill: AES Output B 1-8
     › Output 3 Fill: AES Output B 9-16
   
   • 4 Fill Outputs
     The AES outputs will be mapped as follows:
     › Output 1: AES Output A 1-8
     › Output 2: AES Output B 1-8
     › Output 3: AES Output A 9-16
     › Output 4: AES Output B 9-16

   If using XPression Studio SCE, select the output configuration for the card from the following options:
   
   • 1 Fill/Key Output
   • 2 Fill Outputs

* These options are only available if the Fill-Only option has been purchased for XPression Studio and XPression Studio SCE. Otherwise, the only options are 2 Fill/Key for XPression Studio and 1 Fill/Key for XPression Studio SCE.
c. In the **GenLock** section, use the **Source** list to select the source of the genlock signal with which to synchronize XPression. The available genlock signal sources are as follows:

- **Internal** — generate internal sync on the video card for all output channels.
- **Blackburst** — sync to analog black.
- **SDI Input 1** — sync to SDI Input 1 source signal.
- **SDI Input 2** — sync to SDI Input 2 source signal.
- **SDI Input 3** — sync to SDI Input 3 source signal.
- **SDI Input 4** — sync to SDI Input 4 source signal.

* If the output mode is set to **Internal** in the **Output** tab, the GenLock **Source** needs to be set to an SDI input.

d. Use the **Standard** list to select the format of the incoming genlock signal.

e. In the **Timing Offset** section, use the **Horizontal** box to enter or select the number of nanoseconds for horizontal timing offset with regards an external reference.

f. In the **Vertical** box, enter or select the number of lines for vertical delay timing offset with regards an external reference.

* If configuring an XMIO card when using XPression with a switcher, the **Horizontal** timing offset must be set to 9930 and the **Vertical** timing offset must be set to 1124 if using 1080i/29.27 frames per second and a Tri Level Sync reference.

7. Select an **Output** tab to configure the parameters of the selected output.

a. In the **Video Mode** section, use the **Standard** list to select the video format for the output.

b. Use the **Transfer Function** list to select how the physical (linear) light is mapped and encoded. The options are:

- **<from project>** (appears only when <from project> is selected in the Standard list)
- **ITU-R BT.1886 (SDR)**
- **ITU-R BT.2100 (HLG)**

c. In the **Keying** section, use the **Mode** list to select a keying mode for the output. The available modes are as follows:

- **External** — select to output video and alpha channels.
- **Internal** — select to key XPression scenes to the associated input.
If the output mode is set to **Internal**, the GenLock **Source** in the **Board** tab needs to be set to an SDI input.

d. Use the **Fill** list to select the fill mode. The available fill options are as follows:

   • **Shaped (premultiplied)** — select to use an additive key to cut precise holes for the fill.
   • **Unshaped** — select to use a multiplicative key based on the gradient values of the alpha.

e. In the **Watchdog** section, select the **Route Input To Output On Application Failure & System Reboot** check box to route the input to an output in the event of application failure or a system reboot.

f. Use the **Key Channel** list to select a transparent or opaque key channel. The available key channels are as follows:

   • **On Failure Set to 0% Key (transparent)** — select to set the key channel to transparent in the event of failure.
   • **On Failure Set to 100% Key (opaque)** — select to set the key channel to opaque in the event of failure.

g. In the **Hardware Frame Buffer Queue** section, use the **Queue Size** box to enter or select the framebuffer queue size. The framebuffer queue size can be between two and seven.

h. Use the **Pre Queue** box to enter or select the pre-queue size. The pre-queue size can be between one and six.

i. In the **Horizontal Timing Offset (ns)** section, use the **Fill Offset** box to enter or select the offset of the fill.

j. Use the **Key Offset** box to enter or select the offset of the key.

k. In the **Misc** section, select the **Clip Chroma Levels** check box to limit the chroma levels in the output.

l. Select the **Allow Super Black** check box to output using the full super black to super white range.

m. Use the **Color Space Conversion** list to select the color space conversion for the outputs. The options are:

   • **Hardware (GPU - Fastest)** (default)
   • **Hardware (Board)**
   • **Software (No Chroma Filter)**

   If using the HLG transfer function, the **Hardware (GPU - Fastest)** option should always be selected.

n. Select the **Enable RGBA -> YUV Filter** check box to enhance the conversion from 4:4:4 RGB to 4:2:2 YUV color space by filtering the down-conversion of the chrominance. If running in 1080p video modes, you should not enable this on more than one channel simultaneously. This option is only available with Matrox driver 9.4.2 or higher.

o. In the **Ancillary Data** section, use the **VANC Output** list to set the vertical ancillary data output. The options are:

   • **None** — do not set a vertical ancillary data output.
   • **Pass VANC from Input 1 to Output 1** — pass the vertical ancillary data from input 1 to output 1
   • **Use Closed Captioning from Video Shader** — when using a Matrox card, select this option to output 608 closed caption (in a 708 CDP) when a video shader is playing back a file with embedded captioning. When the XPression INcoder is set to a target folder, it will extract 608 closed captioning from an MOV file. The INcoder will transcode the MOV file to an XPression AVI file as well as an XMD file that contains the closed caption metadata. When the AVI file is played back from XPression, XPression will look for the XMD file and play out with the AVI file.

   Files played back from the Clip Store do not support Closed Captioning.
8. Select an **Input** tab to configure the parameters of the selected input.

   ![Image of Input Configuration](image)

   a. In the **Video Mode** section, use the **Standard** list to select the video format for the input.
   
   b. In the **Audio Channel Mapping** section, use the **Capture** list to select the audio type for the input.
   
   c. In the **AES/EBU Pair Mapping** area, use the **Pair** lists to define the mapping of the AES/EBU inputs.
   
   d. In the **Ancillary Data** section, select the **Pass VANC data from Input 1 to Output 1** check box to pass vertical ancillary data from Input 1 to Output 1 when using a Live Source shader in the scene and a Matrox board.

   Requires Matrox DSX version 7.5.2.457.

   e. In the **Options** section, use the **Input to Output** latency box to enter or select a time interval offset, in frames, between the input and output.
   
   f. If configuring **Input 2**, select the **Use Input 2 as Key Channel for Input 1** to use the input as the key channel for Input 1, if necessary.

9. Click **OK**.

   The configured Matrox framebuffer board is added to the **Inputs / Outputs** tab of the **Hardware Setup** dialog box.

10. In the **Hardware Setup** dialog box, click **Close**.

    The **Hardware Setup** dialog box closes.
NewTek™ Network Device Interface (NDI™)

- Up to eight channels of audio supported for NDI in version 8.5 build 4518 or higher.
- Only one NDI framebuffer can be created on single channel XPression hardware and up to two NDI framebuffers can be created on two-channel XPression hardware.
- XPression video recordings are in the format and video mode of the input NDI source, not the project mode.

1. In XPression, use the Edit menu to select Hardware Setup.
   - The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

```
3. Click Add.
   - The Add New FrameBuffer Board dialog box opens.
```

```
5. Click OK.
```
6. In the **Settings** tab, use the **Output Name** box to enter an output name for the NDI output source (for example, NDI Output 1). This output name will be the source to connect the device receiving the output signal.

7. Use the **Input Name Contains** box to enter an input name or keyword(s) associated with one or multiple inputs to which the external NDI output is directed.

8. Configure the following settings in the **Output** section as necessary:
   - **Fill-Only** — select this check box to output the video signal with no key.
   - **Use GPU Color Space Conversion** — select this check box to use the GPU to perform the color space conversion on the outputs.

9. In the **Input** section, select the **Use GPU Color Space Conversion** check box to use the GPU to perform the color space conversion on the inputs.

10. Select the **Fill Only (Ignore incoming alpha channel)** to view fill only and ignore the incoming alpha channel.

11. Click **OK**.

   The configured NDI framebuffer is added to the **Inputs / Outputs** tab of the **Hardware Setup** dialog box.

12. In the **Hardware Setup** dialog box, click **Close**.

   The **Hardware Setup** dialog box closes.

13. Configure a self-contained data source panel for XPression in DashBoard or connect to another XPression as the output for the NDI source:

   **DashBoard**
   b. In the **NDI Tag Attributes** section of the **Insert into ABS Component** dialog box, use the **Source Name** list to select an NDI output for the NDI data source video monitor in the DashBoard panel.
   c. Click **OK**.

   When the source NDI output is online in the Sequencer in XPression, it will display in the NDI data source video monitor in the DashBoard panel.

   **XPression**
   a. In the second **XPression** machine, use the **Edit** menu to select **Hardware Setup**.

      The **Hardware Setup** dialog box opens.
   b. Click the **Inputs / Outputs** tab.
c. Click Add.
   The Add New FrameBuffer Board dialog box opens.

   ![Add New FrameBuffer Board dialog box](image)

   d. Select NewTek Network Device Interface from the Brand list.

   e. Click OK.

   ![NewTek™ Device Interface - Framebuffer Setup dialog box](image)

   f. In the Settings tab, use the Input Name Contains box to enter the name of the NDI input source to use (for example, NDI Output 1). This input name is the output name from the device outputting the signal.

   g. Click OK.
   The configured NDI framebuffer is added to the Inputs / Outputs tab of the Hardware Setup dialog box.

   h. In the Hardware Setup dialog box, click Close.
   The Hardware Setup dialog box closes.
Configure an XPression AVI Recorder

The XPression AVI Recorder is used to render scenes or scene groups and save the output as an AVI file. Before using this functionality, the AVI Recorder must be configured as a video output in the Hardware Setup dialog box.

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

3. Click the Add.
   The Add New FrameBuffer Board dialog box opens.

4. Select XPression AVI Recorder from the Brand list.
5. Click OK.
   The AVI Recorder - Setup dialog box opens.

6. Use the Fill Mode list to select the method used to process fill graphics before output. The available processing methods are as follows:
   • Unshaped Video — Output fill and key signals “as is”.
   • Shaped Video (premultiplied fill) — Multiply/shape the fill signal color information by the luminance information in the key signal.
7. Click OK.
   An XPression Virtual Output is added to the Inputs / Outputs tab of the Hardware Setup dialog box.
8. In the Hardware Setup dialog box, click Close.
   The Hardware Setup dialog box closes.

For More Information on...
• rendering output to an AVI file, refer to the procedure “Render Output to an AVI File” on page 23–3.
Configure an XPression Desktop Preview Client

The XPression Desktop Preview Server offers an IP based preview server for multi-channel and MOS Remote Sequencer workflows.

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.

2. Click the Inputs / Outputs tab.

3. Click Add.
   The Add New FrameBuffer Board dialog box opens.

4. In the Brand list, select XPression Desktop Preview Server Client from the Brand list.

5. Click OK.
   The Desktop Preview Client - Setup dialog box opens.

6. Use the Host box to enter the IP address of the XPression Desktop Preview Server.

7. Use the Channel list to select a preview channel in the XPression Desktop Preview Server for the output.

8. Click OK.
   A Desktop Preview Client connection is added to the Inputs / Outputs tab of the Hardware Setup dialog box.

9. In the Hardware Setup dialog box, click Close.
   The Hardware Setup dialog box closes.
For More Information on...

• the XPression Desktop Preview Server, refer to the *XPression Desktop Preview Server User Guide*. 
Configure an XPression DirectShow Capture Source

Use a Microsoft DirectShow compatible device as an input.

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

3. Click Add.
   The Add New FrameBuffer Board dialog box opens.
4. In the Brand list, select XPression DirectShow Capture Source from the Brand list.
5. Click OK.
   The Capture Source Setup dialog box opens.
6. Use the Input list to select an input for the capture source.
7. Use the Format list to select a frame format for the input.
8. Select the Asynchronous Capture check box to allow better support for webcams that are running at a framerate lower than the framerate of the project.
9. Click OK.
   A DirectShow Capture Source framebuffer input is added to the Inputs / Outputs tab of the Hardware Setup dialog box.
10. In the Hardware Setup dialog box, click Close.
    The Hardware Setup dialog box closes.
Configure an XPression RossLinq Connector

The RossLinq feature allows you to connect XPression directly to RossLinq compatible devices over ethernet. Have XPression render images and graphics to the RossLinq compatible devices without using any of the video input BNC.

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.
3. Click Add.
   The Add New FrameBuffer Board dialog box opens.
4. In the Brand list, select XPression RossLinq Connector from the Brand list.
5. Click OK.
   The RossLinq Setup dialog box opens.
6. Enter the IP address of the RossLinq compatible device in the Host box.
7. Use the Channel list to select the channel on the device that you want to upload images to.
8. Check the Passive Connection box to establish a passive FTP connection.
9. Check the **Override Login** box to override the username and password for the connection.

10. In the **User** box, enter a username for the connection to the RossLinq compatible device.

11. In the **Password** box, enter a password for the connection to the RossLinq compatible device.

12. In the **Output Mode** section, use the **Frame Size** menu to select the resolution of the images rendered and sent to the compatible RossLinq device. The available options are as follows:
   - `<from project>` — select this to use the same format as the project.
   - PAL, 720x576
   - NTSC, 720x486
   - HD 720p, 1280x720
   - HD 1080i, 1920x1080
   - HD 1080p, 1920x1080
   - UHD 2160p, 3840x2160

   Select the **Send Black Image when Framebuffer is Cleared** check box to display a black screen when the framebuffer is cleared.

13. Click **OK**.

   A RossLinq connection is added to the **Inputs / Outputs** tab of the **Hardware Setup** dialog box.

14. In the **Hardware Setup** dialog box, click **Close**.

   The **Hardware Setup** dialog box closes.
Configure the XPression Tile Mapper

The XPression Tile Mapper enables XPression to create an output framebuffer to simultaneously render a scene through multiple outputs for videowall applications.

1. In XPression, use the Edit menu to select Hardware Setup.
   
The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

   ![Hardware Setup Dialog Box]

3. Click the Add.

   The Add New FrameBuffer Board dialog box opens.

4. Select XPression Tile Mapper from the Brand list.
5. Click OK.

   The Tile Mapper dialog box opens.

6. In the Tile Mapper dialog box, use the Tiles section to configure the number and position of the tiles used to render the scene.
   
a. Use the Horizontal box to enter or select the amount of horizontal tiles used to render a scene.
   
b. Use the Vertical box to enter or select the amount of vertical tiles used to render a scene.
7. In the **Tile to Framebuffer Mapping** table, use the list in the **Framebuffer** column to select the output for each tile number.

- Virtual outputs cannot be used for the Tile Mapper framebuffer.
- The first mapped output supports audio output.

8. Click **OK**.

   The configured Tile Mapper framebuffer board is added to the **Inputs / Outputs** tab of the **Hardware Setup** dialog box.

9. In the **Hardware Setup** dialog box, click **Close**.

   The **Hardware Setup** dialog box closes.
Configure an XPression Virtual Input

The XPression Virtual Input enables XPression to create Live Source materials without a physical input card installed in the XPression computer.

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

3. Click the Add.
   The Add New FrameBuffer Board dialog box opens.

4. Select XPression Virtual Input from the Brand list.
5. Click OK.
   The Virtual Input Settings dialog box opens.

6. Use the Test Pattern list to select a test signal for the virtual input. The options are:
   - Black
   - White
   - Color Bars
     The color bar test pattern includes -18dbFS audio tone.
7. Click OK.
   An XPression Virtual Input is added to the Inputs / Outputs tab of the Hardware Setup dialog box.
8. In the Hardware Setup dialog box, click Close.
   The Hardware Setup dialog box closes.
Configure an XPression Virtual Output

The XPression Virtual Output enables XPression software to run without any framebuffer cards installed in the XPression computer. In this case, the Virtual Output is used to display output in a window on the XPression computer.

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

3. Click the Add.
   The Add New FrameBuffer Board dialog box opens.
4. Select XPression Virtual Output from the Brand list.
5. Click OK.
   The Virtual Output Settings dialog box opens.
6. In the Description box, enter a name or brief description for the virtual output.
7. In the **Options** section, configure the following:
   - **Show On Startup** — select this check box to have the virtual output open when XPression is launched.
   - **Fullscreen** — select this check box to make the virtual output window fullscreen.
   - **Stay On Top** — select this command to always display the virtual output on top of all other open and/or active windows on the screen.
   - **Vertical Sync** — currently not implemented.
   - **Render at Monitor Refresh Rate** — currently not implemented.
   - **Adjust Aspect Ratio to Match First Scene** — select this check box to change the aspect ratio of the virtual framebuffer to match the scene played on it as opposed to the format of the project.

8. Click **OK**.
   
   An XPression Virtual Output is added to the **Inputs / Outputs** tab of the **Hardware Setup** dialog box.

9. In the **Hardware Setup** dialog box, click **Close**.
   
   The **Hardware Setup** dialog box closes.
Change the Order of Video Inputs / Outputs

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.

2. Click the Inputs / Outputs tab.

3. In the Inputs / Outputs list, select an input or output to move in the list.

4. At the bottom of the dialog box, click Move Down to move the selected device down one position in the Inputs / Outputs list, or Move Up to move up one position in the list.
   The Move Up button is not available when the selected device is positioned at the top of the list. The Move Down button is not available when the selected device is positioned at the bottom of the list.

5. Click Close.
   The Hardware Setup dialog box closes.
Delete a Video Input / Output

1. In XPRESSion, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Inputs / Outputs tab.

3. In the Inputs / Outputs list, select the input or output to delete.

4. Click Delete at the bottom of the dialog box.
   A Warning dialog box opens.
5. Click Yes.
   The selected video device is deleted from Inputs / Outputs list.
6. Click Close.
   The Hardware Setup dialog box closes.
Configure an Audio Device

1. In XPression, use the Edit menu to select Hardware Setup.

   The Hardware Setup dialog box opens.

2. Click the Audio Devices tab.

3. Click Add.

   The Add Audio Device dialog box opens.

4. Use the Engine list to select engine used to produce audio.

5. Use the Device list to select the sound card to output audio.

6. Click OK.

   The Audio Engine Setup dialog box opens.

7. In the Configuration section, use the Sample Rate list to select the sample rate for the audio signal.

   The selected sample rate defines the number of samples per second taken from analog signal to make a
digital signal. A sample rate of 48 kHz is the recommended setting, but 44.1 kHz can also be used.

8. In the Delay (frames) box, enter or select the number of frames to delay the audio signal.

9. Click OK.

   The configured audio device is added to the Audio Devices tab of the Hardware Setup dialog box.
10. In the Hardware Setup dialog box, click Close.

The Hardware Setup dialog box closes.

* Adding an audio device is not required to output embedded or AES audio.
Delete an Audio Device

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Audio Devices tab.

3. In the Audio Devices list, select the Audio Device to delete.

4. Click Delete at the bottom of the dialog box.
   A Warning dialog box opens.
5. Click Yes.
   The selected audio device is deleted from Audio Devices list.
6. Click Close.
   The Hardware Setup dialog box closes.
Add a Timecode Source

1. In XPression, use the Edit menu to select **Hardware Setup**.
   The **Hardware Setup** dialog box opens.

2. Click the **Timecode Sources** tab.

3. Click **Add**.
   The **Add New TimeCode Source** dialog box opens.

4. In the **Brand** list, select a timecode source. The possible options include:
   - **Adrienne TC/GPIO Card** — if installed, select the Adrienne TC/GPIO card as the timecode source.
   - **Blackmagic Design (Legacy)** — if installed, select the Blackmagic Design (legacy) card as the timecode source.
   - **Countdown Timer Broadcast** — send countdown clocks via UDP to DashBoard or other devices.
   - **Free Running Timecode** — use the system clock of the machine or a custom preset time as the timecode source.

5. Click **OK**.
   The setup dialog box for the selected timecode source opens.

**Adrienne TC/GPIO Card**
If the Adrienne TC/GPIO card is selected, the **Adrienne Setup (Timecode)** dialog box opens.

   a. In the **Timecode Settings** section, use the **Mode** list to select the frame rate to use for the timecode.
Blackmagic Design (Legacy)

If the Blackmagic Design (legacy) card is selected, the Blackmagic Design - Timecode Source Setup dialog box opens.

![Image of Blackmagic Design - Timecode Source Setup dialog box]

a. In the Timecode Settings section, use the Source Mode list to select a source mode for the timecode data. The available options are:
   - VITC (Vertical Interval Time Code)
   - HANC (Horizontal Ancillary Data)
   - RS-422 (Serial)

b. Use the Input list to select an input on the card to receive the timecode data.

c. Use the Video Format list to select the video format of the received video signal.

Countdown Timer Broadcast

If countdown timer broadcast is selected, the Countdown Timer Broadcast dialog box opens.

![Image of Countdown Timer Broadcast dialog box]

a. In the Network Settings section, select the Enabled check box to send countdown clocks via UDP to DashBoard or other devices. It is enabled by default.

b. Use the UDP Destination IP box to enter the IP address of the device to receive the countdown timer.

   Select the UDP Broadcast check box to send UDP countdown timer packets to a range of IP addresses within a subnet. When the UDP Broadcast check box is enabled, the UDP Destination IP box changes to Broadcast Address.

c. Use the Port box to enter or select the port number to use for the connection.

d. In the Options section, use the Clock Format check boxes to select the format of the timer to send to the receiving device:
   - Include Hours — select this check box to use hours in the clock format.
   - Include Frames — select this check box to use frames in the clock format.

e. Use the Layers to Include box to enter the framebuffer layers to include in the clock format.

Free Running Timecode

If the free running timecode is selected, the XPression - Free Running Timecode Source dialog box opens.

![Image of XPression - Free Running Timecode Source dialog box]
a. In the **Timecode Settings** section, use the **Timecode Source** list to select a source mode for the timecode. The options are:

- **System Clock** — use the internal system clock for the timecode.
- **Preset Time** — use a custom start time for the timecode.

If using a preset time, use the **Timecode Start** box to enter a start time for the timecode. Select the **Wrap at 23:59:59.xx** check box to restart at the configured preset start time when the time has reached 23:59:59:xx.

b. Use the **Mode** list to select the frame rate to use for the timecode.

c. Use the **State** list to select a status for the timecode:

- **Active** — use the selected timecode.
- **Inactive** — disable the selected timecode.

6. Click **OK**.

The timecode source is added to the list in the **Timecode Sources** tab.

7. In the **Options** section, use the **Timecode Offset** box to enter or select a number of frames to offset the timecode when playing out a scene or a clip.

8. Click **Close**.

The **Hardware Setup** dialog box closes.
Configure Video Preview and Audio Monitor

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.

2. Click the Preview & Monitor tab.

3. In the Video Preview Output section, use the Up Next Preview Output list to select the video output device on which to preview video. All framebuffers can be used to preview video.

   When <none selected> is the selected preview output, video preview is only possible within XPression.

   If a configured framebuffer from the Inputs / Outputs tab is used as a preview output, the Hardware Setup dialog box must be closed and reopened before the configured framebuffer is available in the Output list.

4. In the Output list, click inside the Assigned Preview Output column and use the Assigned Preview Output list to select a framebuffer as the individual preview output for the selected framebuffer in the Output list.
5. In the Audio Monitor section, use the Device list to select the audio output device from which to monitor audio. The audio monitor device monitors audio from the Scene Director in the scene loaded in the layout. It is not used for any scenes on framebuffer outputs, etc.

6. Click Close.
   The Hardware Setup dialog box closes.
Configure RS232 CTS/DSR GPI for Contact Closures

1. Ensure that a USB-232 dongle is installed and assigned to a Communication port or that the system has a built-in RS232 port before configuring GPI for RS232.

* Not all USB to serial converters support contact closures.

2. In XPression, use the Edit menu to select Hardware Setup.

   The Hardware Setup dialog box opens.

3. Click the GPI Boards tab.

4. Click Add.

   The Add New GPI Board dialog box opens.

5. Use the Brand list to select Serial GPI (CTS/DSR).

   The Serial GPI Setup dialog box opens.

6. In the RS232 GPI Settings section, select Enabled from the State list. Select Disabled to turn off RS232 GPI.

   When enabled, RS232 GPI (General Purpose Interface) is used to control functions of XPression in sequencer mode. RS232 GPI can trigger the state of the next take of scenes and scene groups from top to bottom of a sequence.

   A standard RS232 serial port can support two GPI signals using the CTS and DSR pins. Connect Pins 6 and 7 for GPI 1 and connect Pins 7 and 8 for GPI 2.

7. Use the Port list to select the Communication port that receives RS232 GPI signals.
8. In the **Debounce Time** box, enter or select the amount of milliseconds between sequential GPI pulses.

When using a contact closure GPI on the CTS/DSR lines, some devices might send GPI signals that are noisy. Connecting the GPI to a mechanical push-button may also exhibit this problem. If the connection is noisy, it could generate multiple triggers that cause the sequence to advance by two or three events at a time. In the **Serial GPI Setup** dialog box, a Debounce Time can be set. This value is the amount of time within which XPression will wait before acting upon a second GPI trigger. A value of around 50-100 milliseconds should be sufficient for filtering out any noise during the GPI trigger.

9. Click **OK**.

The **Serial GPI Setup** dialog box closes and the configuration appears in the GPI Boards tab list.

**For More Information on...**

- configuring and working with GPIs, refer to the *GPI White Paper* available from Ross Video.
Configure a 25-Pin GPIO Port

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the GPI Boards tab.

3. Click Add.
   The Add New GPI Board dialog box opens.

4. Use the Brand list to select Adrienne TC/GPIO Card.
   The Adrienne TC/GPIO card is installed in Ross Video Turnkey systems. The 25 pin GPIO port can be accessed through .NET applications or by using the Keyboard / GPI Mapping dialog box to configure functions.
5. Click OK.
   The Adrienne Setup (GPI) dialog box opens.

6. In the Polling Frequency box, enter or select a polling frequency in milliseconds for checking the GPI inputs.
7. Use the Initial Output Pin State list to select the state of the pins when XPression is launched. The options are:
   - Low (0v)
   - High (+5v)
8. Select the Active Low Outputs check box to use the active low status (0v) when the GPI is activated in XPression. If not enabled, the GPI is +5v when the GPI is activated in XPression.
9. Click **OK**.

    The Adrienne TC/GPIO card is displayed in the GPI Board list.

10. Click **Close**.

    The **Hardware Setup** dialog box closes.

**For More Information on...**

- configuring and working with GPIs, refer to the **GPI White Paper** available from Ross Video.
- creating a custom GPI, refer to the section “Create a Custom GPI Map” on page 25-11.
Configure a SeaLevel GPIO Board

SeaLevel 8004e and SeaLevel 8012 GPIO cards are customer-supplied.

1. In XPression, use the Edit menu to select Hardware Setup.
The Hardware Setup dialog box opens.

2. Click the GPI Boards tab.

3. Click Add.
The Add New GPI Board dialog box opens.

4. Use the Brand list to select Sealevel GPIO.
The 32 pin GPIO port can be accessed through .NET applications or by using the Keyboard / GPI Mapping dialog box to configure functions.

5. Click OK.
The SeaLevel I/O Setup dialog box opens.

6. In the State list, select Enabled to use the card.

7. In the Card list, select the SeaLevel GPIO card to use.

8. Use the Debounce Time (ms) box to enter or select the amount of milliseconds between sequential GPI pulses.
9. Click OK.
   The SeaLevel 8004e card is displayed in the GPI Board list.

10. Click Close.
    The Hardware Setup dialog box closes.

For More Information on...
• configuring and working with GPIs, refer to the GPI White Paper available from Ross Video.
• creating a custom GPI, refer to the section “Create a Custom GPI Map” on page 25-11.
Configure Smart GPI / RossTalk

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the GPI Boards tab.

3. Click Add.
   The Add New GPI Board dialog box opens.

4. Use the Brand list to select Smart GPI / RossTalk.
   Smart GPI/RossTalk is an ASCII based protocol that can be sent over TCP/IP or RS232 that is used to trigger various actions in XPression.
5. Click OK.
   The Smart GPI / RossTalk Setup dialog box opens.

6. In the Settings section, select Enabled from the State list. Select Disabled to turn off Smart GPI/RossTalk.
7. Select a Mode for Smart GPI/RossTalk:
   - **Serial RS232** — select to use RS232 to send Smart GPI/RossTalk signals to XPression.
   - **TCP** — select to use TCP/IP to send Smart GPI/RossTalk signals to XPression.
   - **UDP** — select to use UDP sockets to send Smart GPI/RossTalk signals to XPression.

8. Configure the selected GPI mode.

   **Serial RS232**
   a. In the RS232 GPI Settings box, use the **Port** list to select the Communication port that receives GPI signals.
   b. Use the **Baudrate** list to select the communication speed for GPI signals.
   c. Use the **Data Bits** list to select the number of bits used to represent one character of data for GPI signals.
   d. Use the **Parity** list to select the method used to check for lost data in a GPI signal.
   e. Use the **Stop Bits** list to select the number of bits used to indicate the end of a byte in a GPI signal.
   f. Use the **Flow Control** list to select the data transmission rate controller for a GPI signal.

   When using Smart GPI/RossTalk, the flow control can be set to **Hardware** or **None**, but it must be set the same in both XPression and the transmitting device.

   **TCP**
   a. In the **Incoming Network Settings** box, use the **TCP Port** box to enter or select the communication port that receives GPI signals.
   b. In the **Outgoing Network Settings** section, use the **Hostname** box to enter the host name of a remote device that is to receive RossTalk messages.
   c. Use the **TCP Port** box to enter or select the communication port that receives the signals.

   **UDP**
   a. In the **Incoming Network Settings** box, use the **UDP Port** box to enter or select the communication port that receives GPI signals.
   b. In the **Outgoing Network Settings** section, use the **Hostname** box to enter the host name of a remote device that is to receive RossTalk messages.
   c. Use the **UDP Port** box to enter or select the communication port that receives the signals.

9. Click **OK**.
   The Smart GPI/RossTalk is displayed in the GPI Board list.

10. Click **Close**.
    The **Hardware Setup** dialog box closes.

For More Information on...
• configuring and working with GPIs, refer to the **GPI White Paper** available from Ross Video.
Configure PBus Interface and PBus Recalls

PBus is an industry standard protocol designed to allow production switchers to communicate with external devices.

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the GPI Boards tab.

3. Click Add.
   The Add New GPI Board dialog box opens.

4. Use the Brand list to select PBus.
5. Click OK.
   The PBus Setup dialog box opens.

6. In the Settings section, select Enabled from the State list. Select Disabled to turn off PBus.
7. Select a Mode for PBus:
   • Serial RS232 — select to use RS232 to send PBus signals to XPression.
   • TCP — select to use TCP/IP to send PBus signals to XPression.
   • UDP — select to use UDP sockets to send PBus signals to XPression.

8. Configure the selected mode.

RS232 GPI Settings
   a. Use the Port list to select the Communication port that receives the signals.
   b. Use the Baudrate list to select the communication speed for the signals.
   c. Use the Data Bits list to select the number of bits used to represent one character of data for the signals.
   d. Use the Parity list to select the method used to check for lost data in a signal.
   e. Use the Stop Bits list to select the number of bits used to indicate the end of a byte in a signal.
   f. Use the Flow Control list to select the data transmission rate controller for a signal.

   The flow control can be set to Hardware or None, but it must be set the same in both XPression and the transmitting device.

TCP & UDP
   a. In the Network Settings section, use the TCP Port/UDP Port box to enter or select the communication port that receives the signals.

9. In the PBus Options section, configure the PBus recall options.

   XPression normally does not perform any action when a PBus recall command is issued. Instead, it stores the recall ID to be used later when a PBus trigger command is issued.

   Configure the following PBus recall options:
   • Clear layer on recall — when this option is selected and a PBus recall command is received, XPression will look to see which channel and layer that the take item being recalled has been assigned. It will then immediately clear that layer and channel. However, the take item will not be read to air until such time as a PBus Trigger command is received to put the item on air. This configuration option is recommended to be enabled in situations where XPression might be used to play back clips/graphics and to ensure that as soon the recall command is issued, any previous graphic that might have been left over on the layer will be removed.
   • Move sequencer focus on recall — this configuration option can be selected to move the sequencer focus to the item that is being recalled. This can be useful as a means of generating a preview output that will show a rendered frame from the item that will be put on air when the PBus trigger command is received.
   • Cue item on recall — selecting this option will place the take item into a cued state when the recall command is received. This is useful when using video clips which might take a few frames to cue.
   • Video Clips cue directly to framebuffer — selecting this option will cause the video clips from the Clip Store that are assigned to a PBus register to cue directly onto the hardware output of XPression in a paused state. When the play command is received, they will begin playing.
   • Ignore LEARN command — selecting this option will ignore the LEARN command. LEARN stores the clip currently loaded into a server channel into the PBus register list when the LEARN command is received.

10. Use the Data Logger list to select an encoding scheme for the data log. The options are:
   • None — select this option to use no data logging.
   • ASCII — select this option to use ASCII encoding for the data log.
   • HEX — select this option to use HEX file formatting for the data log.
   • Both — select this option to use both ASCII encoding and HEX file formatting for the data log.

11. Click OK.

   The PBus interface is displayed in the GPI Board list.

12. Click Close.

   The Hardware Setup dialog box closes.

For More Information on...
   • configuring and working with GPIs, refer to the GPI White Paper available from Ross Video.
Configure Camera Tracking

1. In XPression, use the Edit menu to select Hardware Setup.
   The Hardware Setup dialog box opens.
2. Click the Camera Tracking tab.

3. Click Add.
   The Select Tracker Source dialog box opens.

4. Use the Brand list to select one of the following camera tracking sources:
   - `<none>` — do not use a camera tracking source.
   - NCam — select this to use the NCam protocol for the camera tracking source.
   - Lucid Track — select this to use the Lucid Track protocol for the camera tracking source.
   - StypeGrip — select this to use the StypeGrip protocol for the camera tracking source.
   - TrackMen — select this to use the TrackMen protocol for the camera tracking source.
   NCam
   The NCam Tracker Setup dialog box opens.

   a. In the Network Settings section, use the Host box to enter the IP address of the host server.
   b. Use the Port box to enter or select the communication port that receives the camera tracking source information.
   c. Choose a Sync Method for the camera tracking source and the XPression virtual camera:
      - Time Code — select this option to synchronize using a time code to label individual frames of video.
      - Counter — select this option to synchronize using a sequential clock.
d. Select the **Enabled** check box to use the camera tracking source.

**Lucid Track**

The **Tracker Setup** dialog box opens.

![Tracker Setup dialog box](image)

a. In the **Network Settings** section, use the **UDP Port** box to enter or select the communication port that receives the camera tracking source information.

b. Select the **Enabled** check box to use the camera tracking source.

**StypeGrip/TrackMen**

The **Tracker Setup** dialog box opens.

![Tracker Setup dialog box](image)

a. In the **Network Settings** section, use the **UDP Port** box to enter or select the UDP communication port that receives the camera tracking source information.

   Select the **Enabled** check box to use the camera tracking source. De-select it to turn off the camera tracking source.

b. Select the **Generate and send test data** check box to compile and send information about the camera tracking source. When enabled, this option will automatically be disabled when real camera tracking data is received.

5. Click **OK**.

   The dialog box closes and the camera tracking source appears in the Camera Tracking tab list.

   * Use the **Latency Offset** box in the Camera Tracking tab to enter or select the latency offset in frames to match video and rendering delay. Select the **Use Dynamic Delay Adjustment** check box to automatically adjust the delay to maintain a fixed packet buffer level.
Setup OpenMAM

1. In XPression, use the Edit menu to select OpenMAM Setup.
   The OpenMAM Setup dialog box opens.

2. Click Add.
   The Add OpenMAM Server dialog box opens.

3. Select an OpenMAM driver from the Select OpenMAM Driver list.
4. Click OK.
   The configuration dialog box for the OpenMAM driver opens.
5. Configure the server and connection settings for the selected driver:
   XPression Maps
   a. In the Server ID section of the XPression Maps Server dialog box, use the ID box to enter the MOS ID.
   b. Use the Description box to enter a brief and unique descriptor to easily identify the driver.
   c. In the Connection Settings section, use the Server URL box to enter the URL address of the host connection.
   d. Use the Plugin App box to enter the location of the computers where the XPression Maps web client is located.
MediaBeacon (v3.0) Driver

a. In the Server Info section of the MediaBeacon Driver Configuration dialog box, use the ID box to enter the MOS ID.

b. Use the Description box to enter a brief and unique descriptor to easily identify the driver.

c. In the Connection Settings section, use the Host box to enter the address of the host connection.

d. Use the Port box to enter or select the port number of the connection.

e. Use the Login box to enter the login name for the MediaBeacon server.

f. Use the Password box to enter the password for the login.

MediaBeacon (v5.0+) Driver

a. In the Connection Settings section of the Configuration tab, use the Plugin ID box to enter or select an ID number for authentication with MediaBeacon. The ID number is user configurable.

Click the Register Plugin button to login into MediaBeacon and register the plugin.

b. In the Server Settings section, use the ID box to enter the MOS ID.

c. Use the Description box to enter a brief and unique descriptor to easily identify the driver.

d. Use the IP Address box to enter the IP address of the connection.

e. Use the Port box to enter or select the port number of the connection.
f. If using the **XPression Asset Cache Server**, click the **Local Cache** tab. The **Local Cache** tab is displayed.

![Local Cache Tab](image)

g. Select the **Retrieve assets from a local Asset Cache Server** check box to enable the XPression Asset Cache Server from which to retrieve assets.

h. In the **Path** box, enter a file path for the cache or click the **Browse (...)** button and use the file browser to navigate to the folder.

### Streamline Server

![Streamline Server Dialog](image)

a. In the **Server ID** section of the **Streamline Server** dialog box, use the **MOS ID** box to enter the MOS ID.

b. Use the **Description** box to enter a brief and unique descriptor to easily identify the driver.

c. In the **Connection Settings** section, use the **Server URL** box to enter the URL address of the host connection.

d. Use the **API Key** box to enter an API key to communicate with Streamline from XPression. The API key is generated by Streamline.

e. In the **Miscellaneous Settings** section, use the **Streamline Version** list to select the version of Streamline being used for OpenMAM.

f. Select the **Allow use of unapproved assets** box to allow unapproved assets to be taken online.

g. Select the **Download only transcoded XPression videos** check box to force Streamline to download only transcoded XPression codec videos.
h. If using the XPression Asset Cache Server, click the Local Cache tab. The Local Cache tab is displayed.

![Local Cache tab](image)

i. Select the Retrieve assets from a local Asset Cache Server check box to enable the XPression Asset Cache Server from which to retrieve assets.

j. In the Path box, enter a file path for the cache or click the Browse (...) button and use the file browser to navigate to the folder.

k. If using the XPression Media Control Gateway, click the Media Watch Folder tab. The Media Watch Folder tab is displayed.

![Media Watch Folder tab](image)

l. In the Media Watch Folder Settings, use the Path box to enter or select a file path for the media watch folder or click the Browse (...) button and use the file browser to navigate to the folder.

m. Select the Use file system change notification check box to enable notification when the files in the watch folder have changed.

n. Select the Scan for changes every check box to enable scans for changes in the files in the watch folder and enter a time interval in seconds to scan for changes.

Select the File size should not change for at least check box to prevent a file that is copying from being added to the media watch folder until it has finished copying and then enter a time in seconds to wait before the copied file is added to the Media Watch Folder. The default and minimum time is five seconds.
6. Click OK.

   The configuration dialog box for the OpenMAM driver closes and the driver is added to the OpenMAM Servers list in the OpenMAM Setup dialog box.

7. Click OK.

   The OpenMAM Setup dialog box closes.

   If an OpenMAM asset can not be retrieved, the original texture from the scene will be used instead.

For More Information on...

• configuring the local cache settings for storing retrieved assets, refer to the OpenMAM settings in “Set Preferences” on page 3–2.
Set Up Server Channels

The Server Channels are used for previewing and playing out clips.

Before using the Server Channels, they must be configured in the XPression Hardware Setup. Once outputs have been configured in XPression, use the following procedure to set up the server channels.

A virtual channel should be assigned a real physical output onto which the clip will be played. It is these virtual channels that the AMP/VDCP Media Control Gateway is controlling.

1. In XPression, click **Edit > Hardware Setup**.
   The **Hardware Setup** dialog box opens.

2. Click the **Server Channels** tab.
   The **Server Channels** tab opens.

3. Click **Add** to add a server channel.
   The **Select Server Channel #** dialog box opens.

4. Use the **Channel** list to select a server channel number.
5. Click **OK**.

   The server channel is added to the list.

![Server Channels dialog box](image)

6. Configure the following as necessary:
   - In the **Name** column, enter a name for the server channel. The default is Server Channel #.
   - In the **Framebuffer** column, use the list to select an output framebuffer for the server channel.
   - In the **Layer** column, enter or select a layer for rendering. The default is 0 (middle).
   - In the **Server Channel # Options** section, select the **Cue video clips directly to framebuffer** check box to cue clips to air immediately when dropped on a server channel from the Clip Browser.

7. Repeat steps 3 to 6 to add more server channels as necessary.

8. Click **Close**.

   The **Hardware Setup** dialog box closes.

For More Information on...
Configure XPression for XPression Clip Store

Once XPression Clip Store has been configured using the Clip Store Manager, XPression needs to be set up for use with the Clip Store.

1. In XPression, click **Edit > Clip Store Setup**.
   The **Clip Store Setup** dialog box opens.

2. Use the **Hostname** box to enter the IP address of the Clip Store service if using remotely. If using the Clip Store service locally, use **localhost** (default).

3. Use the **Port** box to enter or select the port number for the Clip Store server connection. The default is 9595.

4. Click **OK**.
   XPression is now connected to the Clip Store service.
PBus Interface

The following topics are discussed in this section:

- Overview
- PBus Triggers
- PBus LEARN Commands
- PBus Mapping
- Using PBus from a Switcher to Recall Items
- Using PBus for Clips

Overview

PBus (Peripheral Bus) is an industry standard protocol designed to allow production switchers to communicate with external devices. Most large production switchers have some capability of sending PBus commands to a device. XPression supports PBus over standard RS232 or TCP/UDP sockets.

The chassis of some turnkey XPression systems might not include a standard RS232 port. However, it is possible to use an RS232-USB adaptor.

If the production switcher has an RS422 serial port, then you will require an RS232-RS422 adaptor. This adaptor will require its own power supply. Generally, the adaptors that are port-powered will not function for these purposes.

☆ On an XPression Bluebox system, a limited subset of PBus functionality is available. PBus commands can be used to trigger take items that have been pre-built in an XPression sequence using either XPression Designer or Studio. It is not possible to customize the PBus registers actions using Bluebox. Each register number corresponds to a specific take item number and cannot be changed. It is not possible to load the PBM or PBMS PBus mapping files on Bluebox.

For More Information on...

- configuring the PBus interface and PBus recalls, refer to "Configure PBus Interface and PBus Recalls" on page 3–107.
PBus Triggers

XPression supports many PBus Trigger commands.

• **Trigger 0 – Play Item**
  
  This trigger can be overridden in the PBus mapping.
  
  Trigger 0 is normally used to play a take item to air. However, this can be overridden to perform other actions on a per-register basis. These actions can be configured in the PBus mapping menu.

• **Trigger 1 – Take Sequence Item Off-Air**
  
  Trigger 1 is used to take an item off air (assuming it was already on air). The item taken off air will be the take item that was previously recalled using a PBus recall command.

• **Trigger 2 – Execute GPI**
  
  Trigger 2 is used to emulate a standard GPI input. In the XPression Keyboard/GPI Mapping, various actions can be configured to be executed on a GPI input being triggered. It is possible to trigger up to 99 different GPIs through PBus. The GPI number that will be triggered is the number that was previously recalled using a PBus recall command.

• **Trigger 3 – Clear Framebuffer**
  
  Trigger 3 will clear the framebuffer assigned to the device in the PBus channel configuration. If the channel is set to `<default>`, this trigger will clear Channel 1.

• **Trigger 4 – Clear Framebuffer Channel 2**
  
  Trigger 4 will clear the framebuffer assigned to the device in the PBus channel configuration. If the channel is set to `<default>`, this trigger will clear Channel 2.

• **Trigger 5 – Read Current Sequence Item to Air**
  
  Trigger 5 will take the currently selected sequence item from the sequencer to air. It ignores the PBus recall command and uses whichever item currently has focus in the XPression sequencer.

• **Trigger 6 – Resume Channel**
  
  Trigger 6 will resume all paused graphics currently on the framebuffer assigned to the device in the PBus Channel Configuration. If the framebuffer is set to `<default>`, this will resume Channel 1.

• **Trigger 7 – Resume Channel**
  
  Trigger 7 will resume all paused graphics currently on the framebuffer assigned to the device in the PBus Channel Configuration. If the framebuffer is set to `<default>`, this will resume Channel 2.

• **Trigger 8 – Resume Take Item**
  
  Trigger 8 will resume a single paused take item. The take item will be the item previously recalled by a PBus recall command.

• **Trigger 10 – Bank 0**
  
  Trigger 10 will change the last recall command into an ID in the 0-99 range (refer to the Bank 1 command below for more details).

• **Trigger 11 – Bank 1**
  
  Trigger 11 is used to allow switchers that can only send PBus recall commands up to 99 to be able to recall take items with values of between 100 and 199.

  This “bank 1” command will add 100 to the last recalled item using a PBus recall command. For example; to recall take ID 135 and put it on air, a switcher could send:
  
  › Recall 035
  › Trigger 11 (changes the 035 into 135)
  › Trigger 0

  It is not necessary to switch back to bank 0 after sending a bank 1 command. XPression will automatically revert to bank 0 for the next PBus recall command.

• **Trigger 12 – Bank 2**
  
  Changes the last PBus recall command into an ID in the 200-299 range.

• **Trigger 13 – Bank 3**
  
  Changes the last PBus recall command into an ID in the 300-399 range.
• **Trigger 14 – Bank 4**
  Changes the last PBus recall command into an ID in the 400-499 range.

• **Trigger 15 – Bank 5**
  Changes the last PBus recall command into an ID in the 500-599 range.

**For More Information on...**

• configuring the PBus interface and PBus recalls, refer to “**Configure PBus Interface and PBus Recalls**” on page 3–107.
PBus LEARN Commands

When a PBus LEARN command is received from a remote device, XPression will look to the configured server channel for the PBus device, and if there is a clip currently cued on that server channel it will assign that clip into the PBus register via the recall ID, if assigned.

There is an option **Ignore LEARN command** in the PBus Setup dialog box in the Hardware Setup. This option is useful if you are manually assigning clips to PBus registers and you do not want to change/overwrite them when storing memories on the production switcher. Most production switchers automatically send the PBus LEARN command when storing the memory.

**For More Information on...**

- the PBus LEARN command, refer to the appropriate switcher documentation.
PBus Mapping

Use PBus mapping to assign clips, functions, scenes, scripts, and other actions and functions to device registers, and then save and load the maps.

The following procedures are covered in this section:

• Configuring PBus Mapping
• Assigning an Action to a PBus Register
• Remapping a PBus Register
• Loading and Saving Maps

For More Information on...

• configuring the PBus interface and PBus recalls, refer to "Configure PBus Interface and PBus Recalls" on page 3–107.

Configuring PBus Mapping

Use the PBus Device Configuration dialog box to configure the Device IDs and channels.

To configure PBus Mapping:

1. In XPression, open the Sequencer.
2. Click Display > PBus Mapping.
   
   The PBus Mapping window opens.
3. Click the **Setup Device Configuration** icon.
   The **PBus Device Configuration** dialog box opens.

4. Click **Add** to add a **Device ID**.
   A device ID is added to the PBus Device Configuration list. At least one Device ID must be added. The Device ID is the ID number that will be sent in PBus messages transmitted from the production switcher.

5. Click inside the **Device ID** column of the ID and enter or select an ID number.
   PBus Device IDs must be between 0 and 23.

6. Click inside the **Name** column of the ID and enter a name to refer to the Device ID. For example, Device A.
7. Click inside the **Server Channel** column of the ID and use the list to select a specific output framebuffer or use the `<default>` framebuffer.

If the framebuffer is set to anything other than `<default>` when a PBus recall command is received for a specific Device ID, then the item will be played on the selected framebuffer. If `<default>` is selected, then the item will be played on the framebuffer for which the original take item was configured. When a clip from the Clip Store is assigned to a register and `<default>` was selected for the Server Channel, the first device configured will use Server Channel 1, the next will use Server Channel 2, etc.

![PBus Mapping Window](image)

If XPression does not have the Clips option, then the Server Channel configuration column will be missing and all take items will be cued to the channel assigned to them through the Sequencer.

8. Click **OK**.

The Device IDs are added as tabs at the bottom of the PBus Mapping window under the assigned device names. If there are no tabs added, then a Device ID was not added to the PBus Device Configuration list.

![PBus Mapping Window](image)
Assigning an Action to a PBus Register

Each device has a list of 4095 registers which can be recalled through PBus.

* Some switchers can only support the first 99 registers.

Each PBus register can be assigned an action that will be executed after the register is recalled and Trigger 0 is received. The default action for each register is to play the corresponding Take Item with the same number as the PBus register.

For More Information on...

- PBus triggers, refer to “PBus Triggers” on page 4–2.

To assign an action to a PBus register:

1. In the PBus Mapping window, select a function from the actions list to the right of the devices.
2. Drag and drop the action onto a register.

The action is added to the register.
Remapping a PBus Register

To remap a PBus register to play a different take item, the take item can be dragged and dropped from the sequencer onto the register in the PBus Mapping window or you can enter or select a different take ID using the **Take ID** box in the **Recall Take Item** section of the PBus Mapping window.

To remap a PBus register using drag and drop from the Sequencer:

1. In the **Sequencer**, select a take item from the **Take ID** list.

2. Drag and drop the take item onto a register in the **PBus Mapping** window.
The take item is added to the register.

To remap a register using the Take ID box:

1. In the PBus Mapping window, select a register number from the devices to the left of the actions list.
2. In the **Recall Take Item** section, use the **Take ID** box to enter or select a take item to add to the selected register.

![Recall Take Item](image)

The take item is added to the selected PBus register.

To remap a PBus register using drag and drop from the Clip Browser:

1. In the **Clip Browser**, select a clip from the list.

![Clip Browser](image)
2. Drag and drop the take item onto a register in the **PBus Mapping** window.

![PBus Mapping window](image)

The take item is added to the register.

---

**Loading and Saving Maps**

PBus maps are not loaded and saved with XPression projects. They are loaded and saved to disk as .pbm or .pbms files using the PBus Mapping window. The .pbm file extension is used for a single PBus map and the .pbms file extension is used for multiple PBus maps.

Use the following PBus Mapping window toolbar icons to load and save PBus maps:

- **Load** ( ![Load](image) ) – click this button to open a file browser to select a PBus map or multiple PBus maps to load.
- **Save All** ( ![Save All](image) ) – click this button to save multiple PBus maps to disk.
- **Save** ( ![Save](image) ) – click this button to save a single PBus map to disk.
Using PBus from a Switcher to Recall Items

풍 Consult the switcher documentation for a complete description of how to use PBus with your particular manufacturer/model. This section is only intended to provide some background information and tips.

Generally, switchers will send a PBus recall command when an EMEM is recalled. The following procedure is an example using take item 0005.

For More Information on...
- configuring the PBus interface and PBus recalls, refer to “Configure PBus Interface and PBus Recalls” on page 3–107.

To recall and play a specific take item from XPression:

1. In XPression, use the Sequencer to create a take item and give it an ID of 0005.
2. Create an EMEM/Memory on the switcher and store it as EMEM 5.
3. Within EMEM 5, ensure that you have enabled the sending of PBus commands.
4. Within the timeline for EMEM 5, issue a PBus Trigger 0 command.

When EMEM 5 is recalled, it will send a PBus recall 5 command to XPression. This command will not yet do anything (unless the configuration options discussed in the “Configure PBus Interface and PBus Recalls” on page 3–107 section are enabled).

When the timeline is run, the switcher will send a PBus Trigger 0 command. At this time, XPression will then put take item #5 on the output channel/layer previously assigned to that item in the sequencer.

There may be several frames of delay between issuing the Trigger 0 command and when the video for the item appears on the SDI output of XPression. This is normal and should be accounted for inside of the timeline on the switcher. For example, you will need a delay between the issuing of trigger 0 and when the keyer containing the XPression is keyed onto the PGM output.

To recall different take items, the timeline on the switcher can be copied into different switcher registers.

For More Information on...
- PBus triggers, refer to “PBus Triggers” on page 4–2.
Using PBus for Clips

Firstly, the PBus configuration must be set to assign a PBus device ID to a specific server channel. This controls the server channel onto which PBus commands to a device will load the clip. Valid device IDs are from 0 to 23.

By default, every PBus register (0 to 4095) will cue/play the corresponding take item with that ID number. However, clips from the Clip Browser can be assigned to a PBus register simply by dragging them from the Clip Browser onto a PBus register. Alternatively, various actions (same ones accessible in the keyboard mapping menu) can be assigned to a PBus register by dragging them from the action list on the right to a PBus register. This is useful for assigning scripts or actions like Take Next/Clear Channel, etc. to a PBus register. Right-click on a register with a clip and select Find Clip in Clip Browser to find a clip or select a different clip in the Clip Browser.

A PBus register map can be saved to disk to a file using the .PBM extension, or maps for all devices can be saved to a .PBMS file. Maps can be loaded from these PBM files or from a specific format of XML file. When using the XML file import, it will assign clips to PBus registers using their recall ID from the clip database.

Using PBus for Clips with Recall IDs

The PBus map contains a column named Recall ID.

If a clip in the Clip Store exists with that recall ID, it will be assigned to that PBus register. A clip’s recall ID can also be entered into the column to assign it to the respective register. The PBus register will always recall the clip with that specific recall ID, so if a new clip is ingested with a matching recall ID, the PBus register will recall the new clip instead. If the clip is manually edited and the recall ID is changed or removed, the PBus register will no longer recall that clip.

A similar behavior exists when dragging a clip with a recall ID into the PBus register; meaning that the PBus register is bound to a specific recall ID and not to a specific clip. Holding Ctrl-Shift and dragging a clip onto a PBus register will link the clip with the PBus register, and it will not be replaced regardless of a clip with a duplicate recall ID being ingested.
Scenes

Within an XPression project, scenes are the containers that hold all of the objects and animations you build to form your graphical creation.

The following topics are discussed in this section:

- Create a Project
- Create a Scene
- Create a Custom Size Scene
- Duplicate a Scene
- Delete a Scene
- Create a Scene Group
- Duplicate a Scene Group
- Delete a Scene Group
- Create a Roll/Crawl from a Scene Group
- Customize a Scene Group Roll/Crawl
- Using Transition Logic
- Import From Project
- Creating Global Macros
Create a Project

1. In XPression, use the File menu to select New.
   The Confirm dialog box opens.

2. Select one of the following options for the current project:
   - Yes — save changes to the current project, then close the project.
   - No — close the project without saving changes.
   - Cancel — continue working on the project.
   After selecting Yes or No, the New Project dialog box opens.

3. In the Presets tree view, expand any video format node to view the available presets for the selected video format.
   The available presets are displayed for the selected video format.

4. Select a preset to define the video format setting for the new project.
   The settings in the selected preset are displayed in the Settings section.
   Custom settings can be configured as well by clicking New Preset and using the Settings section in the New Project dialog box to configure the new preset.
5. Click **Browse** to the right of the **Location** box to select a folder in which save the new project. The **Select Project Folder** dialog box opens.

![Select Project Folder dialog box]

6. In the **Folder** tree view, locate and select a folder in which save the new project.

7. Click **OK**.

   In the **New Project** dialog box, the full pathname of the selected folder is displayed in the **Location** box.

8. Enter in the **Name** box a name for the new project.

   Project names may only contain letters, numbers, spaces, hyphens, or underscores. Project files are saved with the extension .xpf.

9. Select the **Create Project Structure** check box to automatically create folders within the project folder to store project items (audio, video, dedicated fonts, images, models, etc.).

10. Click **OK**.

    The new project is saved in the project folder and the **New Project** dialog box closes.
Create a Scene

1. In the Scene Manager window, select the scene or scene group below which to add a new scene.

2. Click the New Scene button in the toolbar.
   A new scene is added to the Scene Manager window below the scene or scene group selected in the scene list.

3. In the title bar of the new scene, right-click the scene name and select Rename from the shortcut menu.
   The scene name is selected for editing.

4. Enter a new name for the scene.

5. Press the Return key to save the new scene name.
   The scene title bar displays the entered name.
Create a Custom Size Scene

1. In the Scene Manager window, right-click the scene or scene group below which to add a new scene. The shortcut menu opens.
2. Select New > Custom Size Scene from the shortcut menu.

The New Scene dialog box opens.

3. In the Virtual Dimensions section, use the width box to enter or select the frame width in pixels of the new scene.
4. In the height box, enter or select the frame height in pixels for the new scene.
5. To save the virtual dimensions of the custom size scene, click the Save as Preset button.

Once a custom virtual dimension has been saved as a preset, it can be selected using the Presets list when creating another custom size scene.
6. Click **OK** to create a new scene with the defined settings and close the **New Scene** dialog box.

A new scene is added to the Scene Manager window below the scene or scene group selected in the scene list.

7. In the title bar of the new scene, right-click the scene name and select **Rename** from the shortcut menu.

The scene name is selected for editing.

8. Enter a new name for the scene.

9. Press the **Return** key to save the new scene name.

The scene title bar displays the entered name.
Duplicate a Scene

1. In the **Scene Manager** window, right-click the scene to duplicate.
   The shortcut menu opens.
2. Select **Duplicate** from the shortcut menu.

A new scene is added to the **Scene Manager** window below the scene selected to duplicate.

3. In the title bar of the new scene, right-click the scene name and select **Rename** from the shortcut menu.
   The scene name is selected for editing.
4. Enter a new name for the scene.
5. Press the **Return** key to save the new scene name.
   The scene title bar displays the entered name.
Delete a Scene

1. In the **Scene Manager** window, right-click the scene to delete.
   The shortcut menu opens.

2. Select **Delete** from the shortcut menu.
   The **Warning** dialog box opens

3. Click **Yes**.
   The selected scene is deleted from the **Scene Manager** window.

* Deleting a scene also deletes all of the objects contained in the scene.
Create a Scene Group

A scene group is a collection of scenes that when played out, displays a vertical rolling credits effect or a horizontal crawling ticker effect.

1. In the Scene Manager window, select the scene or scene group above which to add a new scene group.

2. Click the New Scene Group button in the toolbar.

   A new scene group is added to the Scene Manager window below the scene or scene group selected in the scene list.

3. In the title bar of the new scene group, right-click the scene group name and select Rename from the shortcut menu.

   The scene group name is selected for editing.

4. Enter a new name for the scene group.
5. Press the **Return** key to save the new scene group name.
   The scene group title bar displays the entered name.

For More Information on...
- rendering output to an AVI file, refer to the procedure “Create a Roll/Crawl from a Scene Group” on page 5–14.
Duplicate a Scene Group

1. In the Scene Manager window, right-click the scene group to duplicate. The shortcut menu opens.

2. Select Duplicate from the shortcut menu.

   A new scene group is added to the Scene Manager window below the scene group selected to duplicate. All of the scenes contained in the original scene group are duplicated in the new scene group.

3. In the title bar of the new scene group, right-click the scene group name and select Rename from the shortcut menu.

   The scene group name is selected for editing.

4. Enter a new name for the scene group.
5. Press the Return key to save the new scene group name. The scene group title bar displays the entered name.
Delete a Scene Group

1. In the **Scene Manager** window, right-click the scene group to delete.
   The shortcut menu opens.

2. Select **Delete** from the shortcut menu.
   The **Warning** dialog box opens

   ![Warning dialog box]

   Deleting a scene group also deletes all of the scenes contained in the scene group.

3. Click **Yes**.
   The selected scene group is deleted from the **Scene Manager** window.
Create a Roll/Crawl from a Scene Group

1. Create a new XPression project or open an existing XPression project to add a roll/crawl effect.
2. In the Scene Manager window, select the scene or scene group above which to add a new scene group.
3. Click the New Scene Group button in the toolbar.

A new scene group is added to the Scene Manager window below the selected scene or scene group. By default, new scene groups are configured to play a Roll (top to bottom) effect.
4. Add objects to the scene group scene that need to be seen for the entire duration of the roll/crawl effect. For example, add objects to the scene group scene that comprise the background for a roll/crawl effect.

5. Click the **New Scene** button in the toolbar to add the first scene for the roll/crawl effect. A new scene is added below the scene group.

6. On the new scene, click and hold the left mouse button.

7. Drag the selected scene on top of the scene group scene.
8. Release the left mouse button.
The new scene is added to scene group. Scenes contained in a scene group are indented and connected to the scene group by a leader line.

![Scene Manager](image)

9. Add objects to the scene that are to move as part of the roll/crawl effect.
For example, add a text object to the scene to represent the first line of text for a set of credits played by the roll/crawl effect.

10. Add additional scenes to the scene group as required.
Duplicating the first scene added to a scene group is a quick way to add the scenes required for a roll/crawl effect. Scene duplication enables object reuse and object alignment to be maintained between scenes.

11. Add objects to and/or edit existing objects in the scenes that were added to the scene group.
For example, each scene could contain a text object that represents one line of text in a set of credits played by the roll/crawl effect.

12. If the position of a scene in the scene group needs to be changed, click on the scene and drag it the required position in the scene group.

13. Double-click the scene group to playout the defined roll/crawl effect.
The selected scene group is sent to the default output.

14. Press the **Spacebar** to start the scene group playout.
The defined roll/crawl effect plays out through the default output.

* Use the keyboard controls to increase or decrease the speed of the scene group roll/crawl during playout:
  - in Layout mode: **CTRL + ALT + NUMPAD +/-**
  - in Sequence mode: **CTRL + SHIFT + +/-**

**For More Information on...**

- duplicating scenes, refer to the procedure “Duplicate a Scene” on page 5–7
- customizing a scene group roll/crawl effect, refer to the procedure “Customize a Scene Group Roll/Crawl” on page 5–17 or the Online Help for the Scene Group tab of the Object Inspector.
Customize a Scene Group Roll/Crawl

1. In the **Scene Manager** window, select the scene group to customize.

   The selected scene group and the objects contained in it are listed in the **Object Manager** window.

2. In the **Object Inspector - Scene Object** window, click the **Scene Group** tab.

   The **Scene Group** tab opens with the properties for the selected scene group.

3. Use the properties in the **Group** section to set roll/crawl effect properties for a scene group.

   **Properties**

   **Effect** — use this list to select the roll/crawl effect with which to playout scenes in a scene group. The available effects are as follows:
   
   - **Roll** — move scene objects vertically.
   - **Crawl** — move scene objects horizontally.

   **Direction** — use this list to select the direction for the selected roll/crawl effect. The available directions depend on the selected **Effect**, and are as follows:

<table>
<thead>
<tr>
<th>Roll Effect</th>
<th>Crawl Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Bottom To Top</td>
<td>• Right To Left</td>
</tr>
<tr>
<td>• Top To Bottom</td>
<td>• Left To Right</td>
</tr>
</tbody>
</table>
4. Use the properties in the **Duration** section to set the playout duration for the selected roll/crawl effect.

   **Properties**
   - **Speed** — select this option to define the roll/crawl effect playout duration in pixels per second. Use the box to the right of this option to enter or select the number of pixels per second to playout a roll/crawl effect.
   - **Seconds** — select this option to define the roll/crawl effect playout duration in seconds. Use the box to the right of this option to enter or select the number of seconds in which to playout a roll/crawl effect.
   - **Frames** — select this option to define the roll/crawl effect playout duration in frames. Use the box to the right of this option to enter or select the number of frames in which to playout a roll/crawl effect.

5. Use the properties in the **Global Margins** section to set the spacing between scenes displayed in a roll/crawl effect.

   **Properties**
   - **Top** — in this box, enter or select the size in pixels of the margin placed above objects in a scene. This margin is used to control vertical spacing between consecutive scenes played out in a roll effect. This box is only available when **Roll** is selected from the **Effect** list.
   - **Bottom** — in this box, enter or select the size in pixels of the margin placed below objects in a scene. This margin is used to control vertical spacing between consecutive scenes played out in a roll effect.
   - **Left** — in this box, enter or select the size in pixels of the margin placed to the left of objects in a scene. This margin is used to control horizontal spacing between consecutive scenes played out in a crawl effect.
   - **Right** — in this box, enter or select the size in pixels of the margin placed to the right of objects in a scene. This margin is used to control horizontal spacing between consecutive scenes played out in a crawl effect. This box is only available when **Crawl** is selected from the **Effect** list.

6. Use the properties in the **Loop** section to set the number of times to playout a roll/crawl effect.

   **Properties**
   - **Enable Looping** — select this check box to loop the playout of a roll/crawl effect. Clear this check box to only playout the roll/crawl effect one time.
   - **Number of Shows Per Scene** — in this box, enter or select the number of times to loop the playout of a roll/crawl effect. Enter 0 to infinitely loop the playout.

   This box is only available when the **Enable Looping** check box is selected.

7. Use the properties in the **Header/Footer** section to set the type of page with which to start and end a roll/crawl effect.

   **Properties**
   - **Blank Page on Start** — select this check box to start the roll/crawl effect with a blank page before displaying the scenes in the roll/crawl effect. Clear this check box to start the roll/crawl effect with the first scene in the scene group.
   - **Blank Page on End** — select this check box to end the roll/crawl effect with a blank page after displaying the scenes in the roll/crawl effect. Clear this check box to end the roll/crawl effect with the last scene in the scene group.
   - **Treat Last Page as Full** — select this check box to display the last scene in a roll/crawl effect as a full page.

8. Use the properties in the **Start/Stop** section to control the start and end playout speed of a roll/crawl effect.

   **Properties**
   - **Ease In** — select this check box to slow the playout speed at the start of a roll/crawl effect.
     - **Frames** — in this box, enter or select the number of frames at which to return a roll/crawl effect to normal playout speed.
   - **Ease Out** — select this check box to slow the playout speed at the end of a roll/crawl effect.
     - **Frames** — in this box, enter or select the number of frames from the end of a roll/crawl effect at which to slow the playout speed.
9. Use the property in the Rendering section to control lighting for a roll/crawl effect.

Property

Per Scene Lighting — select this check box to use a different lighting source for each scene in a roll/crawl effect. Clear this check box to use the lighting source in the first scene of the scene group for all of the other scenes in the roll/crawl effect.

10. Double-click the scene group to preview the customized roll/crawl effect.

The selected scene group is sent to the default output.

11. Press the Spacebar to start the scene group playout.

The customized roll/crawl effect plays out through the default output.

Use the keyboard controls to increase or decrease the speed of the scene group roll/crawl during playout:

- in Layout mode: CTRL + ALT + NUMPAD +/- 
- in Sequence mode: CTRL + SHIFT + +/-
Using Transition Logic

Use Transition Logic to choreograph how XPression templates transition from one to the other or update on air. Set rules and conditions for different scenarios using the Transition Logic tab in the Object Inspector of a scene. When scenes are coordinated for visually coherent transitions with each other, graphics will always enter and exit the screen smoothly, regardless of which graphic is coming up next.

Transition Logic leverages the Scene Directors to create individual animations for different playout scenarios. Animations can be created for playing graphics created from the same scene to output back-to-back or graphics from different scenes playing back-to-back.

The following information is covered in this section:

- Prerequisites
- Setting Up Rules and Conditions

Prerequisites

Before configuring the rules/conditions for Transition Logic, some items need to be set up in XPression:

- A scene containing the necessary objects (for example, text object and quad object)
- Scene Directors and animations for transitions

The following is an example of the prerequisite set up for using Transition Logic.

Scenes

- Create a scene to use for Transition Logic. For example, a scene that will contain a lower third:
• Add objects to the scene. These can be under the scene object itself or in a group object under the scene object. For example:

Scene Directors and Animations

Create the Scene Directors, add animation, and edit in the timeline of the track or use the Key Graph Editor to create transitions. For example:

- Create the Default Scene Director:
• Create a Back-to-Back in Scene Director:

• Create a Back-to-Back out Scene Director:

• Create an In Scene Director:

• Create an Out Scene Director:
• Create a Subtitle In Scene Director:

• Create a Subtitle Out Scene Director:

• Create a Title Update In Scene Director:

• Create a Title Update Out Scene Director:

**Sequencer**
Add multiple instances of the scene to the sequencer. Once added, use the sequencer to view the transition logic effect played out between different scenes.
Setting Up Rules and Conditions

The following procedure explains how to set up the rules and conditions of transitions for a scene. After the general procedures for adding a rule, adding and configuring conditions, an example (with conditions) is provided using the example scene from the Prerequisites section for each of the In/Out, Back To Back, and Scene Trigger transitions.

1. In the Scene Manager window, select a scene.
2. In the Object Inspector - Scene Object window, click the Transition Logic tab.
   
   The Transition Logic tab opens.

3. Click the Add a new rule button ( ) to add conditions or actions that determine whether or not the transition will occur.

   A new rule is added to the list.

4. Click inside the rule column and enter a name for the rule.

5. Right-click on a selected rule to add conditions to the rule as necessary. Conditions are checked before the rule is run in order to determine if the rule will be run or not. The options are:
   
   • Add Condition > Back To Back Conditions > Compare Text Objects — compare text assigned to text objects before the rule is applied.
   
   • Add Condition > Back To Back Conditions > Compare Scene Name/ID — compare a scene name or scene ID assigned to scenes before a rule is applied.
   
   • Add Condition > Back To Back Conditions > Compare Object Material — compare the materials assigned to an object before the rule is applied.
   
   • Add Condition > Check Scene / Layer — add specific scene and layer conditions to check before a rule is applied.
   
   • Add Condition > Check Text Object — add specific text object conditions to check before the rule is applied.
   
   • Add Condition > Script — add a specific script to check before the rule is applied.
6. If a condition has been applied, configure the properties of the selected condition:

**Compare Text Objects**

If Compare Text Objects is selected, the **Text Compare Properties** section is displayed.

![Text Compare Properties](image)

Use this section to select the text properties for a back to back text compare condition on a rule.

- **a.** Use the **Text Object** list to select the object with which to compare a text object.
- **b.** Select one of the following options:
  - **Text is Different** — select this option to apply the rule if the text is different.
  - **Text is Same** — select this option to apply the rule if the text is the same.

To invert the properties of the text compare condition, select the **Invert Condition** check box.

**Compare Scene Name/ID**

If Compare Scene Name/ID is selected, the **Scene Name Properties** section is displayed.

![Scene Name Properties](image)

Use this section to select the scene name or ID properties for a back to back scene name/ID compare condition on a rule.

- **a.** Select one of the following options:
  - **Scene Name** — select this option and enter the name of the scene with which to compare.
  - **Scene ID** — select this option and enter or select the scene ID with which to compare.
  - **This scene** — select this option to compare with the same scene.

To invert the properties of the scene name/ID compare condition, select the **Invert Condition** check box.

**Compare Object Material**

If Compare Object Material is selected, the **Material Compare Properties** section is displayed.

![Material Compare Properties](image)

Use this section to select the material properties for a back to back material compare condition on a rule.

- **a.** Use the **Object** list to select the object with which to compare a material.
- **b.** Select one of the following options:
  - **Material is Different** — select this option to apply the rule if the material is different.
  - **Material is Same** — select this option to apply the rule if the material is the same.
To invert the properties of the material compare condition, select the **Invert Condition** check box.

**Check Scene / Layer**

If Check Scene / Layer is selected, the **Scene Online Properties** section is displayed.

![Scene Online Properties](image)

Use this section to select the scene and layer properties for a scene online condition on a rule.

- **a.** Select one of the following options:
  - **Scene Name** — select this option and enter the name of a scene that when online the rule will be applied. Leave the field blank to apply to any scene.
  - **Scene ID** — select this option and enter or select the ID of a scene that when online the rule will be applied.
  - **No scene (layer empty)** — select this option to use no scene online to apply the rule.

- **b.** Use the **Framebuffer** list to select a framebuffer that the selected scene name or scene ID must be online on for the rule to apply:
  - **Current** — use the current framebuffer that is being used for the selected scene.
  - **Any** — use any framebuffer that is being used for the scene.
  - **Framebuffer X** — use a specific framebuffer that is being used for the scene.

- **c.** Use the **Layer** list to enter or select a specific layer that the selected scene name or scene ID must be using for the rule to apply:
  - **Current** — select this check box to select the current layer as the layer that the scene or scene ID must be using for the rule to apply.
  - **Any** — select this check box to select any layer as the layer that the scene or scene ID must be using for the rule to apply.

To invert the properties of the scene online condition, select the **Invert Condition** check box.

**Check Text Object**

If Check Text Object is selected, the **Text Object Properties** section is displayed.

![Text Object Properties](image)

Use this section to select the text object properties to check for a text object condition on a rule.

- **a.** Select one of the following **Scene To Check** options:
  - **This Scene** — check the text object of the current scene.
  - **Other Scene** — check the text object from another scene.

- **b.** Use the **Text Object** list to select a text object to check for the defined properties of the condition.
c. Select one of the following properties to check:
   - **Has Data** — check that the selected text object has text/data.
   - **Is Empty** — check that the selected text object has no text/data.
   - **Equals** — check that the selected text object is equal to specific text/data.
     Use the **Value** box to enter the specific text/data.
   - **Contains** — check that the selected text object contains specific text/data.
     Use the **Value** box to enter the specific text/data.

To invert the properties of the text object condition, select the **Invert Condition** check box.

**Script**

If Script is selected, the **Script Properties** section is displayed.

Use this section to add a script to apply as a condition on a rule.

a. Click **Edit Script** to open the Script Editor to create or edit a script to apply as a condition on a rule.

To invert the properties of the script condition, select the **Invert Condition** check box.

7. Click one of the following tabs to configure the transitions:
   - **In / Out**
   - **Back To Back**
   - **Scene Triggers**

   The selected transition tab is displayed.

**In / Out**

Use the **In / Out** tab to configure an in/out transition to execute for a rule applied to the scene when the rule is true and/or false.

a. In the **If Rule Is True** section, use the **In** list to select a Scene Director to use for a transition in when the rule is true.

   Select the **Wait for out effect** check box to wait for a scene transitioning out with a transition out to finish before playing this scene in.

b. Use the **Out** list to select a Scene Director to use for a transition out when the rule is true.

   Select the **Play out when incoming cuts** check box to play the out effect even when the transition of an incoming scene is set to Cut.

a. In the **If Rule Is False** section, use the **In** list to select a Scene Director to use for a transition in when the rule is false.

   Select the **Wait for out effect** check box to wait for a scene transitioning out with a transition out to finish before playing this scene in.
b. Use the **Out** list to select a Scene Director to use for a transition out when the rule is false.

c. Select the **Play out when incoming cuts** check box to play the out effect even when the transition of an incoming scene is set to Cut.

**Example of In / Out with Conditions:**

Using the scene example in the **Prerequisites** section, the scene has been assigned an In / Out transition as the first rule where if the rule is true, then use the In transition to transition the scene in and Out transition to transition the scene out:

![Scene Transition Logic](image)

This rule is to be applied should the condition be met that the previous scene on air is not the same as the Election 2016 Title Bar scene and that the incoming scene after playout is not the same as the Election 2016 Title Bar scene, as noted by the selection of the **Inverse Condition** check box in the **Scene Name Properties** for the condition:

![Scene Name Properties](image)

**Back To Back**

Use the **Back To Back** tab to configure a back to back transition to execute for a rule applied to the scene when the rule is true and/or false.

![Back To Back Tab](image)

a. In the **If Rule Is True** section, use the **B2B In** list to select a Scene Director to use for the back to back in scene transition when the rule is true.

b. Use the **B2B Out** list to select a Scene Director to use for the back to back out scene transition when the rule is true.

Select the **Render animated objects only** check box to only render animated objects on the back to back out scene.

Select the **Render incoming scene on top** check box to render the incoming scene on top of the outgoing scene.

c. In the **If Rule Is False** section, use the **B2B In** list to select a Scene Director to use for the back to back in scene transition when the rule is false.
d. Use the B2B Out list to select a Scene Director to use for the back to back out scene transition when the rule is false.

Select the **Render animated objects only** check box to only render animated objects on the back to back out scene.

Select the **Render incoming scene on top** check box to render the incoming scene on top of the outgoing scene.

**Example of Back To Back with Conditions:**

Using the scene example in the **Prerequisites** section, the scene has been assigned an Back to Back transition as the second rule where if the first rule is false, then use the Back to Back rule to use the B2B In transition to transition the scene in and the B2B Out transition to transition the scene out, and that the only objects from the scene rendered in the transition are those that have animation:

```
This rule is to be applied should the condition be met that the previous scene on air is the same as the Election 2016 Title Bar scene and that the incoming scene after playout is the same as the Election 2016 Title Bar scene:
```

**Scene Triggers**

Use the **Scene Triggers** tab to configure the scene directors to be played in and out when any scene goes online or offline on a different layer when the rule is true and/or false.

a. In the **If Rule Is True** section, use the **On Scene Online** list to select a Scene Director that will be played when any scene goes online on a different layer when the rule is true.

b. Use the **On Scene Offline** list to select a Scene Director that will be played when any scene goes offline on a different layer when the rule is true.

c. In the **If Rule Is False** section, use the **On Scene Online** list to select a Scene Director that will be played when any scene goes online on a different layer when the rule is false.

d. Use the **On Scene Offline** list to select a Scene Director that will be played when any scene goes offline on a different layer when the rule is false.
Example of Scene Trigger with Conditions:
Using the scene example in the Prerequisites section, the scene has been assigned a Scene Triggers transition as the third rule where if the first and second rules are false, then use the Scene Triggers rule to:

- use the Subtitle In transition as the Scene Director that will be played when any scene goes online on a different layer when the rule is true.
- use the Subtitle Out transition as the Scene Director that will be played when any scene goes offline on a different layer when the rule is true.
- use the Title Update In transition as the Scene Director that will be played when any scene goes online on a different layer when the rule is false.
- use the Title Update Out transition as the Scene Director that will be played when any scene goes offline on a different layer when the rule is false.

This rule is to be applied should the condition be met that the scene going online on a different layer is a different scene that still contains the Breaking Text text object and with a value that equals the text 'Breaking News':

8. Add multiple instances of the scene to the sequencer. Use the sequencer to see the transition logic effect as different scenes are played out.
Import From Project

Use the Import From Project feature to import scenes, materials, models, fonts, audio clips, stagger animations, and widgets from an existing XPression project.

1. In XPression, click File > Import > From Project/File.
   A file browser opens.

2. Select a project and click Open.
   The Import From Project dialog box opens with the selected project loaded.

3. Use the Scenes, Materials, Models, Fonts, Audio Clips, Stagger Anims, Widgets, and Global Lists tabs to select the items to import. Select items for importing by selecting the check box for the individual item.

   Use the Filter box in the Scenes tab to enter the name or details of specific scenes to locate.

   Click and hold on the Thumbnail Size slider to increase or decrease the thumbnail size by sliding right or left.
4. Click **Next** once all necessary items have been selected.
   
The details of the import are displayed as well as some import options.

5. In the **Options** section, configure the following import options:
   
   - **Copy Resources Into Project** — select this check box to copy resources into the local project using its local directory structure. If disabled, the local project will point to the location of the resource in the second project. It is selected by default.
   
   - **Use existing fonts where possible** — select this check box to use the existing fonts of a project already open in XPression, where possible.
   
   - **Maintain folder structure when importing resources** — select this check box to preserve the subfolder structure of resources when importing materials and scenes into a project. This is useful when the source project has a number of subfolders underneath Images/ or Videos/ etc. It is selected by default.

   To adjust the default settings for the import options, refer to the **Import** section in “Set Preferences” on page 3–2.
6. Click Next.

One of two results can occur:

- The items are ready for import.

If this is the case, proceed to step 7.

- Imported scenes and materials might have names and material GUID that overlaps with scenes and materials in the open project in XPression.
If this is the case, do the following as necessary:

- Click **Import All** to import all scenes and materials as new items.
- Click **Replace All** to replace the existing scenes and materials with the imported ones.
- Use the drop-down list in the **Action** column to select the import or replace options for each individual item.

Any existing sequencer items will be updated to use the newly overwritten scene. It is recommended to ensure published fields are a match.

Once all duplicate import items are configured, click **Next**.

7. Click **Finish** to import the items.

   The items begin importing.

8. Once all items have completed importing, click **Close** to exit the Import From Project dialog box.
Creating Global Macros

Create project specific global macros that can be used inside DataLinq or dynamic material paths. Global macros can be used inside DataLinq and dynamic materials by using @MacroName@. If a text object shares the same name, the global macro can be forced by prefixing it with @G:MacroName@.

1. IN XPression, click Project > Global Macros.

   The Edit Global Macros dialog box opens.

2. In the Edit Global Macros dialog box, click Add.

   A new global macro is added to the list.

3. In the list, click inside the Name column of the macro to enter a unique name for the global macro. The default is Macro 1, Macro 2, etc.

4. Click inside the Value column of the macro to enter the value to assign to the global macro.

5. Click Close.

   The Edit Global Macros dialog box closes.
Base Objects

In XPression, text and backgrounds can be linked to various sources and formatted using defined styles. The following topics are discussed in this section:

• Create a Text Object
• Use Tabs in a Text Object
• Align Text Objects to Build a Table
• Apply a Material to a Text Object
• Apply Word Wrap to a Text Object
• Apply Texture Mapping to a Text Object
• Applying Underline, Superscript, and Subscript to a Text Object in the Main Viewport
• Applying Underline, Superscript, and Subscript to a Text Object in the Take Inspector
• Create a Background Object
Create a Text Object

1. In the Scene Manager window, select the scene or scene group to add a text object. The selected scene or scene group is displayed in the active Viewport.

2. In the Base Objects section of the Object Library window, click the Text button. A new text object is added to the upper left corner of the active Viewport.

   * To use right to left text layout, right-click inside the text object and select Text Layout > Right To Left from the shortcut menu. A Text tab is added to the Object Inspector - Text Object window once Right to Left text has been selected. The text must be in Arabic and must be entered using the text editor in the Text tab.

3. Select the text object in the Object Manager.

4. Select a font using the Scene Fonts tab or the Font Manager window:

   Scene Fonts

   a. In the Object Inspector - Text Object window, click the Scene Fonts tab. The Scene Fonts tab opens.

   b. Select a font for the text object from the Used or Stock font list.
Font Manager

Click **Display > Font Manager** to open the **Font Manager** window.

In the **Font Manager** window, double-click a font for the text object from the list of **All Fonts**.

The selected font is highlighted green in the list of **All Fonts** and is applied to the text object.

5. Type the text for the text object.
   The entered text is displayed in the text object.

6. To move the text object to a new position in the **Viewport**, place the cursor on the text object, press the **Ctrl** key, then click and drag the text object to a new position.

   The settings on the **Transform** tab of the **Object Inspector - Text Object** window can be used to precisely position a text object.

   **For More Information on...**
   - fonts, refer to the section “**Fonts**” on page 15–1.
Use Tabs in a Text Object

Tabs are used to align text at set positions.

* Word wrap is disabled when tabs are used.

1. Add a text object to a scene.

2. Enter some text in the new text object, then press the Tab key.

   After the entered text, the cursor is positioned at the tab that follows the text. By default, five tabs are set for a text object. In a text object, tab positions are marked by a vertical line with an square on top.

   ![Tab Marker](image)

3. To edit the tabs set for a text object, click the Tabs & Options tab in the Object Inspector - Text Object window.

   The Tabs & Options tab opens.

4. Use the Tabs section to edit, add, or delete tabs.
   a. To edit the position of a tab, click in the Position column and enter or select a new tab position in pixels.

      The text associated with the edited tab automatically moves to the new tab position.
   b. To edit the alignment of a tab, click in the Alignment column and select a new text alignment for the tab.

      The text associated with the edited tab automatically move to match the new text alignment set for the tab. The first tab sets the justification of a text object when no other tab are used.
   c. To add a new tab, click New.

      The new tab is added to the end of the tab list. Edit the values in the Position and Alignment columns to modify the new tab.
   d. To delete a tab, select the tab to delete in the tab list then click Delete.

      After a tab is deleted, text is reformatted to align with the remaining tabs.

5. Use the Auto Squeeze section to set the size settings of the text object.
   a. Select the Enabled check box to scale the text content within the maximum width of the text object.
   b. In the Max Width box, enter or select the maximum width of the text object.
   c. Click Set To Current to set the maximum width to the current width of the text object.
d. Use the **Scaling** list to select the scaling condition of the auto squeeze. The available scaling options are as follows:
   - **Width Only** — select to apply auto squeeze to the width of the text object.
   - **Height & Width** — select to apply auto squeeze to the height and width of the text object.

6. Use the **Auto Scale** section to set the scaling of the children to the parent text object.
   a. Select the **Enabled** check box to scale children according to the auto squeeze settings of the selected text object.
   b. Use the **Target** list to select the children to scale according to the auto squeeze configuration of the parent text object. The available target options are as follows:
      - **First Child** — scale the first child according to the auto squeeze configuration of the parent text object.
      - **Children** — scale the children according to the auto squeeze configuration of the parent text object.
   c. Use the **Mode** list to select the scaling condition of the auto scale. The available mode options are as follows:
      - **Width & Height** — select to apply auto scale to the width and height of the first child or children.
      - **Width Only** — select to apply auto scale to the width of the of the first child or children.
      - **Height Only** — select to apply auto scale to the height of the of the first child or children.

For More Information on...
- adding a text object to a scene, refer to the procedure “**Create a Text Object**” on page 6–2.
Align Text Objects to Build a Table

1. In the **Scene Manager** window, select the scene or scene group to add a table.
2. Create a text object for each column heading in the table.

![Image of scene with text objects labeled Head 1, Head 2, Head 3, Head 4]

3. Position the text object of the first column heading in the scene to set the top left corner of the table.

![Image of scene showing the position of the first column heading]

4. In relation to the first column heading text object, position the text object of the last column heading to set the table width.

![Image of scene showing the position of the last column heading]

5. Use the **Selection** tool to select the text object of the first column heading.

6. Shift-click each of the remaining column heading text objects.
7. Click the **Align Bottom Edges** button in the toolbar.
   The bottom edges of all the column headings are aligned with the first column heading.

8. Click the **Distribute Objects Horizontally** button in the toolbar.
   The column heading text objects are evenly distributed between the first and last column heading.

9. Below the column heading text objects, create a text object for each column value in the first row of the table.

10. Use the **Selection** tool to select the text object of the first column value.
11. Shift-click each of the remaining column value text objects.
12. Click the **Align Bottom Edges** button in the toolbar.

The bottom edges of all the column values are aligned with the first column value.

13. To create additional table rows, repeat steps 9 to 12.

14. Use the **Selection** tool to select the text object of the first column heading.

15. Shift-click each of the remaining text objects in the first column of the table.

16. Click the **Align Left Edges** button in the toolbar.

The left edges of all the text objects in the first column of the table are aligned with the first column heading.
17. Click the **Distribute Objects Vertically** button in the toolbar.

All the text objects in the first column of the table are evenly distributed between the column heading and the last table row.

18. For each of the remaining table columns, repeat steps 14 to 17.

For More Information on...

- creating text objects, refer to the procedure “Create a Text Object” on page 6–2.
Apply a Material to a Text Object

1. Select the characters in the text object to apply a material.

2. Use the Display menu to select Material Manager.
   The Material Manager window opens.

   The Material Manager contains text materials and materials, which can be applied to text and other objects.

3. In the Face column, select one or more text elements to apply a material.
   After selecting the initial text element, Shift-click another element to select all elements between the two selections or Ctrl-click individual elements to add them to the original selection.

4. Select the thumbnail of the material to apply to the selected text.
5. Double click the thumbnail to apply the selected material to the selected text.
The selected text elements of the selected text are updated with the selected material. The applied material does not affect the text font style.

6. To remove an applied material from a text element, Right-click the text element name in the Face column and select Unbind from the shortcut menu.
The selected text element reverts to the material used by the text font style.

For More Information on...
- how to add a text object to a scene, refer to the procedure “Create a Text Object” on page 6–2.
Apply Word Wrap to a Text Object

Word wrap enables the length of a text object to be adjusted so that the text will continue on a new line accordingly.

* Tabs are disabled when word wrap is enabled.

1. Create a text object or open a scene or scene group that includes a text object.

2. In the Object Manager, select the text object from the Object list.

3. In the Object Inspector, select the Tabs & Options tab. The Tabs & Options tab opens.

4. In the Word Wrap section, select the Enabled check box to apply word wrap to the text object.
5. Use the **Fixed Width** box to enter or select an amount to adjust the width of the text object and set the location where the line of text ends before the text continues on a new line.

   The width can also be adjusted by clicking and dragging the handle at the end of the text object.

For More Information on...

- how to add a text object to a scene, refer to the procedure **"Create a Text Object"** on page 6–2.
Apply Texture Mapping to a Text Object

Use texture mapping to apply graphical detail to a text object.

1. Create a text object or open a scene or scene group that includes a text object.

2. In the **Object Manager**, select the text object from the **Object** list.

3. Apply a texture material to the text object.

4. In the **Object Inspector**, select the **Tabs & Options** tab.
   
   The **Tabs & Options** tab opens.
5. In the **Texture Mapping** section, use the **Mode** list to select the method for applying the texture map to the text object. The options are as follows:
   - **Per Character** — apply the texture map to the dimensions of each individual character of the text object.
   - **Text Object Dimensions** — apply the texture map to the dimensions of the text object.
• **Scene Dimensions** — apply the texture map to the dimensions of the scene that contains the text object.

![Texture Map Example]

**For More Information on...**

- how to add a text object to a scene, refer to the procedure "Create a Text Object" on page 6–2.
- how to apply a material to a text object, refer to the procedure "Apply a Material to a Text Object" on page 6–10.
Applying Underline, Superscript, and Subscript to a Text Object in the Main Viewport

Underline, superscript, and subscript font formats can be applied to 2D text objects in the Main Viewport.

1. Create a 2D text object or open a scene or scene group that includes a 2D text object.

2. Highlight the portion of the text for applying the underline, superscript, or subscript.

   **Underline**

   Right-click on the highlighted text and select **Attributes > Underline** (or **Ctrl+U**).

   The underline is applied to the highlighted text.
**Superscript**
Right-click on the highlighted text and select **Attributes > Superscript** (or **Ctrl+P**).
The superscript is applied to the highlighted text.

![Image of superscript text]

**Subscript**
Right-click on the highlighted text and select **Attributes > Subscript** (or **Ctrl+B**).
The subscript is applied to the highlighted text.

![Image of subscript text]

* Once the underline, superscript, or subscript is applied in the Main Viewport, text typed immediately after retains settings and settings are retained when enter/return is used to add a new line.

**For More Information on...**
- creating a text object, refer to “Create a Text Object” on page 6–2.
Applying Underline, Superscript, and Subscript to a Text Object in the Take Inspector

Underline, superscript, and subscript font formats can be applied to 2D text objects in the Template Data tab of the Take Inspector.

The following commands are used to apply or end underlines, superscripts, and subscripts:

- `{U}` — apply underline attribute
- `{/U}` — end underline attribute
- `{SUP}` — apply superscript attribute
- `{/SUP}` — end superscript attribute
- `{SUB}` — apply subscript attribute
- `{/SUB}` — end subscript attribute
- `{}` — end all text attributes

To apply underline, superscript, or subscript:

1. Create, add, or select a scene in the Sequencer that includes a 2D text object.
2. In the Take Inspector, select the Template Data tab.

   The Template Data tab opens.

Underline

a. In the Static tab, place the cursor in front of the text for applying the underline.

b. Enter `{U}` to apply the underline.

   The underline is applied to all text after the `{U}` command.
c. To end the underline at a specific location within the text, place the cursor at the end of the text intended to include the underline and enter { }. The underline is applied to the text within the \{U\} and \} commands.

\[\text{Superscript}\]

a. In the Static tab, place the cursor in front of the text for applying the superscript.

b. Enter \{SUP\} to apply the superscript.

The superscript is applied to all text after the \{SUP\} command.

c. To end the superscript at a specific location within the text, place the cursor at the end of the text intended to include the superscript and enter { }. The superscript is applied to the text within the \{SUP\} and \} commands.
**Subscript**

a. In the **Static** tab, place the cursor in front of the text for applying the subscript.

b. Enter `{SUB}` to apply the subscript.

    The subscript is applied to all text after the `{SUB}` command.

c. To end the subscript at a specific location within the text, place the cursor at the end of the text intended to include the subscript and enter `{}`.

    The subscript is applied to the text within the `{SUB}` and `{}` commands.

**Underline with Superscript or Subscript**

a. In the **Static** tab, place the cursor in front of the text for applying the underline with superscript or subscript.

b. Enter `{U}` and `{SUP}` (or `{SUB}`) to apply the underline with superscript (or subscript).

    The underline and superscript (or subscript) is applied to all text after the `{U}` and `{SUP}` (or `{SUB}`) commands.
To end the underline after a certain point in the text but keep the superscript (or subscript) for the rest of the text, enter `{/U}` in the location to end the underline.

Conversely, to end the superscript (or subscript) after a certain point in the text but keep the underline for the rest of the text, enter `{/SUP}` (or `{/SUB}`) in the location to end the superscript (or subscript).

* Underline, superscript, and subscript are row independent in the Static text section of the Template Data tab. A new line removes all tags. Tags must be added manually to every row.
Create a Background Object

1. In the Scene Manager window, select the scene or scene group to add a background object. The selected scene or scene group is displayed in the active Viewport.

2. In the Base Objects section of the Object Library window, click the Background button. A new background object is added to the active Viewport.

3. In the Object Inspector - Background Object window, click the Background tab. The Background tab opens.

4. In the Background tab, use the Options section to configure the dimensions of the background object.
5. To move the background object to a new position in the **Viewport**, place the cursor on the background object, press the **Ctrl** key, then click and drag the background object to a new position.

The settings on the **Transform** tab of the **Object Inspector - Background Object** window can be used to precisely position a background object.

![](image1.png)

6. In the **Object Inspector - Background Object** window, click the **Materials** tab.

The **Materials** tab opens.

![](image2.png)

7. Double-click the thumbnail of the material to apply to the background.

The background is updated with the selected material.

8. To remove an applied material from a background object, right-click the text element name in the **Face** column and select **Unbind** from the shortcut menu.

The background object reverts to no applied material.

**For More Information on...**

- adding continuous animation to an object, refer to the section “Add Continuous Animation to an Object” on page 16–2.
Mesh Objects

XPression can build a graphic creation using 3D models imported from external 3D applications.

The following topic is discussed in this section:

- Import a 3D, FBX, or OBJ Model into a Scene
- Add a 3D Model to a Scene Director
Import a 3D, FBX, or OBJ Model into a Scene

1. In the Scene Manager window, select the scene or scene group to add a 3D, FBX, or OBJ model object. The selected scene or scene group is displayed in the active Viewport.

2. In the Primitives section of the Object Library window, click the 3D Model button. The Open dialog box opens.

3. Use the Open dialog box to locate and select the 3D, FBX, or OBJ model file to import into the current scene. 3D, FBX, and OBJ model files are created using applications outside of XPression.

4. Click Open. The XPression Model Importer dialog box opens.

5. In the Node Tree section, expand the model folder. The components of the model are displayed.

6. Clear the check box to the left of each component to not import.
7. Click **Import**.
   The model is imported into XPression and placed at the center of the active **Viewport**.

8. In the **Viewport**, select the model.
   The selected model is highlighted. Depending on how the model was built, clicking on the model selects the entire model or just a component of the model.

9. Use the **Display** menu to select **Material Manager**.
   The **Material Manager** window opens.
10. In the **Face** column, select one or more of the elements from the selected model or component to apply a material.

   After selecting the initial element, Shift-click another element to select all elements between the two selections or Ctrl-click individual elements to add them to the original selection.

11. Double-click the thumbnail of the material to apply to the model or component.

   The selected elements are updated with the selected material.

12. To remove an applied material from an element, Right-click the element name in the **Face** column and select **Unbind** from the shortcut menu.

   All material is removed from the selected element.

13. To move the model object to a new position in the **Viewport**, select the main 3D Object in the **Object Manager**, press the Ctrl key, then click and drag the model object to a new position.

   To precisely position the model object, use the settings on the **Transform** tab of the **Object Inspector - Model 3D Object** window.
Add a 3D Model to a Scene Director

Dragging and dropping a multi-file OBJ 3D model onto a Scene Director allows for the playout of 3D model rendered animation.

1. Import a multi-file 3D model into a scene.
   The 3D model group object is added to the Object Manager.

2. In the Object Manager, expand the 3D model group object.

3. Drag and drop a 3D model object node onto a Scene Director track.
   The 3D model object is added to the Scene Director track.

All 3D model object nodes should be added to the scene director track. Every node should be placed on its own track, to align object playback properly in time.
Primitives

The primitives available in XPression to build a graphic creation include quads, spheres, cubes, cylinders, and tori.

The following topics are discussed in this section:

- Create a Quad Object
- Create a Sphere Object
- Create a Cube Object
- Set the Culling Mode for a Cube Object
- Create a Cylinder Object
- Create a Torus Object
- Create a Slab Object
- Set the Culling Mode for a Slab Object
- Create a Lines Object
Create a Quad Object

1. In the **Scene Manager** window, select the scene or scene group to add a quad object. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **Quad** button. A new quad object is added to the center of the active **Viewport**.

   ![Quad Object Image]

   The new quad object is invisible until a material applied to it.

3. In the **Object Inspector - Quad Object** window, click the **Quad** tab. The **Quad** tab opens.

   ![Object Inspector Image]

4. In the **Options** section, use the **Width** box to enter or select a value in pixels to set the width of the quad object.

5. In the **Height** box, enter or select a value in pixels to set the height of the quad object.

   Select the **Lock Aspect** check box to maintain the aspect ratio between the width and height of a quad object when changing the value in the **Width** box.

6. In the **Tessellation** box, enter or select the number of vertices used to construct a quad object.

7. Use the **Auto Size** menu to select one of the following auto-size options for the quad object:

   - **Disabled** — select this option to disable auto-sizing of the quad object.
   - **On Material Assign Only** — select this to automatically resize the dimensions of a quad object to the size of the material applied to the quad object at the time the material is assigned.
   - **On Material Resize** — select this to automatically resize the dimensions of a quad object when an applied material assigned to the quad object is resized.
8. Select the **Maintain Aspect Ratio of Texture** check box to maintain the aspect ratio of the texture when it is applied to the quad object and use the **Mode** list to adjust the aspect according to one of the following options:

- **Best Fit** — adjust the aspect of the texture to best fit within the dimensions of the quad. This is the default setting.
- **Best Fit (Cropped)** — crop the texture to best fit within the dimensions of the quad.
- **Fit Width** — adjust the aspect of the texture according to width.
- **Fit Height** — adjust the aspect of the texture according to height.
- **Crop** — crop the texture within the dimensions of the quad.

9. Select the **Ignore Object Alpha** check box so that the material will not be influenced by the alpha level of the quad object.

10. Use the **Display** menu to select **Material Manager**.

   The **Material Manager** window opens.

   ![Material Manager Window](image.png)

   * Materials can also be applied by using the **Materials** tab in the **Object Inspector**.
11. Double-click the thumbnail of the material to apply to the quad object.

   The surface of the quad object is covered with the selected material.

12. To remove the material from a quad object, Right-click the quad object name in the Face column and select Unbind from the shortcut menu.

   Without a material, quad objects are displayed as a wire frame mesh.

13. To move the quad object to a new position in the Viewport, place the cursor on the quad object, press the Ctrl key, then click and drag the quad object to a new position.

   To precisely position the quad object, use the settings on the Transform tab of the Object Inspector - Quad Object window.
Create a Sphere Object

1. In the Scene Manager window, select the scene or scene group to add a sphere object. The selected scene or scene group is displayed in the active Viewport.

2. In the Primitives section of the Object Library window, click the Sphere button. A new sphere object is added to the center of the active Viewport.

The new sphere object is invisible until a material applied to it.

3. In the Object Inspector - Quad Sphere window, click the Sphere tab. The Sphere tab opens.

4. In the Options section, use the Diameter box to enter or select a value in pixels to set the diameter of the sphere object.

5. In the Tesselation box, enter or select the number of vertices used to construct the sphere object. The number of vertices used to construct a sphere object is directly related to the quality and smoothness of the sphere object. More vertices equals a higher quality sphere object with a smoother surface, but may compromise output performance.
6. Use the Display menu to select Material Manager.
   The Material Manager window opens.

   * Materials can also be applied by using the Materials tab in the Object Inspector.

7. Double-click the thumbnail of the material to apply to the sphere object.
   The surface of the sphere object is covered with the selected material.

8. To remove the material from the sphere object, Right-click the sphere object name in the Face column and select Unbind from the shortcut menu.
   Without a material, sphere objects are displayed as a wire frame mesh.
9. To move the sphere object to a new position in the Viewport, place the cursor on the sphere object, press the Ctrl key, then click and drag the sphere object to a new position.

To precisely position a sphere object, use the settings on the Transform tab of the Object Inspector - Sphere Object window.
Create a Cube Object

1. In the **Scene Manager** window, select the scene or scene group to add a cube object. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **Cube** button. A new cube object is added to the center of the active **Viewport**.

3. In the **Object Inspector - Cube Object** window, click the **Cube** tab. The **Cube** tab opens.

4. In the **Options** section, use the **Width** box to enter or select a value in pixels to set the width of the cube object.

5. In the **Height** box, enter or select a value in pixels to set the height of the cube object.

6. In the **Depth** box, enter or select a value in pixels to set the depth of the cube object.

   Select the **Lock Aspect** check box to maintain the aspect ratio between the width, height, and depth of a cube object when changing the value in the **Width** box. Changing the value in the **Height** or **Depth** boxes will only adjust those respective values.
7. Use the **Display** menu to select **Material Manager**.

   The **Material Manager** window opens.

   ![Material Manager Window](image)

   * Materials can also be applied by using the **Materials** tab in the **Object Inspector**.

8. In the **Face** column, select one or more cube faces to apply a material.

   After selecting the initial cube face, Shift-click another face to select all faces between the two selections or Ctrl-click individual faces to add them to the original selection.

9. Double-click the thumbnail of the material to apply to the cube object.

   The selected cube faces are covered with the selected material.

   ![Cube with Material](image)

10. To remove the material from a cube face, Right-click the cube face in the **Face** column and select **Unbind** from the shortcut menu.

    Without a material, cube faces are displayed as a wire frame mesh.
11. To move the cube object to a new position in the **Viewport**, place the cursor on the cube object, press the **Ctrl** key, then click and drag the cube object to a new position.

To precisely position a cube object, use the settings on the **Transform** tab of the **Object Inspector - Cube Object** window.
Set the Culling Mode for a Cube Object

1. Add a cube object to a scene.
2. Select the new cube object.
3. Click the Rendering tab in the Object Inspector - Cube Object window.
   The Rendering tab opens.

4. Use the Culling Mode list to select the culling mode for the selected cube object. The available culling modes are as follows:
   - None — do not cull back faces of a cube. This mode renders all faces of a cube object, even the faces that are not visible.
   - Clockwise — cull the back faces of a cube object that have clockwise vertices. In this mode, material is applied to the inside of a cube object.
   - Counter Clockwise — cull the back faces of a cube object that have counter clockwise vertices. In this mode, material is applied to the outside of a cube object.
   The Clockwise and Counter Clockwise culling modes decrease the time required to render a scene.
5. Use the Depth Writes list to control whether or not to render the hidden parts of a cube object. The available options are as follows:
   - Enabled — do not display the hidden parts of a cube object.
   - Disabled — display the hidden parts of a cube object.
   - Automatic — use the set rendering method to control determine whether or not to display the hidden parts of a cube object.
6. Select the Depth Testing check box to use depth values to determine whether an object is displayed on top or behind other objects.
7. Clear this check box to disable depth testing and use the render order of an object to determine whether an object is displayed on top or behind other objects.

For More Information on...
- how to add a cube object to a scene, refer to the procedure “Create a Cube Object” on page 8–8.
Create a Cylinder Object

1. In the Scene Manager window, select the scene or scene group to add a cylinder object. The selected scene or scene group is displayed in the active Viewport.

2. In the Primitives section of the Object Library window, click the Cylinder button. A new cylinder object is added to the center of the active Viewport.

   ![Image of a cylinder object in a viewport with a checkerboard texture]

   The new cylinder object is invisible until a material is applied to it.

3. In the Object Inspector - Cylinder Object window, click the Cylinder tab. The Cylinder tab opens.

   ![Image of the Object Inspector with the Cylinder tab selected]

4. In the Options section, use the Radius 1 box and Radius 2 box to enter or select a value in pixels to set the radii of the cylinder object. Select the Lock Aspect check box to maintain the aspect ratio between the radii of a cylinder object when changing the value in the Radius 1 box.

5. In the Length box, enter or select a value in pixels to set the length of the cylinder object.

6. Use the Start Angle box and End box to enter or select a value in degrees for the start and end of the angle relative to the X axis of the cylinder object.

7. Use the Inner Radius box to enter or select an inner radius value to create hollow cylinders.

8. In the Tessellation box, enter or select a number of vertices to construct the cylinder object.

9. Select the End Caps check box to add a Face to the ends of the cylinder object.
10. Use the Display menu to select Material Manager.

The Material Manager window opens.

11. In the Face column, select one or more cylinder faces to apply a material.

After selecting the initial cylinder face, Shift-click another face to select all faces between the two selections or Ctrl-click individual faces to add them to the original selection.

12. Double-click the thumbnail of the material to apply to the cylinder object.

The selected cylinder faces are covered with the selected material.

Materials can also be applied by using the Materials tab in the Object Inspector.

13. To remove the material from a cylinder face, Right-click the cylinder face in the Face column and select Unbind from the shortcut menu.

Without a material, cylinder faces are displayed as a wire frame mesh.
14. To move the cylinder object to a new position in the **Viewport**, place the cursor on the cylinder object, press the **Ctrl** key, then click and drag the cylinder object to a new position.

To precisely position a cylinder object, use the settings on the **Transform** tab of the **Object Inspector - Cylinder Object** window.
Create a Torus Object

1. In the **Scene Manager** window, select the scene or scene group to add a torus object. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **Torus** button. A new torus object is added to the center of the active **Viewport**.

3. In the **Object Inspector - Torus Object** window, click the **Torus** tab. The **Torus** tab opens.

   ![Object Inspector - Torus Object](image)

   The new torus object is invisible until a material applied to it.

4. In the **Options** section, use the **Main Diameter** box to enter or select a value in pixels to set the diameter of the center of the torus object.

5. In the **Tube Diameter** box, enter or select a value in pixels to set the diameter of the tube of the torus object.

6. In the **Tesselation** box, enter or select a number of vertices to construct the torus object.
7. Use the **Display** menu to select **Material Manager**.

   The **Material Manager** window opens.

   ![Material Manager]

   ∗ Materials can also be applied by using the **Materials** tab in the **Object Inspector**.

8. Double-click the thumbnail of the material to apply to the torus object.

   The torus face is covered with the selected material.

   ![Torus with Material]

9. To remove the material from a torus face, Right-click the torus face in the **Face** column and select **Unbind** from the shortcut menu.

   Without a material, the torus face is displayed as a wire frame mesh.
10. To move the torus object to a new position in the **Viewport**, place the cursor on the torus object, press the **Ctrl** key, then click and drag the torus object to a new position.

To precisely position a torus object, use the settings on the **Transform** tab of the **Object Inspector - Torus Object** window.
Create a Slab Object

Slab objects are similar to quad objects but can be extruded, beveled, and can have rounded or cutoff corners.

1. In the **Scene Manager** window, select the scene or scene group to add a slab object.
   The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **Slab** button.
   A new slab object is added to the center of the active **Viewport**.

   ![Slab Object Example](image)

   The new slab object is invisible until a material applied to it.

3. In the **Object Inspector - Slab Object** window, click the **Slab** tab.
   The **Slab** tab opens.

   ![Object Inspector - Slab Object](image)

4. In the **Options** section, use the **Width** box to enter or select a value in pixels to set the width of the slab object.

5. In the **Height** box, enter or select a value in pixels to set the height of the slab object.
   Select the **Lock Aspect** check box to maintain the aspect ratio between the width and height of a slab object when changing the value in the **Width** box.

6. In the **Extrusion** box, enter or select a value in pixels to set the 3D depth of the slab.

7. Select the **Front Face** check box to make the front face of the slab visible.
   Select the **Back Face** check box to make the rear face of the slab visible.
8. Select the **Front Bevel** check box to use the bevel effect on the front of the slab.

Select the **Back Bevel** check box to use the bevel effect on the rear of the slab.

If using a bevel effect on the slab, use the **Front Bevel** and **Back Bevel** sections to configure the size and style of the bevel(s):

- **Size** — enter or select the size in points of the bevel between the front/back face and extrusion of the slab.
- **Style** — use this list to select the shape of the bevel between the front/back face and extrusion of the slab.

9. In the **Skew** section, use the Skew box to enter or select an angle in degrees with which to slant the slab. Positive angles slant the slab forwards, while negative angles slant the slab backwards.

Select the **Skew Texture** box to skew textures simultaneously with the slab.

10. In the **Corners** section, configure the radius and smoothing for the upper left, upper right, lower left, and lower right corners of the slab:

- **Radius** — enter or select a radius for the respective corners of the slab.
- **Smoothing** — enter or select an amount of smoothness to apply to the respective corners of the slab. The lower the numerical value is, the harsher the appearance of the corner.

Select the **Lock all corners** check box to lock together the radius and smoothing of all corners.

11. Use the **Display** menu to select **Material Manager**.

The **Material Manager** window opens.

* Materials can also be applied by using the **Materials** tab in the **Object Inspector**.
12. In the **Face** column, select one or more slab faces to apply a material.

   After selecting the initial slab face, **Shift**-click another face to select all faces between the two selections or **Ctrl**-click individual faces to add them to the original selection.

13. Double-click the thumbnail of the material to apply to the slab object.

   The selected slab faces are covered with the selected material.

14. To remove the material from a slab object, right-click the slab object name in the **Face** column and select **Unbind** from the shortcut menu.

   Without a material, slab objects are displayed as a wire frame mesh.

15. To move the slab object to a new position in the **Viewport**, place the cursor on the slab object, press the **Ctrl** key, then click and drag the slab object to a new position.

   To precisely position the slab object, use the settings on the **Transform** tab of the **Object Inspector - Slab Object** window.
Set the Culling Mode for a Slab Object

1. Add a slab object to a scene.
2. Select the new slab object.
3. Click the Rendering tab in the Object Inspector - Slab Object window.
   The Rendering tab opens.

4. Use the Culling Mode list to select the culling mode for the selected slab object. The available culling modes are as follows:
   • None — do not cull back faces of a slab. This mode renders all faces of a slab object, even the faces that are not visible.
   • Clockwise — cull the back faces of a slab object that have clockwise vertices. In this mode, material is applied to the inside of a slab object.
   • Counter Clockwise — cull the back faces of a slab object that have counter clockwise vertices. In this mode, material is applied to the outside of a slab object.
   The Clockwise and Counter Clockwise culling modes decrease the time required to render a scene.

5. Use the Depth Writes list to control whether or not to render the hidden parts of a slab object. The available options are as follows:
   • Enabled — do not display the hidden parts of a slab object.
   • Disabled — display the hidden parts of a slab object.
   • Automatic — use the set rendering method to control determine whether or not to display the hidden parts of a slab object.

6. Select the Depth Testing check box to use depth values to determine whether an object is displayed on top or behind other objects.
7. Clear this check box to disable depth testing and use the render order of an object to determine whether an object is displayed on top or behind other objects.

For More Information on...
• how to add a slab object to a scene, refer to the procedure “Create a Slab Object” on page 8–18.
Create a Lines Object

Use the lines object to create 2D and 3D lines.

1. In the **Scene Manager** window, select the scene or scene group to add a lines object. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **Lines** button. A new line object is added to the **Object Manager**.

3. In the **Object Inspector - Lines Object** window, click the **Lines** tab. The **Lines** tab opens.

4. Select a lines object **Mode**:
   - **2D** — click this button to define the lines as a single pixel width line.
   - **3D** — click this button to define the lines as a textured three-dimensional object with customizable thickness.

**2D Lines Object**

a. Click **Add List**.

A starting point for a line is added to the Lines list. The X, Y, and Z coordinates of the first line added to the list represent the origin point of the line in 3D space.

b. Click inside the **Name** column to enter a name for the line.
c. Click **Add Point**.

A line point is added to the list. Line points enable the drawing out of a line.

Add as many points as desired.

d. Use the **Color Mode** list at the far right to select the color definition mode. The available modes are as follows:

- **HSL** — define color by setting hue, saturation, and lightness values.
- **RGB** — define color by setting red, green, and blue values.

e. Use the selected color definition mode to set the diffuse color of the line.

**HSL Color Selection Mode**

- Select the **H** option, then use one of the following methods to set the hue value for the new color:
  - Place the slider along the hue scale to set the hue value.
  - In the box to the right of the **H** option, enter or select the hue value (0 to 359).

After setting the **H** value, the **S** and **L** color values can be set by clicking a color in the **Color Box**.

- Select the **S** option, then use one of the following methods to set the saturation value for the new color:
  - Place the slider along the saturation scale to set the saturation value.
  - In the box to the right of the **S** option, enter or select the saturation value (0 to 100).

After setting the **S** value, the **H** and **L** color values can be set by clicking a color in the **Color Box**.

- Select the **L** option, then use one of the following methods to set the lightness value for the new color:
  - Place the slider along the lightness scale to set the lightness value.
  - In the box to the right of the **L** option, enter or select the lightness value (0 to 100).

After setting the **L** value, the **S** and **H** color values can be set by clicking a color in the **Color Box**.

To select a color on the screen as the new color, click and drag the **Dropper Tool** to a color on the screen then release the mouse button (before releasing the mouse button, the color preview will split to show the new color selection in the top half and the current color selection in the bottom half). The **H**, **S**, and **L** color values are set to match the color selected from the screen.

**RGB Color Selection Mode**

- Select the **R** option, then use one of the following methods to set the red value for the new color:
  - Place the slider along the red scale to set the red value.
  - In the box to the right of the **R** option, enter or select the red value (0 to 255).

After setting the **R** value, the **G** and **B** color values can be set by clicking a color in the **Color Box**.

- Select the **G** option, then use one of the following methods to set the green value for the new color:
  - Place the slider along the green scale to set the green value.
  - In the box to the right of the **G** option, enter or select the green value (0 to 255).

After setting the **G** value, the **R** and **B** color values can be set by clicking a color in the **Color Box**.

- Select the **B** option, then use one of the following methods to set the blue value for the new color:
  - Place the slider along the blue scale to set the blue value.
  - In the box to the right of the **B** option, enter or select the blue value (0 to 255).

After setting the **B** value, the **R** and **G** color values can be set by clicking a color in the **Color Box**.

To select a color on the screen as the new color, click and drag the **Dropper Tool** to a color on the screen then release the mouse button (before releasing the mouse button, the color preview will split to show
the new color selection in the top half and the current color selection in the bottom half). The R, G, and B color values are set to match the color selected from the screen.

f. Use the Alpha box to enter or select a transparency value for the color of the line object (0.0 to 100).

g. Select the Use Spline Interpolation check box to add curvature between interpolating line segments.

h. Use the X, Y, and Z columns in the line list to enter the pixel coordinates for the line segments:
   • Use the X column to enter or select a coordinate along the X axis for the selected line segment.
   • Use the Y column to enter or select a coordinate along the Y axis for the selected line segment.
   • Use the Z column to enter or select a coordinate along the Z axis for the selected line segment.

The line segments are visible in the Main Viewport.

3D Lines Object

a. Click Add List.

A starting point for a line is added to the Lines list. The X, Y, and Z coordinates of the first line added to the list represent the origin point of the line in 3D space.

b. Click inside the Name column to enter a name for the line.
c. Click Add Point.

A line point is added to the list. Line points enable the drawing out of a line.

Add as many points as desired.

d. Click inside the Percentage cell and enter or select an overall percentage of the lines to display.

e. Use the X, Y, and Z columns in the line list to enter the pixel coordinates for the line segments:
   - Use the X column to enter or select a coordinate along the X axis for the selected line segment.
   - Use the Y column to enter or select a coordinate along the Y axis for the selected line segment.
   - Use the Z column to enter or select a coordinate along the Z axis for the selected line segment.

f. Click inside the Diameter cell and enter or select a diameter in pixels for the lines object.

Select the Lock Diameter for All Points check box to lock the diameter for all points of the lines objects in the lines list. If the diameter of one line in the lines list is adjusted, all other line diameters are adjusted accordingly.

g. Select the Use Spline Interpolation check box to add curvature between interpolating line segments.

h. In the Tessellation box, enter or select the number of vertices used to construct the lines objects.

i. In the Radial Tessellation box, enter or select the number of vertices used to construct the radius of the lines objects.

The line segments are visible in the Main Viewport.
Lights

The objects in an XPression scene are made visible by the light emitted by directional, point, and spot light objects.

The following topics are discussed in this section:

- Add a Directional Light Source to a Scene
- Add a Point Light Source to a Scene
- Add a Spot Light Source to a Scene
Add a Directional Light Source to a Scene

1. In the Scene Manager window, select the scene or scene group to add a directional light source. The selected scene or scene group is displayed in the active Viewport.

2. In the Primitives section of the Object Library window, click the Directional Light button. A new directional light object (center dot) is added to the center of the active Viewport.

* Optionally, when adding a light object, hold Shift to keep the light object from automatically binding to the current scene objects.

3. In the Object Inspector - Light Object window, click the Directional Light tab. The Directional Light tab opens.

4. Click Diffuse to set the color of light projected by the directional light object. The diffuse color is set using the color controls to the right.

5. Use the Color Mode list at the far right to select the color definition mode. The available modes are as follows:
   - HSL — define color by setting hue, saturation, and lightness values.
   - RGB — define color by setting red, green, and blue values.

6. Use the selected color definition mode to set the diffuse color.

   HSL Color Selection Mode
   a. Select the H option, then use one of the following methods to set the hue value for the new color:
      - Place the slider along the hue scale to set the hue value.
      - In the box to the right of the H option, enter or select the hue value (0 to 359).
      After setting the H value, the S and L color values can be set by clicking a color in the Color Box.
   b. Select the S option, then use one of the following methods to set the saturation value for the new color:
      - Place the slider along the saturation scale to set the saturation value.
      - In the box to the right of the S option, enter or select the saturation value (0 to 100).
      After setting the S value, the H and L color values can be set by clicking a color in the Color Box.
c. Select the \( L \) option, then use one of the following methods to set the lightness value for the new color:
   - Place the slider along the lightness scale to set the lightness value.
   - In the box to the right of the \( L \) option, enter or select the lightness value (0 to 100).

   After setting the \( L \) value, the \( S \) and \( H \) color values can be set by clicking a color in the Color Box.

To select a color on the screen as the new color, click and drag the eye dropper icon to a color on the screen then release the mouse button. The \( H \), \( S \), and \( L \) color values are set to match the color selected from the screen.

RGB Color Selection Mode

a. Select the \( R \) option, then use one of the following methods to set the red value for the new color:
   - Place the slider along the red scale to set the red value.
   - In the box to the right of the \( R \) option, enter or select the red value (0 to 255).

   After setting the \( R \) value, the \( G \) and \( B \) color values can be set by clicking a color in the Color Box.

b. Select the \( G \) option, then use one of the following methods to set the green value for the new color:
   - Place the slider along the green scale to set the green value.
   - In the box to the right of the \( G \) option, enter or select the green value (0 to 255).

   After setting the \( G \) value, the \( R \) and \( B \) color values can be set by clicking a color in the Color Box.

c. Select the \( B \) option, then use one of the following methods to set the blue value for the new color:
   - Place the slider along the blue scale to set the blue value.
   - In the box to the right of the \( B \) option, enter or select the blue value (0 to 255).

   After setting the \( B \) value, the \( R \) and \( G \) color values can be set by clicking a color in the Color Box.

To select a color on the screen as the new color, click and drag the Dropper Tool to a color on the screen then release the mouse button. The \( R \), \( G \), and \( B \) color values are set to match the color selected from the screen.

7. Click Ambient to set the color of the light from other sources that blends with the directional light.

Follow steps 5 and 6 to set the ambient color for the directional light object.

8. Click Specular to set the color of light emitted by an object on which the directional light shines.

Follow steps 5 and 6 to set the ambient color for the directional light object.

9. To move the directional light to a new position in the Viewport, place the cursor on the directional light object, press the Ctrl key, then click and drag the directional light object to a new position.

To precisely position the directional light object, use the settings on the Transform tab of the Object Inspector - Light Object window.
Add a Point Light Source to a Scene

1. In the Scene Manager window, select the scene or scene group to add a point light source. The selected scene or scene group is displayed in the active Viewport.

2. In the Primitives section of the Object Library window, click the Point Light button. A new point light object (center dot) is added to the center of the active Viewport.

* Optionally, when adding a light object, hold Shift to keep the light object from automatically binding to the current scene objects.

3. In the Object Inspector - Light Object window, click the Point Light tab. The Point Light tab opens.

4. In the Light section, use the Falloff box to enter or select the intensity of light as it spreads out from the point light object.

5. In the Range box, enter or select the overall size in pixels that is lit by the point light object.

6. In the Attenuation section, use the Constant box to enter or select the constant attenuation factor for the gradual loss in intensity for the point light object. The default value is 1.

7. In the Linear box, enter or select the linear attenuation factor times the distance between the light and the vertex being illuminated. The default value is 0.

8. In the Quadratic box, enter or select the quadratic attenuation factor times the square of the distance between the light and vertex. The default value is 0.

9. In the Color section, click Diffuse to set the color of light projected by the point light object. The diffuse color is set using the color controls to the right.

10. Use the Color Mode list at the far right to select the color definition mode. The available modes are as follows:
    • HSL — define color by setting hue, saturation, and lightness values.
    • RGB — define color by setting red, green, and blue values.

11. Use the selected color definition mode to set the diffuse color.
HSL Color Selection Mode

d. Select the **H** option, then use one of the following methods to set the hue value for the new color:
   - Place the slider along the hue scale to set the hue value.
   - In the box to the right of the **H** option, enter or select the hue value (0 to 359).

   After setting the **H** value, the **S** and **L** color values can be set by clicking a color in the Color Box.

e. Select the **S** option, then use one of the following methods to set the saturation value for the new color:
   - Place the slider along the saturation scale to set the saturation value.
   - In the box to the right of the **S** option, enter or select the saturation value (0 to 100).

   After setting the **S** value, the **H** and **L** color values can be set by clicking a color in the Color Box.

f. Select the **L** option, then use one of the following methods to set the lightness value for the new color:
   - Place the slider along the lightness scale to set the lightness value.
   - In the box to the right of the **L** option, enter or select the lightness value (0 to 100).

   After setting the **L** value, the **S** and **H** color values can be set by clicking a color in the Color Box.

To select a color on the screen as the new color, click and drag the eye dropper icon to a color on the screen then release the mouse button. The **H**, **S**, and **L** color values are set to match the color selected from the screen.

RGB Color Selection Mode

a. Select the **R** option, then use one of the following methods to set the red value for the new color:
   - Place the slider along the red scale to set the red value.
   - In the box to the right of the **R** option, enter or select the red value (0 to 255).

   After setting the **R** value, the **G** and **B** color values can be set by clicking a color in the Color Box.

b. Select the **G** option, then use one of the following methods to set the green value for the new color:
   - Place the slider along the green scale to set the green value.
   - In the box to the right of the **G** option, enter or select the green value (0 to 255).

   After setting the **G** value, the **R** and **B** color values can be set by clicking a color in the Color Box.

c. Select the **B** option, then use one of the following methods to set the blue value for the new color:
   - Place the slider along the blue scale to set the blue value.
   - In the box to the right of the **B** option, enter or select the blue value (0 to 255).

   After setting the **B** value, the **R** and **G** color values can be set by clicking a color in the Color Box.

To select a color on the screen as the new color, click and drag the eye dropper icon to a color on the screen then release the mouse button. The **R**, **G**, and **B** color values are set to match the color selected from the screen.

12. Click **Ambient** to set the color of the light from other sources that blends with the point light.

   Follow steps 5 and 6 to set the ambient color for the point light object.

13. Click **Specular** to set the color of light emitted by an object on which the point light shines.

   Follow steps 5 and 6 to set the ambient color for the point light object.
14. To move the point light to a new position in the Viewport, place the cursor on the point light object, press the Ctrl key, then click and drag the point light object to a new position.

To precisely position the point light object, use the settings on the Transform tab of the Object Inspector - Light Object window.
Add a Spot Light Source to a Scene

1. In the **Scene Manager** window, select the scene or scene group to add a spot light source. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Primitives** section of the **Object Library** window, click the **Spot Light** button. A new spot light object (center dot) is added to the center of the active **Viewport**.

3. **Optionally, when adding a light object, hold **Shift** to keep the light object from automatically binding to the current scene objects.**

4. In the **Object Inspector - Light Object** window, click the **Spot Light** tab. The **Spot Light** tab opens.

5. In the **Light** section, use the **Falloff** box to enter or select the intensity of light as it spreads out from the spot light object.

6. In the **Range** box, enter or select the overall size in pixels that is lit by the spot light object.

7. In the **Spotlight Cone** section, use the **Inner Angle** to enter or select the size in degrees of the inner light (beam) emitted from the spot light object. Inner angle values range from 0 to 180 degrees.

8. In the **Outer Angle** box, enter or select the size in degrees of the outer light (blur light) emitted from the spot light object. Outer angle values range from 0 to 180 degrees.

   In order to display the entire the outer angle, this value must be less than the value set for the Range box in the Light section.

9. In the **Color** section, click **Diffuse** to set the color of light projected by the spot light object.

   The diffuse color is set using the color controls to the right.

10. Use the **Color Mode** list at the far right to select the color definition mode. The available modes are as follows:

   - **HSL** — define color by setting hue, saturation, and lightness values.
   - **RGB** — define color by setting red, green, and blue values.

11. Use the selected color definition mode to set the diffuse color.
HSL Color Selection Mode

d. Select the **H** option, then use one of the following methods to set the hue value for the new color:
   • Place the slider along the hue scale to set the hue value.
   • In the box to the right of the **H** option, enter or select the hue value (0 to 359).

After setting the **H** value, the **S** and **L** color values can be set by clicking a color in the **Color Box**.

e. Select the **S** option, then use one of the following methods to set the saturation value for the new color:
   • Place the slider along the saturation scale to set the saturation value.
   • In the box to the right of the **S** option, enter or select the saturation value (0 to 100).

After setting the **S** value, the **H** and **L** color values can be set by clicking a color in the **Color Box**.

f. Select the **L** option, then use one of the following methods to set the lightness value for the new color:
   • Place the slider along the lightness scale to set the lightness value.
   • In the box to the right of the **L** option, enter or select the lightness value (0 to 100).

After setting the **L** value, the **S** and **H** color values can be set by clicking a color in the **Color Box**.

To select a color on the screen as the new color, click and drag the eye dropper icon to a color on the screen then release the mouse button. The **H**, **S**, and **L** color values are set to match the color selected from the screen.

RGB Color Selection Mode

a. Select the **R** option, then use one of the following methods to set the red value for the new color:
   • Place the slider along the red scale to set the red value.
   • In the box to the right of the **R** option, enter or select the red value (0 to 255).

After setting the **R** value, the **G** and **B** color values can be set by clicking a color in the **Color Box**.

b. Select the **G** option, then use one of the following methods to set the green value for the new color:
   • Place the slider along the green scale to set the green value.
   • In the box to the right of the **G** option, enter or select the green value (0 to 255).

After setting the **G** value, the **R** and **B** color values can be set by clicking a color in the **Color Box**.

c. Select the **B** option, then use one of the following methods to set the blue value for the new color:
   • Place the slider along the blue scale to set the blue value.
   • In the box to the right of the **B** option, enter or select the blue value (0 to 255).

After setting the **B** value, the **R** and **G** color values can be set by clicking a color in the **Color Box**.

To select a color on the screen as the new color, click and drag the eye dropper icon to a color on the screen then release the mouse button. The **R**, **G**, and **B** color values are set to match the color selected from the screen.

11. **Click Ambient** to set the color of the light from other sources that blends with the spot light.

Follow steps 5 and 6 to set the ambient color for the spot light object.

12. **Click Specular** to set the color of light emitted by an object on which the spot light shines.

Follow steps 5 and 6 to set the ambient color for the spot light object.
13. To move the spot light to a new position in the **Viewport**, place the cursor on the spot light object, press the **Ctrl** key, then click and drag the spot light object to a new position.

To precisely position the spot light object, use the settings on the **Transform** tab of the **Object Inspector - Light Object** window.

![Object Inspector - SpotLight - Light Object](image)
Cameras

The point of view for an XPression scene is set by a camera object.

The following topic is discussed in this section:

- Add a Perspective Camera to a Scene
- Add an Orthographic Camera to a Scene
Add a Perspective Camera to a Scene

A perspective camera provides the possibility to view the scene from a different angle.

1. In the Scene Manager window, select the scene or scene group to add a perspective camera object. The selected scene or scene group is displayed in the active Viewport.

2. In the Cameras section of the Object Library window, click the Persp. Camera button. A new perspective camera object is added to the center of the active Viewport.

3. In the Object Inspector - Perspective Camera Object window, click the Camera tab. The Camera tab opens.

4. In the Position section, enter coordinates in the X, Y, and Z boxes to set the position of the perspective camera object in scene.

5. In the Direction section, click one of the following tabs to set the direction of view for the perspective camera object:
   • Direction — set the direction of view by setting the orientation of the perspective camera object.
   • Fixed — set the direction of view by pointing the perspective camera object at a fixed point.
   • Object — set the direction of view by pointing the perspective camera object at an object in the scene.

6. Use the selected Direction tab to set the direction of view for the perspective camera object.

   Direction

   Use the settings in this section to set the direction that the camera observes by orienting the perspective camera object.

   a. In the Tilt box, enter or select the degrees to rotate the perspective camera object upwards or downwards, around the X axis. Positive angles point the perspective camera object view upwards, while negative angles point the perspective camera object view downwards.

   b. In the Pan box, enter or select the degrees to rotate the perspective camera object to the right or left, around the Y axis. Positive angles point the perspective camera object view to the right, while negative angles point the perspective camera object view to the left.
c. In the **Rotate** box, enter or select the degrees to twist the perspective camera object to the right or left, around the Z axis. Positive angles twist the perspective camera object view to the right, while negative angles twist the perspective camera object view to the left.

d. Use the **Rotation Order** list to select the mathematical sequence for the rotation of the object.

**Fixed**

Use the settings in this section to set the fixed point to always face the perspective camera object.

a. In the **X** box, enter or select the X coordinate in pixels of the fixed point to face the perspective camera object.

b. In the **Y** box, enter or select the Y coordinate in pixels of the fixed point to face the perspective camera object.

c. In the **Z** box, enter or select the Z coordinate in pixels of the fixed point to face the perspective camera object.

d. In the **Rotate** box, enter or select the degrees to twist the view of perspective camera object to the right or left, around the Z axis. Positive angles twist the perspective camera object view to the right, while negative angles twist the perspective camera object view to the left.

**Object**

Use this section to select the object to always face the perspective camera object.

a. Use the **Object** list to select the object to face the perspective camera object.

7. In the **Pivot** section, set the pivot point of a perspective camera object.

a. In the **X**, **Y**, and **Z** boxes, enter or select the X, Y, and Z coordinates for the perspective camera object pivot point.

b. Select one of the following:
   - Click the **Center** button to set the pivot point from the center of the X, Y, and Z coordinate.
   - Click the **X** button to pivot from the X axis.
   - Click the **Y** button to pivot from the Y axis.
   - Click the **Z** button to pivot from the Z axis.

8. In the **Lens** section, set the field of view for a perspective camera object.

a. In the **FOV (degr.)** box, enter or select the field of view value in degrees for a perspective camera object. The default value is 45 degrees.

   Click the **Horizontal FOV** button to switch to a horizontal field of vision for the camera object. Vertical field of vision is the default.

b. In the **Aspect** box, enter or select the aspect ratio for the camera. This acts as a multiplier of the current aspect ratio of the project.

c. In the **Near** box, enter or select the distance in pixels from the viewer to the nearest clipping plane. This distance is always positive.

d. In the **Far** box, enter or select the distance in pixels from the viewer to the farthest clipping plane. This distance is always positive.

e. In the **Spherical Distortion** area, select the **Enabled** check box if you want to apply a spherical distortion to the perspective camera object. If applied, configure the following:
   - **K1** — in this box, enter or select a value to create and adjust a barrel-shaped spherical distortion.
   - **K2** — in this box, enter or select a value to create or adjust a pin cushion-shaped spherical distortion.
   - **K3** — in this box, enter or select a value to create or adjust a spherical distortion combining the K1 value in the middle with the K2 value around the edges.
f. In the **CCD Chip Size/Offset** area, configure the following charge-coupled device settings if needed:
   
   - In the **Width** box, enter or select the width in millimeters of the charge-coupled device chip.
   - In the **Height** box, enter or select the height in millimeters of the charge-coupled device chip.
   - In the **H Offset** box, enter or select the horizontal charge-coupled device offset in pixels.
   - In the **V Offset** box, enter or select the vertical charge-coupled device offset in pixels.

   ➤ The CCD size for a perspective camera will be used for calculating the aspect ratio of the camera.

   ➤ When the CCD size is not set, the CCD offset will be in pixels and the 3rd order lens correction parameter will be enabled.

   g. In the **Depth Of Field** area, select the **Enabled** check box if you want to configure a difference in sharpness between the nearest and farthest objects in the scene. If applied, configure the following:
   
   - In the **Focal Distance** box, enter or select a distance value for the focal point for the camera.
   - In the **Focal Width** box, enter or select a width value for the focal point for the camera.
   - In the **Max CoC** box, enter or select an average amount of pixels that are used to defocus for the blur kernel.
   - Select the **Visualize Focal Width** check box to use color to visualize the affected areas of the objects in a scene.

9. In the **Flags** section, select the **Active** check box to activate the selected perspective camera object for a scene and use it to view the scene from the perspective camera on the output.

   The new perspective camera object is set as the active camera object for the scene. Only one camera object can be active in a scene at any time.

   Select the **Show Crosshair** check box to enable a crosshair for better accuracy when setting the CCD offset.

10. In the **Tracking / Global Camera** section:

   a. Use the **Tracking** list to enable or disable the global camera:

   - **Disabled** — select this option to disable the use of the coordinates of the global camera when this camera is active.
   - **Global Tracker** — select this option so that when this camera is active its position is dictated by the coordinates of the global camera.
   - **Video Shader** — select this option to associate the camera tracking data with a video shader using a matching .xpCam file.

   b. Configure the following global camera options:

   - **FOV** — select the check box to use the field of vision of the global camera.
   - **FOV Direction** — select the check box to use the field of vision directional setting of the global camera.
   - **CCD Size** — select the check box to use the charge-coupled device chip settings of the global camera.
   - **CCD Offset** — select the check box to use the charge-coupled device chip offsets of the global camera.
   - **Position** — select the check box to use the positional settings of the global camera.
   - **Direction** — select the check box to use the directional settings of the global camera.
   - **Lens Distortion** — select the check box to use the lens distortion settings of the global camera.
   - **Depth Of Field** — select the check box to use the depth of field settings of the global camera.
11. Double-click the scene containing the perspective camera object.
   The selected scene is sent to the default output, and displayed using the active perspective camera object.

   ![Car scene](image)

   Use the following keyboard and mouse commands to orbit, pan, and zoom the camera in the Main Viewport:
   
   - **ALT + Left Mouse Button** — orbit the camera in the Main Viewport.
   - **ALT + Middle Mouse Button** — pan the camera in the Main Viewport.
   - **Mouse Wheel** — zoom in and zoom out in Main Viewport.

   For More Information on...
   - camera tracking, refer to "Configure Camera Tracking" on page 3–109.
Add an Orthographic Camera to a Scene

The view from an orthographic camera results in a flat display (no perspective) of the scene.

1. In the **Scene Manager** window, select the scene or scene group to add an orthographic camera object. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Cameras** section of the **Object Library** window, click the **Ortho. Camera** button. A new orthographic camera object is added to the center of the active **Viewport**.

3. In the **Object Inspector - Orthographic Camera Object** window, click the **Camera** tab. The **Camera** tab opens.

4. In the **Position** section, enter coordinates in the **X**, **Y**, and **Z** boxes to set the position of the orthographic camera object in scene.

5. In the **Direction** section, click one of the following tabs to set the direction of view for the orthographic camera object:
   - **Direction** — set the direction of view by setting the orientation of the orthographic camera object.
   - **Fixed** — set the direction of view by pointing the orthographic camera object at a fixed point.
   - **Object** — set the direction of view by pointing the orthographic camera object at an object in the scene.

6. Use the selected **Direction** tab to set the direction of view for the orthographic camera object.

   **Direction**
   
   Use the settings in this section to set the direction that the camera observes by orienting the orthographic camera object.

   c. In the **Tilt** box, enter or select the degrees to rotate the orthographic camera object upwards or downwards, around the X axis. Positive angles point the orthographic camera object view upwards, while negative angles point the orthographic camera object view downwards.

   d. In the **Pan** box, enter or select the degrees to rotate the orthographic camera object to the right or left, around the Y axis. Positive angles point the orthographic camera object view to the right, while negative angles point the orthographic camera object view to the left.
e. In the **Rotate** box, enter or select the degrees to twist the orthographic camera object to the right or left, around the Z axis. Positive angles twist the orthographic camera object view to the right, while negative angles twist the orthographic camera object view to the left.

f. Use the **Rotation Order** list to select the mathematical sequence for the rotation of the object.

**Position**

Use the settings in this section to set the position to face the orthographic camera object.

a. In the **X** box, enter or select the X coordinate in pixels of the position to face the orthographic camera object.

b. In the **Y** box, enter or select the Y coordinate in pixels of the position to face the orthographic camera object.

c. In the **Z** box, enter or select the Z coordinate in pixels of the position to face the orthographic camera object.

d. In the **Rotation** box, enter or select the degrees to twist the view of orthographic camera object to the right or left, around the Z axis. Positive angles twist the orthographic camera object view to the right, while negative angles twist the orthographic camera object view to the left.

**Object**

Use this section to select the object to always face the orthographic camera object.

a. Use the **Object** list to select the object to face the orthographic camera object.

7. In the **Flags** section, select the **Active** check box.

The new orthographic camera object is set as the active camera object for the scene. Only one camera object can be active in a scene at any time.

8. Double-click the scene containing the orthographic camera object.

The selected scene is sent to the default output, and displayed using the active orthographic camera object.
Layers

Layers are used to render a group of objects together but separately from other objects or layers. For example, use layers to mask a group of objects without masking other objects or layers.

The following topic is discussed in this section:

- Add a Layer Object to a Scene
- Add a Camera Layer Object to a Scene
Add a Layer Object to a Scene

Layer objects are used to render a group of objects together but separately from other objects or layers.

1. In the Scene Manager window, select the scene or scene group to add a layer object. The selected scene or scene group is displayed in the active Main Viewport.

2. In the Layers section of the Object Library window, click the Layer Object button. A new layer object is added to the scene or scene group in the Object Manager.

3. In the Object Inspector - Layer Object window, click the Rendering tab. The Rendering tab opens.

4. In the Depth Sorting section, set the rendering properties for the layer object by selecting one of the following:
   - **Automatic** — select this radio button to use the Z value to determine the layering.
   - **Manual** — select this radio button to use the order of the objects in the Object Manager to determine the layering.
   - **Back To Front** — select this radio button to use the order of the objects from back to front to determine the layering.
   - **Front To Back** — select this radio button to use the order of the objects from front to back to determine the layering.

   By default, the depth sorting mode of a layer is set to Manual, meaning the order of objects within the Layer Object dictates the rendering order. In Manual mode, objects are drawn in descending order, with the top-most object in the object tree being drawn at the back and the bottom-most object in the tree being drawn in front.

   Switching the depth sorting mode to Automatic means objects will now be rendered based on their position in 3D space.

   *All objects within a layer object must have depth writes enabled.*

5. In the Preview section, select the Render Layer in Preview Only if rendering the layer object on preview only and not on air. This is useful for visually distinguishing multiple scenes that are different but similar in appearance.

6. Add objects to the scene or scene group as needed.

7. In the Object column of the Object Manager window, click and hold the left mouse button on an object to add to the new layer object.

8. Drag the selected object to the new layer object.
9. Release the left mouse button.
   The selected object is added to the new layer object. Objects contained in a layer object are indented and
cconnected to the layer object by a leader line.

10. If the scene uses more than one layer object, you can order the various layer objects using the **Layer Order** tab
    in the **Object Inspector - Layer Object** window.
    a. In the **Object Inspector - Layer Object** window, click the **Layer Order** tab.
       The **Layer Order** tab opens.

       b. Use the up and down arrows to reorganize the layer order.

       The layers listed in the Layer Rendering Order list are arranged from back to front so that they better match
   the ordering when using manual depth sorting.

**For More Information on...**
* creating a scene, refer to the procedure “Create a Scene” on page 5–4.
* creating a scene group, refer to the procedure “Create a Scene Group” on page 5–9.
Add a Camera Layer Object to a Scene

Camera layers are used to view a group of objects together from a different angle but separately from other objects or layers.

1. In the **Scene Manager** window, select the scene or scene group to add a camera layer object.
   The selected scene or scene group is displayed in the active **Main Viewport**.

2. In the **Layers** section of the **Object Library** window, click the **Camera Layer** button.
   A new camera layer object is added to the scene or scene group in the **Object Manager**.

3. In the **Object Inspector - Camera Layer Object** window, click the **Rendering** tab.
   The **Rendering** tab opens.

4. In the **Depth Sorting** section, set the rendering properties for the camera layer by selecting one of the following:
   - **Automatic** — select this radio button to use the Z value to determine the layering.
   - **Manual** — select this radio button to use the order of the objects in the Object Manager to determine the layering.
   - **Back To Front** — select this radio button to use the order of the objects from back to front to determine the layering.
   - **Front To Back** — select this radio button to use the order of the objects from front to back to determine the layering.

5. In the **Default Scene Camera** section, set the camera properties for the camera layer by performing the following:
   - **Mode** — use the menu to select one of the following:
     - **Perspective** — select this to provide the possibility to view the scene from a different angle.
     - **Orthogonal** — select this to view the scene in a flat display (no perspective).
   - **FOV** — in this box, enter or select the field of view value in degrees for the camera layer. The default value is 45 degrees.
   - **Aspect** — in this box, enter or select the aspect ratio for the camera.
   - **Near** — in this box, enter or select the distance in pixels from the viewer to the nearest clipping plane. This distance is always positive.
   - **Far** — in this box, enter or select the distance in pixels from the viewer to the farthest clipping plane. This distance is always positive.

6. Add objects to the scene or scene group as needed.
7. In the **Object** column of the **Object Manager** window, click and hold the left mouse button on an object to add to the new camera layer object.

8. Drag the selected object to the new camera layer object.

9. Release the left mouse button.

   The selected object is added to the new camera layer object. Objects contained in a camera layer object are indented and connected to the camera layer object by a leader line.

   ![Object Manager Window](image)

   The **Right** and **Left Arrow** buttons in the toolbar can also be used to move an object into and out of layers.

**For More Information on...**

- creating a scene, refer to the procedure “**Create a Scene**” on page 5–4.
- creating a scene group, refer to the procedure “**Create a Scene Group**” on page 5–9.
Markers

An event marker object is used to perform an action when the event marker becomes rendered in the scene or is no longer rendered in the scene. It is used to script events or to modify the roll/crawl.

The following topic is discussed in this section:

- Add an Event Marker to a Scene
Add an Event Marker to a Scene

1. In the **Scene Manager** window, select the scene or scene group to add an event marker. The selected scene or scene group is displayed in the active **Viewport**.

2. In the **Markers** section of the **Object Library** window, click the **Event Marker** button. A new event marker object is added to **Object Manager** window as part of the scene displayed in the active **Viewport**.

3. In the **Object Inspector - Event Marker** window, select the **Event Marker** tab. The **Event Marker** tab opens.

4. At the bottom of the **Event Marker** tab, perform one of the following:
   - select the **On Show** tab to configure the settings for the event marker when it is rendered in the scene, or
   - select the **On Hide** tab to configure the settings for the event marker when it is not rendered in the scene.

5. In the **Event Marker** tab, use the **Mode Change** list to select the action of the event marker:
   - **<none>** — select this to assign no mode change to the event marker.
   - **Pause** — select this to assign a pause action to the event marker.
   - **Start** — select this to assign a start action to the event marker.
   - **Take Offline** — select this to take a scene group offline.

6. Select the **Change Speed** check box to adjust the speed of the roll/crawl or event script when the event marker is rendered or no longer rendered in the scene.
   - Use the **Speed** box to enter or select the speed of the roll/crawl or event script.
   - Use the **Inertia** box to enter or select the degree to which the roll/crawl or event script speed change accelerates or decelerates.

7. In the **Delayed Action** section, use the **Delay** box to enter or select an amount of frames to delay the selected mode change.
   - Select the **Resume playing** check box to resume playing the scene or scene group after the selected mode change occurs.
8. If the **Resume playing** check box is selected, the **Change Speed** check box can be selected to change the speed of the roll/crawl or event script after the delayed action.

   Use the **Speed** box to enter or select the speed of the roll/crawl or event script.

   Use the **Inertia** box to enter or select the degree to which the roll/crawl or event script speed change accelerates or decelerates.

9. To move the event marker object to a new position in the **Viewport**, click and drag the event marker object to a new position.

   The settings on the **Transform** tab of the **Object Inspector - Event Marker Object** window can be used to precisely position an event marker object.
Miscellaneous Objects

Miscellaneous object functions can be performed using XPression, such as grouping objects, positioning objects, or publishing template links.

The following topics are discussed in this section:

• Group Scene Objects
• Position an Object
• Publish Template Links
Group Scene Objects

1. In the Scene Manager window, select the scene or scene group to add a group object. The selected scene or scene group is displayed in the active Viewport.

2. In the Misc section of the Object Library window, click the Group button. A new group object is added to Object Manager window as part of the scene displayed in the active Viewport.

3. In the Object column of the Object Manager window, click and hold the left mouse button on an object to add to the new group object.

4. Drag the selected object to the new group object.

5. Release the left mouse button. The selected object is added to the new group object. Objects contained in a group object are indented and connected to the group object by a leader line.

6. To select a group object, click the group object in the Object column of the Object Manager window. The order of objects in a group is changed by clicking and dragging the object to reorder, or using the Arrow buttons in the toolbar to move the object to reorder.

For More Information on...
- positioning group object in a scene, refer to the procedure "Create a Text Object" on page 6–2.
Position an Object

In addition to the Object Inspector Transform tab, the Move Tool and Rotate Tool can be used to position objects.

1. In the Object Manager window, select a group or object group to move or rotate.

2. To move the selected object, click the Move Tool in the Editor window toolbar.
   The Move Tool axis is displayed at the pivot point of the selected group object.

3. Use the Move Tool as follows to move the selected object:
   - Click and drag the Red (X), Green (Y), or Blue (Z) axis displayed at the object pivot point to move the object along the selected axis.
   - Click and drag the Yellow center of the axis displayed at the object pivot point to move the object horizontally and/or vertically in the scene.

4. To rotate the selected object, click the Rotation Tool in the Editor window toolbar.
   The Rotation Tool axis is displayed at the pivot point of the selected object.
5. Use the **Rotate Tool** as follows to move the selected group object:
   - Click and drag the **Red** (X), **Green** (Y), or **Blue** (Z) axis ring displayed at the object pivot point to rotate the object around the selected axis.
   - Click and drag the **Yellow** center of the axis rings displayed at the object pivot point to rotate the object about the scene.

6. To precisely position a group object, use the settings on the **Transform** tab of the **Object Inspector - Group Object** window.

   ![Object Inspector - Group Object](image)

   For More Information on...
   - how to add a group object to a scene, refer to the procedure “**Group Scene Objects**” on page 13–2.
Publish Template Links

1. Add a text, 3D model, primitive, light, camera, event marker, or group object to a scene.
2. Select the new object.
3. In the Object Inspector window, click the Template Links tab.
   The Template Links tab opens.

   The Template Links tab lists the attributes associated with the selected object that can be published to the Template Data section in the Sequencer, where they are used in output mode to replace the template values.

4. In the Template Links section, select the Publish Object check box to publish the selected object.
   The object attribute information available for publishing and automation is listed below the Publish Object check box.
5. Select the check box in the Published column for each object attribute to publish.
   Text objects are published by default. This default can be disabled in the Project Properties.
6. To update Sequencer items with the current value of publishable properties, select one or multiple property types from the list and click the Update Take Item Data button to use the Update Take Item Data dialog box to specify the take items to be updated.
7. If required, use the ↑ and ↓ button in the Published Object Order section to change the position of a selected object in the publishing hierarchy.
   The publishing hierarchy determines the order in which the published parameters are listed in the Take Inspector - Group window. Objects higher in the hierarchy are displayed higher in the list of published parameters.

For More Information on...

- adding a text object to a scene, refer to the procedure “Create a Text Object” on page 6–2.
- adding a 3D model to a scene, refer to the procedure “Import a 3D, FBX, or OBJ Model into a Scene” on page 7–2.
- adding a primitive object (e.g. quad, sphere, etc.) to a scene, refer to the chapter “Primitives” on page 8–1.
- adding a light object to a scene, refer to the chapter “Lights” on page 9–1.
- adding a camera to a scene, refer to the chapter “Cameras” on page 10–1.
- adding an event marker to a scene, refer to the procedure “Add an Event Marker to a Scene” on page 12–2.
- adding a group object to a scene, refer to the procedure “Group Scene Objects” on page 13–2.
- modifying template content for playout, refer to the procedure “Modify Template Content” on page 21–3.
Materials

In XPression, materials are used to define the look and style of objects in a scene.

The following topics are discussed in this section:

• Create a Texture Material
• Create a Video Material
• Create a Server Channel Shader
• Create a Live Source Material
• Create a Low Latency Scaler Live Source Material
• Create a Window Capture Material
Create a Texture Material

1. In XPression, select **Display > Material Manager**.

   The **Material Manager** window opens. To prevent the **Material Manager** window from getting covered by other windows, click the **Pin** button in the window title bar.

2. In the **Material Manager** window, click the **Create New Material** button in the toolbar.

   The **Material Editor** dialog box opens.

3. Enter in the **Name** box a name for the new material.
4. In the **Preview** section, select **Texture** from the **Shader** list.
   A Texture shader is added to the material.

5. In the **Tree View**, select the new **Texture** shader.
   The **Texture File** section opens.

6. Enter in the **Filename** box the full path to the image file to use as a texture, or click **Browse** to use the **Texture Explorer** dialog box to select the image file.
   The **RGB** thumbnail displays the selected image file.

7. Click **OK**.
   The new material is added to the **Material Manager**, and is ready to be applied to text, background, quad, sphere, or cube objects.

   When a texture material is applied to a new quad object, the quad is resized to the texture image of the texture material. When applied to an existing quad, the texture image of the texture material is resized to fit the quad.

   For More Information on...
   - how to apply a material to a text object, refer to the procedure “Apply a Material to a Text Object” on page 6–10.
   - how to apply a material to a quad object, refer to the procedure “Create a Quad Object” on page 8–2.
   - how to apply a material to a sphere object, refer to the procedure “Create a Sphere Object” on page 8–5.
   - how to apply a material to a cube object, refer to the procedure “Create a Cube Object” on page 8–8.
   - how to apply a material to a cylinder object, refer to the procedure “Create a Cylinder Object” on page 8–12.
   - how to apply a material to a torus object, refer to the procedure “Create a Torus Object” on page 8–15.
   - how to apply a material to a slab object, refer to the procedure “Create a Slab Object” on page 8–18.
Create a Video Material

1. In XPression, select Display > Material Manager.
   
The Material Manager window opens. To prevent the Material Manager window from getting covered by other windows, click the Pin button in the window title bar.

2. In the Material Manager window, click the Create New Material button in the toolbar.
   
The Material Editor dialog box opens.

3. Enter in the Name box a name for the new material.
4. In the **Preview** section, select **Video** from the **Shader** list. A Video shader is added to the material.

5. In the **Tree View**, select the new **Video** shader. The **Video** shader sections open.

6. In the **Video** section, enter the full path to the video file in the **Video File** box, or click **Browse (...)** to use the **Open** dialog box to select the video file.

7. In the **DataLinq** box, click **Browse (...)** to use the **Set DataLinq Properties** dialog box to select the DataLinq properties.

8. Use the **Source Mode** list to select the mode used by the video source to define transparency. The available modes are as follows:
   - **Shaped Video Source (premultiplied)** — the video file uses a shaped key, where the key alpha cuts a hole based on the monochrome value of the alpha. Shades of gray are translated into either white or black, giving the key a hard edge.
   - **Unshaped Video Source** — the video file uses an unshaped key, where the key alpha cuts a hole based on the gradient values of the alpha. Shades of gray are translated into transparency levels, giving the key a soft edge.

9. Use the **Field Mode** list to override the field mode of the video file. The options are as follows:
   - `<autodetect>` — interpret the video according to the source video.
   - **Progressive** — interpret the video as progressive scan.
   - **Upper Field First** — interpret the video using upper field first.
   - **Lower Field First** — interpret the video using lower field first.

10. If using Tessera, use the **Tessera Eng ID** list to select a Tessera engine ID that will load the video in the video shader. Use multiple engines by typing in the engine IDs, using a comma to separate each engine ID.

11. Use the **Preview Frame** box to enter or select a frame number from the video to use for generating previews.

12. In the **Run Mode** section, use the **Mode** list to select the play mode for the video file. The available play modes are as follows:
   - **Stopped** — display the first frame in the video file, but do not play the video file.
   - **Play Once** — only play the video file once, then display the last frame in the video file.
   - **Loop** — continuously play the video file from start to finish.
   - **Ping Pong** — continuously play the video file back and forth.

13. Select the **Auto Start** check box to enable the video to start immediately when the scene comes on-air. The start time of the video file may also be controlled from the **Scene Director** by dragging the video material to a **Scene Director** track.
14. Click OK.

The new material is added the Material Manager, and is ready to be applied to text, background, quad, sphere, or cube objects.

When a video material is applied to a new quad object, the quad is resized to the video file played by the video material. When applied to an existing quad, the video file of the video material is resized to fit the quad.

For More Information on...

- how to apply a material to a text object, refer to the procedure “Apply a Material to a Text Object” on page 6–10.
- how to apply a material to a quad object, refer to the procedure “Create a Quad Object” on page 8–2.
- how to apply a material to a sphere object, refer to the procedure “Create a Sphere Object” on page 8–5.
- how to apply a material to a cube object, refer to the procedure “Create a Cube Object” on page 8–8.
- how to apply a material to a cylinder object, refer to the procedure “Create a Cylinder Object” on page 8–12.
- how to apply a material to a torus object, refer to the procedure “Create a Torus Object” on page 8–15.
- how to apply a material to a slab object, refer to the procedure “Create a Slab Object” on page 8–18.
- controlling Scene Director tracks, refer to the procedure “Add Key Frame Animation to an Object” on page 16–5.
Create a Server Channel Shader

1. In XPression, select **Display > Material Manager**.

   The **Material Manager** window opens. To prevent the **Material Manager** window from getting covered by other windows, click the **Pin** button in the window title bar.

2. In the **Material Manager** window, click the **Create New Material** button in the toolbar.

   The **Material Editor** dialog box opens.

3. Enter in the **Name** box a name for the new material.
4. In the **Preview** section, select **Server Channel** from the **Shader** list. A Server Channel shader is added to the material.

5. In the **Tree View**, select the new **Server Channel** shader. The **Server Channel** and **Run Mode** sections open.

6. In the **Server Channel** section, use the **Channel** list to select a server channel for the shader.

7. In the **Resolution** section, use the **Width** and **Height** boxes to enter resolution in pixels for the shader.

8. In the **Run Mode** section, select the **Automatically start server channel when going online** check box to start playing the server channel shader when the take item goes online.

9. Click **OK**. The new material is added the **Material Manager**, and is ready to be applied to text, background, quad, sphere, or cube objects.

When a video material is applied to a new quad object, the quad is resized to the video file played by the video material. When applied to an existing quad, the video file of the video material is resized to fit the quad.

For More Information on...

- how to apply a material to a text object, refer to the procedure “**Apply a Material to a Text Object**” on page 6–10.
- how to apply a material to a quad object, refer to the procedure “**Create a Quad Object**” on page 8–2.
- how to apply a material to a sphere object, refer to the procedure “**Create a Sphere Object**” on page 8–5.
- how to apply a material to a cube object, refer to the procedure “**Create a Cube Object**” on page 8–8.
- how to apply a material to a cylinder object, refer to the procedure “**Create a Cylinder Object**” on page 8–12.
- how to apply a material to a torus object, refer to the procedure “**Create a Torus Object**” on page 8–15.
- how to apply a material to a slab object, refer to the procedure “**Create a Slab Object**” on page 8–18.
- controlling Scene Director tracks, refer to the procedure “**Add Key Frame Animation to an Object**” on page 16–5.
Create a Live Source Material

1. In XPression, select Display > Material Manager.

   The Material Manager window opens. To prevent the Material Manager window from getting covered by other windows, click the Pin button in the window title bar.

2. In the Material Manager window, click the Create New Material button in the toolbar.

   The Material Editor dialog box opens.

3. Enter in the Name box a name for the new material.
4. In the **Preview** section, select **Live Source** from the **Shader** list. A Live Source shader is added to the material.

5. In the **Tree View**, select the new **LiveSource** shader. The **Video** section opens.

6. In the **Video** section, use the **Input Source** list to select the source from which to capture live video.

7. Click **OK**. The new material is added the **Material Manager**, and is ready to be applied to text, background, quad, sphere, or cube objects.

   When a live source material is applied to a new quad object, the quad is resized to the input source streamed by the live source material. When applied to an existing quad, the input source of the live source material is resized to fit the quad.

For More Information on...

- how to apply a material to a text object, refer to the procedure "**Apply a Material to a Text Object**" on page 6–10.
- how to apply a material to a quad object, refer to the procedure "**Create a Quad Object**" on page 8–2.
- how to apply a material to a sphere object, refer to the procedure "**Create a Sphere Object**" on page 8–5.
- how to apply a material to a cube object, refer to the procedure "**Create a Cube Object**" on page 8–8.
- how to apply a material to a cylinder object, refer to the procedure "**Create a Cylinder Object**" on page 8–12.
- how to apply a material to a torus object, refer to the procedure "**Create a Torus Object**" on page 8–15.
- how to apply a material to a slab object, refer to the procedure "**Create a Slab Object**" on page 8–18.
- controlling Scene Director tracks, refer to the procedure "**Add Key Frame Animation to an Object**" on page 16–5.
Create a Low Latency Scaler Live Source Material

• With the on-board scaler enabled in the material, all other live source options are disabled and the material can only be applied to quad and background objects.

• The low latency scaler is only available if the Enable On-Board Compositing check box is selected for the output in the framebuffer hardware setup.

1. Open the Material Manager (Ctrl+M or click the Material Manager tab).
   The Material Manager opens.

2. In the All Materials list, right-click and select New > Live Source.
   The Material Editor opens with a new Live Source material.

3. In the Video section, use the Input Source list to select a video input.

4. Select the On-Board Scaler check box if it is not already selected. It is selected by default. This enables the low latency material scaler.

5. Use the Compositing Order list to select one of the following options:
   • Background — layer the scaled input behind the graphics.
   • Foreground — layer the scaled input over the graphics.
6. Click OK.
   The Material Editor closes.

7. Apply the new material to an object.

For More Information on...
• creating a live source material, refer to “Create a Live Source Material” on page 14–9.
Create a Window Capture Material

* If using Chrome, the Use hardware acceleration when available setting needs to be disabled in order to use the window capture feature.

1. Outside of XPression, open an item to be captured.
   Anything in Windows can be captured using this feature (for example, a web browser, file, etc.).

2. Position the item on the screen so that it and the XPression window are visible at the same time.

3. If using a web browser, navigate to the web site for the window capture material.

4. In XPression, select Display > Material Manager.
   The Material Manager window opens. To prevent the Material Manager window from getting covered by other windows, click the Pin button in the window title bar.
5. In the Material Manager window, click the Create New Material button in the toolbar. The Material Editor dialog box opens.

6. Enter in the Name box a name for the new material.

7. In the Preview section, select Window Capture from the Shader list. A Window Capture shader is added to the material.

8. In the Tree View, select the new Window Capture shader. The Window Capture section opens.

9. On the Preview thumbnail in the Window Capture section, click and hold the left mouse button.
10. Position the mouse pointer over the content of the item to capture for the window capture material.

A red box highlights the selected content.

11. When the required content is highlighted, release the left mouse button.

A snapshot of the selected content is displayed in the Preview thumbnail.

For objects that use the window capture material to display the selected content, the item containing the selected content must remain open while the objects are online. Closing the item removes the content from the online objects. Also, to not compromise the output, ensure that no other window covers the captured window.

12. Select the Capture Mouse Pointer check box to display the mouse pointer along with the content from the captured window.

13. Select the Disable Warning When Loading Shader check box to hide the Warning dialog box when loading the Window Capture shader.

14. Click OK.

The new material is added the Material Manager, and is ready to be applied to text, background, quad, sphere, or cube objects.

When a window capture material is applied to a new quad object, the quad is resized to the window captured by the window capture material. When applied to an existing quad, the captured window of the window capture material is resized to fit the quad.

For More Information on...

- how to apply a material to a text object, refer to the procedure “Apply a Material to a Text Object” on page 6–10.
- how to apply a material to a quad object, refer to the procedure “Create a Quad Object” on page 8–2.
- how to apply a material to a sphere object, refer to the procedure “Create a Sphere Object” on page 8–5.
- how to apply a material to a cube object, refer to the procedure “Create a Cube Object” on page 8–8.
- how to apply a material to a cylinder object, refer to the procedure “Create a Cylinder Object” on page 8–12.
- how to apply a material to a torus object, refer to the procedure “Create a Torus Object” on page 8–15.
- how to apply a material to a slab object, refer to the procedure “Create a Slab Object” on page 8–18.
- controlling Scene Director tracks, refer to the procedure “Add Key Frame Animation to an Object” on page 16–5.
Fonts

In XPression, fonts are used to define the look and style of text objects in a scene.

The following topics are discussed in this section:

- Add a Private Font to a Project
- Apply a Material to a Font
Add a Private Font to a Project

The fonts installed in the Windows system font directory are available to all XPression projects. Private fonts are kept in a Fonts folder within an XPression project folder, and are only available to that project.

Private fonts can be added using the Font Manager or the Scene Fonts Tab in the Object Inspector:

- Add a Private Font Using the Font Manager
- Add a Private Font Using the Scene Fonts Tab

Add a Private Font Using the Font Manager

1. In XPression, click the Explorer button to open the project folder.
2. In the project folder, create a new folder named Fonts or, if a project is already loaded, a font folder will exist in the folder structure.
3. For each private font to add to the project, copy the associated True Type Font file into the Fonts folder.
4. In the Scene Manager window, select a scene or scene group that contains a text object.
5. Select Display > Font Manager.

The Font Manager window opens. To prevent the Font Manager window from getting covered by other windows, click the Pin button in the window title bar.

6. Right-click inside the Fonts list and select New Font from the shortcut menu.

A new font is added to the list.
7. Right-click the new font and select **Rename** from the shortcut menu.

8. Enter a name for the new font.

9. Right-click the font and select **Edit** from the shortcut menu.
The Font Editor opens.

10. In the Font Settings section, select the Face check box.

The Font Face tab opens.

11. Use the Face list to select a private font face, indicated by the (private) tag following the font face name, for the new font.

The new font is ready to be applied to text objects.

For More Information on...
• how to apply a font to a text object, refer to the procedure “Create a Text Object” on page 6–2.

Add a Private Font Using the Scene Fonts Tab

1. In XPression, click the Explorer button to open the project folder.
2. In the project folder, create a new folder named Fonts.
3. For each private font to add to the project, copy the associated True Type Font file into the new Fonts folder.

4. In the Scene Manager window, select a scene or scene group that contains a text object.

   ![Scene Manager](image)

   The objects contained in the selected scene or scene group are listed in the Object Manager.

5. In the Object Manager window, select a text object.

   ![Object Manager](image)

6. In the Object Inspector - Text Object window, click the Scene Fonts tab.

   The Scene Fonts tab opens.

   ![Object Inspector - Text Object](image)
7. In the Fonts section, click New.
   A new font is added to the Stock list.

8. Right-click the new font and select Rename from the shortcut menu.

9. Enter a name for the new font.
10. Select the Face check box.
    The Font Face tab opens.

11. Use the Face list to select a private font face, indicated by the (private) tag following the font face name, for the new font.
    The new font is ready to be applied to text objects.

For More Information on...
• how to apply a font to a text object, refer to the procedure “Create a Text Object” on page 6–2.
Apply a Material to a Font

1. In the **Scene Manager** window, select a scene or scene group that contains a text object.

2. In the **Object Manager**, select a text object.

3. Select a font using the **Scene Fonts** tab or the **Font Manager** window:
   - **Scene Fonts**
     - In the **Object Inspector - Text Object** window, click the **Scene Fonts** tab.
     - The **Scene Fonts** tab opens.
b. In the **Used** or **Stock** list, select the font to apply a material.

![Font Manager window](image)

b. In the **Used** or **Stock** list, select the font to apply a material.

![Font Manager window](image)

**c. Select a font attribute to apply a material. Font attributes are as follows:**

<table>
<thead>
<tr>
<th>2D Fonts</th>
<th>3D fonts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face</td>
<td>Face</td>
</tr>
<tr>
<td>Border</td>
<td>Bevel</td>
</tr>
<tr>
<td>Stroke</td>
<td>Extrusion</td>
</tr>
<tr>
<td>Neon</td>
<td>Back Bevel</td>
</tr>
<tr>
<td>Shadow</td>
<td>Back Face</td>
</tr>
</tbody>
</table>

**Font Manager**

In the **Font Manager** window, double-click a font for the text object from the **Fonts** list.

The selected font is applied to the text object and is highlighted green in the **Fonts** list.

a. **Select Display > Font Manager.**

The **Font Manager** window opens. To prevent the **Font Manager** window from getting covered by other windows, click the **Pin** button in the window title bar.
b. Right-click the font and select **Edit** from the shortcut menu.

The **Font Editor** opens.
c. Select a font attribute to apply a material. Font attributes are as follows:

<table>
<thead>
<tr>
<th>2D Fonts</th>
<th>3D fonts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Face</td>
<td>Face</td>
</tr>
<tr>
<td>Border</td>
<td>Bevel</td>
</tr>
<tr>
<td>Stroke</td>
<td>Extrusion</td>
</tr>
<tr>
<td>Neon</td>
<td>Back Bevel</td>
</tr>
<tr>
<td>Shadow</td>
<td>Back Face</td>
</tr>
</tbody>
</table>

4. Click Edit Material.
   The Material Editor dialog box opens.

5. Use the Material Editor to edit the material of the selected font attribute.

6. Click OK.
   The edited material is applied to the font attribute to change the style of the selected font. Materials applied to fonts in this manner are not displayed in the Material Editor.

   All of the text objects in the project that were created with the edited font are changed to match the new style of the font.

For More Information on...
- how to create a 2D texture material to a scene, refer to the procedure “Create a Texture Material” on page 14–2.
- how to create a video material, refer to the procedure “Create a Video Material” on page 14–4.
- how to create a live source material, refer to the procedure “Create a Live Source Material” on page 14–9.
- how to create a window capture material, refer to the procedure “Create a Window Capture Material” on page 14–13.
Animations

Continuous animation and keyframe animation are the methods used in XPression to add movement to objects in a scene.

The following topics are discussed in this section:

• Add Continuous Animation to an Object
• Add Key Frame Animation to an Object
• Move Key Frames in Animation Controller Timeline
• Trigger Clips and Audio
• Create Animation with Multiple Controllers
• Copy Keyframes to Animate an Object
• Copy and Paste Animation Controllers
• Scale an Active Animation Controller
Add Continuous Animation to an Object

1. In the **Scene Manager** window, select a scene or scene group that contains an object to animate.

![Scene Manager](image)

   The objects contained in the selected scene or scene group are listed in the **Object Manager**.

2. In the **Object Manager** window, select an object to animate.

![Object Manager](image)

3. Click the **Continuous Anim** tab in the **Object Inspector** window.

   ![Object Inspector](image)

   The **Continuous Anim** tab opens.

4. Click **New Track**.

   A new continuous animation track is added to the **Tracks** table.

![Tracks Table](image)
5. In the **Waveform** column, use the list to select the continuous animation movement for the object. The available movement options are as follows:

- Sine — ![Sine Waveform]
- Cosine — ![Cosine Waveform]
- Triangle — ![Triangle Waveform]
- Square — ![Square Waveform]
- Sawtooth — ![Sawtooth Waveform]
- Random — ![Random Waveform]

The selected wave form is displayed in the **Graph** column.

6. In the **Mode** column, use the list to select the mode used to continue the animation when it reaches the set **Amplitude** value. The available modes are as follows:

- **Symmetric** — the amplitude value is copied after reaching the set value end.
- **Asymmetric** — the animation flips over to the starting position after reaching the set amplitude value.

7. In the **Channel** column, use the list to select the channel to animate. The available channels are as follows:

- **Position X** — move the object along the X axis.
- **Position Y** — move the object along the Y axis.
- **Position Z** — move the object along the Z axis.
- **Rotation X** — rotate the object around the X axis.
- **Rotation Y** — rotate the object around the Y axis.
- **Rotation Z** — rotate the object around the Z axis.
- **Scaling X** — scale the object along the X axis.
- **Scaling Y** — scale the object along the Y axis.
- **Scaling Z** — scale the object along the Z axis.
- **Pivot X** — pivot the object along the X axis.
- **Pivot Y** — pivot the object along the Y axis.
- **Pivot Z** — pivot the object along the Z axis.
- **Alpha** — fade the alpha channel of the object in and out. The key fades translucency until it disappears.

8. In the **Amplitude** column, use the box to enter or select the degree of movement for an object.

For example, a value of 180 set for **Rotation Z** rotates an object 180 degrees around the Z axis.

9. In the **Amp Offset** column, use the box to enter or select the vertical starting point for the **Amplitude** setting.

10. In the **Phase Offset** column, use the box to enter or select the horizontal starting point for the **Amplitude** setting.

11. In the **Cycle** column, use the box to enter or select the speed of the animation cycle.

12. In the **Pause** column, use the box to enter or select the amount of frames to pause before the next animation cycle.

13. In the **Sync** column, use the list to select the method used to start a continuous animation track. The available options are as follows:

- **Reset** — start a continuous animation track at the starting point of the animation.
- **Clock** — base the start of a continuous animation track on the clock. Select this method to synchronize a continuous animation track with previous animations.

14. In the **Enabled** column, select the check box to enable the continuous animation track. Clear this check box to turn off the continuous animation track.

15. To add additional continuous animation tracks to an object, repeat steps 4 to 14.

You can also right-click and copy the continuous animation track of an object and paste it in the **Tracks** section of the **Continuous Anim** tab for another object.
16. Double-click the scene containing the animated object.

   The selected scene is sent to the default output and the object continuous animation tracks start running to animate object. To preview continuous animations in the active Viewport, click the Show or Hide Continuous Animations and Other Effects button in the Viewport toolbar.
Add Key Frame Animation to an Object

1. In the **Scene Manager** window, select a scene or scene group that contains an object to animate.

   ![Scene Manager Window]

   The objects contained in the selected scene or scene group are listed in the **Object Manager** window.

2. In XPression, select **Animation > Scene Director**.

   The **Scene Director** window opens with a default animation controller added for **Track 1**.

   Multiple scene directors can be added to a scene and managed using the **Scene Directors** window.

3. Click and hold on the animation controller and move it to the position to start at in the **Timeline**.

   ![Ticking Scene Director]

4. In the **Animation Controller** window at the bottom of the **Editor**, use the list at the bottom right of the window to select the animation controller for animating objects in the current scene.

5. Use the **Total Range** box to enter or select the number of key frames in the animation.

6. In the **Working Range Start** box, enter or select the key frame for the start of the key frame scale.

7. In the **Working Range End** box, enter or select the key frame for the end of the key frame scale.
8. In active **Viewport**, position the object to animate at the start position of the animation.

9. Press the **Ctrl** and **K** key at the same time.
   The **Set Keyframe** dialog box opens.

   ![Set Keyframe dialog box](image.png)

   The attributes highlighted in green (Position, Rotation, and Scale) are captured. Red highlighted attributes (Alpha) are not captured.

10. In the **Set Key at Time** box to enter or select the key frame for the start position of the animation.

11. Click **Set & Close**.
    The set key frame is marked by a vertical line on the **Key Frame Scale** in the **Animation** window and in the active animation controller.

12. In active **Viewport**, position the object to animate at the next position in the animation.

13. Press the **Ctrl** and **K** key at the same time.
    The **Set Keyframe** dialog box opens.

14. In the **Set Key at Time** box to enter or select the key frame for the next position in the animation.

15. Click **Set & Close**.
    The set key frame is marked by a vertical line on the **Key Frame Scale** in the **Animation** window.

16. To add object position to the animation, repeat steps 12 to 15.

17. Double-click the scene containing the animated object.
    The selected scene is sent to the default output.

18. Click the **Play** button.
    The defined animation starts playing in the default output.
Move Key Frames in Animation Controller Timeline

Once key frames have been set, they can be moved directly from within the timeline of the animation controller.

1. In the **Scene Manager** window, select a scene or scene group that contains object animation that uses key frames.

   ![Scene Manager](image)

   The objects contained in the selected scene or scene group are listed in the **Object Manager** window.

2. In the **Animation Controller** window at the bottom of the **Editor**, use the list at the bottom right of the window to select the animation controller that contains the key frames to be moved.

   The selected animation controller opens in the **Animation Controller** window.

3. Click and drag the playout slider onto the vertical yellow key frame marker that is to be moved.

4. Right-click on the playout slider and select **Move Keys** from the shortcut menu.

   The **Move Key Frames** dialog box opens.

5. In the **Selected Objects** section, select the check box of the animated objects from the scene for which the key frame is to be moved.
6. In the **New Position** section, use the **Target** box to enter or select the frame number within the timeline to which the key frame is to be moved.

![New Position section](image)

7. Click **OK**.

The **Move Key Frames** dialog box closes and the vertical yellow key frame marker is moved to the selected frame number in the timeline.

![Move Key Frames dialog box](image)

**For More Information on...**

- adding key frame animation to an object, refer to “**Add Key Frame Animation to an Object**” on page 16–5.
Trigger Clips and Audio

1. In the **Scene Manager** window, select a scene or scene group that contains an object to animate.

The objects contained in the selected scene or scene group are listed in the **Object Manager** window.

2. In XPression, select **Animation > Scene Director**.

The **Scene Director** window opens.

* Multiple scene directors can be added to a scene and managed using the **Scene Directors** window.

3. In the **Editor**, select **Display > Audio Files**.

The **Audio Files** window opens.

4. In **Audio Files** window, right-click and select **Import File** from the shortcut menu.

The **Open** dialog box opens.

5. In the **Open** dialog box, locate and select one or multiple Waveform Audio File Format (.WAV) audio file to import into the project.
6. Click Open.
   The selected .WAV audio file is added the Audio Files window.

7. Drag the .WAV audio file from the Audio Files window onto an audio track in the Scene Director.

8. In the Scene Director, click and drag the audio track into the required position.

9. Right-click the audio track and select Properties from the shortcut menu.
   The Audio Channel Mapping dialog box opens.
10. Select the crosspoints for the Source Channels and Destination Channels as necessary.

[*] The AJA input framebuffer supports up to eight channels of embedded audio.

[*] If using four fill outputs on a Matrox card, the AES outputs can provide eight AES channels per output:

› 2 Fill/Key Outputs
   The AES outputs will be mapped as follows:
   › Output 1: AES Output A 1-16
   › Output 2: AES Output B 1-16

› 1 Fill/Key + 2 Fill Outputs
   The AES outputs will be mapped as follows:
   › Output 1 Fill/Key: AES Output A 1-16
   › Output 2 Fill: AES Output B 1-8
   › Output 3 Fill: AES Output B 9-16

› 4 Fill Outputs
   The AES outputs will be mapped as follows:
   › Output 1: AES Output A 1-8
   › Output 2: AES Output B 1-8
   › Output 3: AES Output A 9-16
   › Output 4: AES Output B 9-16

   Click Default to return the audio mapping to its default state.

11. Click OK.
   The Audio Channel Mapping dialog box closes.

12. Click the Play button.
   The defined animation starts playing in the default output.

[*] Audio files can be replaced by right-clicking on the file in the Audio Files window and selecting Replace File.
   Replacing an audio file removes the previous audio file from any Scene Director that uses that file and replaces it with the newly selected file.

For More Information on...
• creating a keyframe animation for an object, refer to the procedure “Add Key Frame Animation to an Object” on page 16–5.
Create Animation with Multiple Controllers

1. In the **Scene Manager** window, select a scene or scene group that contains two or more objects to animate.

   ![Scene Manager Window]

   The objects contained in the selected scene or scene group are listed in the **Object Manager** window.

2. In XPression, select **Animation > Scene Director**.

   The **Scene Director** window opens with a default animation controller added for **Track 1**.

   Multiple scene directors can be added to a scene and managed using the **Scene Directors** window.

3. Select an object to animate.

4. Use the animation controller to animate the selected object in the current scene.

5. Select a second object to animate.

6. In the **Scene Director**, right-click in an empty track and select **Add Clip > Animation Controller** from the shortcut menu to add an animation controller to the selected track.
An animation controller is added the selected track.

7. Use the new animation controller to animate the selected object in the current scene.
8. In the two tracks, click and drag the animation controllers to set the relative timing for the associated objects. Both objects move at the same time where the two animation controllers overlap on the timeline.
9. Click the Play button. The defined animations start playing in the default output.

For More Information on...
- creating a keyframe animation for an object, refer to the procedure “Add Key Frame Animation to an Object” on page 16–5.
Copy Keyframes to Animate an Object

1. In the **Scene Manager** window, select a scene or scene group that contains two or more objects to animate.

   The objects contained in the selected scene or scene group are listed in the **Object Manager**.

2. In XPression, select **Animation > Scene Director**.

   The **Scene Director** window opens.

   ![Scene Director Window](image)

   Multiple scene directors can be added to a scene and managed using the **Scene Directors** window.

3. Select an object to animate.

4. In the **Scene Director**, right-click in an empty track and select **Add Clip > Animation Controller** from the shortcut menu to add an animation controller to the selected track.

   ![Animation Controller](image)

5. Select the new animation controller.

6. Create a keyframe based animation for selected object.
7. In the **Editor**, select **Animation > Key Graph Editor**. The **Key Graph Editor** window opens.

![Key Graph Editor Window]

8. In the **Objects** list, double-click the name of the object displayed in **bold** face type. The selected object is added to the **Channels** list.

![Channels List]

9. If required, expand the object added to the **Channels** list. The object channels are displayed below the expanded object.

10. Select one or more of the object channels displayed in **bold** face type. Only the object channels displayed in **bold** face type can be copied to another object.
11. On the selected object channels, right-click and select **Copy** from the shortcut menu. The values of the selected channels are copied for each keyframe of the select object.

12. Collapse the object in the **Channels** list.

13. In the **Objects** list, double-click the object to which to copy the keyframes and object channels. The selected object is added to the **Channels** list.
14. In the **Channels** list, right-click the new object and select **Paste** from the shortcut menu.

The copied keyframes and object channel values are pasted into the selected object. The updated object channels are displayed in **bold** face type.

15. If required, edit the keyframes copied to the object.
   a. In the **Channels** list, select the channel to edit for an object.
      
      The **Graph** displays the keyframes for the selected object channel. Each white square in the **Graph** represents a keyframe.
   b. In the **Graph**, select the keyframe to edit.
   c. To move the selected keyframe vertically in the **Graph**, hold down the **CTRL** key then click and drag the keyframe up or down. To move the selected keyframe horizontally in the **Graph**, hold down the **CTRL + Shift** keys then click and drag the keyframe to the right or left.
   d. Use the displayed properties to set the required values for the selected keyframe.
      
      The properties of the selected keyframe are displayed below the **Graph**.
   e. For each keyframe that requires editing, repeat steps b and d.

16. Close the **Key Graph Editor** window.

17. Click the **Play** button.
      
      The edited animation starts playing in the default output.

For More Information on...
   • creating a keyframe animation for an object, refer to the procedure **“Add Key Frame Animation to an Object”** on page 16–5.
Copy and Paste Animation Controllers

Animation Controllers can be copied and pasted to the same track in a scene, a different track in the scene, and a different scene altogether. This allows you to quickly and easily apply keyframe animations to other objects within a scene or in a different scene.

1. In XPression, open a project and select a scene that contains keyframe animations.
2. Select Animation > Scene Director.
   The Scene Director window opens.

3. Right-click on the Animation Controller and select Copy.

4. Right-click inside a track in the Scene Director and select Paste.
   The copied animation controller can be pasted onto the same track or a new track in the same scene, or onto tracks in the Scene Director from another scene.
The **Paste Animation Controller** dialog box opens.

![Paste Animation Controller dialog box](image)

5. Do one of the following, if necessary:
   - in the **Destination Object** column, click on individual objects whose name includes a numeric (for example, PerspCamera1) to open a dropdown menu and select a different object increment (for example, PerspCamera2).
   - click the **Increment Destination** button to select the next increment for objects in the Destination Object list.

6. **Click OK.**

   The **Paste Animation Controller** dialog box closes and the copied animation controller is pasted onto the track in the Scene Director.

   The name of the pasted controller will be based on the name of the copied animation controller.

![Scene Director](image)

**For More Information on...**

- creating a keyframe animation for an object, refer to the procedure "**Add Key Frame Animation to an Object**" on page 16–5.
Scale an Active Animation Controller

Active animation controllers can be scaled and the key frame animation will adjust proportionately.

1. In the Animation Controller window at the bottom of the Editor, use the list at the bottom right of the window to select the animation controller to scale.

   The selected animation controller opens in the Animation Controller window.

2. Right-click on the playout slider and select Scale Time.

   The Scale Animation Controller Time dialog box opens.

3. In the New Duration section of the Scale Animation Controller Time dialog box, use one of the following three settings to configure a scaled animation controller:
   - Use the Frames box to enter or select a new duration in frames for the animation controller.
   - Use the Seconds box to enter or select a new duration in seconds for the animation controller.
   - Use the Percent box to enter or select a duration percentage in relation to the original duration.

   Adjusting any one of the three duration settings will automatically adjust the other two settings accordingly.

4. Click OK.

   The animation controller is scaled and the key frame animations are adjusted proportionally within the animation controller timeline.

For More Information on...

- creating a keyframe animation for an object, refer to the procedure “Add Key Frame Animation to an Object” on page 16–5.
Stagger Animations

Stagger animations are used in XPression to add character effects to text objects and to animate group objects in a scene.

The following topic is discussed in this section:

• Add Stagger Animation to a Text or Group Object
Add Stagger Animation to a Text or Group Object

1. In the **Scene Manager** window, select a scene or scene group that contains a text or group object to animate.

   The text or group object contained in the selected scene or scene group are listed in the **Object Manager**.

2. In the **Object Manager** window, select the text or group object to animate.

3. Use the **Display** menu to select **Stagger Animations**.

   The **Stagger Animations** window opens.
4. Click New.

The **Edit Stagger Animation** dialog box opens.

5. In the **Name** box, enter a name for the stagger animation.

6. In the **Description** box, enter a brief description to describe the stagger animation.

7. In the **Tracks** section, right-click and use the shortcut list to select a track, or tracks, to add an animation. The available tracks are as follows:
   - **Position.X** — move the object along the X axis.
   - **Position.Y** — move the object along the Y axis.
   - **Position.Z** — move the object along the Z axis.
   - **Rotation.X** — rotate the object around the X axis.
   - **Rotation.Y** — rotate the object around the Y axis.
   - **Rotation.Z** — rotate the object around the Z axis.
   - **Scale.X** — scale the object along the X axis.
   - **Scale.Y** — scale the object along the Y axis.
   - **Scale.Z** — scale the object along the Z axis.
   - **Alpha** — fade the alpha channel of the object in and out. The key fades translucency until it disappears.

   Right-click a track in the timeline and select **Set Length** to open the **Edit Clip Length** dialog box to edit the frame length of the clip if necessary.

8. In the **Track Animation** section, click the **Insert Keyframe** button to insert a keyframe at the timeframe marker.

9. In the **Track Animation** graph, click a keyframe to select it.

   A keyframe can also be selected by clicking and holding the left mouse button inside the **Track Animation** graph and dragging the mouse so that a dashed rectangle highlight surrounds the keyframe. Release the left mouse button to select the keyframe.

   Keyframes can be deleted from the Track Animation Graph by right-clicking on the selected keyframe and selecting **Delete** from the shortcut menu.
10. Once a keyframe is selected, use the **Key Value** box to enter or select a keyframe value.

    The selected keyframe can also be moved vertically in the **Track Animation** graph by holding down the **Ctrl** key then clicking and dragging the keyframe up or down. To move the selected keyframe horizontally in the **Track Animation** graph, hold down the **Ctrl + Shift** keys and then click and drag the keyframe to the right or left.

11. In the **Total Duration** section, use the **Frames** box to enter or select the length in frames for the stagger animation.

12. Use the **Timing Offsets** section to offset stagger animations.

    a. Use the **Character** box to enter or select a value to offset the characters of a text object to the overall framerate of the stagger animation.

    b. Use the **Word** box to enter or select a value to offset the words of a text object to the overall framerate of the stagger animation.

    c. Use the **Line** box to enter or select a value to offset the lines of a text object to the overall framerate of the stagger animation.

    d. Use the **Paragraph** box to enter or select a value to offset the paragraphs of a text object to the overall framerate of the stagger animation.

13. In the **Pivots** section, use the **Mode** list to select a method to pivot an object. The following options are available:

    - **Baseline Center** — pivots objects from the base of the object.
    - **Center** — pivots objects from the center of the object.
    - **Origin** — pivots objects from the center of the whole of the objects.

14. Click **OK**.

    The new stagger animation appears in the list in the **Stagger Animations** window.

15. Click and drag the stagger animation into the **Timeline** area for the text or group object in the **Scene Director**.

    The stagger animation appears in the timeline of the text or group object.

    ∗ The stagger animation can be copied and pasted to another text or group object in the Scene Director by using **Ctrl-C / Ctrl-V** or by right-clicking and using the **Copy** and **Paste** functions from the shortcut menu.

16. Click the **Play** button.

    The defined stagger animation starts playing in the default output.
Widgets

XPression widgets are used to generate clocks, timers, and counters for scenes.

The following topics are discussed in this section:

- Add a Realtime Clock Display to a Scene
- Customize the Time Format of a Widget
- Rename a Widget
- Add a Timer Display to a Scene
- Add a Counter Display to a Scene
- Customize the Counter Format of a Widget
- Add a Text List to a Scene
Add a Realtime Clock Display to a Scene

Use this widget to use a clock to display a time of day.

1. In XPression, use the Display menu to select Widgets.
   The Widgets window opens.

2. In the Widgets window, select New Widget > Clock Timer.
   A realtime clock widget is added to the Widgets window.

3. Add a text object to a scene.
4. In the Object Manager window, select the text object for the realtime clock widget.

5. Click the Data Source tab in the Object Inspector - Text Object window.
   The Data Source tab opens.

6. Select the Widget option.
   A Widget list is displayed below the options.
7. Use the Widget list to select a realtime clock widget, for example ClockTimer1. Since widget names can be modified, the names of realtime clock widgets vary between XPression systems.

A Warning dialog box opens.

8. Click Yes.

The text in the selected text object is replaced with the time of day generated by the selected realtime clock widget.

9. Double-click the scene containing the text object linked to the realtime clock widget.

The selected scene is sent to the default output, and the clock in linked text object starts running.

For More Information on...

• adding a text object to a scene, refer to the procedure “Create a Text Object” on page 6–2.
• customizing the time displayed by a widget, refer to the procedure “Customize the Time Format of a Widget” on page 18–4.
Customize the Time Format of a Widget

1. In a scene, select a text object that is associated with a realtime clock widget.
2. Click the **Data Source** tab in the **Object Inspector - Text Object** window.
   The **Data Source** tab opens.

3. In the **Select Data Source** section, note the name of the widget associated with the selected text object.
4. From the **Display** menu, select **Widgets**.
   The **Widgets** window opens.

5. In the **Widgets** window, right-click the widget associated with the selected text object.
   The shortcut menu opens.

6. Select **Properties** from the shortcut menu.
   The **Widget Properties (Realtime Clock, Timer)** dialog box opens
7. In the Format list, select or type the time format in which to display the current time and/or date. The available time formats are as follows:
   • HH:NN — 16:35
   • HH:NN:SS — 16:35:40
   • HH:NN:SS.ZZZ — 16:35:40.765
   • HH:NN AM/PM — 04:35 PM
   • HH:NN:SS AM/PM — 04:35:40 PM
   • HH:NN:SS.ZZZ AM/PM — 04:35:40.765 PM
   • DD-MM-YY — 27-11-09
   • DD-MM-YY HH:NN — 27-11-09 16:35
   • DD-MM-YY HH:NN:SS — 27-11-09 16:35:40
   • DD/MM/YY — 11/27/09
   • DD/MM/YY HH:NN — 11/27/09 16:35
   • DD/MM/YY HH:NN:SS — 11/27/09 16:35:40

The characters used to separate the date and time strings can be changed for each time format.

8. Use the Date Sep list to select the character displayed between the elements of a date string.

9. Use the Time Sep list to select the character displayed between the elements of a time string.

10. Use the Source list to select the timecode source for the realtime clock widget.
    This menu is populated with the internal clock of the XPression system and the timecode sources that have been configured in the Timecode Sources tab of the Hardware Setup dialog box.

11. In the Time Offset section, use the Hours box to enter or select the number of hours to offset the time displayed by a widget from the current local time.

12. In the Mins box, enter or select the number of minutes to offset the time displayed by a widget from the current local time.

13. In the Secs box, enter or select the number of seconds to offset the time displayed by a widget from the current local time.

14. In the MS box, enter or select the number of milliseconds to offset the time displayed by a widget from the current local time.

15. Click OK.
    The new settings are saved, and the Widget Properties dialog box closes.

16. Double-click the scene containing the text object linked to the realtime clock widget.
    The selected scene is sent to the default output, and the customized clock in the liked text object starts running.
Rename a Widget

1. From the Display menu, select Widgets.
   The Widgets window opens.

2. In the Widgets window, right-click the widget to rename.
   The shortcut menu opens.

3. Select Rename from the shortcut menu.
   The Rename Widget dialog box opens.

4. In the Name box, enter a new name for the selected widget.

5. Click OK.
   The selected widget is updated with the new name.
Add a Timer Display to a Scene

Use this widget to use a timer to count time up or down.

1. In XPression, use the Display menu to select Widgets.
   The Widgets window opens.

2. In the Widgets window, select New Widget > Clock Timer.
   A clock timer widget is added to the Widgets window.

3. In the Widgets window, right-click the widget associated with the selected text object.
   The shortcut menu opens.

4. Select Properties from the shortcut menu.
   The Widget Properties (Realtime Clock, Timer) dialog box opens
5. Use the **Mode** list to select **Timer**.
   
   The **Widget Properties** dialog box displays the settings for a timer.

6. In the **Start At** box, enter the hours, minutes, seconds, and hundredths of seconds of the time from which to start the timer.

7. In the **Stop At** box, enter the hours, minutes, seconds, and hundredths of seconds of the time at which to stop the timer.

8. Use the **Direction** list to select the timer direction. The available directions are as follows:
   - **Up** — increase the time value from the time set in the Start At box until the timer is stopped.
   - **Down** — decrease the time value from the time set in the Start At box until the timer is stopped.

9. In the **Format** list, select or type the time format used by the widget to display the current time value. The available time formats are as follows:
   - **S** — 16545
   - **SSS** — 16545
   - **S.ZZZ** — 16545.765
   - **SSS.ZZZ** — 16545.765
   - **HH:NN** — 04:35
   - **HH:NN:SS** — 04:35:40
   - **HH:NN:SS.ZZZ** — 04:35:40.765
   - **NN:SS** — 35:40
   - **NN:SS.ZZZ** — 35:40.765

10. Use the **Start** list to select the method used to start the timer. The available methods are as follows:
    - **Manual** — in the Widget window, click the Start button associated with the timer widget to start the timer.
    - **When Online** — start the timer when the scene goes online.
    - **Ctrl + 1** — press the Ctrl and 1 key at the same time to start the timer.
    - **Ctrl + 2** — press the Ctrl and 2 key at the same time to start the timer.
    - **Ctrl + 3** — press the Ctrl and 3 key at the same time to start the timer.
    - **Ctrl + 4** — press the Ctrl and 4 key at the same time to start the timer.
    - **Ctrl + 5** — press the Ctrl and 5 key at the same time to start the timer.
    - **Ctrl + 6** — press the Ctrl and 6 key at the same time to start the timer.
    - **Ctrl + 7** — press the Ctrl and 7 key at the same time to start the timer.
    - **Ctrl + 8** — press the Ctrl and 8 key at the same time to start the timer.
    - **Ctrl + 9** — press the Ctrl and 9 key at the same time to start the timer.
11. Use the Stop list to select the method used to stop the timer. The available methods are as follows:

- **Manual** — in the Widget window, click the Stop button associated with the timer widget to stop the timer.
- **When Offline** — stop the timer when the scene goes offline.
- **Ctrl + 1** — press the Ctrl and 1 key at the same time to stop the timer.
- **Ctrl + 2** — press the Ctrl and 2 key at the same time to stop the timer.
- **Ctrl + 3** — press the Ctrl and 3 key at the same time to stop the timer.
- **Ctrl + 4** — press the Ctrl and 4 key at the same time to stop the timer.
- **Ctrl + 5** — press the Ctrl and 5 key at the same time to stop the timer.
- **Ctrl + 6** — press the Ctrl and 6 key at the same time to stop the timer.
- **Ctrl + 7** — press the Ctrl and 7 key at the same time to stop the timer.
- **Ctrl + 8** — press the Ctrl and 8 key at the same time to stop the timer.
- **Ctrl + 9** — press the Ctrl and 9 key at the same time to stop the timer.

12. Use the Reset list to select the method used to reset the timer. The available methods are as follows:

- **Manual** — in the Widget window, click the Reset button associated with the timer widget to reset the timer to the start time set for the timer widget.
- **When Online** — reset the timer when the scene goes online.
- **When Offline** — reset the timer when the scene goes offline.
- **Ctrl + 1** — press the Ctrl and 1 key at the same time to reset the timer.
- **Ctrl + 2** — press the Ctrl and 2 key at the same time to reset the timer.
- **Ctrl + 3** — press the Ctrl and 3 key at the same time to reset the timer.
- **Ctrl + 4** — press the Ctrl and 4 key at the same time to reset the timer.
- **Ctrl + 5** — press the Ctrl and 5 key at the same time to reset the timer.
- **Ctrl + 6** — press the Ctrl and 6 key at the same time to reset the timer.
- **Ctrl + 7** — press the Ctrl and 7 key at the same time to reset the timer.
- **Ctrl + 8** — press the Ctrl and 8 key at the same time to reset the timer.
- **Ctrl + 9** — press the Ctrl and 9 key at the same time to reset the timer.

13. Click OK.

The new settings are saved, and the updated widget is displayed in the Widget window.

To edit the timer widget value manually, enter a value in the time box and then click Set.

14. Add a text object to a scene.
15. In the **Object Manager** window, select the text object for the clock timer widget.

![Object Manager window](image)

16. Click the **Data Source** tab in the **Object Inspector - Text Object** window.

   The **Data Source** tab opens.

![Object Inspector - Text Object](image)

17. Select the **Widget** option.

   A **Widget** list is displayed below the options.

18. Use the **Widget** list to select a timer widget, for example **ClockTimer2**. Since widget names can be modified, the names of timer widgets vary between XPression systems.

   A **Warning** dialog box opens.

19. Click **Yes**.

   The text in the selected text object is replaced with a time generated by the selected timer widget.

20. Double-click the scene containing the text object linked to the timer widget.

   The selected scene is sent to the default output, and the linked text object displays the timer.

21. Use the start method set in step 10 to start the timer.

**For More Information on...**

- adding a text object to a scene, refer to the procedure “**Create a Text Object**” on page 6–2.
Add a Counter Display to a Scene

Use this widget to display stats such as game scores, periods/quarters/innings, etc.

1. In XPression, use the Display menu to select Widgets.
   The Widgets window opens.

![Widgets window]

2. In the Widgets window, select New Widget > Counter.
   A counter widget is added to the Widgets window.

![Counter widget]

3. In the Value box, enter or select the number at which to start the counter.
4. Add a text object to a scene.
5. In the Object Manager window, select the text object for the counter widget.

![Object Manager window]

6. Click the Data Source tab in the Object Inspector - Text Object window.
   The Data Source tab opens.

![Object Inspector - Text Object]

7. Select the Widget option.
   A Widget list is displayed below the options.
8. Use the Widget list to select a counter widget, for example Counter1. Since widget names can be modified, the names of counter widgets vary between XPression systems.
   
   A Warning dialog box opens.

9. Click Yes.
   
   The text in the selected text object is replaced with the starting number set for the counter in step 3.

10. Double-click the scene containing the text object linked to the counter widget.
    
   The selected scene is sent to the default output, and the linked text object displays the counter starting number.

11. In the Widget window, click the Up button associated with the timer widget increase the counter value. To decrease the counter value, click the Down button associated with the timer widget

For More Information on...

• adding a text object to a scene, refer to the procedure “Create a Text Object” on page 6–2.

• customizing the counter displayed by a widget, refer to the procedure “Customize the Time Format of a Widget” on page 18–4.
Customize the Counter Format of a Widget

1. In a scene, select a text object that is associated with a counter widget.
2. Click the Data Source tab in the Object Inspector - Text Object window.
   The Data Source tab opens.

3. In the Select Data Source section, note the name of the widget associated with the selected text object.
4. From the Display menu, select Widgets.
   The Widgets window opens.

5. In the Widgets window, right-click the widget associated with the selected text object.
   The shortcut menu opens.

6. Select Properties from the shortcut menu.
   The Widget Properties (Counter) dialog box opens
7. Use the **Count Up** list to select the method used to increase the counter value. The available methods are as follows:
   - **Manual** — in the Widget window, click the Up button associated with the counter widget to increase the counter value.
   - **When Online** — increase the counter value when the scene goes online.
   - **Ctrl + 1** — press the Ctrl and 1 key at the same time to increase the counter value.
   - **Ctrl + 2** — press the Ctrl and 2 key at the same time to increase the counter value.
   - **Ctrl + 3** — press the Ctrl and 3 key at the same time to increase the counter value.
   - **Ctrl + 4** — press the Ctrl and 4 key at the same time to increase the counter value.
   - **Ctrl + 5** — press the Ctrl and 5 key at the same time to increase the counter value.
   - **Ctrl + 6** — press the Ctrl and 6 key at the same time to increase the counter value.
   - **Ctrl + 7** — press the Ctrl and 7 key at the same time to increase the counter value.
   - **Ctrl + 8** — press the Ctrl and 8 key at the same time to increase the counter value.
   - **Ctrl + 9** — press the Ctrl and 9 key at the same time to increase the counter value.

8. Use the **Count Down** list to select the method used to decrease the counter value. The available methods are as follows:
   - **Manual** — in the Widget window, click the Down button associated with the counter widget to decrease the counter value.
   - **When Offline** — decrease the counter value when the scene goes offline.
   - **Ctrl + 1** — press the Ctrl and 1 key at the same time to decrease the counter value.
   - **Ctrl + 2** — press the Ctrl and 2 key at the same time to decrease the counter value.
   - **Ctrl + 3** — press the Ctrl and 3 key at the same time to decrease the counter value.
   - **Ctrl + 4** — press the Ctrl and 4 key at the same time to decrease the counter value.
   - **Ctrl + 5** — press the Ctrl and 5 key at the same time to decrease the counter value.
   - **Ctrl + 6** — press the Ctrl and 6 key at the same time to decrease the counter value.
   - **Ctrl + 7** — press the Ctrl and 7 key at the same time to decrease the counter value.
   - **Ctrl + 8** — press the Ctrl and 8 key at the same time to decrease the counter value.
   - **Ctrl + 9** — press the Ctrl and 9 key at the same time to decrease the counter value.

9. Use the **Reset** list to select the method used to reset the counter. The available methods are as follows:
   - **Manual** — in the Widget window, click the Reset button associated with the counter widget to reset the counter to the set starting value.
   - **When Online** — reset the counter when the scene goes online.
   - **When Offline** — reset the counter when the scene goes offline.
   - **Ctrl + 1** — press the Ctrl and 1 key at the same time to reset the counter.
   - **Ctrl + 2** — press the Ctrl and 2 key at the same time to reset the counter.
   - **Ctrl + 3** — press the Ctrl and 3 key at the same time to reset the counter.
   - **Ctrl + 4** — press the Ctrl and 4 key at the same time to reset the counter.
   - **Ctrl + 5** — press the Ctrl and 5 key at the same time to reset the counter.
   - **Ctrl + 6** — press the Ctrl and 6 key at the same time to reset the counter.
   - **Ctrl + 7** — press the Ctrl and 7 key at the same time to reset the counter.
   - **Ctrl + 8** — press the Ctrl and 8 key at the same time to reset the counter.
   - **Ctrl + 9** — press the Ctrl and 9 key at the same time to reset the counter.

10. In the **Value Increment** box, enter or select the amount to change the counter value when the counter value is increased or decreased.

11. In the **Max Value** box, enter or select the number at which the counter stops increasing the counter value.

12. In the **Min Value** box, enter or select the number at which the counter stops decreasing the counter value.

13. Click **OK**.

   The new settings are saved, and the **Widget Properties** dialog box closes.
14. Double-click the scene containing the text object linked to the counter widget.
   The selected scene is sent to the default output, and the linked text object displays the counter starting number.
15. Use the increment methods set in steps 7 and 8 to change the counter value.
Add a Text List to a Scene

Use this widget to display team names, player names, etc.

1. In XPression, use the Display menu to select Widgets.
   The Widgets window opens.

2. In the Widgets window, select New Widget > Text List.
   A text list widget is added to the Widgets window.

3. Right-click inside the text list widget.
   The shortcut menu opens.

4. Select Properties from the shortcut menu.
   The Widget Properties (Text List) dialog box opens.
5. Click **Add**.

A new text item is added to the **Text List Entries**.

![Text List Entries](image)

6. Enter text for the new text item.

7. Repeat steps 5 and 6 for additional text items as necessary.

Select the **Allow manual entry of text** check box to enter text manually inside the text box of the TextList widget if necessary, and also to edit manually the text list in the Take Inspector Template Data. This allows for one-time error correction if any text entry in the widget list is incorrect before going to air.

Text List entries can also be imported from existing text list text files by clicking **Import** and selecting a file to import for the widget. The text list can also be exported as a text file by clicking **Export** and saving the file.

8. Add a text object to a scene.

9. In the **Object Manager** window, select the text object for the text list widget.

![Object Manager](image)

10. Click the **Data Source** tab in the **Object Inspector - Text Object** window.

    The **Data Source** tab opens.

11. Select the **Widget** option.

    A **Widget** list is displayed below the options.

12. Use the **Widget** list to select a text list widget, for example **TextList1**. Since widget names can be modified, the names of text list widgets can vary.

    A **Warning** dialog box opens.
13. Click Yes.

The text object displays the selected entry from the text list in the **Widgets** window.

14. In the **Widgets** window, use the list in the text list widget to select a different entry to display in the text object, or click inside the text box and manually type the text (if manual text entry has been enabled).

**For More Information on...**
- adding a text object to a scene, refer to the procedure "**Create a Text Object**" on page 6–2.
Effects

XPression effects are used to add various post-effects to individual objects and entire scenes. The following topics are discussed in this section:

- Add an Effect or Transition to an Object or Scene
Add an Effect or Transition to an Object or Scene

1. In XPression, create or select a scene.
2. In the Object Manager window, select an object for the effect or transition.

3. Use the Display menu to select Effects.
   The Effects window opens.

4. In the Effects window, use the folders to browse and select an effect or transition for the selected object.

5. Add the effect or transition to the Object Inspector or add the effect to the Scene Director.
   ✴ Some effects can only be used for specific objects. For example, Depth of Field is only applicable to Scene Objects.
   ✴ Transitions are only useable in the Scene Director.
Object Inspector

a. Drag and drop the selected effect or transition into the **Effects** tab in the **Object Inspector**.
   
   The effect or transition is added to the **Effects** tab.

b. In the **Effects** tab list, double-click on the effect.
   
   The **Effect Properties** dialog box opens.

c. Use the **Effect Properties** dialog box to configure the properties for the effect or transition.

d. Click **OK**.
   
   The **Effect Properties** dialog box closes.

Scene Director

a. Use the **Animation** menu to select **Scene Director**.

   The **Scene Director** window opens.

* Multiple scene directors can be added to a scene and managed using the **Scene Directors** window.
b. Drag and drop the selected effect or transition onto the object track in the **Scene Director**.

A controller for the effect or transition is added to the object track.

c. In the controller for the effect or transition, double-click the object controller.

The **Effect Properties** dialog box opens.

d. Use the **Effect Properties** dialog box to configure the properties for the effect or transition.

e. Click **OK**.

The **Effect Properties** dialog box closes.

6. Repeat steps 2 to 5 to add other effects or transitions to an object.

For More Information on...

- adding animations, refer to the section "**Animations**" on page 16–1.
DataLinq™

DataLinq enables live templates to be automatically filled with external data from XML files, RSS feeds, SMS servers, Text files, or any ODBC data source; like Access, MS SQL, Interbase, Firebird, or MySQL.

The XPression DataLinq Server software runs on either the XPression system itself, or one or more other computer systems to gather data from external sources and make it available to XPression systems. XPression systems use the XPression DataLinq Manager to connect to one or more DataLinq Servers (Figure 20.1). The XPression DataLinq Manager enables objects in an XPression project to link to any of the external data sources gathered by the connected DataLinq Servers.

Figure 20.1 DataLinq Connections to External Data Sources
The following topics are discussed in this section:

- Start the DataLinq Server
- Connect XPression to a DataLinq Server
- Link a Text Object to a DataLinq Data Source
- Link a Background Object to a DataLinq Source
- Link a Quad Object to a DataLinq Source
- Link a Sphere Object to a DataLinq Source
- Link a Cube Object to a DataLinq Source
- Link a Cylinder Object to a DataLinq Source
- Link a Torus Object to a DataLinq Source
- Link a Slab Object to a DataLinq Source
- Using DataLinq Keys with an ADO DB DataLinq
- Using DataLinq Keys with an XML DataLinq
- Using SQL Queries
- Using a Macro with a DataLinq Key
- Create a Data Page
- Using a Static URL
- Using a Dynamic URL
- Using Default URL Macros
- Using Table Presets
Start the DataLinq Server

If multiple DataLinq servers contain sources with the same name, the data retrieval can automatically failover to the other server if the primary server becomes disconnected. The order of priority is determined by the order of DataLinq servers added to the DataLinq Manager; so the primary server should be added before the backup servers.

1. Use one of the following methods to start the DataLinq Server.
   - Double-click the XPression DataLinq Server icon on the desktop.
   - Use the Start menu to select All Programs > XPression > XPression DataLinq Server.
   
The XPression DataLinq Server window opens.

![Image of XPression DataLinq Server window]

The port number used by the DataLinq Server to communicate with other XPression clients is displayed in the window title bar. The port number can be changed in the XPression DataLinq Server - Preferences dialog box by selecting File > Preferences.

2. Click Add New.

   The Add DataLinq Source dialog box opens.

![Image of Add DataLinq Source dialog box]

3. From the list of DataLinq sources, select the type of external data source to access. The available types of DataLinq sources are as follows:
   - **ADODB DataLinq Source** — access data contained in OLEDB, ODBC, Access, and other database sources.
   - **Amtote DataLinq Source** — access data from an Amtote serial data source.
   - **ANC DataLinq Source** — access data contained in ANC database sources.
   - **ASCII DataLinq Source** — access data contained in a stream of ASCII data (serial, TCP, or UDP) and extract fixed length fields from the messages. This can be used to parse some generic protocols and other devices such as radar gun data. The ASCII DataLinq supports messages up to 4095 bytes.
   - **Captioning DataLinq Source** — access data from streamed Caption data sources.
   - **Colorado Time Systems Scoreboards DataLinq Source** — access data from the Colorado Time Systems swimming feed database.
   - **Daktronics DataLinq Source** — access data from the Daktronics sports feed database.
   - **Daktronics RTD DataLinq Source** — access real-time data from Daktronics and other compatible data sources
   - **DashBoard DataLinq Source** — access data from a DashBoard server (DashBoard version 6.1 or higher).
- **Electro-Mech Scoreboards DataLinq Source** — access data from the Electro-Mech Scoreboards football or hockey/lacrosse data source.
- **GSIS DataLinq Source** — access data from the NFL Game Statistics & Information System.
- **JSON DataLinq Source** — access data by parsing local JSON files.
- **NBA NGSS DataLinq Source** — access data from the NBA NGSS stats.
- **OES Scoreboards DataLinq Source** — access data from the OES Football, Lacrosse, Baseball Model7929, Basketball, Hockey, Soccer, Volleyball, Wrestling, Baseball ISC9000Std, or Baseball ISC9000Pro feeds.
- **RSS Feed DataLinq Source** — access data through a RSS (Really Simple Syndication) feed. RSS feeds use a standard format to publish frequently updated works; such as, news headlines, blog entries, audio, and video.
- **SMT Tennis Umpire Clock DataLinq** — access data from the Tennis Umpire Clock data source.
- **Sportech DataLinq Source** — access data from a Sportech serial data source.
- **Stats Perform API DataLinq Source** — access data from the Stats Perform data source.
- **Stats Perform DataLinq Source** — access data from the Stats Perform Out of Town Scores data source.
- **Swiss Timing Scoreboards DataLinq Source** — access data from the Swiss Timing Saturn/Vega Scoreboard protocol.
- **Text DataLinq Source** — access data contained in delimited text files stored on disk.
- **White Way DataLinq Source** — access data from White Way databases for basketball or football.
- **XML DataLinq Source** — access XML data files stored on disk.
- **XML/JSON TCP DataLinq Source** — access XML/JSON data over TCP.

4. Click **OK**.

   The dialog box that opens to define data source settings depends on the selected data source.

5. Configure the selected DataLinq source.

   **ADODB DataLinq Source**

   The **ADODB DataLinq Configuration** dialog box opens.

   a. In the **Connection** tab, use the **Connection String** box to enter the connection string of the DataLinq Source, or click **Select Template** to select an existing connection string.

   b. Click **Test Connection** to view the status of the connection string.

   c. Enter or select a time in seconds in the **Refresh Every** box to update the data retrieved from the database.

   d. Select the **Wrap Indices** check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

   The **Wrap Indices** check box is selected by default.
e. In the **Table Sorting** tab, use the **Fields** table to add a sort field for a table within a database (some databases, such as Access and MySQL, require a specified sort order or the data could be returned in random order):

- **Table Name** — use the list to select a table for the DataLinq.
- **Sort Field** — use the list to select the sort field for the data.
- **Order** — use the list to select the sorting order for the data. The options are:
  - **ASC** — sort the data in ascending order.
  - **DESC** — sort the data in descending order.
- **Add** — click this button to add a field row to the Fields table.
- **Delete** — click this button to delete a selected row from the table.
- **Move Up** — click this button to move a selected row up in the table.
- **Move Down** — click this button to move a selected row down in the table.

f. In the **Fixed Tables** tab, select the **Force DataLinq to use a fixed table** check box to use fixed tables.

g. Choose one of the following options:

- Select the **Table** option and use the list to select a table from the connected database.
  - Click **Refresh** to update the data retrieved from the database.
- Select the **SQL Query** option and modify the string to query the database.

h. In the **Advanced** tab, use the **Database Settings** section to select a compatibility mode for the SQL database and to optimize the speed for accessing data.

- **Compatibility** — use this list to select a compatibility mode for the SQL database:
  - **MS SQL (Access/Excel)**
  - **MySQL**
  - **Standard SQL**
- **Use Record Limiting clause (TOP / LIMIT)** — select this check box to optimize the speed for accessing data by limiting the amount of records from the selected database using the TOP clause or LIMIT clause to specify the number of records to return.
  - Select the **Optimize custom queries to use Record Limiting clause** check box to automatically add a TOP clause so that the DataLinq will only retrieve the records specified in the query.
- **Include System Tables** — select this check box to include the SQL database system tables in the list of tables in the source for the DataLinq.
- **Use a persistent connection** — select this check box to maintain a persistent open connection to the SQL database.

🌟 In the **Debug Tools** section, select the **Log SQL Queries** check box to compile the SQL queries only if debugging. These queries can be viewed by clicking **Windows > Log Window** in the **XPression DataLinq Server**.

i. Use the **Maximum Records to Display in Browser** box to enter or select a maximum amount of data records to display in the **Select DataLinq Field** dialog box. The maximum is 2000.

j. Click **OK**.

The **ADODB DataLinq Configuration** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the **XPression DataLinq Server** window.
Amtote DataLinq Source

The **Amtote Linq - Configuration** dialog box opens.

![](image)

**a.** In the **Settings** section, use the **Mode** radio buttons to select the Amtote DataLinq connection type. The options are:

- **Serial RS232** — select this option to use an RS232 serial GPI port as the connection type.
- **TCP Server** — select this option to have the DataLinq Server listen for a connection from a remote client.
- **TCP Client** — select this option to connect to a remote server listening and waiting for connections.
- **UDP** — select this option to listen to UDP broadcasts.

**b.** Do one of the following:

- If **Serial RS232** is selected in the **Settings** section, use the **RS232 Settings** section to configure the GPI settings for the RS232 serial connection:
  - **Port** — enter or select the serial port number for the connection to the Amtote DataLinq.
  - **Baudrate** — use this list to select the communication speed for the signals.
  - **Data Bits** — use this list to select the number of bits used to represent one character of data for the signals.
  - **Parity** — use this list to select the method used to check for lost data in a signal.
  - **Stop Bits** — use this list to select the number of bits used to indicate the end of a byte in a signal.
  - **Flow Control** — use this list to select the data transmission rate controller for a signal.

- If **TCP Server**, **UDP**, or **TCP Client** is selected in the **Settings** section, use the **Network Settings** section to configure the port settings for the connection:
  - **TCP** — if **TCP Server** or **TCP Client** has been selected in the **Settings** section, enter or select the **TCP Port** number for the connection to the Amtote DataLinq.
  - **UDP** — if **UDP** has been selected in the **Settings** section, enter or select the **UDP Port** number for the connection to the Amtote DataLinq.

  - Use the **Hostname** box to enter the host name or IP address of the device if using TCP client.

**c.** In the **Protocol** section, use the **Version** list to select the protocol of the Amtote data source.

**d.** In the **Options** section, select the **Trim Text** check box to remove extra spaces from the feed.

**e.** Select the **Sample Data** check box to receive sample data for building projects outside of races.

**f.** Use the **Data Logger** list to select an encoding scheme for the data log. The options are:

- **None** — select this option to use no data logging.
- **ASCII** — select this option to use ASCII encoding for the data log.
- **HEX** — select this option to use HEX file formatting for the data log.
- **Both** — select this option to use both ASCII encoding and HEX file formatting for the data log.

**g.** Click **OK**.

The **Amtote Linq - Configuration** dialog box closes and the new DataLinq Source is added the **DataLinq Sources** section of the **Xpression DataLinq Server** window.
ANC DataLinq Source

The ANC Linq - Configuration dialog box opens.

![ANC Linq - Configuration dialog box](image)

a. Enter in the **Host** box the IP address of the ANC DataLinq database.
b. Enter in the **Port** box the port number for the ANC DataLinq database.
c. Click **OK**.

The ANC DataLinq Configuration dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.

ASCII DataLinq Source

The ASCII DataLinq Setup dialog box opens.

![ASCII DataLinq Setup dialog box](image)

a. In the **Settings** section, use the **Mode** radio buttons to select the ASCII DataLinq connection type. The options are:

- **Serial RS232** — select this option to use an RS232 serial GPI port as the connection type.
- **TCP** — select this option to use a TCP port as the connection type.
- **UDP** — select this option to use a UDP port as the connection type.

b. Do one of the following:

- If **Serial RS232** is selected in the **Settings** section, use the **RS232 Settings** section to configure the GPI settings for the RS232 serial connection:
  
  - **Port** — enter or select the serial port number for the connection to the ASCII DataLinq.
  - **Baudrate** — use this list to select the communication speed for the signals.
  - **Data Bits** — use this list to select the number of bits used to represent one character of data for the signals.
  - **Parity** — use this list to select the method used to check for lost data in a signal.
  - **Stop Bits** — use this list to select the number of bits used to indicate the end of a byte in a signal.
  - **Flow Control** — use this list to select the data transmission rate controller for a signal.
• If TCP or UDP is selected in the **Settings** section, use the **Network Settings** section to configure the port settings for the connection:
  › **TCP** — if TCP has been selected in the **Settings** section, enter or select the **TCP Port** number for the connection to the ASCII DataLinq.
  › **UDP** — if UDP has been selected in the **Settings** section, enter or select the **UDP Port** number for the connection to the ASCII DataLinq.

c. Use the **Fields** table to define a region of the incoming ASCII data stream to locate specific information (for example, Home Score, Visitor Score, Period, etc.):
  • **Name** — click inside a row to enter or edit a name for the field.
  • **Start Byte** — click inside a row to enter or edit the location where the field begins in the data stream.
  • **Length** — click inside a row to enter or edit the amount of bytes the field uses.
  • **Trim** — click inside a row and then select the check box to remove extra spaces from the data.
  • **Add** — click this button to add a field to the table.
  • **Delete** — click this button to delete a selected field from the table.

d. In the **Protocol Settings** section, use the **Start of Packet** list to select a start of packet control code. The available options are:
  • **<none>** — do not use a control code for the start of packet.
  • **STX** — use the start of text control code.
  • **SOH** — use the start of heading control code.
  • **Custom** — use a custom start of packet value. In the **ASCII Value** box, enter or select a custom start of packet value.

e. Use the **End of Packet** list to select a start of packet control code. The available options are:
  • **CR** — use the carriage return control code.
  • **LF** — use the line feed control code.
  • **ETX** — use the end of text control code.
  • **EOT** — use the end of transmission control code.
  • **Custom** — use a custom end of packet value. In the **ASCII Value** box, enter or select a custom end of packet value.

f. Click **OK**.

The **ASCII DataLinq Setup** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the **XPression DataLinq Server** window.

**Captioning DataLinq Source**

The **Captioning DataLinq Setup** dialog box opens.
a. In the **Settings** section, use the **Mode** radio buttons to select the Captioning DataLinq connection type. The options are:

- **Serial RS232** — select this option to use an RS232 serial GPI port as the connection type.
- **TCP Server** — select this option to have the DataLinq Server listen for a connection from a remote client.
- **UDP** — select this option to listen to UDP broadcasts.
- **TCP Client** — select this option to connect to a remote server listening and waiting for connections.

b. Do one of the following:

- If **Serial RS232** is selected in the **Settings** section, use the **RS232 Settings** section to configure the GPI settings for the RS232 serial connection:
  - **Port** — enter or select the serial port number for the connection to the Captioning DataLinq.
  - **Baudrate** — use this list to select the communication speed for the signals.
  - **Data Bits** — use this list to select the number of bits used to represent one character of data for the signals.
  - **Parity** — use this list to select the method used to check for lost data in a signal.
  - **Stop Bits** — use this list to select the number of bits used to indicate the end of a byte in a signal.
  - **Flow Control** — use this list to select the data transmission rate controller for a signal.

- If **TCP Server**, **UDP**, or **TCP Client** is selected in the **Settings** section, use the **Network Settings** section to configure the port settings for the connection:
  - **TCP** — if **TCP Server** or **TCP Client** has been selected in the **Settings** section, enter or select the **TCP Port** number for the connection to the Captioning DataLinq.
  - **UDP** — if **UDP** has been selected in the **Settings** section, enter or select the **UDP Port** number for the connection to the Captioning DataLinq.

  Use the **Hostname** box to enter the host name or IP address of the device.

c. In the **Captioning Display Options** section, configure the following captioning options for the source:

- **Max Chars per Line** — use this box to enter or select a maximum amount of characters to display per line.
- **Delay after Shift** — use this box to enter a time in milliseconds to delay reading in data for the new blank line at the bottom after the lines are shifted up after receiving a full line of data. Without delay, and some sort of animation that visually shifts the lines on screen, one could end up with new words appearing on the bottom line before the animation finishes.
- **Ignore Carriage Returns** — select this check box to ignore carriage returns from the source.
- **Custom Newline Sequence** — select this check box and use the text box to enter a custom character sequence to search for in the incoming data to replace with a newline character in the rendered text.

d. In the **Logging** section, use the **Data Logger** list to select an encoding scheme for the data log. The options are:

- **None** — select this option to use no data logging.
- **ASCII** — select this option to use ASCII encoding for the data log.
- **HEX** — select this option to use HEX file formatting for the data log.
- **Both** — select this option to use both ASCII encoding and HEX file formatting for the data log.

e. In the **Timeout** section, select the **Clear line on data timeout** check box and use the **Timeout** box enter or select an amount of time in seconds before a line is cleared when the data has timed out.

f. Click **OK**.

The Captioning DataLinq Setup dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.
Colorado Time Systems Scoreboards DataLinq Source

The **Colorado Time Systems Linq - Configuration** dialog box opens.

![Configuration dialog box](image)

**a.** Select the **Trim Text** check box to remove extra spaces from the feed.

**b.** In the **Connection Options** section, use the **Connection Type** options to select the connection to the Colorado Time Systems device:

- **UDP** — select this option to use a UDP port as the connection type and configure the following:
  - **Port** — enter or select the UDP port number for the Colorado Time Systems device.
- **Serial** — select this option to use a serial port as the connection type and configure the following:
  - **Port** — enter or select the serial port number for the Colorado Time Systems device.
  - **Baudrate** — use the list to select the communication speed for the signals.
  - **Data Bits** — use the list to select the number of bits used to represent one character of data for the signals.
  - **Parity** — use the list to select the method used to check for lost data in a signal.
  - **Stop Bits** — use the list to select the number of bits used to indicate the end of a byte in a signal.
  - **Flow Control** — use the list to select the data transmission rate controller for a signal.

**c.** Use the **Data Logger** list to select an encoding scheme for the data log. The options are:

- **None** — select this option to use no data logging.
- **ASCII** — select this option to use ASCII encoding for the data log.
- **HEX** — select this option to use HEX file formatting for the data log.
- **Both** — select this option to use both ASCII encoding and HEX file formatting for the data log.

**d.** Click **OK**.

The **Colorado Time Systems Linq - Configuration** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the **XPression DataLinq Server** window.
Daktronics DataLinq Source

The **Daktronics TV Feed - Configuration** dialog box opens.

![Daktronics DataLinq Source](image)

a. In the **Settings** section, use the **Game Feed** list to select a Daktronics sports feed. The available sports feeds are as follows:

- Baseball
- Basketball (Rev 0)
- Basketball (Rev 1)
- Basketball (Rev 2)
- Football
- Football (Legacy protocol)
- Hockey
- Lacrosse
- Soccer
- Volleyball

b. Select a **Mode** for the Daktronics feed:

- **Serial RS232** — select to use a serial RS232 port as the connection type.
- **TCP** — select to use a TCP port as the connection type.
- **UDP** — select to use a serial UDP port as the connection type.

c. Configure the selected mode.

**RS232 GPI Settings**

- Use the **Port** list to select the Communication port that receives the signals.
- Use the **Baudrate** list to select the communication speed for the signals.
- Use the **Data Bits** list to select the number of bits used to represent one character of data for the signals.
- Use the **Parity** list to select the method used to check for lost data in a signal.
- Use the **Stop Bits** list to select the number of bits used to indicate the end of a byte in a signal.
- Use the **Flow Control** list to select the data transmission rate controller for a signal.

The flow control can be set to **Hardware** or **None**, but it must be set the same in both XPression and the transmitting device.

**TCP & UDP**

- In the **Network Settings** section, use the **TCP Port/UDP Port** box to enter or select the communication port that receives the signals.

d. In the **Options** section, select the **Trim Text** check box to remove extra spaces from the feed.

e. Select the **Ignore Checksums** check box to ignore the block of data that detects errors occurring during transmission.
f. Use the Data Logger list to select an encoding scheme for the data log. The options are:
   • None — select this option to use no data logging.
   • ASCII — select this option to use ASCII encoding for the data log.
   • HEX — select this option to use HEX file formatting for the data log.
   • Both — select this option to use both ASCII encoding and HEX file formatting for the data log.

g. Click OK.

The Daktronics TV Feed - Configuration dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.

Daktronics RTD DataLinq Source

The Daktronics RTD DataLinq Setup dialog box opens.

a. In the Settings section, use the Mode radio buttons to select the Daktronics RTD DataLinq connection type. The options are:
   • Serial RS232 — select this option to use an RS232 serial GPI port as the connection type.
   • TCP — select this option to use a TCP port as the connection type.
   • UDP — select this option to use a UDP port as the connection type.

b. Do one of the following:
   • If Serial RS232 is selected in the Settings section, use the RS232 Settings section to configure the GPI settings for the RS232 serial connection:
     › Port — enter or select the serial port number for the connection to the Daktronics RTD DataLinq.
     › Baudrate — use this list to select the communication speed for the signals.
     › Data Bits — use this list to select the number of bits used to represent one character of data for the signals.
     › Parity — use this list to select the method used to check for lost data in a signal.
     › Stop Bits — use this list to select the number of bits used to indicate the end of a byte in a signal.
     › Flow Control — use this list to select the data transmission rate controller for a signal.
   • If TCP or UDP is selected in the Settings section, use the Network Settings section to configure the port settings for the connection:
     › TCP — if TCP has been selected in the Settings section, enter or select the TCP Port number for the connection to the Daktronics RTD DataLinq.
     › UDP — if UDP has been selected in the Settings section, enter or select the UDP Port number for the connection to the Daktronics RTD DataLinq.

c. Use the Description box to enter a brief name or descriptor for the data source.

d. Click Import ITF to import a Daktronics .itf interface file to populate the data.

The Fields table is populated with the data from the interface file.
e. Click inside the Trim row and then select the check box to remove extra spaces from the data.

f. Click OK.

The Daktronics RTD DataLinq Setup dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.

DashBoard DataLinq Source

The DashBoard Linq - Configuration dialog box opens.

![Image of the DashBoard Linq - Configuration dialog box]

a. In the Connection Options section, enter in the Host box the IP address of the DashBoard DataLinq database.

b. Enter in the Port box the port number for the DashBoard DataLinq database.

c. In the Options section, select the Represent data as an XML tree check box to represent the data as an XML tree structure and allow DataLinq keys and normal XML searching.

Select the Include parameter names check box to include the parameter names in the data.

d. Select the Log Received Data check box to collect the received data in the DataLinq log.

e. Click OK.

The DashBoard Linq - Configuration dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.

Electro-Mech Scoreboards DataLinq Source

The Electro-Mech Linq - Configuration dialog box opens.

![Image of the Electro-Mech Linq - Configuration dialog box]

a. Use the Game Feed list to select an Electro-Mech sports feed. The available sports feeds are as follows:

- Football
- Hockey - Lacrosse
- Basketball

b. Select the Trim Text check box to remove extra spaces from the feed.
c. In the **Connection Options** section, use the **Connection Type** options to select the connection to the Electro-Mech device:
   - **UDP** — select this option to use a UDP port as the connection type and configure the following:
     - **Port** — enter or select the UDP port number for the Electro-Mech device.
   - **Serial** — select this option to use a serial port as the connection type and configure the following:
     - **Port** — enter or select the serial port number for the Electro-Mech device.
     - **Baudrate** — use the list to select the communication speed for the signals.
     - **Data Bits** — use the list to select the number of bits used to represent one character of data for the signals.
     - **Parity** — use the list to select the method used to check for lost data in a signal.
     - **Stop Bits** — use the list to select the number of bits used to indicate the end of a byte in a signal.
     - **Flow Control** — use the list to select the data transmission rate controller for a signal.

d. Use the **Data Logger** list to select an encoding scheme for the data log. The options are:
   - **None** — select this option to use no data logging.
   - **ASCII** — select this option to use ASCII encoding for the data log.
   - **HEX** — select this option to use HEX file formatting for the data log.
   - **Both** — select this option to use both ASCII encoding and HEX file formatting for the data log.

e. Click **OK**.

The **Electro-Mech Linq - Configuration** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the **XPression DataLinq Server** window.

**GSIS DataLinq Source**

The **GSIS Linq - Configuration** dialog box opens.

a. In the **Message Queue Path** box, enter the full pathname of the message queue folder.

   ✔️ It is essential that the **Message Queue Path** matches the information sent from GSIS.

b. In the **Message Label** box, enter a name for the message queue.

c. Select the **Wrap Indices** check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

   The **Wrap Indices** check box is selected by default.

d. Select the **Cache Results To Disk** check box to cache query results to disk. This check box should be selected when using looping queries.

e. Click **OK**.

The **GSIS Linq - Configuration** dialog box closes and the new DataLinq Source is added the **DataLinq Sources** section of the **XPression DataLinq Server** window.
The **JSON Linq - Configuration** dialog box opens.

![JSON Linq Configuration Dialog Box](image1.png)

a. Enter in the **Filename** box the full pathname of the JSON file that contains the data for the DataLinq source, or click **Browse** (...) to use the **Open** dialog box to locate and open the JSON file.

b. Select one of the following radio buttons to determine when to check for JSON source file changes:
   - **Wait for file change events** — update when the JSON source file is updated. This is not recommended for network drives.
   - **Poll every** — select this radio button and then enter or select a time interval in seconds to poll the JSON source file for any updates or changes.

c. In the **Options** section, use the **Encoding** list to select a file encoding protocol. The options are:
   - ASCII
   - UTF-8
   - UTF-16-BE
   - UTF-16-LE
   - ISO-8859
   - UCS2

d. Select the **Wrap Indices** check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

e. In the **Options** section, select the **Enable Table Presets** check box to use the **Table Presets** tab to configure a list of preset tables that will be available in the Table dropdown option when browsing for data. If table presets has been selected, click the **Table Presets** tab to configure the list of table presets when using a JSON DataLinq.

   The **Table Presets** tab opens.

   ![Table Presets Tab](image2.png)

   Click **Add** to add a table preset to the list and configure the following:
   - **Name** — enter a name for the table preset.
   - **Path** — enter the path that will be used as a filter to match the streamed data.

f. In the **Options** section of the **Settings** tab, select the **Enable Logging** check box to record the JSON DataLinq info in the XPression logs.
g. Click OK.

The JSON Linq - Configuration dialog box closes and the new DataLinq Source is added the DataLinq Sources section of the XPression DataLinq Server window.

NBA NGSS DataLinq Source

The Genius Live Stream Linq - Configuration dialog box opens.

![Connection Settings](image)

a. In the Connection Settings section, use the NBA NGSS Host list to select the host URL for the DataLinq connection. The options are:
   - api.ngss.nba.com
   - api-uat.ngss.nba.com

b. Use the Local Data Folder box to enter a local folder path for the data. The default location is the DataLinqs folder in the XPression DataLinq Server folder of the Program Files on the C: drive.

c. Use the API Key box to enter an API key to communicate with the NBA NGSS host from XPression. The API key is generated by the NBS NGSS host.

d. Select the Save all incoming messages to disk check box to store all incoming messages from the NBA NGSS host.

OES Scoreboards DataLinq Source

The OES Linq - Configuration dialog box opens.

![Game Feed](image)

a. Use the Game Feed list to select a sports feed. The available feeds are:
   - Baseball ISC9000Pro
   - Baseball ISC9000Std
   - Baseball Model7929
   - Basketball
   - Field Hockey
   - Football
   - Hockey
   - Lacrosse
   - Soccer
   - Volleyball
   - Wrestling
b. Select a Mode for the OES feed:
   • **Serial RS232** — select to use a serial RS232 port as the connection type.
   • **TCP** — select to use a TCP port as the connection type.
   • **UDP** — select to use a serial UDP port as the connection type.

c. Configure the selected mode.

**RS232 GPI Settings**
- Use the **Port** list to select the Communication port that receives the signals.
- Use the **Baudrate** list to select the communication speed for the signals.
- Use the **Data Bits** list to select the number of bits used to represent one character of data for the signals.
- Use the **Parity** list to select the method used to check for lost data in a signal.
- Use the **Stop Bits** list to select the number of bits used to indicate the end of a byte in a signal.
- Use the **Flow Control** list to select the data transmission rate controller for a signal.
  The flow control can be set to **Hardware**, **Software**, or **None**, but it must be set the same in both XPression and the transmitting device.

**TCP & UDP**
- In the **Network Settings** section, use the **TCP Port/UDP Port** box to enter or select the communication port that receives the signals.

d. In the **Options** section, select the **Trim Text** check box to remove extra spaces from the feed.

e. Select the **Ignore Checksums** check box to ignore the block of data that detects errors occurring during transmission.

f. Select the **OES supports game time over 99 mins** check box to allow for soccer games that run over 99 minutes (OES soccer game feed only).

g. Use the **Data Logger** list to select an encoding scheme for the data log. The options are:
   - **None** — select this option to use no data logging.
   - **ASCII** — select this option to use ASCII encoding for the data log.
   - **HEX** — select this option to use HEX file formatting for the data log.
   - **Both** — select this option to use both ASCII encoding and HEX file formatting for the data log.

h. Click **OK**.

The **OES Linq - Configuration** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the **XPression DataLinq Server** window.
RSS / HTTP DataLinq Source

The RSS / HTTP DataLinq - Configuration dialog box opens by default on its Settings tab.

Settings
In the Settings tab, configure the URL and data settings for the RSS / HTTP DataLinq.

a. In the URL Settings section, use the URL box to enter the URL or macro used to access the RSS feed.

b. Select a data Format to read from the RSS feed:
   - XML — select this option to read XML sources.
   - JSON — select this option to read HTTP based JSON sources.
   - Automatic (HTTP Content-Type) — select this option to automatically detect XML versus JSON data based on the HTTP Content-Type header.

c. In the Update Interval box, enter or select the number of milliseconds to wait between RSS feed update checks.

d. In the Mode section, select a mode for the RSS / HTTP DataLinq. The options are:
   - Static URL — select this option to use the RSS feed of a single URL as entered in the URL settings. It is refreshed asynchronously.
     Use Table Presets — select this check box to use the Table Presets tab with Static URLs to allow multiple URLs to be queried by the same DataLinq, with each one exposed as a separate table source to XPression. If the base URL contains the %table% macro, then each table preset entry will be substituted into the base URL where the %table% macro exists. If the base URL does not contain %table%, then each table entry must be its own URL to be queried.
   - Dynamic URL — select this option to use multiple RSS feeds by configuring a dynamic URL based on DataLinq keys and table presets. The results are refreshed on demand.

If Dynamic URL is selected, configure the following options:
   - Cache Results for — use this box to enter or select an amount of time in milliseconds to cache the results of the query.
   - Timeout if data not received in — use this box to enter or select a time in milliseconds to timeout the query if data has not been received in the specified amount of time.
e. In the **Data Options** section, use the **RSS Encoding** list to select an encoding protocol for RSS feeds. The options are:
   - `<automatic>` — select this option to automatically detect the protocol.
   - UTF-8
   - UTF-16-BE
   - UTF-16-LE
   - ISO-8859
   - UCS2

f. If using the XML data format, use the **XSLT Filename** box to enter a file path or click **Browse (...)** to select an XSLT file to use with the XML data.

g. Select the **Save all data to disk (for diagnostics)** check box to store all data for diagnostic purposes.

h. Select the **Wrap Indices** check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

   The **Wrap Indices** check box is selected by default.

**HTTP Config**

a. Click the **HTTP Config** tab to configure the credentials for an HTTP server.

   The **HTTP Config** tab opens.

![HTTP Config Tab](image)

b. Select the **Use Basic Authentication** check box to set a username and password for the DataLinq Source:
   - **User Name** — enter a username for the basic authentication.
   - **Password** — enter a password for the basic authentication.

c. Select the **Use Proxy Server** check box to use a proxy server to connect to the network and then enter the connection info:
   - **Host** — enter the host address of the proxy server.
   - **Port** — enter the port number for the proxy server. The default is 80.

d. Use the **Custom Header Parameters** section to configure custom parameters to send to the HTTP server. Click **Add** to add a custom header parameter to the list and configure the following:
   - **Name** — enter a name that describes the value being sent.
   - **Value** — enter the value to send to the HTTP server.
**Default URL Macros**

a. Click the **Default URL Macros** tab to configure macros that replace the %macroname% tags in the URL configuration.

The **Default URL Macros** tab opens.

Default URL macros enable browsing of the DataLinq source URL with default values when the URL contains macros that would usually be set by DataLinq keys in a scene.

b. Click **Add** to add a URL replacement macro to the list and configure the following:

   - **Name** — enter a name for the URL replacement macro (for example, ‘feed’ if using a news website URL with an RSS feed).
   - **Value** — enter the value of the URL replacement macro (for example, ‘world’ if a news website URL has an RSS feed for world news).

**Table Presets**

a. Click the **Table Presets** tab to configure URL preset values for the Table list in the **Select DataLinq Field** window when using an RSS / HTTP DataLinq with a text object.

The **Table Presets** tab opens.
The **Table Presets** list represents preset values that are available in the Table list when browsing for data. The table can be used to dynamically change the URL by using a %table% macro inside the URL or as the entire URL.

b. Click **Add** to add a table preset to the list and configure the following:
   
   - **Name** — enter a name for the table preset (for example, ‘world’ if a news website URL has an RSS feed for world news).
   - **Value** — enter the value of the table preset (for example, the URL of the world news RSS feed from a news website).

c. Click **OK**.

   The **RSS Linq - Configuration** dialog box closes and the new DataLinq Source is added the **DataLinq Sources** section of the **XPression DataLinq Server** window.

For More Information on...

- using a static URL, refer to "Using a Static URL" on page 20–67.
- using a dynamic URL, refer to "Using a Dynamic URL" on page 20–69.
- using default URL macros, refer to "Using Default URL Macros" on page 20–72.
- using table presets, refer to "Using Table Presets" on page 20–73.

**SMT Tennis Umpire Clock DataLinq Source**

The **SMT Tennis DataLinq Setup** dialog box opens.

a. Select one of the following options:
   
   - **Server** — select this option to have the DataLinq Server listen for a connection from a remote client.
   - **Client** — select this option to connect to a remote server listening and waiting for connections.

b. Use the **TCP Port** box to enter or select the TCP Port number for the connection to the SMT Tennis DataLinq.

c. Use the **IP Address** box to enter the IP address of the SMT data client server.

d. Click **OK**.

   The **SMT Tennis DataLinq Setup** dialog box closes and the new DataLinq Source is added the **DataLinq Sources** section of the **XPression DataLinq Server** window.
Sportech DataLinq Source

The Sportech Linq - Configuration dialog box opens.

![Configuration dialog box]

a. In the Settings section, use the Mode radio buttons to select the Sportech DataLinq connection type. The options are:
   • Serial RS232 — select this option to use an RS232 serial GPI port as the connection type.
   • TCP Server — select this option to have the DataLinq Server listen for a connection from a remote client.
   • TCP Client — select this option to connect to a remote server listening and waiting for connections.
   • UDP — select this option to listen to UDP broadcasts.

b. Do one of the following:
   • If Serial RS232 is selected in the Settings section, use the RS232 Settings section to configure the GPI settings for the RS232 serial connection:
     › Port — enter or select the serial port number for the connection to the Sportech DataLinq.
     › Baudrate — use this list to select the communication speed for the signals.
     › Data Bits — use this list to select the number of bits used to represent one character of data for the signals.
     › Parity — use this list to select the method used to check for lost data in a signal.
     › Stop Bits — use this list to select the number of bits used to indicate the end of a byte in a signal.
     › Flow Control — use this list to select the data transmission rate controller for a signal.
   • If TCP Server, UDP, or TCP Client is selected in the Settings section, use the Network Settings section to configure the port settings for the connection:
     › TCP — if TCP Server or TCP Client has been selected in the Settings section, enter or select the TCP Port number for the connection to the Sportech DataLinq.
     › UDP — if UDP has been selected in the Settings section, enter or select the UDP Port number for the connection to the Sportech DataLinq.
   • Use the Hostname box to enter the host name or IP address of the device if using TCP client.

c. In the Protocol section, use the Version list to select the software version of the Sportech data source.
   Select the Ignore Version Mismatch check box to have DataLinq not report errors when there is a mismatch between protocols.

d. In the Options section, select the Trim Text check box to remove extra spaces from the feed.

e. Select the Ignore Checksums check box to ignore the block of data that detects errors occurring during transmission.

f. Select the Sample Data check box to receive sample data for building projects outside of races.
g. Use the **Data Logger** list to select an encoding scheme for the data log. The options are:
   - **None** — select this option to use no data logging.
   - **ASCII** — select this option to use ASCII encoding for the data log.
   - **HEX** — select this option to use HEX file formatting for the data log.
   - **Both** — select this option to use both ASCII encoding and HEX file formatting for the data log.

h. In the **Filter** section, use the **Meet Names** box to filter race data by meet names. When receiving data for multiple meet names, separate the names using a comma.

i. Click **OK**.

   The **Sportech Linq - Configuration** dialog box closes and the new DataLinq Source is added the **DataLinq Sources** section of the **XPression DataLinq Server** window.

### Stats Perform API DataLinq Source

The **Stats Perform DataLinq - Configuration** dialog box opens.

![Stats Perform DataLinq - Configuration dialog box](image)

**Settings**

In the **Settings** tab, configure the URL and data settings for the Stats Perform API DataLinq.

a. In the **URL Settings** section, use the **URL** box to enter the URL used to access the Stats Perform feed.

b. Select a data **Format** to read from the Stats Perform feed:
   - **XML** — select this option to read XML sources.
   - **JSON** — select this option to read HTTP based JSON sources.
   - **Automatic (HTTP Content-Type)** — select this option to automatically detect XML versus JSON data based on the HTTP Content-Type header.

c. In the **Update Interval** box, enter or select the number of milliseconds to wait between Stats Perform feed update checks.
d. In the **Mode** section, select a mode for the RSS / HTTP DataLinq. The options are:

- **Static URL** — select this option to use the Stats Perform feed of a single URL as entered in the URL settings. It is refreshed asynchronously.
  
  **Use Table Presets** — select this check box to use the Table Presets tab with Static URLs to allow multiple URLs to be queried by the same DataLinq, with each one exposed as a separate table source to XPression. If the base URL contains the `%table%` macro, each table preset entry will be substituted into the base URL where the `%table%` macro exists. If the base URL does not contain `%table%`, each table entry must be its own URL to be queried.

- **Dynamic URL** — select this option to use multiple Stats Perform feeds by configuring a dynamic URL based on DataLinq keys and table presets. The results are refreshed on demand.
  
  If Dynamic URL is selected, configure the following options:
  
  - **Cache Results for** — use this box to enter or select an amount of time in milliseconds to cache the results of the query.
  - **Timeout if data not received in** — use this box to enter or select a time in milliseconds to timeout the query if data has not been received in the specified amount of time.

e. In the **Data Options** section, use the **Encoding** list to select an encoding protocol for Stats Perform feeds. The options are:

- `<automatic>` — select this option to automatically detect the protocol.
- UTF-8
- UTF-16-BE
- UTF-16-LE
- ISO-8859
- UCS2

f. If using the XML data format, use the **XSLT Filename** box to enter a file path or click **Browse (…)** to select an XSLT file to use with the XML data.

g. Select the **Save all data to disk (for diagnostics)** check box to store all data for diagnostic purposes.

h. Select the **Wrap Indices** check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

The **Wrap Indices** check box is selected by default.

**HTTP Config**

a. Click the **HTTP Config** tab to configure the credentials for an HTTP server.

The **HTTP Config** tab opens.
b. Select the **Use Basic Authentication** check box to set a username and password for the DataLinq Source:
   - **User Name** — enter a username for the basic authentication.
   - **Password** — enter a password for the basic authentication.

c. Select the **Use Proxy Server** check box to use a proxy server to connect to the network and then enter the connection info:
   - **Host** — enter the host address of the proxy server.
   - **Port** — enter the port number for the proxy server. The default is 80.

d. Use the **Custom Header Parameters** section to configure custom parameters to send to the HTTP server. Click **Add** to add a custom header parameter to the list and configure the following:
   - **Name** — enter a name that describes the value being sent.
   - **Value** — enter the value to send to the HTTP server.

### Default URL Macros

a. Click the **Default URL Macros** tab to configure macros that replace the `%macroname%` tags in the URL configuration.

The **Default URL Macros** tab opens.

![Default URL Macros Tab](image)

Default URL macros enable browsing of the DataLinq source URL with default values when the URL contains macros that would usually be set by DataLinq keys in a scene.

b. Click **Add** to add a URL replacement macro to the list and configure the following:
   - **Name** — enter a name for the URL replacement macro.
   - **Value** — enter the value of the URL replacement macro.
Table Presets

a. If Dynamic URL has been selected in the Settings tab, click the Table Presets tab to configure URL preset values for the Table list in the Select DataLinq Field window when using an HTTP DataLinq with a text object.

The Table Presets tab opens.

![Table Presets Tab](image)

The Table Presets list represents preset values that are available in the Table list when browsing for data. The table can be used to dynamically change the URL by using a %table% macro inside the URL or as the entire URL.

b. Click Add to add a table preset to the list and configure the following:
   - Name — enter a name for the table preset.
   - Value — enter the value of the table preset.

c. Click OK.

The Stats Perform DataLinq - Configuration dialog box closes and the new DataLinq Source is added the DataLinq Sources section of the XPression DataLinq Server window.

For More Information on...
- using a static URL, refer to “Using a Static URL” on page 20–67.
- using a dynamic URL, refer to “Using a Dynamic URL” on page 20–69.
- using default URL macros, refer to “Using Default URL Macros” on page 20–72.
- using table presets, refer to “Using Table Presets” on page 20–73.

Stats Perform DataLinq Source

The Stats Perform - Configuration dialog box opens.

![Stats Perform Configuration Dialog](image)
a. In the **Connection Settings** section, use the **Stats Inc. Host** box to enter or select the host URL for the DataLinq connection.

b. Use the **Local Data Folder** box to enter a local folder path for the data or click **Browse (...)** to locate and retrieve the data. The default location is the DataLinqs folder in the XPression DataLinq Server folder of the Program Files on the C: drive.

c. Use the **Username** box to enter the user name for the Stats Perform login.

d. Use the **Password** box to enter the password for the Stats Perform login.

e. In the **Options** section, use the **Past Days to Include** box to enter or select an amount of previous days of stats to include in the results.

f. Use the **Future Days to Include** box to enter or select an amount of upcoming days of stats to include in the results.

g. Use the **Timezone** list to select a timezone to use for the date and time.

h. Use the **Date Format** box to enter a date format to use for the DataLinq.

i. Use the **Time Format** box to enter a time format to use for the DataLinq.

### Swiss Timing Scoreboards DataLinq Source

The **Swiss Timing Linq - Configuration** dialog box opens.

- **Protocol** list to select one of the following scoreboard protocols:
  - Saturn/Vega Scoreboard
  - NBA Tissot Timer

b. Select the **Trim Text** check box to remove extra spaces from the data.

c. In the **Connection Options** section, use the **Connection Type** options to select the connection to the Swiss Timing device:
   - **UDP** — select this option to use a UDP port as the connection type and configure the following:
     - **Port** — enter or select the UDP port number for the Swiss Timing device.
   - **Serial** — select this option to use a serial port as the connection type and configure the following:
     - **Port** — enter or select the serial port number for the Swiss Timing device.
     - **Baudrate** — use the list to select the communication speed for the signals.
     - **Data Bits** — use the list to select the number of bits used to represent one character of data for the signals.
     - **Parity** — use the list to select the method used to check for lost data in a signal.
     - **Stop Bits** — use the list to select the number of bits used to indicate the end of a byte in a signal.
     - **Flow Control** — use the list to select the data transmission rate controller for a signal.

d. Select the **Ignore Checksums** check box to ignore the block of data that detects errors occurring during transmission.
e. Use the Data Logger list to select an encoding scheme for the data log. The options are:
   • None — select this option to use no data logging.
   • ASCII — select this option to use ASCII encoding for the data log.
   • HEX — select this option to use HEX file formatting for the data log.
   • Both — select this option to use both ASCII encoding and HEX file formatting for the data log.
f. Click OK.

   The Swiss Timing Linq - Configuration dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.

TeleTimer DataLinq Source

   The TeleTimer DataLinq Setup dialog box opens.

   a. In the Settings section, select a Mode for the TeleTimer feed:
      • Serial RS232 — select to use a serial RS232 port as the connection type.
      • TCP — select to use a TCP port as the connection type.
      • UDP — select to use a serial UDP port as the connection type.
   b. Configure the selected mode.

RS232 GPI Settings

   In the RS232 Settings section, configure the following settings:
   • Use the Port list to select the communication port that receives the signals.
   • Use the Baudrate list to select the communication speed for the signals.
   • Use the Data Bits list to select the number of bits used to represent one character of data for the signals.
   • Use the Parity list to select the method used to check for lost data in a signal.
   • Use the Stop Bits list to select the number of bits used to indicate the end of a byte in a signal.
   • Use the Flow Control list to select the data transmission rate controller for a signal.
      The flow control can be set to Hardware or None, but it must be set the same in both XPression and the transmitting device.

TCP & UDP

   In the Network Settings section, use the TCP Port/UDP Port box to enter or select the communication port that receives the signals.

c. Use the Data Logger list to select an encoding scheme for the data log. The options are:
   • None — select this option to use no data logging.
   • ASCII — select this option to use ASCII encoding for the data log.
   • HEX — select this option to use HEX file formatting for the data log.
   • Both — select this option to use both ASCII encoding and HEX file formatting for the data log.
d. Click OK.

   The TeleTimer DataLinq Setup dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.
Teleview DataLinq Source

The Teleview DataLinq Setup dialog box opens.

![Teleview DataLinq Setup dialog box]

a. In the Settings section, select a Mode for the Teleview feed:
   - Serial RS232 — select to use a serial RS232 port as the connection type.
   - TCP — select to use a TCP port as the connection type.
   - UDP — select to use a serial UDP port as the connection type.

b. Configure the selected mode.

**RS232 GPI Settings**

In the RS232 Settings section, configure the following settings:

- Use the Port list to select the communication port that receives the signals.
- Use the Baudrate list to select the communication speed for the signals.
- Use the Data Bits list to select the number of bits used to represent one character of data for the signals.
- Use the Parity list to select the method used to check for lost data in a signal.
- Use the Stop Bits list to select the number of bits used to indicate the end of a byte in a signal.
- Use the Flow Control list to select the data transmission rate controller for a signal.

   The flow control can be set to Hardware or None, but it must be set the same in both XPression and the transmitting device.

**TCP & UDP**

In the Network Settings section, use the TCP Port/UDP Port box to enter or select the communication port that receives the signals.

c. Use the Data Logger list to select an encoding scheme for the data log. The options are:
   - None — select this option to use no data logging.
   - ASCII — select this option to use ASCII encoding for the data log.
   - HEX — select this option to use HEX file formatting for the data log.
   - Both — select this option to use both ASCII encoding and HEX file formatting for the data log.

d. Click OK.

The Teleview DataLinq Setup dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.
Text DataLinq Source

The **Text Source - Setup** dialog box opens.

![Text Source - Setup dialog box](image)

**a.** In the **File Options** section, enter in the **Filename** box the full pathname of the text file that contains the data for the DataLinq source, or click **Browse (...)** to use the **Open** dialog box to locate and open the text file.

**b.** Select one of the following radio buttons to determine when to check for text source file changes:

- **Wait for file change events** — update the text when the text file source is updated. This is not recommended for network drives.
- **Poll every** — select this radio button and then enter or select a time interval in seconds to poll the text source for any updates or changes.

**c.** Use the **Encoding** list to select a character encoding for the text file source. The available encoding options are as follows:

- **<automatic>** — selecting this option automatically uses ANSI for encoding the text file source.
- **UTF-8**
- **UTF-16-BE**
- **UTF-16-LE**
- **ISO-8859**
- **UCS2**
- **ANSI**

**d.** Select the **Allow reading of files that are currently being written by other applications** check box to enable the Text DataLinq to read text files that are currently open for writing in other applications that lock the file.

**e.** Select the **Ignore empty files (0 bytes)** check box to ignore empty files from the text source and retain the previous data. This will also apply to files filled with invalid characters.

**f.** In the **Parsing Options** section, select the **Strip blank lines from file** check box to remove blank lines of text from the text source.
g. Select the **Wrap Indices** check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

The **Wrap Indices** check box is selected by default.

h. Select the **Text File has Header Row** check box to indicate that the first row of data in the text source represents the column names.

i. In the **Format** section, use the **Delimiter** list to select the character used to divide the data values on each line in the text file. The available delimiters are as follows:

- Comma (,)
- Colon (:)
- Semicolon (;)
- Tab
- None
- Other

When **Other** is the selected delimiter, enter the delimiter character to use in the box to the right of this list.

j. Use the **New Line** list to select the character used in the text file to start a new line. The available characters are as follows:

- None
- Break tag “<br>”
- Paragraph “¶”
- Carriage Return Line Feed “\CrLf”
- Slash n “\n”
- Carat p “^p”
- Other

When **Other** is the selected new line, enter the new line character to use in the box to the right of this list.

k. Use the **Text Quotation** list to select the character used in the text file to enclose quotations. The available characters are as follows:

- Normal Quotation Mark (”)
- Apostrophe (‘)
- None

l. Use the **Escape Quotes in Text Using** setting to select the method used to treat quotation marks in the text file as a regular character. The available modes are as follows:

- **Two Quotation Marks** — select this option to treat two quotation marks (””) as a single quotation mark (”) character with no special meaning.
- **Backslash Prefix** — select this option to treat backslash character followed by a quotation mark (\”) as a single quotation mark (”) character with no special meaning.

HTML character entity references are converted to the correct symbol, such as &copy (©) and &reg (®).

m. Click **OK**.

The **Text Linq - Configuration** dialog box closes and the new DataLinq Source is added to the **DataLinq Sources** section of the XPression DataLinq Server window.
White Way DataLinq Source

The White Way Linq - Configuration dialog box opens.

![White Way Linq - Configuration dialog box](image)

a. Use the Game Feed list to select a sports feed:
   - Basketball
   - Football (New)

b. Select the Trim Text check box to remove extra spaces from the feed.

c. In the Connection Options section, use the Connection Type options to select the connection to the White Way device:
   - UDP — select this option to use a UDP port as the connection type and configure the following:
     › Port — enter or select the UDP port number for the White Way device.
   - Serial — select this option to use a serial port as the connection type and configure the following:
     › Port — enter or select the serial port number for the White Way device.
     › Baudrate — use the list to select the communication speed for the signals.
     › Data Bits — use the list to select the number of bits used to represent one character of data for the signals.
     › Parity — use the list to select the method used to check for lost data in a signal.
     › Stop Bits — use the list to select the number of bits used to indicate the end of a byte in a signal.
     › Flow Control — use the list to select the data transmission rate controller for a signal.

d. Use the Data Logger list to select an encoding scheme for the data log. The options are:
   - None — select this option to use no data logging.
   - ASCII — select this option to use ASCII encoding for the data log.
   - HEX — select this option to use HEX file formatting for the data log.
   - Both — select this option to use both ASCII encoding and HEX file formatting for the data log.

e. Click OK.

The White Way Linq - Configuration dialog box closes and the new DataLinq Source is added to the DataLinq Sources section of the XPression DataLinq Server window.
XML DataLinq Source

The XML Linq - Configuration dialog box opens.

a. Enter in the XML Filename box the full pathname of the XML file that contains the data for the DataLinq source, or click Browse (...) to use the Open dialog box to locate and open the XML file.

b. Enter in the XSLT Filename box the full pathname of the XSLT file to use with the XML file, or click Browse (...) to use the Open dialog box to locate and open the XSLT file.

c. In the Options section, select one of the following radio buttons to determine when to check for XML source file changes:
   - Wait for file change events — update when the XML source file is updated. This is not recommended for network drives.
   - Poll every — select this radio button and then enter or select a time interval in seconds to poll the XML source file for any updates or changes.

d. Use the Encoding list to select an encoding protocol for XML data. The options are:
   - <automatic> — select this option to automatically detect the protocol.
   - UTF-8
   - UTF-16-BE
   - UTF-16-LE
   - ISO-8859
   - UCS2

e. Select the Ignore empty files (0 bytes) check box to ignore empty files from the text source and retain the previous data. This will also apply to files filled with invalid characters.

f. Select the Enable Table Presets check box to use the Table Presets tab to configure a list of preset tables that will be available in the Table dropdown option when browsing for data.

If table presets has been selected, click the Table Presets tab to configure the list of table presets when using an XML DataLinq.

The Table Presets tab opens.
Click **Add** to add a table preset to the list and configure the following:

- **Name** — enter a name for the table preset.
- **XML File Path** — enter the path for the XML data file or click **Browse (...)** to locate and select the file.
- **XSLT File Path** — enter the path for the XSLT file that will be used with the XML data file or click **Browse (...)** to locate and select the file.

g. In the **Options** section of the **Settings** tab, select the **Enable Logging** check box to record the XML DataLinq info in the XPression logs.

h. Select the **Wrap Indices** check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

i. Click **OK**.

The XML Linq - Configuration dialog box closes and the new DataLinq Source is added the **DataLinq Sources** section of the XPression DataLinq Server window.

**XML/JSON TCP DataLinq Source**

The XML/JSON TCP DataLinq Setup dialog box opens.

![XML/JSON TCP DataLinq Setup dialog box](image)

a. In the **Network Settings** section, select one of the following:
   - **TCP Server** — select this option to have the DataLinq Server listen for a connection from a remote client.
   - **TCP Client** — select this option to connect to a remote server listening and waiting for connections.
   - **UDP** — select this option to listen to UDP broadcasts.

b. Use the **TCP Port** box to enter or select the TCP Port number for the connection to the data.

c. Use the **IP Address** box to enter the IP address of the TCP client. The IP address is only applicable when TCP Client is selected.

d. In the **Options** section, select the **Use Table Presets** check box to use the **Table Presets** tab to configure a list of preset tables that will be available in the Table dropdown option when browsing for data.

   If table presets has been selected, click the **Table Presets** tab to configure the list of table presets when using an XML/JSON TCP DataLinq.
The **Table Presets** tab opens.

Click **Add** to add a table preset to the list and configure the following:

- **Name** — enter a name for the table preset.
- **Path** — enter the path that will be used as a filter to match the streamed data.
- **Mode** — select one of the following options:
  - **All Data** — load the entire message to the table.
  - **Path Data** — load the filtered node to the table.

**e.** Select the **Wrap Indices** check box to wrap the indices above the record count within record count limits. This check box should be selected when using looping queries.

**f.** Select the **Enable Logging** check box to record the XML/JSON TCP DataLinq info in the XPression logs.

**g.** Select the **Enable Command Parsing** check box to allow the XML/JSON TCP DataLinq to process table commands.

**h.** Select a data **Format**:
- **XML** — select this option to read XML data over a TCP socket.
- **JSON** — select this option to read JSON data over a TCP socket.

**i.** If using XML, use the **Encoding** list to select an encoding protocol for the XML data. The options are:
- `<automatic>` — select this option to automatically detect the protocol.
- **UTF-8**
- **UTF-16-BE**
- **UTF-16-LE**
- **ISO-8859**
- **UCS2**
- **ASCII**

**j.** If using XML, enter in the **XSLT File** box the full pathname of the XSLT file to use with the XML file, or click **Browse (…)** to use the **Open** dialog box to locate and open the XSLT file.

**k.** Click **OK**.

The XML/JSON TCP DataLinq Setup dialog box closes and the new DataLinq Source is added the **DataLinq Sources** section of the XPression DataLinq Server window.

6. In the **Name** column of the XPression DataLinq Server window, click a DataLinq Source name to select the DataLinq name.

7. Enter a new name for the selected DataLinq source.

**For More Information on**...
- connecting to a DataLinq Server from XPression, refer to the procedure “**Connect XPression to a DataLinq Server**” on page 20–36.
- creating a text object from a DataLinq source, refer to the procedure “**Link a Text Object to a DataLinq Data Source**” on page 20–37.
Connect XPression to a DataLinq Server

1. In the Editor window, select Project > DataLinq Manager.
   The XPression DataLinq Manager dialog box opens.

2. Click Add.
   The DataLinq Server - Properties dialog box opens.

3. In the Name box, enter a name for the new DataLinq server connection.
4. In the Host Address box, enter a the IP address of the computer running the DataLinq server to which to connect. Enter localhost when the DataLinq server is running on the same computer as XPression.
5. In the Port box, enter or select the port number used to communicate with the computer running the DataLinq server. The default port number is 8888.
6. Click OK.
   The defined DataLinq server connection is added to the DataLinq Servers section of the XPression DataLinq Manager dialog box. The DataLinq sources made available by the new DataLinq server connection are listed in the Available DataLinq Sources section.
7. To connect to additional DataLinq servers, follow steps 2 to 6.

For More Information on...
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 20–3.
- creating a text object from a DataLinq source, refer to the procedure “Link a Text Object to a DataLinq Data Source” on page 20–37.
Link a Text Object to a DataLinq Data Source

1. Add a text object to a scene.

2. In the Object Manager window, select the text object for the DataLinq.

3. Click the Data Source tab in the Object Inspector - Text Object window. The Data Source tab opens.

4. Select the DataLinq option. DataLinq information and a Set button are displayed below the options.

5. Click Set. The Set DataLinq Properties dialog box opens.

6. Select the Enabled check box to enable DataLinq property configuration for the text object.

7. Use the DataLinq list to select the DataLinq source that contains the data for the text object to display.

8. Click Browse to use the Select DataLinq Field dialog box to select the column and row, or table, that contains the text object data, or use the Column, Row, and Table boxes to enter the names of the column and row, or table, that contain the text object data.

9. Use the <n> Increment box to select or enter a value other than 0 when the <n> increment differs from the number of templates.
10. In the **Options** section:
   a. Select the **Live Update** check box to immediately update an online text object with changes from the associated DataLinq source changes when the scene is on-air.
   b. Select the **Entity Decoding** check box to translate HTML character entity reference codes into the correct corresponding characters.
      For example, the HTML character entity reference code `©` is translated into the © character for a text object.
   c. Select the **Return Empty on Failure** check box to leave the object empty if the DataLinq fails.
   d. Select the **Disable Font Tag Parser** check box to disable the parsing of {font} tags from the DataLinq source.
   e. Select the **Requery scene datalinqs on data page** check box to re-query all DataLinqs of a scene when a field with a DataLinq has been changed. This allows a DataLinq value such as ‘JerseyNumber’ to cause other fields such as ‘Stats’ to re-query.

11. In the **Data Result Modification** section, define an option string that will be prepended or appended to the resulting value that comes back from the DataLinq source, if necessary. This is useful for adding labels, units, or file paths to the data.
   a. Use the **Prepend** box to enter an option string to place at the beginning of the DataLinq value. The `%datalinqkey%` and `@textobject@` macros can be inserted.
   b. Use the **Append** box to enter an option string to place at the end of the DataLinq value. The `%datalinqkey%` and `@textobject@` macros can be inserted.
      Select the **Apply fields even when data is empty** check box to apply the option strings when the DataLinq value is empty. This is selected by default.

12. Click **OK**.
    Data from the selected DataLinq source is displayed by the selected text object.

For More Information on...
- adding a text object to a scene, refer to the procedure “Create a Text Object” on page 6–2.
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 20–36.
Link a Background Object to a DataLinq Source

1. Add a background object to a scene.
2. In the Object Manager window, select the background object for the DataLinq.

3. Click the DataLinq tab in the Object Inspector - Background Object window. The DataLinq tab opens.

4. Select the DataLinq option. The DataLinq Properties section is displayed.

5. Select the Enabled check box to enable DataLinq property configuration for the background object.
6. Use the DataLinq list to select the DataLinq source that contains the data for the background object to display.
7. Click Browse to use the Select DataLinq Field dialog box to select the column and row, or table, that contain the background object data, or use the Column, Row, and Table boxes to enter the names of the column and row, or table, that contain the background object data.

   This data could be formatted as a file path or a material name from the currently loaded project.

8. Select the Live Update check box to immediately update an online background object with changes from the associated DataLinq source changes when the scene is on-air.
9. Select the Entity Decoding check box to translate HTML character entity reference codes into the correct corresponding materials.
10. Select the Clear Image on Failure or Empty Data check box to clear the image if the value returned from the DataLinq is empty.
11. Select the Check datalinq for downloadable asset check box to check the DataLinq for downloadable assets when the scene is placed in the sequencer. This enables video clips from Inception to be DataLinq’d and downloaded for playout.

12. Use the <n> Increment box to select or enter a value other than 0 when the <n> increment differs from the number of templates.

For More Information on...
- adding a background object to a scene, refer to the procedure “Create a Background Object” on page 6–23.
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 20–36.
Link a Quad Object to a DataLinq Source

1. Add a quad object to a scene.
2. In the Object Manager window, select the quad object for the DataLinq.

3. Click the DataLinq tab in the Object Inspector - Quad Object window. The DataLinq tab opens.

4. Select the DataLinq option. The DataLinq Properties section is displayed.

5. Select the Enabled check box to enable DataLinq property configuration for the quad object.
6. Use the DataLinq list to select the DataLinq source that contains the data for the quad object to display.
7. Click Browse to use the Select DataLinq Field dialog box to select the column and row, or table, that contain the quad object data, or use the Column, Row, and Table boxes to enter the names of the column and row, or table, that contain the quad object data. This data could be formatted as a file path or a material name from the currently loaded project.
8. In the Options section:
   a. Select the Live Update check box to immediately update an online quad object with changes from the associated DataLinq source changes when the scene is on-air.
   b. Select the Entity Decoding check box to translate HTML character entity reference codes into the correct corresponding materials.
   c. Select the Clear Image on Failure or Empty Data check box to clear the image if the value returned from the DataLinq is empty.
d. Select the **Check datalinq for downloadable asset** check box to check the DataLinq for downloadable assets when the scene is placed in the sequencer. This enables video clips from Inception to be DataLinq’d and downloaded for playout.

e. Use the **<n> Increment** box to select or enter a value other than 0 when the <n> increment differs from the number of templates.

9. In the **Data Result Modification** section, define an option string that will be prepended or appended to the resulting value that comes back from the DataLinq source, if necessary. This is useful for adding labels, units, or file paths to the data.

   a. Use the **Prepend** box to enter an option string to place at the beginning of the DataLinq value. The %datalinqkey% and @textobject@ macros can be inserted.

   b. Use the **Append** box to enter an option string to place at the end of the DataLinq value. The %datalinqkey% and @textobject@ macros can be inserted.

Select the **Apply fields even when data is empty** check box to apply the option strings when the DataLinq value is empty. This is selected by default.

For More Information on...

- adding a quad object to a scene, refer to the procedure “Create a Quad Object” on page 8–2.
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 20–36.
Link a Sphere Object to a DataLinq Source

1. Add a sphere object to a scene.

2. In the **Object Manager** window, select the sphere object for the DataLinq.

3. Click the **DataLinq** tab in the **Object Inspector - Sphere Object** window.
   The **DataLinq** tab opens.

4. Select the **DataLinq** option.
   The **DataLinq Properties** section is displayed.

5. Select the **Enabled** check box to enable DataLinq property configuration for the sphere object.

6. Use the **DataLinq** list to select the DataLinq source that contains the data for the sphere object to display.

7. Click **Browse** to use the **Select DataLinq Field** dialog box to select the column and row, or table, that contain the sphere object data, or use the **Column**, **Row**, and **Table** boxes to enter the names of the column and row, or table, that contain the sphere object data.

   This data could be formatted as a file path or a material name from the currently loaded project.

8. Select the **Live Update** check box to immediately update an online sphere object with changes from the associated DataLinq source changes when the scene is on-air.

9. Select the **Entity Decoding** check box to translate HTML character entity reference codes into the correct corresponding materials.

10. Select the **Clear Image on Failure or Empty Data** check box to clear the image if the value returned from the DataLinq is empty.
11. Select the **Check datalinq for downloadable asset** check box to check the DataLinq for downloadable assets when the scene is placed in the sequencer. This enables video clips from Inception to be DataLinq’d and downloaded for playout.

12. Use the \(<n>\) Increment box to select or enter a value other than 0 when the \(<n>\) increment differs from the number of templates.

**For More Information on...**

- adding a sphere object to a scene, refer to the procedure “**Create a Sphere Object**” on page 8–5.
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “**Start the DataLinq Server**” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “**Connect XPression to a DataLinq Server**” on page 20–36.
Link a Cube Object to a DataLinq Source

1. Add a cube object to a scene.
2. In the Object Manager window, select the cube object for the DataLinq.

3. Click the DataLinq tab in the Object Inspector - Cube Object window.
   The DataLinq tab opens.

4. Select the side of the cube object from the Face list to which the material is to be applied.
5. Select the DataLinq option.
   The DataLinq Properties section is displayed.

6. Select the Enabled check box to enable DataLinq property configuration for the cube object face.
7. Use the DataLinq list to select the DataLinq source that contains the data for the cube object face to display.
8. Click Browse to use the Select DataLinq Field dialog box to select the column and row, or table, that contain the cube object face data, or use the Column, Row, and Table boxes to enter the names of the column and row, or table, that contain the cube object face data.
9. Select the Live Update check box to immediately update an online cube object face with changes from the associated DataLinq source changes when the scene is on-air.
10. Select the Entity Decoding check box to translate HTML character entity reference codes into the correct corresponding materials.
11. Select the Clear Image on Failure or Empty Data check box to clear the image if the value returned from the DataLinq is empty.
12. Select the **Check datalinq for downloadable asset** check box to check the DataLinq for downloadable assets when the scene is placed in the sequencer. This enables video clips from Inception to be DataLinq’d and downloaded for playout.

13. Use the **<n> Increment** box to select or enter a value other than 0 when the <n> increment differs from the number of templates.

14. Repeat steps 4 to 13 for all other cube object faces that a material from a DataLinq source is to be applied.

**For More Information on...**

- adding a cube object to a scene, refer to the procedure “Create a Cube Object” on page 8–8.
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 20–36.
Link a Cylinder Object to a DataLinq Source

1. Add a cylinder object to a scene.
2. In the Object Manager window, select the cylinder object for the DataLinq.
3. Click the DataLinq tab in the Object Inspector - Cylinder Object window.
   The DataLinq tab opens.

4. Select the face of the cylinder object from the Face list to which the material is to be applied.
5. Select the DataLinq option.
   The DataLinq Properties section is displayed.

6. Select the Enabled check box to enable DataLinq property configuration for the cylinder object.
7. Use the DataLinq list to select the DataLinq source that contains the data for the cylinder object to display.
8. Click Browse to use the Select DataLinq Field dialog box to select the column and row, or table, that contain the cylinder object data, or use the Column, Row, and Table boxes to enter the names of the column and row, or table, that contain the cylinder object data.
   This data could be formatted as a file path or a material name from the currently loaded project.
9. Select the Live Update check box to immediately update an online cylinder object with changes from the associated DataLinq source changes when the scene is on-air.
10. Select the Entity Decoding check box to translate HTML character entity reference codes into the correct corresponding materials.
11. Select the Clear Image on Failure or Empty Data check box to clear the image if the value returned from the DataLinq is empty.
12. Select the **Check dataLinq for downloadable asset** check box to check the DataLinq for downloadable assets when the scene is placed in the sequencer. This enables video clips from Inception to be DataLinq’d and downloaded for playout.

13. Use the **<n> Increment** box to select or enter a value other than 0 when the <n> increment differs from the number of templates.

14. Repeat steps 4 to 13 for all other cylinder object faces that a material from a DataLinq source is to be applied.

**For More Information on...**

- adding a sphere object to a scene, refer to the procedure “Create a Cylinder Object” on page 8–12.
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 20–36.
Link a Torus Object to a DataLinq Source

1. Add a torus object to a scene.
2. In the **Object Manager** window, select the torus object for the DataLinq.

3. Click the **DataLinq** tab in the **Object Inspector - Torus Object** window. The **DataLinq** tab opens.

4. Select the **DataLinq** option. The **DataLinq Properties** section is displayed.

5. Select the **Enabled** check box to enable DataLinq property configuration for the torus object.
6. Use the **DataLinq** list to select the DataLinq source that contains the data for the torus object to display.
7. Click **Browse** to use the **Select DataLinq Field** dialog box to select the column and row, or table, that contain the torus object data, or use the **Column**, **Row**, and **Table** boxes to enter the names of the column and row, or table, that contain the torus object data.
   
   This data could be formatted as a file path or a material name from the currently loaded project.

8. Select the **Live Update** check box to immediately update an online torus object with changes from the associated DataLinq source changes when the scene is on-air.
9. Select the **Entity Decoding** check box to translate HTML character entity reference codes into the correct corresponding materials.
10. Select the **Clear Image on Failure or Empty Data** check box to clear the image if the value returned from the DataLinq is empty.
11. Select the **Check datalinq for downloadable asset** check box to check the DataLinq for downloadable assets when the scene is placed in the sequencer. This enables video clips from Inception to be DataLinq’d and downloaded for playout.

12. Use the `<n> Increment` box to select or enter a value other than 0 when the `<n>` increment differs from the number of templates.

**For More Information on...**
- adding a torus object to a scene, refer to the procedure “Create a Torus Object” on page 8–15.
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 20–36.
Link a Slab Object to a DataLinq Source

1. Add a slab object to a scene.
2. In the Object Manager window, select the slab object for the DataLinq.

3. Click the DataLinq tab in the Object Inspector - Slab Object window.
   The DataLinq tab opens.

4. Select the face of the slab object from the Face list to which the material is to be applied.
5. Select the DataLinq option.
   The DataLinq Properties section is displayed.

6. Select the Enabled check box to enable DataLinq property configuration for the slab object face.
7. Use the DataLinq list to select the DataLinq source that contains the data for the slab object face to display.
8. Click Browse to use the Select DataLinq Field dialog box to select the column and row, or table, that contain
   the slab object face data, or use the Column, Row, and Table boxes to enter the names of the column and row,
   or table, that contain the slab object face data.
9. Select the Live Update check box to immediately update an online slab object face with changes from the
   associated DataLinq source when the scene is on-air.
10. Select the Entity Decoding check box to translate HTML character entity reference codes into the correct
    corresponding materials.
11. Select the Clear Image on Failure or Empty Data check box to leave the object face empty if the DataLinq
    fails.
12. Select the **Check datalinq for downloadable asset** check box to check the DataLinq for downloadable assets when the scene is placed in the sequencer. This enables video clips from Inception to be DataLinq’d and downloaded for playout.

13. Use the **<n> Increment** box to select or enter a value other than 0 when the <n> increment differs from the number of templates.

14. Repeat steps 4 to 13 for all other slab object faces to which a material from a DataLinq source is to be applied.

**For More Information on...**

- adding a cube object to a scene, refer to the procedure “Create a Slab Object” on page 8–18.
- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 20–36.
Using DataLinq Keys with an ADODB DataLinq

A DataLinq Key is a value that can be set up to globally increment the data field within a specific DataLinq template.

1. Open or create a project in XPression that uses an ADODB DataLinq.
2. Select a Scene or Scene Group in the Object Manager window.

3. Click the DataLinq Keys tab in the Object Inspector - Scene Object window.
   The DataLinq Keys tab opens.

4. Click Add.
   A new DataLinq Key is added to the Keys list.

5. In the Name column, enter a name for the DataLinq Key.
   It is important to give the key a meaningful name in regards to the scene or scene group; for example ‘Jersey Number’.

6. In the Published column, select the check box to publish the DataLinq key to the sequencer if necessary. This is selected by default.

7. Select an object in the scene or scene group that uses DataLinq as its data source and is to be linked with the DataLinq Key.
   For example, a text object that has a player name or a quad object that contains a player headshot.
8. Depending on the selected object, click the **Data Source** or **DataLinq** tab in the **Object Inspector** window of the object.

    The **Data Source** or **DataLinq** tab opens.

![Data Source or DataLinq tab in Object Inspector](image1.png)

9. Click **Set**.

    The **Set DataLinq Properties** dialog box opens.

![Set DataLinq Properties dialog box](image2.png)

10. In the **Row** box, enter the name of the DataLinq Key. For example, for the 'Jersey Number' example, enter `%Jersey Number%`.

11. Click **OK**.

    The **Set DataLinq Properties** dialog box closes.

12. Repeat steps 7 to 11 to link the DataLinq Key with other objects.

13. In the **Object Manager** window, select the **Scene** or **Scene Group** that contains the DataLinq Key.

14. Click the **DataLinq Keys** tab in the **Object Inspector - Scene Object** window.

    The **DataLinq Keys** tab opens.

15. Configure the value:

    **Layout**

    a. In the **Object Manager** window, select the **Scene** or **Scene Group** object that contains the DataLinq Key.

    b. Click the **DataLinq Keys** tab in the **Object Inspector - Scene Object** window.

        The **DataLinq Keys** tab opens.

    c. Enter a value (for example, a player jersey number) or a macro in the **Value** column of the DataLinq Key and press **Enter**.

        The objects linked to the DataLinq Key are updated in the Main Viewport with the data from the DataLinq source.
Sequencer

a. In the **Sequencer**, select the take item that contains the objects linked to the DataLinq Key.

b. Click the **Template Data** tab in the **Take Inspector - Item** window.

   The **Template Data** tab opens.

![Template Data tab](image)

   

c. Use the Template Data editor next to the Object List to enter a value for the DataLinq Key.

   The changes to the DataLinq Key value for the take item are reflected in the Preview window.

**For More Information on...**

- running a DataLinq server and configuring DataLinq sources, refer to the procedure “**Start the DataLinq Server**” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “**Connect XPression to a DataLinq Server**” on page 20–36.
- using a macro with a DataLinq Key, refer to the procedure “**Using a Macro with a DataLinq Key**” on page 20–62.
Using DataLinq Keys with an XML DataLinq

A DataLinq Key is a value that can be set up to globally increment the data field within a specific DataLinq template.

1. Open or create a project in XPression that uses an XML DataLinq source.
2. In the Object Manager window, select an object for the DataLinq.

3. Click the Data Source tab in the Object Inspector - Object window.
   The Data Source tab opens.

4. Select the DataLinq option.
   DataLinq information and a Set button are displayed below the options.
5. Click Set.
   The Set DataLinq Properties dialog box opens.

6. Select the Enabled check box to enable DataLinq property configuration for the object.
7. Use the DataLinq list to select the XML DataLinq source that contains the data for the object to display.
8. Click Browse.
   The Select DataLinq Field dialog box opens.
9. In the **Data** section, select a data attribute or child data element to use for the object. For example, if using an XML DataLinq for a sporting event, select a player uniform number as the attribute.

   ✠ It is often easier to use a second record as the data attribute because it automatically enters the brace brackets required to enter the data increment format.

10. **Click OK.**

    The **Select DataLinq Field** dialog box closes and the **Set DataLinq Properties** dialog box is updated with the selected DataLinq settings.

11. **Click OK.**

    The **Set DataLinq Properties** dialog box closes.

12. Repeat steps 2 to 11 to configure other objects in the scene or scene group that are to use DataLinq Keys. For example, if using a DataLinq for a sporting event, select the player name from the **Data** section in the **Select DataLinq Field** dialog box.

13. In the **Object Manager**, select the **Scene** or **Scene Group** that contains the DataLinq objects.

14. **Click the DataLinq Keys tab in the Object Inspector - Scene Object window.**

    The **DataLinq Keys** tab opens.
15. Click Add.

A new DataLinq Key is added to the Keys list.

16. In the Name column, enter a name for the DataLinq Key.

   It is important to give the key a meaningful name in regards to the scene or scene group; for example ‘jersey’.

17. In the Published column, select the check box to publish the DataLinq key to the sequencer if necessary. This is selected by default.

18. In the Value column, enter a default value for the DataLinq Key.

   For example, a jersey number.

19. Select the object in the scene or scene group that uses the DataLinq as its data source and is to be linked with the DataLinq Key.

20. Click the Data Source tab in the Object Inspector - Object window.

21. Click Set.

   The Set DataLinq Properties dialog box opens.

22. In the Column box, between the brace brackets, set up the data increments for the DataLinq Key value. For example, for the jersey number in this procedure, the data increment format would be <uni=%jersey%>.

   DataLinq Keys must always be wrapped in ‘%’ characters.

   DataLinq Keys can search multiple attributes or elements to return a node that matches all search criteria. For example, players<team=NY;jersey=10>.

23. Click OK.

   The objects in the scene are updated with the DataLinq Key values and the DataLinq settings are updated in the Data Source tab of the object.

24. Repeat steps 13 to 23 for any other objects in the scene or scene group that use DataLinq.

For More Information on...

- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 20–36.
Using SQL Queries

Use SQL queries to sort and filter data in templates.

1. Open or create a project in XPression that uses an ADODB DataLinq source.
2. In the Object Manager window, select an object for the DataLinq.

3. Click the Data Source tab in the Object Inspector - Object window. The Data Source tab opens.

4. Select the DataLinq option. DataLinq information and a Set button are displayed below the options.

5. Click Set. The Set DataLinq Properties dialog box opens.

6. Select the Enabled check box to enable DataLinq property configuration for the object.
7. Use the DataLinq list to select the ADODB DataLinq source that contains the data for the object to display.
8. Click Browse. The Select DataLinq Field dialog box opens.
9. Use the Table box to enter the query. For example, SELECT * FROM ROSTER ORDER BY PTS DESC. Queries entered into this field are case sensitive.
10. Click OK.

The **Select DataLinq Field** dialog box closes and the **Set DataLinq Properties** dialog box is updated with the query.

11. Click OK.

The **Set DataLinq Properties** dialog box closes.

12. In the **Data Source** tab in the **Object Inspector - Object** window, right-click inside the **Select Data Source** section and select **Copy DataLinq** from the shortcut menu.

13. In the **Object Manager**, select a different object to be used for the DataLinq query.

14. Click the **Data Source** tab in the **Object Inspector - Object** window.

The **Data Source** tab opens.

15. Select the **DataLinq** option.

16. Right-click inside the **Select Data Source** section and select **Paste DataLinq** from the shortcut menu.

The DataLinq source information is added to the **Select Data Source** tab.
17. Right-click inside the Select Data Source section and select Increment Row to increase the row number.

The Row number increases by one.

18. Repeat steps 13 to 17 for other objects to be used for the DataLinq query.

For More Information on...

- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 20–36.
Using a Macro with a DataLinq Key

1. Open or create a project in XPression that uses DataLinq.
2. Create a DataLinq Key.
3. Use the Sequencer or Layout to apply a macro to the DataLinq Key.

Sequencer

a. In the Sequencer, select the take item that contains the objects linked to the DataLinq Key.

b. Click the Template Data tab in the Take Inspector - Item window.

The Template Data tab opens.

c. In the Template Data editor next to the Object List, right-click and select a macro. The options are as follows:

   • Insert Macro > tak eid — select this macro to generate a DataLinq Key based on the Take ID number.
     This macro can be used as an equation. For example, if you have a Take ID number of 101 and want to
     access record 1 in the DataLinq, the tak eid macro with an equation would be entered as
     <%takeid% - 100>.

   • Insert Macro > groupid — select this macro to generate a DataLinq Key based on the Group ID number.
     This macro can be used as an equation. For example, if you have a Group ID number of 101 and want to
     access record 1 in the DataLinq, the groupid macro with an equation would be entered as
     <%groupid% - 100>.

   • Insert Macro > relid — select this macro to generate a DataLinq Key value based on the Take ID value
     relative to the Group ID value.

   • Insert Macro > DataLinq Keys > DataLinq Key — select this option to select a DataLinq Key and its
     value as the macro.
     This macro can be used as an equation. For example, if you have a DataLinq Key with a value of 20 and
     want to access record 30 in the DataLinq, the <DataLinq Key> macro with an equation would be entered
     as <%%DataLinq Key% + 10>.

Layout

a. In the Layout, select the scene that contains the objects linked to the DataLinq Key.

b. In the Object Manager window, select the Scene or Scene Group object that contains the DataLinq Key.

c. Click the DataLinq Keys tab in the Object Inspector - Scene Object window.

The DataLinq Keys tab opens.
d. In the **Value** column, enter a macro for the DataLinq Key. The options are as follows:

- **%takeid%** — enter this macro to generate a DataLinq Key based on the Take ID number.
  This macro can be used as an equation. For example, if you have a Take ID number of 101 and want to access record 1 in the DataLinq, the takeid macro with an equation would be entered as `<%takeid% - 100>`.

- **%groupid%** — enter this macro to generate a DataLinq Key based on the Group ID number.
  This macro can be used as an equation. For example, if you have a Group ID number of 101 and want to access record 1 in the DataLinq, the groupid macro with an equation would be entered as `<%groupid% - 100>`.

- **%relid%** — enter this macro to generate a DataLinq Key value based on the Take ID value relative to the Group ID value.

- **%DataLinq Key%** — enter a value to use as a macro.
  This macro can be used as an equation. For example, if you have a DataLinq Key with a value of 20 and want to access record 30 in the DataLinq, the `<DataLinq Key>` macro with an equation would be entered as `<%DataLinq Key% + 10>`.

**For More Information on...**

- running a DataLinq server and configuring DataLinq sources, refer to the procedure “[Start the DataLinq Server](#)” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “[Connect XPression to a DataLinq Server](#)” on page 20–36.
- creating a DataLinq Key, refer to the procedure “[Using DataLinq Keys with an ADO DB DataLinq](#)” on page 20–53.
Create a Data Page

Create Data Pages to use text/materials in an on-air scene to be updated via another take item in the Sequencer. Data Pages function as a holder for information. The Data Page can be cued prior to the original scene or taken after the original scene is already on the air.

1. Open a project in XPression.
2. Ensure that objects in the selected scene that are to be used with the Data Page(s) are published in the Template Links tab in the Object Inspector in Layout mode.
3. Create a Category in the Project Manager for storing the Data Pages. It is recommended that the category be given a meaningful name. For example, ‘Data Pages’.
   The new category appears in the Scene Manager.

4. Create a new scene in the newly created category.

5. In the new scene, create a text object, an object that uses a material (such as a quad or cube object), or a widget.
6. In the Object Manager, enter a name for the new object that is the same as the object in the on-air scene that will use the Data Page.
   For example, if the object in the on-air scene is named ‘DATA’, name the object in the Data Page scene ‘DATA’.
7. Publish the object using the Template Links tab in the Object Inspector in Layout mode.
8. In the Sequencer, create a new Group in the Take Item list and give it a meaningful name. For example, if the project is for a sports broadcast, the new Group could be named ‘Roster’. 
9. Add scenes to the new **Group** in the Take Item list that are to be used with the Data Page.

10. Create a new **Group** in the Take Item list for storing Data Pages and give it a meaningful name. For example, 'Data Pages'.

11. In the **Group** tab in the **Take Inspector - Group** window, select **Data Pages** from the **Playout Mode** list.

![Image](image1.png)

12. Drag the scene from the Data Pages **Category** in the **Scene Manager** and drop it in the **Group** item in the Take Item list used for the Data Pages.

- Ensure that the Data Page and the scene to which the data is being added are outputting on the same Layer and Framebuffer.

13. In the **Template Data** tab in the **Take Inspector - Item** window for the Data Page scene:

- Select the **Static** tab to use the **Template Data Editor** box to enter text for the Data Page. For example, 'WIDE RECEIVER'.

![Image](image2.png)

- Select the **DataLinq** tab to use the **DataLinq Properties** box to link the Data Page to a DataLinq.

![Image](image3.png)
• Select the **Widget** tab to use the **Widgets** list to link the Data Page to a widget.

![Widget tab in Take Inspector](image)


   The **State** displays as **data cued**.

   Conversely, double-click a scene to cue it for use with the Data Page scene.

15. Take online the scene that uses the Data Page scene, or if a scene has been cued for use with the Data Page scene, double-click the Data Page scene.

   The preview for a Data Page scene displays the Data Page scene as applied to a cued/online scene on the same layer. Conversely, the preview for a scene displays the scene as applied to a cued/online Data Page scene on the same layer.

**For More Information on...**

• creating a category, refer to the procedure “**Create a Category**” on page 26–2.

• publishing objects to the Sequencer, refer to the procedure “**Modify Template Content**” on page 21–3.
Using a Static URL

Use the RSS feed of a single URL as entered in the URL settings. It is refreshed asynchronously.

1. In the XPression DataLinq Server, add an RSS / HTTP DataLinq Source.
   The RSS / HTTP DataLinq - Configuration dialog box opens.

2. In the URL Settings section, use the URL box to enter the URL of an RSS feed. For example, https://www.rossvideo.com/media/rss-news.

3. Click OK.
   The RSS / HTTP DataLinq - Configuration dialog box closes and the RSS / HTTP DataLinq source is added to the DataLinq Sources list in the XPression DataLinq Server.

4. In XPression, create or select a scene that contains a text object.

5. In the Object Manager, select the text object from the Object list.
6. In the **Object Inspector**, click the **Data Source** tab.  
   The **Data Source** tab opens.

   ![Object Inspector - Text1 - Text Object](image)

7. In the **Select Data Source** section, select the **DataLinq** radio button.
8. Click **Set**.  
   The **Set DataLinq Properties** dialog box opens.

9. Use the **DataLinq** list to select the RSS / HTTP DataLinq source.
10. Click **Browse**.  
    The **Select DataLinq Field** dialog box opens.
11. In the **Data** section, select the row from the RSS feed that contains the info to add to the text object.
12. Click **OK**.  
    The **Select DataLinq Field** dialog box closes.
13. Click **OK**.  
    The **Set DataLinq Properties** dialog box closes and the text object is updated with the text from the RSS feed.

For More Information on...  
- running a DataLinq server and configuring DataLinq sources, refer to the procedure "**Start the DataLinq Server**" on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure "**Connect XPression to a DataLinq Server**" on page 20–36.
Using a Dynamic URL

Use multiple RSS feeds by configuring a dynamic URL. The results are refreshed on demand.

1. In the XPression DataLinq Server, add a an RSS / HTTP DataLinq Source. The RSS / HTTP DataLinq - Configuration dialog box opens.

2. In the URL Settings section, use the URL box to enter the URL of an RSS feed. For example, https://www.rossvideo.com/media/rss-news.

3. In the Mode section, select the Dynamic URL radio button and configure the following settings as necessary:
   - Cache Results for — use this box to enter or select an amount of time in milliseconds to cache the results of the query.
   - Timeout if data not received in — use this box to enter or a select a time in milliseconds to timeout the query if data has not been received in the specified amount of time.

4. In the URL box in the URL Settings section, create a DataLinq key in place of the RSS section of the URL entered in step 2. For example, change https://www.rossvideo.com/media/rss-news to https://www.rossvideo.com/media/rss-%feed%.

5. Click OK. The RSS / HTTP DataLinq - Configuration dialog box closes and the RSS / HTTP DataLinq source is added to the DataLinq Sources list in the XPression DataLinq Server.

6. In XPression, create or select a scene that contains a text object.

7. In the Object Manager, select the scene object from the Object list.
8. In the **Object Inspector**, click the **DataLinq Keys** tab.

The **DataLinq Keys** tab opens.

![DataLinq Keys tab](Image)

9. In the **DataLinq Keys** tab, click **Add**.

A DataLinq key is added to the **Keys** list.

![DataLinq Keys tab](Image)

10. In the **Keys** list, click inside the **Name** column of the DataLinq key and enter "feed" as the name.

11. Click inside the **Value** column and enter a variable ending of the URL being used for the DataLinq.

   For example, the URL being used is **https://www.rossvideo.com/media/rss-news** with the variable ending being replaced with the DataLinq key `%feed%` (**https://www.rossvideo.com/media/rss-%feed%**) in the DataLinq configuration.

12. In the **Object Manager**, select the text object from the **Object** list.

![Object Manager](Image)

13. In the **Object Inspector**, click the **Data Source** tab.

The **Data Source** tab opens.
14. In the Select Data Source section, select the DataLinq radio button.

15. Click Set.

The Set DataLinq Properties dialog box opens.

16. Use the DataLinq list to select the RSS / HTTP DataLinq source.

17. Click Browse.

The Select DataLinq Field dialog box opens.

18. In the Data section, select the row from the RSS feed that contains the info to add to the text object.

19. Click OK.

The Select DataLinq Field dialog box closes.

20. Click OK.

The Set DataLinq Properties dialog box closes and the text object is updated with the text from the RSS feed.

21. If the website has other RSS feed URLs, such as https://www.rossvideo.com/media/rss-events or https://www.rossvideo.com/media/rss-announcements, enter one of events or announcements in the Value column.

This can be executed for any amount of RSS URLs that have the same URL other than where the %feed% DataLinq key was entered, and any previous value entered can be returned to by reentering it as the value for the DataLinq key.

For More Information on...

- running a DataLinq server and configuring DataLinq sources, refer to the procedure “Start the DataLinq Server” on page 20–3.
- connecting to a DataLinq Server from XPression, refer to the procedure “Connect XPression to a DataLinq Server” on page 20–36.
Using Default URL Macros

Default URL macros are macros that replace the %macroname% tags in the URL configuration. Default URL macros enable browsing of the DataLinq source URL with default values when the URL contains macros that would usually be set by DataLinq keys in a scene.

1. Configure a dynamic URL in the Settings tab of the RSS / HTTP DataLinq - Configuration dialog box.
2. Click the Default URL Macros tab.
   - The Default URL Macros tab opens.

3. Click Add to add a URL replacement macro to the list and configure the following:
   - Name — enter a name for the URL replacement macro (for example, 'feed' if using a news website URL with an RSS feed).
   - Value — enter the value of the URL replacement macro (for example, 'world' if a news website URL has an RSS feed for world news).
4. Repeat steps 2 to 3 for any other URL replacement macros. For example, enter the name as 'national' for a more a national feed and enter the value as 'canada'.
5. Click the Settings tab.
   - The Settings tab opens.
6. In the URL box, enter a configured URL replacement macro in the section of the URL that represents the URL replacement macro.
7. Click OK.
   - The RSS / HTTP DataLinq - Configuration closes.
8. In the XPression DataLinq Server window, click Browse.
   - The Browse DataLinq dialog box opens to the RSS URL provided by the URL replacement macro.

For More Information on...
- configuring a dynamic DataLinq URL, refer to the procedure “Using a Dynamic URL” on page 20–69.
Using Table Presets

Table Presets are preset URL values for the Table list in the Select DataLinq Field window when using a dynamic URL RSS DataLinq with a text object. The Table Presets list represents preset values that are available in the Table list when browsing for data. The table can be used to dynamically change the URL by using a %table% macro inside the URL or as the entire URL.

1. Create a dynamic URL RSS DataLinq.
2. In the RSS / HTTP DataLinq - Configuration dialog box, click the Table Presets.
   The Table Presets tab opens.
3. In the Table Presets tab, click Add.
   A new table preset is added to the Table Presets list.
4. In the Table Presets list, click inside the Name column and enter a name for the table preset. For example, 'news' if the URL is https://www.rossvideo.com/media/rss-news.
5. Click inside the Value column and enter a URL value for the table preset. For example, https://www.rossvideo.com/media/rss-news if the name entered is 'news'.
6. Repeat steps 3 to 5 for other table presets as necessary.
7. Click the Settings tab.
   The Settings tab opens.

   ![Settings tab image]

8. In the URL Settings section, use the URL box to enter \%table\%.
9. In XPression, create or select a scene that contains a text object.
10. In the Object Manager, select the text object from the Object list.

   ![Object Manager image]

11. In the Object Inspector, click the Data Source tab.
    The Data Source tab opens.

   ![Object Inspector image]

12. In the Select Data Source section, select the DataLinq radio button.
13. Click **Set**.

The **Set DataLinq Properties** dialog box opens.

14. Use the **DataLinq** list to select the RSS / HTTP DataLinq source.

15. Click **Browse**.

The **Select DataLinq Field** dialog box opens.

16. In the **Selection** section, use the **Table** list to select an RSS DataLinq URL to display the data. The list is populated with the configured table presets.

17. In the **Data** section, select an item to display in the text object.

18. Click **OK**.

The text object displays the selected item from the RSS URL.

**For More Information on...**

- configuring a dynamic DataLinq URL, refer to the procedure “Using a Dynamic URL” on page 20–69.
Sequences

XPression uses the Sequencer to playout the scenes in a project.

The following topics are discussed in this section:

• Create a Sequence
• Modify Template Content
• Control Sequence Playout
• Playout a Sequence in Manual Mode
• Playout a Sequence in Automatic Mode
• Create a Roll/Crawl from a Take Item Group
• Customize a Take Item Group Roll/Crawl
• Playout a Take Item or Take Item Group Using Timecode
• Render Take Items to Video
Create a Sequence

1. Use XPression to create a number of scenes or scene groups from which to build a sequence.

2. Click **Sequence** at the top of the window to use the **Sequencer** to place scenes or scene groups on a sequence timeline for playout.

3. In the **Scene Manager**, click and drag the scenes or scene groups to playout into the **Sequencer**. Each scene or scene group added to the Sequencer list is given a Take ID and becomes a take item.

4. To reorder take items in the Sequencer list, click and drag a take item to a new position in the list. Toolbar tools, shortcut menu commands, and keyboard shortcuts can also be used to reorder take items.

5. Organize take items by adding a take item group to the Sequencer list. A group can be configured to automatically playout the take items contained in the group.

   **Steps**
   
   a. Click the **Create a New Group** button in the toolbar.
      
      A take item group is added to the Sequencer.
   
   b. Click in the **Name** column for the group to enter a new name for the group.
   
   c. Click and drag take items from the Sequencer list into the new group.

6. Highlight take items by adding color to the Sequencer list.

   **Steps**
   
   a. Select one or more take items and/or take item groups to highlight with a colored background.
   
   b. Right-click and select **Color**.
      
      The **Color** menu opens.
   
   c. Select a highlight color from the **Color** menu.
      
      The background of the selected take items in the Sequencer list is shaded with the selected color. Coloring the background of a take item group also colors each take item in the group.

7. Adjust the font size of the take items by clicking the **Increase the size of the sequencer font** button to make the font size larger or the **Decrease the size of the sequencer font** button to make the font size smaller.

For More Information on...

- creating scenes, refer to the procedure “Create a Scene” on page 5–4.
- controlling sequence playout, refer to the procedure “Control Sequence Playout” on page 21–5.
Modify Template Content

1. In XPression, use the Scene Manager window to select a scene or scene group that contains objects to use as a template in a sequence.
2. In the Object Manager, select an object to use as a template.
3. Click the Template Links tab in the Object Inspector window.
4. In the Template Links section, select the Publish Object check box.
5. In the Published column, select the check boxes associated with the object attributes to publish.
6. Note the name of the template object.
7. Click Sequence at the window to use the Sequencer to place the scene or scene group containing the template object on a sequence timeline for playout.
8. Add the template object scene or scene group to the Sequencer.
9. In the Sequencer, select the take item created for the template object scene or scene group.
10. Click the Template Data tab in the Take Inspector - Item window.
11. In the **Objects** column, expand the template object. The attributes published for the template object are displayed.

12. Select the attribute to set a value for playout.

   If the template object is a text object, the text box to the right in the **Static** tab displays the value of the selected attribute. For other template objects, the **Materials** tab, **Image Files** tab, or **Video Files** tab displays the value of the selected attribute.

**Text Objects**

   a. In the **Static** tab:
      - use the text box to change the font for the text by entering a tag (e.g. \{font number or name\}) that represents the name or ID of the font to be used. Entering an empty font tag of {} will restore the original font.
      - use the text box to enter and apply a material tag and font attribute layer by digit (1-5). For example, \{M:1:material name\} for **Face**, \{M:2:material name\} for **Border**, \{M:3:material name\} for **Stroke**, \{M:4:material name\} for **Neon**, \{M:5:material name\} for **Shadow**.
      - click the **Insert Font Change Macro** button to select a font thumbnail to apply to the attribute. The tag for the selected font is automatically placed at the current cursor location.

   b. To open a saved text file in the template, click the **File** menu and select **Import** to open the **Import Text File** dialog box.

   c. Adjust the font size of the text by clicking the **Increase Font Size** button to make the font size larger or the **Decrease Font Size** button to make the font size smaller.

**Other Objects**

   a. Select the **Materials** tab to open the list of material thumbnails.
   b. Double-click a material thumbnail to apply the material as the value of the attribute.
   c. Select the **Image Files** tab to open the list of image file thumbnails.
   d. Double-click an image file thumbnail to apply the image as the value of the object attribute. Use the browser above the image file thumbnails to open a different image file location.
   e. Select the **Video Files** tab to open the list of video material thumbnails.
   f. Double-click a video file thumbnail to apply the video file as the value of the object attribute. If the object had originally been assigned a video file, the properties of that video will be applied to the newly assigned video. Use the browser above the video file thumbnails to open a different video file location.

13. In the **Sequencer**, double-click the template object take item. The selected take item plays out through the default output using the entered attribute values.

14. To stop playout, right-click the template object take item and select **Take Offline** from the shortcut menu.

**For More Information on...**

   • creating sequences, refer to the procedure “Create a Sequence” on page 21–2.
   • controlling sequence playout, refer to the procedure “Control Sequence Playout” on page 21–5.
Control Sequence Playout

1. In the **Sequencer**, click the **Create a New Group** button in the toolbar to create a take item group to contain the scenes or scene groups to playout.

2. In the **Scene Manager**, click and drag the scenes or scene groups to playout into the new take item group in the **Sequencer**.

   The selected scene or scene groups are added to the take item group as take items.

3. To reorder a take item in a take item group, click and drag a take item to a new position in the group.

4. Select the take item group that contains the take items to playout.

5. In the **Take Inspector - Group** window, select **Manual** from the **Playout Mode** list.

6. In the **Sequencer**, double-click a take item to playout the selected take item.

   The selected take item plays out through the default output, and the **State** changes to **online** for take items or **Active** for take item groups.
7. To stop playout of an online or Active take item, right-click the take item and select **Take Offline** from the shortcut menu.

---

**Keyboard Control**

The keyboard number pad can also be used to control the playout of a sequence. The following keyboard shortcuts are available in the Sequencer:

- **Cursor Up Arrow** — select the previous take item in the sequence.
- **Cursor Down Arrow** — select the next take item in the sequence.
- **Cursor Left Arrow** — collapse an expanded sequence group.
- **Cursor Right Arrow** — expand a collapsed sequence group.
- **Home** — select the first take item in the sequence.
- **End** — select the last take item in the sequence.
- **Ctrl-Cursor Up Arrow** — move the selected take item up one position in the sequence.
- **Ctrl-Cursor Down Arrow** — move the selected take item down one position in the sequence.
- **Ctrl-Shift-Page Up** — select previous scene template.
- **Ctrl-Shift-Page Down** — select next scene template.
- **Ctrl-Page Up** — select the previous object in the Template Data tab for the selected take item.
- **Ctrl-Page Down** — select the next object in the Template Data tab for the selected take item.
- **Delete** — remove the selected take item from the sequence. The associated scene or scene group is not deleted.
- **+/-** — increase (+) or decrease (-) the speed of a roll/crawl while it is online.
- **Number Pad Enter** — playout the selected take item. This shortcut requires the **Fast Recall** button to be enabled.
- **Number Pad +** — playout the selected take item and select the next take item in the sequence.
- **Number Pad -** — take the current take item offline if it is online.
- **Number Pad .** — cue a selected take item prior to putting them online by pressing the decimal key on the number pad. Cueing them will pre-cache all video clips in the scene. Multiple items can be cued and brought to air simultaneously.
- **Number Pad *” — focus a take item. This shortcut requires the **Fast Recall** button to be enabled.
Playout a Sequence in Manual Mode

1. In the **Sequencer**, select the take item group that contains the take items to playout.

2. In the **Take Inspector - Group** window, select **Manual** from the **Playout Mode** list.

3. In the **Sequencer**, click the take item to playout.
   The selected take item plays out through the default output.

4. To stop playout of a take item, right-click the take item and select **Take Offline** from the shortcut menu.

For More Information on...
- creating sequences, refer to the procedure “Create a Sequence” on page 21–2.
- controlling sequence playout, refer to the procedure “Control Sequence Playout” on page 21–5.
Playout a Sequence in Automatic Mode

1. In the Sequencer, select the take item group that contains the take items to playout.

2. In the Take Inspector - Group window, select Timed from the Playout Mode list.

3. Use the Start at list to set the playout start time for the take item group. The available options are as follows:
   - Immediate — start playout immediately upon selecting a take item group for playout.
   - Clock Time — start playout at the time set in the Start Time box after selecting a take item group for playout.

4. Use the Item Timing list to select the item level on which to base playout duration. The available options are as follows:
   - Item Duration — use the playout durations set for the items in the item group. The playout duration for the item group equals the total of all the item durations.
   - Group Duration — set a playout duration for the entire item group. The duration is set in the Group Duration box.
   - Fixed Item Duration — use a fixed playout duration for each of the items in the item group regardless of the durations of the individual take items. The duration for each item is set in the Item Duration box.
   - Scene Director — use the default scene director of a scene to control when an item group should advance.
   - Advance Manually — double click the scene group or use a script to advance the item group manually.

5. Use the Repeat list to set the number of times to repeatedly playout the item group. The available options are as follows:
   - Never — do not repeat playout, only playout the item group once.
   - When Done — repeat the playout of an item group when the playout ends. With this option, playout continually repeats until it is manually stopped.
   - After — repeat the playout of an item group after the time set using the Time Value box and Time Unit list. With this option, playout continually repeats until it is manually stopped.
   - Every — repeat the playout of an item group at a time interval set using the Time Value box and Time Unit list.

6. Use the When Finished list to set the action to complete after finishing the playout of the take item group. The available options are as follows:
   - Keep Online — leave the take item group status as Active, making the group available for immediate playout.
   - Take Offline — change the take item group status to Offline.
7. In the **Sequencer**, double-click the take item group that contains the take items to playout. The selected take item group plays out through the default output, and the **State** changes to **Active**.

**For More Information on...**
- creating sequences, refer to the procedure “Create a Sequence” on page 21–2.
- controlling sequence playout, refer to the procedure “Control Sequence Playout” on page 21–5.
Create a Roll/Crawl from a Take Item Group

1. Create a new XPression project or open an existing project to add a roll/crawl effect.
2. Create one or more scenes or scene groups to contain the objects displayed by the roll/crawl effect.
3. Select a scene and scene objects to it that are to move as part of the roll/crawl effect.
   For example, add a text object to a scene to represent the first line of text for a set of credits to be played by the roll/crawl effect.
4. Add objects to additional scenes as required.
   For example, each scene contains a text object that represents one line of text in a set of credits played by the roll/crawl effect.
5. Click Sequence at the top of the window to use the Sequencer to place scenes or scene groups on a sequence timeline for playout.
6. In the Sequencer, click the Create a New Group button in the toolbar to create a take item group to contain the scenes or scene groups that comprise the roll/crawl effect.
7. In the Scene Manager, click and drag the scenes or scene groups for the roll/crawl effect into the new take item group in the Sequencer.
8. To reorder take items in the roll/crawl effect, click and drag a take item to a new position in the take item group.
9. Select the take item group that contains the roll/crawl effect.
10. In the Take Inspector - Group window, select Roll/Crawl from the Playout Mode list.

11. In the Sequencer, double-click the take item group that contains the roll/crawl effect to playout the defined roll/crawl effect.

   The selected take item group plays out through the default output, and the State changes to Active.

For More Information on...

• customizing a sequence roll/crawl effect, refer to the procedure “Customize a Take Item Group Roll/Crawl” on page 21–12.
• controlling sequence playout, refer to the procedure “Control Sequence Playout” on page 21–5.
Customize a Take Item Group Roll/Crawl

1. In the Sequencer, select the take item group the contains the roll/crawl effect to customize.

   ![Take Item Group Table]

   The properties of the selected take item group are displayed in the Take Inspector - Group window.

2. Use the properties in the Group section to set roll/crawl effect properties for a take item group.

   **Properties**

   **Effect** — use this list to select the roll/crawl effect with which to playout take items in a take item group. The available effects are as follows:
   - Roll — move take items vertically.
   - Crawl — move take items horizontally.

   **Direction** — use this list to select the direction for the selected roll/crawl effect. The available directions depend on the selected Effect, and are as follows:

<table>
<thead>
<tr>
<th>Roll Effect</th>
<th>Crawl Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bottom To Top</td>
<td>Right To Left</td>
</tr>
<tr>
<td>Top To Bottom</td>
<td>Left To Right</td>
</tr>
</tbody>
</table>

3. Use the properties in the Duration section to set the playout duration for the selected roll/crawl effect.

   **Properties**

   **Speed** — select this option to define the roll/crawl effect playout duration in pixels per second. Use the box to the right of this option to enter or select the number of pixels per second to playout a roll/crawl effect.

   **Seconds** — select this option to define the roll/crawl effect playout duration in seconds. Use the box to the right of this option to enter or select the number of seconds in which to playout a roll/crawl effect.

   **Frames** — select this option to define the roll/crawl effect playout duration in frames. Use the box to the right of this option to enter or select the number of frames in which to playout a roll/crawl effect.
4. Use the properties in the **Global Margins** section to set the spacing between take items displayed in a roll/crawl effect.

**Properties**

**Top** — in this box, enter or select the size in pixels of the margin placed above take items. This margin is used to control vertical spacing between consecutive take items played out in a roll effect.

**Bottom** — in this box, enter or select the size in pixels of the margin placed below take items. This margin is used to control vertical spacing between consecutive take items played out in a roll effect.

**Left** — in this box, enter or select the size in pixels of the margin placed to the left of take items. This margin is used to control horizontal spacing between consecutive take items played out in a crawl effect.

**Right** — in this box, enter or select the size in pixels of the margin placed to the right of take items. This margin is used to control horizontal spacing between consecutive take items played out in a crawl effect.

5. Use the properties in the **Loop** section to set the number of times to playout a roll/crawl effect.

**Properties**

**Enable Looping** — select this check box to loop the playout of a roll/crawl effect. Clear this check box to only playout the roll/crawl effect one time.

**Number of Shows Per Scene** — in this box, enter or select the number of times to loop the playout of a roll/crawl effect. Enter 0 to infinitely loop the playout.

This box is only available when the Enable Looping check box is selected.

6. Use the properties in the **Header/Footer** section to set the type of page with which to start and end a roll/crawl effect.

**Properties**

**Blank Page on Start** — select this check box to start the roll/crawl effect with a blank page before displaying the take items in the roll/crawl effect. Clear this check box to start the roll/crawl effect with the first take item in the take item group.

**Blank Page on End** — select this check box to end the roll/crawl effect with a blank page after displaying the take items in the roll/crawl effect. Clear this check box to end the roll/crawl effect with the last take item in the take item group.

**Treat Last Page as Full** — select this check box to display the last take item in a roll/crawl effect as a full page.

7. Use the properties in the **Start/Stop** section to control the start and end playout speed of a roll/crawl effect.

**Properties**

**Ease In** — select this check box to slow the playout speed at the start of a roll/crawl effect.

- **Frames** — in this box, enter or select the number of frames at which to return a roll/crawl effect to normal playout speed.

**Ease Out** — select this check box to slow the playout speed at the end of a roll/crawl effect.

- **Frames** — in this box, enter or select the number of frames from the end of a roll/crawl effect at which to slow the playout speed.

8. Use the property in the **Rendering** section to control lighting for a roll/crawl effect.

**Property**

**Per Scene Lighting** — select this check box to use a different lighting source for each take item in a roll/crawl effect. Clear this check box to use the lighting source in the first take item of the take item group for all of the other take items in the roll/crawl effect.

9. Double-click the take item group to playout the customized roll/crawl effect.

The selected take item group is sent to the default output.
Playout a Take Item or Take Item Group Using Timecode

Play take items or take item groups in the Sequencer using a timecode source.

1. In the Sequencer, enable timecode by right-clicking inside the column headers of the sequence list and selecting Columns > Timecode Start.

   The Timecode Start column is added to the displayed columns of the sequence list.

2. Select a take item or take item group in the sequence list.
Take Item

If a take item is selected, do the following:

a. In the Take Inspector - Item window, click the Scene Control tab.
   The Scene Control tab opens.

![Scene Control Tab](image)

b. In the Timecode / Automation section, select the Play at Timecode box to enable a timecode start for the selected take item.

   Use the timecode box to enter or select a specific timecode start time for the selected take item.

Take Item Group

* A timecode source needs to be configured in the Hardware Setup before using timecode with Sequencer take item groups.

If a take item group is selected, do the following:

a. In the Take Inspector - Group window, click the Timecode / Automation tab.
   The Timecode / Automation tab opens.

![Timecode / Automation Tab](image)

b. In the Timecode Settings section, select the Enabled check box to enable a timecode source for the selected take item group.

c. Use the Timecode Source list to select an available timecode source.

   This menu is populated with the internal clock of the XPression system and the timecode sources that have been configured in the Timecode Sources tab of the Hardware Setup dialog box.

For More Information on...

- configuring a timecode source, refer to “Add a Timecode Source” on page 3–94.
**Render Take Items to Video**

Export take items in the Sequencer to video to store in a folder or the Clip Store.

1. Select a take item or take items in the **Sequencer**.

2. Click **File > Export Take Item To > Video**.

   The Export to Video dialog box opens.

3. In the Export to Video dialog box, select the check box of the **Take ID** to export. Select the respective check boxes of Take IDs if exporting multiple videos.

4. Select a **Destination** for the video(s):
   - **Folder** — select this option to save the video(s) to a target folder.
   - **Clip Store** — select this option to save the video(s) to the Clip Store for use within a clips workflow.

   **Folder**
   a. Use the **Naming** list to select whether to use a fixed base name or the sequence item name for the video. The available options are:
      - **Base Name** — select this to use a fixed base name for the video.
        If selected, use the **Base Name** text box to enter a central name for the file or files to be exported. Unicode is supported for filenames.
      - **Use Item Name** — select this to use the sequence item name(s) for the file(s) to be exported.
b. Use the **File Numbering** list to select the numbering convention for the file or files to be exported. The available options are:
   - **Take ID** — select this to save the file or files by Take ID number.
   - **Incremental** — select this to save the file or files by incremental numbers.

c. Use the **Target Folder** box to enter a file path for the target folder where the take item is to be exported as a video, or click the **Browse** button to select a folder.

d. Use the **File Format** list to select the video format for the file or files. The available options are:
   - **MOV** (QuickTime encoder required)
   - **AVI**

e. Use the **Codec** list to select an encoder.

f. If **XPression Codec** is selected, click **Codec Settings**.

   The XPression Video Codec 2 dialog box opens.

![](image)

   g. In the **Compression Settings** section, use the **Quantization Level** box to enter or select the percentage of the color sampling. The higher the percentage, the better the color sampling quality. The default of 80 is recommended.

   h. In the **Input Format** section, use the **Color Space** list to select the specific organization of colors for the compression. The options are:
      - **Standard RGB (sRGB)**
      - **ITU-R BT.601 / Rec. 601**
      - **ITU-R BT.709 / Rec. 709**
      - **ITU-R BT.2020 / Rec. 2020**

   i. Use the **Gamma Curve** list to select the method for optimizing the usage of bits for encoding the video. The options are:
      - **Standard Dynamic Range**
      - **Hybrid Log Gamma (HLG)**
      - **Perceptual Quantization (PQ)**

   j. Select the **Ignore alpha channel for 64 bit input formats** check box to ignore the alpha channel in the encoding when using 64-bit input formats.

   k. Click **OK**.

   The XPression Video Codec 2 dialog box closes.

The video settings can be saved to a file by clicking the **Save Profile** button. Click **Load Profile** to open a file browser to locate and select previously saved video settings.
Clip Store

a. Use the **Naming** list to select whether to use a fixed base name or the sequence item name for the video. The available options are:
   - **Base Name** — select this to use a fixed base name for the video.
     If selected, use the **Base Name** text box to enter a central name for the file or files to be exported.
     Unicode is supported for filenames.
   - **Use Item Name** — select this to use the sequence item name(s) for the file(s) to be exported.

b. Use the **File Numbering** list to select the numbering convention for the file or files to be exported. The available options are:
   - **Take ID** — select this to save the file or files by Take ID number.
   - **Incremental** — select this to save the file or files by incremental numbers.

c. Use the **Project** list to select a project in the Clip Store in which to save the video, or enter a new project name to add to the Clip Store.

   Select the **Looping** check box to save the video with looping enabled by default.

   Select the **Hold Last Frame** check box to hold the last frame of the saved video by default.

5. Use the **Frame Mode** list to select the frame mode for the video(s). The available options are:
   - **From Project** — select this to use the project frame mode.
   - **Upper Field First** — select this to override the project frame mode and render in upper field first video.
   - **Lower Field First** — select this to override the project frame mode and render in lower field first video.
   - **Frame Based** — select this to render the video(s) as frame based.

6. Use the **Color Mode** list to select a color mode for the video file. The available options are:
   - **True Color** — select this to use 24-bit color.
   - **True Color + Alpha** — select this to use 24-bit color with alpha.

7. Use the **Fill Mode** list to select the method used to process fill before output. The available processing methods are as follows:
   - **Shaped** — shape the fill signal color information by the luminance information in the key signal.
   - **Unshaped** — output the fill and key signals “as is”.

8. Use the **Size** list to select a frame size for the video(s). The available options are:
   - **From Project** — select this to use the project dimensions.
   - **From Project (virtual)** — select this to use the viewport resolution. This is only applicable to video formats with non-square pixels.
   - **From Scene** — select this to use the scene dimensions.

9. Use the **Audio** list to select an audio setting for the video(s). The available options are:
   - **None** — select this to use no audio for the video(s).
   - **Linear PCM, 16bit, 2ch** — select this to export with two channel audio.

10. Click **Export**.

    The take item is exported to video. The **Progress** bar displays the progress of the video(s) being saved.
Record Client

Use the Record Client dialog box to record an input as a video file or as a still image.

The following topics are discussed in this section:

- Recording a Video from an Input
- Capturing a Still Image from an Input
- Using Multiple Records Clients
- Using Fill/Key Simultaneously
- Create a Material from a Video or Image
- Send a Video or Image to Clip Store
Recording a Video from an Input

Use the Record Client to record and save input video as a video file. The recordings will be made into the XPression Video Codec AVI format.

* When using a NewTek™ Network Device Interface (NDI™), XPression video recordings are in the format and video mode of the input NDI source, not the project mode.

1. In XPression, click the Record Client ( ) toolbar icon.
   
The Record Client dialog box opens.

2. Use the Input list to select the input that contains the source video for the file to be recorded.
   
The video loads in the preview window.

3. In the Base Name box, enter a name for the video file to be recorded.
4. Use the **Bit Depth** list to select the quality of the signal quantization for the clip:
   - 24 bit RGB or;
   - 32 bit RGBA to include the alpha.

5. Use the **Audio Channels** list to select the number of active audio channels to use with the recording.

6. Use the **Destination Folder** box to enter a file path for the destination folder where the video will be stored or click **Browse (…)** to open a file browser and select a file path.
   Any videos or images that have been previously stored in the selected destination folder will appear as AVI and TGA thumbnails next to the folder tree.

   ✴ A default record folder can be configured in the **Folders** section of the **Preferences** dialog box.

7. Click **Crash Record** to start recording the video.

   The video begins recording and a .avi video file thumbnail is displayed.

   An indicator appears at the top of XPression that lists the active recording.

   If the Record Client dialog box has been closed or minimized, click the **Active Recording** indicator to open the Record Client dialog box.

   If using the XPression Clip Server option, multiple Record Clients can be active and the Active Recording indicator will display multiple active recordings. In this case, clicking the Active Recording indicator will open the **Record Monitor** window where the multiple recordings can be tracked and managed.

   ✴ Click the **Split** button to stop the recording and begin recording a new video from the input. This is helpful when recording a lengthy video feed, such as a live feed. The filename for the new recording increments automatically.
8. Click **Stop Record** to stop recording the video. The .avi video thumbnail is completed and the video is added to the **Recent Recordings** list.

![Xpression Record Client](image)

🌟 Click **Explore** to locate and open the video file for viewing in a media player.

**For More Information on...**

- using multiple Record Clients, refer to “Using Multiple Records Clients” on page 22–8.
- configuring a default record folder, refer to “Set Preferences” on page 3–2.
Capturing a Still Image from an Input

Use the Record Client to capture and save input video as a still image.

1. In XPression, click the Record Client ( ) toolbar icon.
   
The Record Client dialog box opens.

2. Use the Input list to select the input that contains the video to be captured as a still image file.
   
The video loads in the preview window.

3. In the Base Name box, enter a name for the image file to be captured.

4. Use the Bit Depth list to select the quality of the signal quantization for the image:
   
   - 24 bit RGB or;
   - 32 bit RGBA to include the alpha.
5. Use the **Grab Settings** menu to select one of the following interlace options for the image file:
   - **Interlaced Settings > Frame Based** — select this to capture the image file without deinterlacing. This setting only works best for scenes with minimal motion.
   - **Interlaced Settings > Field (line doubled)** — select this to capture the image file with each line doubled. For example, it will replace field two with a duplicate of field one.
   - **Interlaced Settings > Field (line interpolated)** — select this to capture the image file by interpolating between odd lines to form even lines.

6. Use the **Grab Settings** menu to select one of the following image file formats for the image:
   - TGA (Targa)
   - PNG (Portable Network Graphic)
   - JPG

7. Use the **Destination Folder** box to enter a file path for the destination folder where the image will be stored or click **Browse (...)** to open a file browser and select a file path.

   Any videos or images that have been previously stored in the selected destination folder will appear as AVI and TGA, PNG, or JPG thumbnails next to the folder tree.

   A default record folder can be configured in the **Folders** section of the **Preferences** dialog box.

8. Click **Grab Still** to capture a frame from the input video as a still image. Still images can be captured without recording the video or while the video is being recorded. Field-based still images can also be captured.

   A .tga, .png, or .jpg image thumbnail is displayed.

   In this procedure, the **Base Name** for the recording and still images has been changed to “crash record still grabs” for demonstrative purposes.
9. If recording the input video while creating still images, click **Grab Still** as many times as necessary for any other desired still images. 

Multiple .tga, .png, or .jpg image thumbnails are displayed.

10. If recording the input video while creating still images, click **Stop Record** to stop recording the video once finished grabbing still images.

The .avi video thumbnail is completed and the video is added to the Recent Recordings list.

* Click **Explore** to locate and open an image file or video file for viewing.

**For More Information on...**
- configuring a default record folder, refer to “Set Preferences” on page 3–2.
Using Multiple Records Clients

If using XPression Clips, multiple Record Clients can be opened and used simultaneously to record videos and capture still images.

* There is no limit to how many Records Clients can be open, but it is highly recommended that no more than four recordings occur at a time providing there is nothing being sent to output during recording. Otherwise, performance issues could occur. Recording to network locations (NAS/SAN) may or may not be possible depending on the bandwidth available.

To open multiple Record Clients, click the Record Client ( ) toolbar icon in XPression to open the Record Client dialog box. Click the Record Client ( ) toolbar icon again to open a second Record Client dialog box, click it a third time to open a third, etc.

When selecting a Destination Folder to store videos and images, if the selected folder already has stored videos or images, these previously created files will appear next to the folder tree as AVI and TGA thumbnails. If the same folder has been selected across multiple Record Clients, these files will appear in the area next to the folder tree in all the open Record Clients that are using that file path, as well as any currently recording video using that file path.

All recent recordings, regardless of the selected file path, will appear in each of the open Record Clients in the Recent Recordings list:

When recording a video using the Record Client, an indicator appears at the top of XPression that lists the number of active recordings.

Click the Active Recordings indicator to open the Record Monitor window to view all active recordings in all open Record Clients:

- Select an active recording and click Open Record Client to open the Record Client used for recording the selected recording.
- Select an active recording and click Delete to discard the selected recording.
- If a selected recording has been stopped in its respective Record Client, the Active status will be listed as Stopped.

For More Information on...
- recording an input video, refer to “Recording a Video from an Input” on page 22–2.
- capturing an input still image, refer to “Capturing a Still Image from an Input” on page 22–5.
Using Fill/Key Simultaneously

This option is only available if using the Matrox XMIO board with XPression.

Using the Record Client, a video plus alpha can be recorded simultaneously by configuring the option in the Input tab in the Matrox XMIO - Framebuffer Setup dialog box.

1. In XPression, use the Hardware Setup to configure a Matrox XMIO board in the Matrox XMIO - Framebuffer Setup dialog box.

2. In the Matrox XMIO - Framebuffer dialog box, select the Input 2 tab.

3. In the Options section, select the Use Input 2 as Key Channel for Input 1 check box to use key/fill simultaneously.

For More Information on...
- configuring the Matrox XMIO board, "Configure a Matrox Video X.mio2 FrameBuffer" on page 3–70.
Create a Material from a Video or Image

Once a recording has been completed it can be added to the Material Manager as a video material. Also, still grabs can be sent to the Material Manager as image materials.

1. Create a video or image in the **Record Client**.

2. Right-click on a video or image thumbnail and select Create Material from the shortcut menu.
The newly created material is added to the Material Manager.

For More Information on...

- materials, refer to "Materials" on page 14–1.
Send a Video or Image to Clip Store

Once a recording has been completed it can be sent to the Clip Store database to be used within the Clip workflow.

1. Create a video or image in the Record Client.

2. Right-click on a video or image thumbnail and select Send to Clip Store from the shortcut menu. Multiple videos and images can be selected by using Shift + click or holding Ctrl and clicking on individual videos and images.

* Only XPression codec clips should be sent to the Clip Store.
The **Send to Clip Store** dialog box opens.

3. In the **Metadata** section, configure the following items:
   - **Name** — enter a new name for the video or image in Clip Store, if necessary.
   - **Recall ID** — enter an identifier to recall the video or image from an external device.
   - **Project** — use this list to select any existing projects from Clip Store or enter a new project name for the video or image. New projects are automatically added to the Clip Store.
   - **Looping** — select this check box to infinitely replay the video each time it reaches the end.
   - **Hold Last Frame** — select this check box to freeze the video on the last frame after playing.
   - **Premultiplied (Shaped)** — select this check box to multiply/shape the fill signal color information by the luminance information in the key signal.

4. Click **Transfer Clip**.

   The video or image file is transferred to the Clip Store. Once the transfer has successfully completed, the **Status** is listed as **Import Complete**, the Progress bar is at **100%**, and **Destination** details are listed.
For More Information on...

- creating a video file in the Record Client, refer to “Recording a Video from an Input” on page 22–2.
- creating an image file in the Record Client, refer to “Capturing a Still Image from an Input” on page 22–5.
Output

The output of an XPression project can be sent to various locations, including being saved in an Audio Video Interleave format (.AVI) video file.

The following topic is discussed in this section:

• Preview Output in a Virtual Output
• Render Output to an AVI File
Preview Output in a Virtual Output

1. Use the **Hardware Setup** dialog box to configure an XPression Virtual Output.

![Hardware Setup dialog box]

2. Use XPression to create a scene or scene group.

3. Click **Sequence** at the top of the window to use the **Sequencer** to place the new scene or group on a sequence timeline for playout.

4. In the **Scene Manager**, click and drag the scene or scene group to output into the **Sequencer**.

![Scene Manager]

5. In the **Output Monitors** window, note the framebuffer number of the **Virtual Output** output monitor.

![Output Monitors]

6. Use the list in the **Output** column of the **Sequencer** to select the framebuffer number of the **Virtual Output** for the scene or scene group to output.

7. Double-click the scene or scene group in the **Sequencer** to take it “online”.

    The **XPression Virtual Output** window opens to display the output of the selected scene or scene group.

    Right-click the output in the **XPression Virtual Output** window and select **Full Screen** to use full screen display.

For More Information on...

- configuring an XPression Virtual Output, refer to the procedure “**Configure an XPression Virtual Output**” on page 3–87.
- creating scenes, refer to the procedure “**Create a Scene**” on page 5–4.
Render Output to an AVI File

1. Use the Hardware Setup dialog box to configure an XPression AVI Recorder.

2. Use XPression to create a scene or scene group to output to an Audio Video Interleave format (.AVI) video file.

3. Click Sequence at the top of the window to use the Sequencer to place the new scene or group on a sequence timeline for playout.

4. In the Scene Manager, click and drag the scene or scene group to output to an AVI file into the Sequencer.

5. In the Output Monitors window, note the framebuffer number of the AVI Output output monitor.

6. Use the list in the Output column of the Sequencer to select the framebuffer number of the AVI Output for the scene or scene group to output.

7. Double-click the scene or scene group in the Sequencer to take it “online”. The Export AVI As dialog box opens.

8. Locate and select a folder in which to save the AVI file, then enter a name for the AVI file in the File Name box.
9. **Click Save.**
   The Video Compression dialog box opens.

![Video Compression dialog box]

10. **Use the Compressor list to select the video compressor with which to output the AVI file.**
11. Based on the selected video compressor, use the available controls to configure video compression settings.
12. **Click OK.**
   The AVI Recorder - Preview window opens to display the output being rendered to the selected AVI file. Depending on the selected scene or scene group, rendering an AVI file may take some time to complete.

**For More Information on...**
- configuring an XPression AVI Recorder, refer to the procedure “**Configure an XPression AVI Recorder**” on page 3–78.
- creating scenes, refer to the procedure “**Create a Scene**” on page 5–4.
Project Server

The Project Server allows XPression projects to be published and deployed using a server.

The following topics are discussed in this section:

• Setup Project Server
• Publish a Project to Project Server
• Deploy a Project from Project Server
Setup Project Server

1. In XPression, use the File menu to select Project Server > Setup.
   The Project Servers Setup dialog box opens.

2. Click Add to add a new project server or click Edit to edit an existing project server.
   The Edit Project Server dialog box opens.

3. Use the Edit Project Server dialog box to enter or edit the project server information.
   a. In the Name box, enter or edit a name for the project server.
   b. In the Host box, enter or edit the host IP address.
   c. In the Port box, enter or edit the host port number.

4. Click OK.
   The added or edited project server appears in the list in the Project Servers Setup dialog box.

5. Click Close.
   The Project Servers Setup dialog box closes.
Publish a Project to Project Server

1. Open a project in XPression.
2. Save the project.
   ✴ Saving the project is required before publishing it to the project server.
3. In XPression, use the File menu to select Project Server > Publish.
   The Log on to project server dialog box opens.

4. In the Log on to project server section, use the Name dropdown list to select the project server.
   ✴ For a project server to appear in the Name list, a project server needs to be configured.
5. In the Login section, use the Login box to enter the project server login.
   The default login is admin.
6. Enter the project server login password in the Password box.
   The default password is admin.
   Select the Save Password check box to save the password.
7. Click **Next**.

   The **Show selection** dialog box opens.

![Show selection dialog box]

8. Use the **Show selection** dialog box to create a new show or to revise an existing show.

   **Create a New Show**
   
   a. Click **New Show**.

   The **New show** dialog box opens.

   ![New show dialog box]

   b. Use the **New show** dialog box to enter the following information for the new show:

   - **Name** — in this box, enter the name of the new show.
   - **Season** — in this box, enter the season of the show.
   - **Client** — in this box, enter the intended recipient of the show.
   - **Description** — in this box, enter a brief descriptor.
   - **Air Date** — from the dropdown calendar, select the air date of the show.
   - **Note** — in this box, enter a note for the show.
Revise a Show

a. If revising an existing show, select the show from the list or use the Search box to find and select a show.

9. Click Next.

The Set project revision information dialog box opens.

10. In the Set project revision information dialog box, use the New Project Revision Information section to revise the following project information:

   • Project Name — in this box, enter a revised name for the project.
   • Author — from the dropdown list, select a revised author for the project.
   • Description — from the dropdown list, select a revised description for the project.
   • Air Date — from the dropdown calendar, select a revised air date for the project.
   • Note — in this box, enter a revised note for the project.

11. Click Next.

The next Set project revision information dialog box opens.

a. In the Options section, select the Include unused files in the project's default folders check box to include unused files for the project in the default folders.

b. Click Add to create a new folder.
12. Click **Next**.

The **Ready to publish** dialog box opens.

13. Use the **Ready to publish** dialog box to review the project information before publishing.

14. Click the **Publish** button to publish the project to the project server.

    * Publishing a revision of a project will send a notification of the revision to any MOS Plugin using that project.

15. Click **Close**.

For More Information on...

- configuring a project server, see *XPression Project Server User Guide*. 
Deploy a Project from Project Server

1. Open a project in XPression.
2. In XPression, use the File menu to select Project Server > Deploy.
   The Log on to project server dialog box opens.

3. In the Project Server section, use the Name dropdown list to select the project server.
4. In the Login section, use the Login box to enter the project server login.
   The default login is admin.
5. Enter the project server login password in the Password box.
   The default password is admin.
   Select the Save Password check box to save the password.
6. Click Next.
   The Select show, category and style to deploy from dialog box opens.

7. Use the Select show, category and style to deploy from dialog box to select a show from the list or use the Search box to find and select a show.
8. Click Next.

The Select revision to deploy dialog box opens.

9. In the Select revision to deploy dialog box, select the revision number to deploy from the project server.

10. Click Next.

The Select target folder for deployment dialog box opens.

11. In the Select target folder for deployment dialog box, use the Local Folder box to type a filepath to a folder or click the Browse button to select a folder.

12. Select the Open project after deployment check box to open the project after deploying.

13. Click the Deploy button to deploy the project from the project server.

14. Click Close.
Keyboard and GPI Mapping

Keyboard and GPI mapping enables many of the XPression functions to be assigned to keyboard shortcuts or GPI input triggers. Many of XPression’s existing default keyboard shortcuts can also be customized.

The following topics are discussed in this section:
- Create a Custom Keyboard Map
- Assign a Project Shortcut
- Assign a Global Shortcut
- Assign a Local Shortcut
- Create a Custom GPI Map
- Use the Quick Menu
Create a Custom Keyboard Map

1. In XPression, use the Edit menu to select Keyboard / GPI Mapping. The Keyboard / GPI Mapping dialog box opens.

2. Click the Save Keyboard Mapping button to create a new custom keyboard mapping. The Save Keyboard Mapping dialog box opens.

3. In the Save Keyboard Mapping dialog box, enter a name for the new custom keyboard mapping.

4. Click OK. The added custom keyboard mapping appears in the Current Keyboard Map list and is saved as a .kbd file.

For More Information on...

- assigning a Global Shortcut, refer to “Assign a Global Shortcut” on page 25–4.
Assign a Project Shortcut

Project shortcuts represent keyboard hotkeys that apply to a specific XPression project.

1. In XPression, use the Edit menu to select Keyboard / GPI Mapping.

   The Keyboard / GPI Mapping dialog box opens.

2. Select a keyboard map from the Current Keyboard Map list or create a custom keyboard map.

3. Drag an item from the Global Functions list into the Project Shortcuts table as necessary.

4. In the Project Shortcuts table, right-click on an item in the shortcuts tree and select Assign Shortcut to assign a custom keyboard control to the selected item.

5. In the Shortcut Details section, perform the following:
   a. In the Name box, edit the name of the selected item if necessary.
   b. In the Shortcut box, enter a keyboard shortcut to assign to the selected item by entering the command on the keyboard.

   The assigned keyboard shortcut appears in the Shortcut box and in the row for the selected item under the Direct Access Shortcut column in the Project Shortcuts table.

   If the assigned keyboard shortcut is already in use by another function, a hazard icon will appear next to the command in the Direct Access Shortcut column. Place the cursor over the hazard icon to view where the conflict occurs.

6. Click OK.

For More Information on...

• creating a custom keyboard map, refer to “Create a Custom Keyboard Map” on page 25–2.
Assign a Global Shortcut

Global Shortcuts represent functions that can be assigned to keyboard hotkeys that are active at any time while XPression is running.

1. In XPression, use the Edit menu to select Keyboard / GPI Mapping.
   
   The Keyboard / GPI Mapping dialog box opens.

2. Select a keyboard map from the Current Keyboard Map list or create a custom keyboard map.

3. In the Available Global Functions list, drag and drop the Group function or click the Add Group button in the toolbar to create a group branch in the Global Shortcuts tree.

4. In the Available Global Functions list, select a function and drag and drop it into the desired spot in the Global Shortcuts tree to add the function.

   Entering a function in the Filter box lets you search the Available Global Functions list for a specific function.
5. In the **Global Shortcuts** table, right-click on an item in the shortcuts tree and select **Assign Shortcut** to assign a custom keyboard control to the selected item.

![Global Shortcuts Table](image)

6. In the **Shortcut Details** section, perform the following:

   a. In the **Name** box, edit the name of the selected item if necessary.

   b. In the **Shortcut** box, enter a keyboard shortcut to assign to the selected item by entering the command on the keyboard.

      The assigned keyboard shortcut appears in the **Shortcut** box and in the row for the selected item under the **Direct Access Shortcut** column in the **Global Shortcuts** table.

      If the assigned keyboard shortcut is already in use by another item, a hazard icon 🟥 will appear next to the command in the **Direct Access Shortcut** column. Place the cursor over the hazard icon to view where the conflict occurs.

   c. Select the **Include In Quick Menu** check box to include the keyboard shortcut in a Quick Menu.

      Quick Menus are shortcut menus that appear when a Quick Key for a Global Shortcut is entered. The keyboard shortcuts available for the selected Global Shortcut are listed in the Quick Menu that appears. This feature only applies to Global Shortcut branches that contain children nodes.

      In the **Quick Key** box, enter a letter or number as the Quick Menu command.

    ![Shortcut Details Section](image)

7. In the options section located to the right of the **Shortcut Details** section, configure the shortcut options of various functions:

   **Animation Menu Options**
   - **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Animation Menu branch when the Quick Key assigned to the Animation Menu group is triggered.

   **Assign Material Options**
   - Select **Current Selected Material** to assign the selected material to an object, or select **Name** and enter a material in the box to assign that material to an object. Select **Name** and leave the box blank to remove the material from an object.

   **Clear Layer Options**
   - **Framebuffer** — use the list to select a framebuffer for clearing the layer.
   - **Layer** — in this box, enter or select a layer.

   **Clear Single Channel Options**
   - **Framebuffer** — use the list to select a framebuffer for clearing the channel.
Clip Browser Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Clip Browser branch when the Quick Key assigned to the Clip Browser group is triggered.

Color Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Clip Browser branch when the Quick Key assigned to the Clip Browser group is triggered.

Cue Item Options
- **Select Current Sequence Item** to apply the shortcut to the current focused item in a sequencer, or select **Take ID** and enter or select a Take ID number in the box to apply the shortcut to the specific Take ID.
- **Move Sequencer Focus to Item** — check this box to set sequencer focus to the selected Take ID.
- **Framebuffer** — use the list to select a framebuffer for the item.

Debug Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Debug branch when the Quick Key assigned to the Debug group is triggered.

Display Menu Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Display Menu branch when the Quick Key assigned to the Display Menu group is triggered.

Edit Menu Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Edit Menu branch when the Quick Key assigned to the Edit menu is triggered.

Focus Options
- **Server Channel** — use this list to select the server channel to focus in the UI.

Group Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the group branch when the Direct Access shortcut assigned to the group is triggered.

Import Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Import branch when the Quick Key assigned to the Import group is triggered.

Material Manager Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Material Manager branch when the Quick Key assigned to the Material Manager group is triggered.

New Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the New branch when the Quick Key assigned to the New group is triggered.

Object Manager Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Object Manager branch when the Quick Key assigned to the Object Manager group is triggered.

Pivot Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Pivot branch when the Quick Key assigned to the Pivot group is triggered.

Preview Options
- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Preview branch when the Quick Key assigned to the Preview group is triggered.
Project Menu Options

- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Project Menu branch when the Quick Key assigned to the Project Menu group is triggered.

Project Server Options

- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Project Menu branch when the Quick Key assigned to the Project Menu group is triggered.

Scene Manager Options

- Run all children actions when group triggered — select this check box to run all of the keyboard shortcuts of the children attached to the Scene Manager branch when the Quick Key assigned to the Scene Manager group is triggered.

Script Action Options

a. Click the **Edit Script Action** button.

   The **Script Editor - Script Shortcut** dialog box opens.

b. In the **OnKeyPress** tab, enter the .net scripting.

Select Font Options

- Select **By Name** and enter a font style name to assign a font to a text object, or select **By ID** and enter or select the font ID to assign the font to a text object.
Send RossTalk Message Options
- **GPI Board** — use the list to select a GPI board for sending the RossTalk message.
- **RossTalk Message** — use the list to select a RossTalk message. The available options are:
  - **CLFB [channel]:[layer]** — clear a single layer on the channel.
    - When using XPression Tessera, this command can be used to clear layers. The framebuffer parameter specified by the channel will be ignored (set to 0).
  - **CLRA** — clear all framebuffers.
  - **CUE [takeid]:[channel]:[layer]** — cue a Take Item on a specified layer of a channel.
  - **DOWN** — move the current selection in the sequencer to the item below it.
  - **FOCUS [takeid]** — set sequencer focus to a specific Take Item.
  - **GPI [gpi num]** — used to trigger a simulated GPI input. RossTalk/Smart GPI supports up to 64 simulated inputs.
  - **LAYEROFF [channel]:[layer]** — clear a single layer on the framebuffer specified by the channel. If the layer is not specified, every layer on the channel will be cleared.
  - **NEXT** — read the current selection in the sequencer to air and advance the current selection to the next item.
  - **READ** — read the current selection in the sequencer to air.
  - **RESUME [channel]:[layer]** — resume a single layer on the framebuffer specified by the channel. If the layer is not specified, every layer on the channel will resume.
  - **SEQI [takeid]:[layer]** — loads a template to air on the specified layer and the template-defined output channel.
  - **SEQO [takeid]** — takes the template off air.
  - **SWAP [channel]** — switches from the current channel to the one specified in the message.
  - **TAKE [takeid]:[channel]:[layer]** — takes a template to air on the specific framebuffer and layer without moving the sequencer focus to that item.
  - **TEMPLATEDATA [takeid]:[object name]:[property]:[value]** — set the value of a specified object in a specified take item.
  - **UP** — move the current selection in the sequencer to the item above it.
  - **UPNEXT** — set the preview in the sequencer without moving the focus bar.

Set Framebuffer Options
- **Framebuffer** — use the list to select a framebuffer or select <none>.

Set GPI Output Options
- **GPI Board** — use the list to select a GPI board for sending the GPI command.
- **GPI #** — use this box to enter or select a GPI pin number.
- **State** — use the list to select the state of the signal:
  - **Low (Inactive)** — select this to use low voltage for the signal.
  - **Low (Active)** — select this to use high voltage for the signal.

Set Layer Options
- **Layer** — in this box, enter or select a layer.

Set Transform Options
- **Position** — use this section to set the placement of an object in a project:
  - **X** — in this box, enter or select the X coordinate for the object location.
  - **Y** — in this box, enter or select the Y coordinate for the object location.
  - **Z** — in this box, enter or select the Z coordinate for the object location.
  - **Center in Viewport** — select this check box to center the object in the viewport.
- **Rotation** — use this section to set the rotation of an object:
  - **X** — in this box, enter or select the degrees to rotate an object around the X axis.
  - **Y** — in this box, enter or select the degrees to rotate an object around the Y axis.
  - **Z** — in this box, enter or select the degrees to rotate an object around the Z axis.
- **Scale** — use this section to scale an object:
  - **X** — in this box, enter or select the scale factor to apply to an object along the X (horizontal) axis.
  - **Y** — in this box, enter or select the scale factor to apply to an object along the Y (vertical) axis.
  - **Z** — in this box, enter or select the scale factor to apply to an object along the Z (depth) axis.
Set Transition Options

- **Current Sequence Item** — select this to use the transition options for the currently selected take item in the sequencer.
- **Take ID** — select this to use the transition options for a specific Take ID in the sequencer. Use the box to enter or select the Take ID number.
- **Transition In/Out** — use the lists to select the in and out transitions for a take item. The available options are as follows:
  - **Cut** — select this to use an instantaneous transition from the take item to the next take item.
  - **Dissolve** — select this to use a gradual transition where a take item dissolves into the next take item.
  - **Push** — select this to use a sliding transition where the take item pushes out the previous take item.
  - **Distort** — select this to use a transition where a take item is warped out.
- **Duration** — use this box to enter or select the duration of the transition in number of frames.

Take Offline Options

- Select **Current Sequence Item** to apply the shortcut to the current item in a sequence, or select **Take ID** and enter or select a Take ID number in the box to apply the shortcut to the specific Take ID, or select **Entire Framebuffer** to take all layers off of a framebuffer and use the list to select the framebuffer.

Take Options

- Select **Current Sequence Item** to apply the shortcut to the current item in a sequence, or select **Take ID** and enter or select a Take ID number in the box to apply the shortcut to the specific Take ID.
- **Move Sequencer Focus to Item** — check this box to set sequencer focus to the selected Take ID.
- **Framebuffer** — use the list to select a framebuffer for the Take Item.
- **Advance Sequence After Take** — check this box to advance to the next Take Item in the sequence after the current or selected Take Item has finished playing.

Tessera Backup Options

- **Backup Node ID** — use this list to select a node ID to use as a backup.
- **Assign as backup of** — use this list to select the node ID to which the backup node ID is assigned.

Tools Menu Options

- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Tools Menu branch when the Quick Key assigned to the Tools Menu group is triggered.

View Context Menu Options

- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the View Context Menu branch when the Quick Key assigned to the View Context Menu group is triggered.

Windows Menu Options

- **Run all children actions when group triggered** — select this check box to run all of the keyboard shortcuts of the children attached to the Windows Menu branch when the Quick Key assigned to the Windows Menu group is triggered.

8. Click **OK**.

For More Information on...

- creating a custom keyboard map, refer to “Create a Custom Keyboard Map” on page 25–2.
- using a Quick Menu, refer to “Use the Quick Menu” on page 25–14
Assign a Local Shortcut

Local shortcuts represent keyboard hotkeys that apply to one particular component of XPression, such as the Sequencer, and are only active when the particular component of XPression has keyboard/mouse focus.

1. In XPression, use the Edit menu to select Keyboard / GPI Mapping.
   The Keyboard / GPI Mapping dialog box opens.

   ![Keyboard / GPI Mapping dialog box]

2. Select a a keyboard map from the Current Keyboard Map list or create a custom keyboard map.

3. In the Local Shortcuts table, right-click on an item in the shortcuts tree and select Assign Shortcut to assign a custom keyboard control to the selected item.

4. In the Shortcut Details section, perform the following:
   a. In the Name box, edit the name of the selected item if necessary.
   b. In the Shortcut box, enter a keyboard shortcut to assign to the selected item by entering the command on the keyboard.

      The assigned keyboard shortcut appears in the Shortcut box and in the row for the selected item under the Direct Access Shortcut column in the Local Shortcuts table.

      If the assigned keyboard shortcut is already in use by another function, a hazard icon \[
      \text{\ding{100}}\]
      will appear next to the command in the Direct Access Shortcut column. Place the cursor over the hazard icon to view where the conflict occurs.

5. Click OK.

For More Information on...
- creating a custom keyboard map, refer to "Create a Custom Keyboard Map" on page 25–2.
Create a Custom GPI Map

1. Use the Hardware Setup dialog box to configure a GPI board for XPression.
2. In XPression, use the Edit menu to select Keyboard / GPI Mapping. The Keyboard / GPI Mapping dialog box opens.

3. Create a custom keyboard mapping that includes global shortcuts.
4. In the Global Shortcuts tree, right-click on a global shortcut and select Edit GPI Assignment.
The same GPI trigger can be assigned to multiple global functions to execute them in order.

5. In the **GPI** column of the **Global Shortcuts** table, perform the following to the selected global shortcut:

**Steps**

a. Select a GPI board from the list.

b. In the **GPI** box, enter or select a GPI input to assign to the selected global shortcut.

   If the assigned GPI input is already in use by another item, a hazard icon ![hazard icon] will appear next to the GPI details in the GPI column. Place the cursor over the hazard icon to view where the conflict occurs.

6. Click **OK**.
For More Information on...

- adding an Adrienne TC/GPIO card, refer to “Configure a 25-Pin GPIO Port” on page 3–101.
- adding a Serial GPI board, refer to “Configure RS232 CTS/DSR GPI for Contact Closures” on page 3–99.
- adding a Smart GPI/RossTalk board, refer to “Configure Smart GPI / RossTalk” on page 3–105.
- creating a custom keyboard, refer to “Create a Custom Keyboard Map” on page 25–2.
- configuring and working with GPIs, refer to the GPI White Paper available from Ross Video.
Use the Quick Menu

1. Create a custom keyboard mapping that includes Global Shortcuts.
2. In XPression, enter the keyboard shortcut for a Global Shortcut branch.
   The Quick Menu for the Global Shortcut branch opens.

3. In the Quick Menu perform one of the following:
   • Use the Quick Keys to select an item from the Quick Menu, or
   • Use the keyboard arrows to select an item and press Enter.
   The selected Quick Menu item action is triggered.
   • Press Esc at any time in a Quick Menu to close the Quick Menu.

For More Information on...
   • creating a custom keyboard, refer to “Create a Custom Keyboard Map” on page 25–2.
   • assigning a Global Shortcut, refer to “Assign a Global Shortcut” on page 25–4.
Project Manager

The Project Manager window is used to create and organize category folders to organize XPression project scenes and scene groups.

The following topics are discussed in this section:

- Create a Category
- Add a Scene or Scene Group to a Category
- Delete a Category
- Open Multiple Projects in the Project Manager
- Activate a Project from a Project Group
- Remove a Project from a Project Group
Create a Category

1. Open or create a new project in XPression.

   The project appears in the Project Manager window under the Project Group node.

2. In the Project Manager window, right-click on the Categories node of the project.

   The shortcut menu opens.

3. Select Add Category Ins.

   A New Category node is added to the Categories node.

   The New Category also appears at the bottom of the Scene Manager window.

4. In the Project Manager window, enter a new name for the category.

5. Press the Return key to save the new category name.

For More Information on...

- adding a scene or scene group to a category, refer to the procedure “Add a Scene or Scene Group to a Category” on page 26–3.
- creating a new project in XPression, refer to the procedure “Create a Project” on page 5–2.
Add a Scene or Scene Group to a Category

1. Create a category in the **Project Manager** window.
2. Add scenes and scene groups to the category.

Add an Existing Scene or Scene Group

a. In the **Scene Manager** window, click and hold on the scene or scene group to be added to the category.

b. Drag the scene or scene group and drop it in the new category.

The scene or scene group appears in the category.
Add a New Scene or Scene Group to a Category

a. In the Scene Manager window, right-click on the category. The shortcut menu opens.

b. Choose one of the following paths from the shortcut menu:
   - New > Scene
   - New > Scene Group

   The new scene or scene group appears in the category.

For More Information on...
- creating a category, refer to the procedure “Create a Category” on page 26–2.
Delete a Category

1. Open a project in XPression.
   The project appears in the Project Manager window under the Project Group node.

2. Right-click on the Category node to be deleted.
   The shortcut menu opens.

3. Select Delete.
   The category is deleted from the Project Manager window and the Scene Manager window.
Open Multiple Projects in the Project Manager

1. In the Project Manager window, right-click on the Project Group node. The Project Group shortcut menu opens.

2. Select one of the following options:
   - Add New Project — select to open the New Project dialog box and create a new project to add to the Project Group.
   - Add Existing Project — select to open the browser and select an existing project to open in the Project Group.

   The new or existing project displays as a project node in the Project Group and opens in XPression.

3. Repeat step 1 to 2 for individual projects as needed.

For More Information on...
Activate a Project from a Project Group

1. Open multiple projects in XPression.
   The projects appear in the Project Manager.

2. In the Project Manager window, right-click on the Project node of the project to be activated.
   The Project shortcut menu opens.

3. Select Activate from the shortcut menu.
   The selected project is activated in the XPression Editor and Sequencer.

For More Information on...
- opening multiple projects in XPression, refer to the procedure “Open Multiple Projects in the Project Manager” on page 26–6
Remove a Project from a Project Group

1. In the Project Manager window, right-click on the Project node of the project to be removed from the project group.
   The Project shortcut menu opens.

2. Select Remove Project from the shortcut menu.
   The selected project is removed from the Project Group in the Project Manager.

For More Information on...
• opening multiple projects in XPression, refer to the procedure “Open Multiple Projects in the Project Manager” on page 26–6.
Clips

The following topics are discussed in this section:

- XPression Clips Playback Overview
- Opening the Server Channels
- Loading a Clip in the Server Channels
- Opening the Clip Browser
- Using the Clip Browser
- Using the Server Channels
- Edit Clip/Add Sub Clip
- Updating the Thumbnail in the Clip Browser
- Creating a 4-Point Loop
- Creating a 3-Point Loop
XPression Clips Playback Overview

Clip playback within XPression can be performed in many ways. The most basic is to drag clips from the Clip Browser and drop them into the Sequencer. This creates a take item which can be assigned an output framebuffer and layer, or server channel, and then played back as a regular take item or placed into a Cued state using the number pad period key [Num pad .].

Regular XPression graphics can be rendered as a clip which will be sent directly to the Clip Store. By right-clicking on a take item in the Sequencer and selecting Export Take Item to Video, the Export to Video dialog box will open and provide the option to render take items into clips transferred to the clip store.

The number of clips that can be played back simultaneously falls under the same performance limitations as normal XPression scenes with clips (e.g. play back will be dependent on current generation hardware).

While playing back, a timer counts down the remaining time in the clip and a time bar indicates the playback amount completed:

Many clips can be dragged into a timed sequence group for a pseudo-playlist capability. Dissolves can even be set on the take items for transitions between the playlist items:

Clips within the Clip Browser can be sorted and filtered using the options in the Advanced Search Options. In the example image below they were filtered by Project Name:
Opening the Server Channels

1. In XPression, open the Sequencer layout.
2. In the Menu bar, click Display > Server Channels.

   The Server Channels window opens.
Loading a Clip in the Server Channels

For clips to load in the Server Channels window, server channels must be configured in the Server Channels tab of the XPression Hardware Setup.

1. In the Sequencer, use the Menu bar to select Display > Clip Browser.
   The Clip Browser window opens.

2. Drag and drop a clip from the Clip Browser onto a Server Channel in the Server Channels window.
   The clip is added to the Preview channel for the Server Channel (or directly to the Server Channel if the preview has been disabled in the options).

   ![Clip Browser](image1)
   ![Server Channels](image2)

   If clips have been sent to the Clip Browser from the Record Client, or if clips have been transcoded by the INcoder into the Watch Folder, clips will automatically load into the Clip Browser.

   The clip will be loaded to its pre-configured in point.

   If loaded in the Preview, click Take to play the clip on air on the Server Channel. While a clip is on air, clips can be cued on the Preview channel while still allowing the on air clip to be controlled and have its timecode and countdown visible.

   Server Channel playback controls are provided or the space bar can be used to pause and start playback.

   A realtime proxy of the clip is shown as it plays in the server channel along with audio meters and a time remaining counter.

   Take items or timed groups in the Sequencer can also be dragged onto a server channel for playback. To preserve the original server channel assignment of a take item, press and hold Ctrl while dragging and dropping from the Sequencer to a server channel.

   Clips can also be loaded to a channel by double clicking them in the Clip Browser. They will be loaded onto the currently active server channel, as shown by a cyan outline around the channel. Once a clip is loaded to a server channel, it can be dragged and dropped from one server channel to another as a duplicate. The active channel can be changed by double clicking any other server channel.

   Clips can also be dragged and dropped directly from Windows Explorer for situations where the clip is not loaded into the Clip Store (or there is no Clip Store present).
3. Click the **Transition** tab to set the in and out transitions for the clip in the active server channel:
   
a. In the **In** tab, select a **Transition** style and **Mode**:
   
   • **Cut** — select this to use an instantaneous transition from the take item to the next take item.
   • **Dissolve** — select this to use a gradual transition where a take item dissolves into the next take item.
     Configure the mode for the dissolve:
     › **Fade** — select this transition to fade in to, or out from, the clip.
     › **Over Black** — select this transition to fade in or out from black.
     › **Additive** — select this transition to gradually add light to the clip when transitioning in or out.
     › **Saturate** — select this transition to saturate the clip when transitioning in or out.
     › **Desaturate** — select this to transition to desaturate the clip when transitioning in or out.
     › **Invert** — select this transition to invert the clip when transitioning in or out.
   • **Push** — select this to use a sliding transition where the take item pushes out the previous take item.
     Configure the mode for the push:
     › **Right To Left** — select this transition to push from right to left.
     › **Left To Right** — select this transition to push from left to right.
     › **Top To Bottom** — select this transition to push from top to bottom.
     › **Bottom To Top** — select this transition to push from bottom to top.
     › **Bottom Right** — select this transition to push to the bottom right.
     › **Top Right** — select this transition to push to the top right.
     › **Bottom Left** — select this transition to push to the bottom left.
     › **Top Left** — select this transition to push to the top left.
   • **Distort** — select this to use a transition where a take item is warped out. Configure the mode for the distortion:
     › **Diverge** — select this transition to use multiple splits in the image in the clip.
     › **Pixelate** — select this transition to pixelate the clip.
     › **Sine Wave** — select this transition to apply a sine wave pattern to the clip.
     › **Shrink** — select this transition to expand the clip from a shrunken image.
     › **Shrink Diff** — select this transition to expand the clip from a shrunken image.
     › **Spiral** — select this transition to spin the clip.
     Select the **Reverse** check box to reverse a Dissolve, Push, or Distort transition.
   
b. Use the **Duration** box to enter or select the duration of the transition in number of frames.
   
c. Click the **Out** tab and repeat steps a to b to configure the **Transition** style and **Mode** for the out transition.

4. Select the **Cue video clips directly to framebuffer** check box to cue clips to air immediately when dropped on a server channel from the Clip Browser or Sequencer.

For More Information on...
- setting up server channels and virtual outputs, refer to “**Set Up Server Channels**” on page 3–116.
- sending clips from the Record Client to the Clip Browser, refer to “**Send a Video or Image to Clip Store**” on page 22–12.
- configuring a Watch Folder for the INcoder, refer to the **INcoder User Guide**.
Opening the Clip Browser

1. In XPression, open the Sequencer layout.
2. In the Menu bar, click Display > Clip Browser.
   The Clip Browser window opens.
Using the Clip Browser

1. In the Clip Browser, select a clip in the clip list to playout. To search for a specific clip or sub clip, use the following features:

   • Click the Fast Recall button on to use the fast recall feature (the button is green when turned on). When turned on, fast recall enables searching clips by recall ID by simply entering a recall ID number using the number pad on the keyboard.
     The clip will be automatically selected in the Clip Browser. Pressing Enter will cue the clip, and pressing Enter a second time will play the clip.
     Clear a recall ID from the Quick Find box by pressing Esc. A clip can be cued by entering the recall ID and pressing cue [.].
   • Use the Quick Find box to enter a clip name or keyword to search for a specific clip in the Clip Browser. Press Esc to clear the box.
   • Click the Show/Hide advanced search options button ( ) to enter more criteria to search for a specific clip.
   • Select the Show all sub clips for matching clips check box to display any sub clips of a clip in the clip list when performing a Quick Find.

2. Right-click on a clip and select one of the following options:

   • Edit — select this command to open the Edit Clip dialog box to edit the selected clip.
   • Add Sub Clip — select this command to open the Add Sub Clip dialog box to create a sub clip from the selected clip.
   • Set Recall ID — set the recall ID of a selected clip or a range of selected clips in the Clip Browser using the Set Recall ID dialog box. Use the Set Recall ID dialog box to enter a recall ID to assign to a selected clip or the starting recall ID for the range of selected clips.
   • Adjust Loop / Hold Last > Enable Looping — enable looping for a clip or a range of selected clips.
   • Adjust Loop / Hold Last > Disable Looping — disable looping for the clip or a range of selected clips if looping is enabled.
   • Adjust Loop / Hold Last > Enable Hold Last Frame — hold the last frame of the clip or a range of selected clips when playout ends. Do not select this function if taking the clip(s) offline automatically using an out transition.
   • Adjust Loop / Hold Last > Disable Hold Last Frame — disable holding the last frame of the clip or a range of selected clips when playout ends if holding the last frame is already enabled.
   • Add to Sequencer — add selected clip or range of clips to the Sequencer.
3. Add the clip to one of the following:

Server Channels

Drag and drop the selected clip onto a Server Channel in the Server Channels window. Double-clicking the clip, or right-clicking and selecting Cue on Server Channel, will also load it onto a selected Server Channel.

The clip is added to the selected Server Channel.

Sequencer

Drag and drop the selected clip into the Sequencer.

The clip is added to the Sequencer.

Multiple clips can be selected, dragged, and dropped into the Sequencer by Shift-clicking and Ctrl-clicking. When dragging a clip into the Sequencer from the Clip Browser, the take ID assigned uses the recall ID or the next higher available number.

Template Data

Drag and drop the selected clip onto a published material in the Template Data tab of the Take Inspector. Holding the Ctrl key while dragging and dropping will link the selected clip to the published field by recall ID instead of the unique clip ID.

The clip is added to the material value of the object.

For More Information on...

- the Sequencer, refer to “Sequences” on page 21–1.
Using the Server Channels

1. Load a clip onto a **Server Channel** in the **Server Channels** window.

![Server Channels window](image)

2. Use the **Transition** tab to select and configure the in and out transition for the clip in the selected Server Channel:

   **a.** Use the **In** and **Out** tabs to select an in and out transition for the clip:
   - **Cut** — select this to use an instantaneous transition to and from the clip.
   - **Dissolve** — select this to use a gradual transition where a clip dissolves in or out.
   - **Push** — select this to use a sliding transition where the clip pushes in or out.
   - **Distort** — select this to use a transition where a clip is warped in or out.

   **b.** Use the **Mode** section to configure the **Dissolve**, **Push**, and **Distort** transition mode:
   - **Dissolve**
     - **Fade** — select this transition to fade in to, or out from, the clip.
     - **Over Black** — select this transition to fade in or out from black.
     - **Additive** — select this transition to gradually add light to the clip when transitioning in or out.
     - **Saturate** — select this transition to saturate the clip when transitioning in or out.
     - **Desaturate** — select this to transition to desaturate the clip when transitioning in or out.
     - **Invert** — select this transition to invert the clip when transitioning in or out.
   - **Push**
     - **Right To Left** — select this transition to push from right to left.
     - **Left To Right** — select this transition to push from left to right.
     - **Top To Bottom** — select this transition to push from top to bottom.
     - **Bottom To Top** — select this transition to push from bottom to top.
     - **Top Right** — select this transition to push to the top right.
     - **Bottom Left** — select this transition to push to the bottom left.
     - **Top Left** — select this transition to push to the top left.
   - **Distort**
     - **Diverge** — select this transition to use multiple splits in the image in the clip.
     - **Pixelate** — select this transition to pixelate the clip.
     - **Sine Wave** — select this transition to apply a sine wave pattern to the clip.
     - **Shrink** — select this transition to expand the clip from a shrunk image.
     - **Shrink Diff** — select this transition to expand the clip from a shrunk image.
     - **Spiral** — select this transition to spin the clip.
   - **Duration** — use this box to enter or select the duration of the transition in number of frames.
   - **Reverse** — check this box to reverse the selected transition.
c. In the **Options** tab, select the **Cue video clips directly to framebuffer** check box to cue clips to air immediately when dropped on a server channel from the Clip Browser or Sequencer.

3. Use the playback controls to playout the clip:

   - **Eject** — click this button to remove a loaded clip from the server channel.
   - **Back** — click this button to return to the beginning of the clip.
   - **Pause** — click this button to pause the clip.
   - **Play** — click this button to play out the clip.
   - **Forward** — click this button to reach the end of the clip.
   - **Loop** — click this button to continuously play the clip. When this button is green, the loop function is turned on. Clicking it again will turn off the loop function.
   - **Scrub Bar** — click and hold on the marker to drag it forward or backward along the time bar to move the clip position to a particular location.

4. Right-click inside the Server Channel and:

   - select **Adjust Clip Volume** to open the **Adjust Clip Volume** dialog box and adjust the clip volume, if necessary.
   - select **Edit Clip** to open the **Edit Clip** dialog box and edit a clip, if necessary.

For More Information on...

- loading a clip on a server channel, refer to “Loading a Clip in the Server Channels” on page 27–4.
- editing a clip, refer to “Edit Clip/Add Sub Clip” on page 27–11.
Edit Clip/Add Sub Clip

Use the Edit Clip and Add Sub Clip dialog boxes to configure metadata for a clip. The Add Sub Clip dialog box has the same interface as the Edit Clip dialog box but is used to create a trimmed clip from an existing clip. A video can have multiple sub-clips defined within it, each with distinctive in/out points. Loading a sub-clip for playout is identical to loading a normal clip.

- The **Edit Clip** dialog box can be accessed by right-clicking in the Clip Browser window and Server Channels window.
- The **Add Sub Clip** dialog box can only be accessed by right-clicking in the Clip Browser window.

Edit Clip/Add Sub Clip Interface

![Image of Edit Clip/Add Sub Clip Interface](image-url)

**Video**

This section displays the clip that has been selected for editing or creating a sub clip. The clip is rendered over a checkerboard pattern so that the alpha channel is visible unless the clip is full frame.

The following actions and commands can be performed:

- Use the timeline marker to select a specific frame in the timeline.
- The video can be scrubbed using the timeline bar; or using common NLE shortcuts like H,J,K to play/rewind at different speeds.
- During scrubbing, audio can be heard by configuring an Audio Monitor device in the Hardware Setup.
• Right-click inside the Clip, Local Events, or Event Track timeline to access the shortcut menu.

Event Track timelines are available if global event tracks have been configured in the Clip Store Manager and added as a processor in the INcoder. They will appear in the timeline as named in the Clip Store Manager. They can be assigned as local events by selecting Preset Event Track > Copy Events to Local Event Track from the shortcut menu.

- Looping > Set Loop Start — select this option to select the current position of the timeline marker as the start of the video loop.
- Looping > Set Loop End — select this option to select the current position of the timeline marker as the end of the video loop.
- Looping > Reset Loop — select this to clear the loop settings.
- Clear In Point — select this to clear a configured start time for the clip.
- Clear Out Point — select this to clear a configured end time for the clip.
- Clear In and Out Points — select this to clear the configured start and end times for the clip.
- Update Clip Thumbnail — select this option to update the thumbnail for the clip to reflect any edits or to use a specific frame as the thumbnail in the Clip Browser.
- Add Event > Rosstalk Event — select this option to directly add a RossTalk event onto the clip timeline.
- Add Event > Scene Director Trigger — select this option to directly add a Scene Director trigger event onto the clip timeline.
- Rename Event — select this option to rename a selected RossTalk or Scene Director trigger event on the clip timeline.
- Delete Event — select this option to delete a selected RossTalk or Scene Director trigger event on the clip timeline.

Set In Point — click this button to set the start time of the clip where the timeline marker has been positioned. Keyboard shortcut ‘I’ can be used to mark an in point.

Set Out Point — click this button to set the end time of the clip where the timeline marker has been positioned. Keyboard shortcut ‘O’ can be used to mark an out point.

Move current position to in point — click this button to return to the in point of the clip.

Start playback — click this button to play back the clip.

Move current position to end point — click this button to reach the end of the clip.

Loop — click this button to loop the playback of the clip. Click it a second time to turn off looped playback.

For More Information on...

• using global event tracks, refer to the XPression Clips Workflow User Guide.
• setting up an audio monitor device, refer to “Configure Video Preview and Audio Monitor” on page 3–97.
• updating the thumbnail in the Clip Browser, refer to “Updating the Thumbnail in the Clip Browser” on page 27–15.
• looping, refer to “Looping Tab” on page 27–13.

Clip Timing (read-only)

Position — indicates the position of the timeline marker in the timeline for the clip.
In — displays the in point for the clip.
Out — displays the out point for the clip.
Length — displays the total duration of the clip in frames.
Duration — displays the time length of the clip.
Source Information (read-only)

Resolution — displays the video format of the source clip.
Frame Rate — displays the frame rate of the source clip.
File Size — displays the file size of the source clip.
Bit Depth — displays the quality of the signal quantization of the source clip.
Audio Channels — displays the amount of embedded audio channels used in the source clip.
Codec UID — displays the type of encoding used for the source clip.
Source TC — displays the timecode of the source clip.
Duration — displays the total duration in frames of the source clip.

Clip Tab

Name — use this box to enter or edit a name for the clip.
Recall ID — use this box to enter an ID number for the clip when it is recalled.
Hold Last Frame — select this check box to hold the last frame of the clip when playout ends. Do not select this check box if taking the clip offline automatically using an out transition.
In Point — use this box to enter a starting point for the clip.
Out Point — use this box to enter an ending point for the clip.
Audio Level — use this box to enter or select a volume level for the clip in decibels. Changing the audio level in the Edit Clip dialog box will not affect live clips on a Server Channel. However, it will apply to the audio monitor if an audio monitor is configured in the Hardware Setup.
Source (read-only) — lists the location where the clip is stored.
File Name (read-only) — lists the name and file extension of the clip.
Project — use this list to select a project for the clip.
Added (read-only) — lists the date the clip was added to the clip store.
Last Modified (read-only) — lists the date the clip was last edited.
Expires — use the calendar to select an expiry date for the clip, if necessary.
Does not expire — select this check box to use no expiry date for the clip.

Looping Tab

Enable Looping — select this check box to enable looping for the clip.
Multi-Point — if looping has been enabled, select this check box to enable the multi-point loop settings.
Multi-Point Loop Settings
Use the multi-point loops to create free running 4-point and 3-point loops:

- 4-point loops use a frame in point, a loop section of start and end frames, and a frame out point.
- 3-point loops use a loop section of start and end frames with either a frame in point the same as the loop start frame or a frame out point the same as the loop end frame.

Loop Start — use this box to enter a starting frame for the loop within the clip time.
Loop End — use this box to enter an end frame for the loop within the clip time.
Loop Count — use this box to enter or select an amount of playbacks the clip will loop before stopping. Use 0 for infinite looping.

- click this button to set the start time or end time of the loop at the position of the timeline marker.
- click this button to skip to the start of the loop.
- click this button to skip to the end of the loop.
For More Information on...
• creating a 4-point loop, refer to “Creating a 4-Point Loop” on page 27–17.
• creating a 3-point loop, refer to “Creating a 3-Point Loop” on page 27–19.

Additional
Original File Name (read-only) — displays the original name of the file as uploaded.
Premultiplied / Shaped — select this check box to multiply/shape the fill signal color information by the luminance information in the key signal.

Event Tracks
Event tracks are configured in the Clip Store Manager, added as processors in the INcoder, and then available to use when editing clips from the Clip Browser. The Event Tracks tab provides a list of available global event tracks.

Assigned Event Tracks — lists the event tracks assigned to the clip.
Available Event Tracks — lists the available event tracks that can be assigned to the clip.
Add Track — select an available event track and click this button to assign it to the clip.
Remove Track — select an assigned event track and click this button to remove it from the clip.

For More Information on...
• using global event tracks, refer to the XPression Clips Workflow User Guide.

Other
Export — use this list to select one of the following options for exporting a clip:
• To Video — open the Export to Video dialog box to save the clip as an AVI or MOV video file.
• Still to Disk — open a save dialog to save a still as a Targa (.TGA), Targa (RLE Compressed) (.TGA), Portable Network Graphic (.PNG), or JPEG (.JPG) format image file.
• Still to Clipstore — open the Send to Clip Store dialog box to send a still to the Clip Store database to be used within the Clips workflow.
• Interlaced Settings > Frame Based — select this to capture the image file without deinterlacing. This setting only works best for scenes with minimal motion.
• Interlaced Settings > Field (line doubled) — select this to capture the image file with each line doubled. For example, it will replace field two with a duplicate of field one.
• Interlaced Settings > Field (line interpolated) — select this to capture the image file by interpolating between odd lines to form even lines.

Save — click this button to save the edited clip or sub clip.
Cancel — click this button to exit the dialog box without saving any changes.
Updating the Thumbnail in the Clip Browser

Update the thumbnail in the Clip Browser to provide a more representative or preferred image to illustrate the content of the clip.

1. In the **Clip Browser**, right-click on a clip and select **Edit Clip** or **Add Sub Clip**.
   The **Edit Clip** / **Add Sub Clip** dialog box opens.

2. In the **Edit Clip** or **Add Sub Clip** dialog box, move the timeline marker to a desired frame in the timeline.
3. Right-click inside the timeline and select **Update Clip Thumbnail** from the shortcut menu.

4. Click **Save**.

   The thumbnail for the clip is updated in the Clip Browser.
Creating a 4-Point Loop

4-point loops use a frame in point, a loop section of start and end frames, and a frame out point.

1. In the Edit Clip / Add Sub Clip dialog box, click the Clip tab.
   
The Clip tab opens.

2. In the In Point box, enter a frame in point.

3. In the Out Point box, enter a frame out point.

4. Click the Looping tab.
   
The Looping tab opens.

5. In the Looping tab, select the Enable Looping check box.

6. Select the Multi-Point check box.
7. In the **Multi-Point Loop Settings** section:
   a. Use the **Loop Start** box to enter a frame start for the loop.
   b. Use the **Loop End** box to enter a frame stop for the loop.
   c. Use the **Loop Count** to enter or select a number of times to playout the loop.

8. Click **Save**.
   
The edited clip is updated in the **Clip Browser**.
Creating a 3-Point Loop

3-point loops use a loop section of start and end frames with either a frame in point the same as the loop start frame or a frame out point the same as the loop end frame.

1. In the Edit Clip / Add Sub Clip dialog box, click the Clip tab.

   The Clip tab opens.

2. In the Clip tab, enter a frame in point in the In Point box or enter a frame out point in the Out Point box.

3. Click the Looping tab.

   The Looping tab opens.

4. In the Looping tab, select the Enable Looping check box.

5. Select the Multi-Point check box.
6. In the **Multi-Point Loop Settings** section:
   a. Use the **Loop Start** box to enter a frame start for the loop.
   b. Use the **Loop End** box to enter a frame stop for the loop.
   c. Use the **Loop Count** to enter or select a number of times to playout the loop. Use 0 for infinite looping.

7. Click **Save**.

The edited clip is updated in the **Clip Browser**.
Visual Logic

Visual Logic is a visually-oriented code authoring environment that enables the quick creation and editing of segments of script code for scenes. Script can be done manually, or using Visual Logic to create and edit scenes visually. Visual Logic enables users with minimal script experience to more easily add script functionality and logic to scenes. In the Visual Logic interface, drag object and function blocks into the logic tab, and then connect them to define their logical relationships.

The following topics are discussed in this section:

- Opening the Visual Logic Editor
- Objects and Function Blocks
- Connecting Object and Function Blocks
- Selecting Multiple Object and Function Blocks
- Copying and Pasting Object and Function Blocks
- Deleting Object and Function Blocks
- Adding a New Visual Logic Tab
- Deleting a Visual Logic Tab
- Saving and Opening Visual Logic Files
Opening the Visual Logic Editor

1. Create or select a scene in XPression.
2. In the Main Viewport, click Edit Visual Logic. The Visual Logic Editor opens.

It is helpful if Show or Hide Continuous Animations and Other Effects is turned on in the Main Viewport in order to view the logic from the Visual Logic Editor in the scene.
Objects and Function Blocks

Objects and Function blocks are visual representations of script code segments. Each object block represents the respective parameters of a scene, object, or material. Each function block represents a functional unit, such as a parameter, a variable, a logical control, or a script function. To create a working visual logic segment, you drag multiple object and logic blocks into the workspace and then link them together to define how they interact.

The following image shows the parts of the Greater Than/Equal To logic function block, which is used to determine if one value is greater than, or equal, to the other:

```
<table>
<thead>
<tr>
<th>Inputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect a parameter to the Base input or enter a Base value in the Properties section of the function block.</td>
</tr>
<tr>
<td>Connect a parameter to the &gt;= input.</td>
</tr>
</tbody>
</table>
```

```
<table>
<thead>
<tr>
<th>Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outputs connect to other blocks, which may or may not be executed based on the result of the logic from the inputs.</td>
</tr>
</tbody>
</table>
```

**Figure 28.2** The Greater Than/Equal To Logic Function Block

The following example shows a Greater Than/Equal To logic function block with inputted Value math function blocks that are outputted to a Quad scene object:

```
<table>
<thead>
<tr>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0</td>
</tr>
<tr>
<td>Value</td>
</tr>
<tr>
<td>3.0</td>
</tr>
</tbody>
</table>
```

**Figure 28.3** The Greater Than/Equal To logic function block connected to other blocks

In the example, the two Value math function blocks provide the data to be compared by the Greater Than/Equal To logic function block. Because the Base value is 2.0 and the >= value is 3.0, the Quad1 Visible scene object block to which the data is outputted will be visible in the scene.

**Line Colors**

The colors of the lines connecting the logic blocks have meanings:

• If a line is green, it indicates that the block can be connected to the selected input.
• Red lines with arrowheads indicate that the block cannot be connected to the selected input.
• Blue lines with arrowheads indicate the sharing of data from one logic block to another.

**Data Inputs**

A green dot on the left side of a block indicates a data input. A yellow dot on the right side of a block indicates a data output. Data inputs and outputs appear on almost every type of logic block. Data can come from objects and function blocks. To share data from one block to another, click and drag from a data output point (yellow dot) on one block to a data input point (green dot) on another block. Data can be shared from one block to multiple other blocks.
Block Colors
The title bars of logic blocks are colored, to visually group the blocks. By default, object blocks are gray, and function blocks are the following:

- Colors: red
- Data Sources: turquoise
- Generators: blue
- Logic: purple
- Math: aqua
- Selectors: orange
- Strings: magenta
- Timers/Counters: green
- Vector Math: yellow

Settings
Use the Settings section to configure specific individual settings for Visual Logic.

Timing
In the Timing section of the Settings, select the Visual Logic should run after scene directors are advanced check box to set Visual Logic to run after the scene directors are advanced so that any objects linked to animated objects will move in sync.
Connecting Object and Function Blocks

Use the workspace within the VLogic tab to drag and drop **Objects** and **Function Blocks**, and then link the blocks to establish logical connections between them.

The Objects tree lists scenes, scene objects, and materials and the parameters associated with the objects.

1. In the **Visual Logic Editor**, drag an **Object** or **Function Block** and drop it onto the **VLogic** tab workspace.
   The block is added to the workspace.

2. Drag another **Object** or **Function Block** and drop it onto the **VLogic** tab workspace.
   The block is added to the workspace.
3. Click on the yellow output of a block and drag the blue arrowhead towards the block with which to connect.

4. Drop the arrowhead onto the desired input of the block with which to connect. The arrowhead and line will turn green if it can be connected; red if it cannot. Once it is connected it will become blue again, or dark red if the connection type is [any].
Selecting Multiple Object and Function Blocks

Multiple object and function blocks can be selected in the VLogic tab workspace using the following actions:

- select multiple specific blocks by holding Shift or Ctrl and selecting the desired blocks.
- click and hold the left mouse button and drag the selection border around the desired blocks. Release the left mouse button when the desired blocks have been surrounded.
Copying and Pasting Object and Function Blocks

Object and function blocks can be copied and pasted in the workspace of the VLogic tabs.

**To copy object and function blocks:**
1. In the workspace, select the block or multiple blocks to copy.
2. Right-click and select **Copy** or press **Ctrl+C**.

**To paste object and function blocks:**
1. Copy a block or blocks in the workspace.
2. Right-click and select **Paste** or press **Ctrl+V**.
Assigning and Pasting a Copied Object Attribute

An object block can assign the copied attributes of a different object by using the Assign & Paste function in the shortcut menu of the Visual Logic tab workspace.

To assign and paste:

1. In the workspace, select an object block or multiple object blocks to copy.
2. Right-click and select Copy or press Ctrl+C.
3. Right-click and select Assign & Paste or press Shift+Ctrl+V.
   
   The Paste Visual Logic Properties window opens.

   ![Paste Visual Logic Properties window](image)

4. In the Paste Visual Logic Properties window, use the Destination Object list to select an object from the scene in which to paste the selected source property.

   ![Destination Object list](image)
The selected source property is assigned to the select destination object.

Clicking the **Increment Destinations** button will assign the selected source property to the next destination object available in the list of destination objects for the scene.

5. **Click OK.**

The **Paste Visual Logic Properties** window closes and the source properties are assigned to the selected destination objects.
Deleting Object and Function Blocks

1. In the workspace, select the block or multiple blocks to delete.
2. Right-click and select **Delete** or press **Delete**.
Adding a New Visual Logic Tab

By default, a Visual Logic tab (VLogic1) is created when the editor is first opened. Multiple tabs can be created and used for a scene.

1. Open the Visual Logic Editor.
2. Click the Visual Logic menu and select Add New (or right-click on the top of the workspace where the VLogic tabs are located and select Add New from the shortcut menu).
   A new VLogic tab is added to the workspace.
Deleting a Visual Logic Tab

1. In the Visual Logic Editor, select the tab to be deleted.
2. Right-click on the tab and select Delete from the shortcut menu.
   The selected tab is deleted.
Saving and Opening Visual Logic Files

Visual Logic configurations for scenes can be saved to an XVL file and loaded as desired.

To save a file:
1. In the Visual Logic Editor, click the Visual Logic menu and select Save to save a tab as an XVL file or Save all tabs to save all tabs as XVL files.
   The Save As file browser opens.
2. Select a folder in which to save the file or files.
3. Click Save.
   The file or files are saved to the selected folder.

To open a saved file:
1. In the Visual Logic Editor, click the Visual Logic menu and select Open.
   The Open file browser opens.
2. Select the file(s) to open.
3. Click Open.
   The file or files are loaded in the Visual Logic Editor.
XPression Tessera

XPression Tessera, part of Ross Video’s broad line of real-time graphics products and workflow tools, is a multi-display real-time graphics designer/controller for sports venues & studio video walls.

Tessera enables users to link together multiple XPression engines to create a scalable matrix of channels for seamless output of scenes across large or irregularly assembled display panels. Perfect for sports scoreboards, ribbon boards, and studio video walls, Tessera’s resolution can scale just by adding more XPression engines or “Tessera nodes” and adding to the mapping.

Frame-accurate, non-tearing recall of graphics and clips across any or all nodes is made possible with XPression’s Multi-Engine Sync technology. More importantly, XPression’s unlimited scene layering on output is preserved across Tessera nodes for incredibly dynamic animations and transitions.

The Tessera Region Manager allows operators to divide scenes into regions and assign those regions to specific nodes. The Tessera Node Manager allocates the XPression engines and channels to be used as render nodes. And, the XPression Project Server handles the automatic one-click publishing of scene updates and resources to all nodes for ultimate efficiency.

Whether you need to drive large displays in sports venues or build a studio video wall, XPression Tessera is the most powerful and cost-effective solution available.

The following topics are discussed in this section:

- User Interface Overview
- XPression Tessera Setup
- Tessera Playback
User Interface Overview

This section provides a user interface overview for the XPression Tessera Region Mapper. It includes the following:

• XPression Tessera Region Mapper - Source Region Layout Settings
• XPression Tessera Region Mapper - Destination Region Layout Settings

XPression Tessera Region Mapper - Source Region Layout Settings

The following screen capture displays the main elements of the XPression Tessera Region Mapper window in XPression with the Source Region Layout section of the selected source region.

1) Menu Bar — use the File menu to load a configured region map from a saved file or save a configuration.
2) Source Region Layouts — use this section to add and delete source outputs of specific resolution and regions across multiple channels of XPression on multiple render engines.
3) Source Region Layout Settings — use this section to configure the settings for a selected source, including defining the region and mapping sources to destinations.
4) Destination Region Layouts — use this section to add and delete destination framebuffer outputs with rendered regions that are mapped to source outputs.
XPression Tessera Region Mapper - Destination Region Layout Settings

The following screen capture displays the main elements of the XPression Tessera Region Mapper window in XPression with the Destination Region Layout section of the selected destination region.

1) **Menu Bar** — use the File menu to load a configured region map from a saved file or save a configuration.

2) **Source Region Layouts** — use this section to add and delete source outputs of specific resolution and regions across multiple channels of XPression on multiple render engines.

3) **Destination Region Layout Settings** — use this section to configure the settings for a selected destination, including defining the region.

4) **Destination Region Layouts** — use this section to add and delete destination framebuffer outputs with rendered regions that are mapped to source outputs.


XPression Tessera Setup

Overview

The XPression Tessera setup consists of the following concepts and workflow:

- Tessera can consist of either a master controller and output node engines, or a single engine setup. The master controller has no actual physical outputs. Output nodes are render devices which do not require a user interface. In single engine mode, the single engine acts as the master controller and output engine.
- Scenes are typically created at the actual size (resolution) that they are to be displayed, but do not have to be.
- There are two elements to a Tessera mapping: Source Region Layouts and Destination Region Layouts.
- Source Region Layouts are "region masks" applied to an XPression scene, and in turn these regions are mapped to destination regions.
- Destination Region Layouts can be viewed as if they are framebuffer outputs. Each destination has regions that will be rendered to, allowing for the slicing of pieces of the overall full resolution canvas should non-standard resolution displays be rendered to.
- Source Region Layouts are eventually mapped to Destination Region Layouts. For example, a destination could have two regions from two sources that would be stitched together.
- Every engine must have GenLock. All engines must be locked to the same GenLock/reference.
- Each XPression turnkey engine has two network cards. One network interface can link to a public network for internet, and the other can link to the private Tessera network. The network synchronization is accomplished using UDP.

**Note:** managed networks may prioritize TCP over UDP, affecting the performance of the synchronization.
- When using multiple engines, projects are centrally located on an XPression Project Server. Every Tessera graphics project MUST be uploaded once to the project server and then re-deployed to the local disk. If the project is simply saved, it will not be synced.

The following topics are discussed in this section:

- Tessera Multiple Engine Mode
- Tessera Single Engine Mode
- Region Mapping
- Scenes
- Saving a Project
- Saving Region Mappings
- Tessera Backup System
- Assigning a Source Output to a Scene or Scene Group in the Object Inspector

Tessera Multiple Engine Mode

Using the **Tessera Settings** dialog box, the output node engines and the master engine can be defined and configured. Once the engines have been set up, the output nodes can be configured. Use the following sections to configure the multiple engine Tessera set up:

- Preconditions
- Setting Up the Output Node Engines
- Setting Up the Master Engine
- Tessera Output Nodes
- Using Clips with Tessera Multiple Engine Mode
- Using DataLinq with Tessera Multiple Engine Mode
Preconditions

The following items should be completed before setting up an XPression Tessera project:

- The master XPression engine, the output node XPression render engines, and the XPression Project Server are connected within the network. All render engines must be linked to the same Project Server or else the render engines will not be able to retrieve the master project.
- If using multiple engines, projects have been centrally located on the XPression Project Server where they can be deployed from the master engine.

Setting Up the Output Node Engines

Output node engines can be configured in XPression Studio and/or XPression BlueBox. Setting up the output render engines first allows for a one-stop configuration of the controlling master engine afterwards.

- Output node channels should only be hardware channels; server channels or virtual outputs should not be used.
- Ensure in the Editor section of the Preferences menu (in Studio) and the BlueBox section of the Preferences menu (in BlueBox) that the Do Not Create Untitled Project check box is selected.

To set up an output node engine:

1. Depending on whether the output node engine is being configured on Studio or BlueBox, do one of the following:
   - In XPression Studio on an output node engine, select Edit > Tessera > Settings to open the Tessera Settings dialog box.
   - On an XPression BlueBox machine, right-click on the XPression BlueBox icon ( ) in the Windows system tray and select Tessera Setup from the menu to open the Tessera Setup dialog box.

The Tessera Settings / Tessera Setup dialog box opens.

- The Master section with the Clock Node ID field is only available on Studio versions.
2. In the **General** section, use the **Mode** list to select **Output Node**.

   The **Tessera NET**, **Output Node**, and **UDP Network** sections become available for configuration.

![Diagram of XPression interface showing General, Tessera NET, Output Node, and UDP Network sections]

3. In the **Tessera NET** section, use the **NET ID** box to enter or select a NET ID if using multiple master/node combinations in parallel on the same network.

4. In the **Output Node** section, use the **Engine ID** box to enter or select an engine ID to use to indicate to other machines what output device this output node engine is relative to the rest of the system.

   A different engine ID is required for each output node engine in the system.

5. In the **UDP Network** section, use the **Broadcast Mode** list to set the broadcast mode to one of the following:

   - **Local Broadcast** — select this option to broadcast packets to all local network addresses.
   - **Broadcast IP** — select this option to broadcast packets to a specific subsection of the network. For example, 192.168.1.255.

   Some routers prevent broadcasting packets as a local broadcast. For example, 255.255.255.

   **Local Broadcast**

   If using the **Local Broadcast** option, do the following:

   a. Use the **IP Address** box to enter 255.255.255.255 as the IP broadcast address to broadcast packets to all of the local network addresses.

   b. Use the **Port** box to enter the port number to use for communication between the output node engine and master engine. The default is 7575.

   **Broadcast IP**

   If using the **Broadcast IP** option, do the following:

   a. Use the **IP Address** box to enter the IP address of the broadcast network.

   This address is used as an IP filter. For example, if the system is set up to function in a 192.168.1.XXX space, use 192.168.1.255 as the IP address to indicate that devices could be located anywhere between 192.168.1.1 and 192.168.1.254. This also ensures that if dual network cards are used, and one of the cards is on a different network address range, Tessera synchronization traffic will not be broadcast to the public side of the network.

   Click **Retrieve** to have XPression determine the most likely subsection to use for broadcasting.

   b. Use the **Port** box to enter the port number to use for communication between the output node engine and master engine. The default is 7575.
6. Click OK.
   The output node engine settings are applied and the dialog box closes.
7. Repeat steps 1 to 6 for any other output node engines in the system.

Setting Up the Master Engine

The master engine can only be configured in Studio versions. Only one master can be configured, and there should be no hardware channels, virtual outputs, or server channels in the hardware profile. They should all be blank.

For the controlling master engine, use the Tessera Settings dialog box to configure the master engine settings.

To set up the master engine:

1. In XPression on the master engine, select Edit > Tessera > Settings.
   The Tessera Settings dialog box opens.
2. In the **General** section, use the **Mode** list to select **Master**.

The **Master** and **Network** sections become available for configuration.

![Screenshot of XPression User Guide](image)

3. In the **Tessera NET** section, use the **NET ID** box to enter or select a NET ID if using multiple master/node combinations in parallel on the same network.

4. In the **Master** section, use the **Primary Clock Node ID** box to enter or select the primary engine node ID to set the clock for all the engines. For a single controller setup, the Primary Clock Node ID will only be set to 1.

5. Use the **Backup Clock Node ID** box to enter or select an output node engine ID as the backup for the Tessera master should the Primary Clock Node ID enter a non-responsive state (Output Node Timed Out, No Communication, or Unknown).

6. In the **Region Map Selection** section, select one of the following:
   - **Use Global Region Map** — select this option to use region maps saved globally on the engine.
   - **Use Region Maps from Projects** — select this option to use region maps stored in a project file.

   Using region maps from projects requires a project server.

7. In the **UDP Network** section, use the **Broadcast Mode** list to set the broadcast mode to one of the following:
   - **Local Broadcast** — select this option to broadcast packets to all local network addresses.
   - **Broadcast IP** — select this option to broadcast packets to a specific subsection of the network. For example, 192.168.1.255.

   Some routers prevent broadcasting packets as a local broadcast. For example, 255.255.255.

   **Local Broadcast**

   If using the **Local Broadcast** option, do the following:

   a. Use the **IP Address** box to enter 255.255.255.255 as the IP broadcast address to broadcast packets to all of the local network addresses.

   b. Use the **Port** box to enter the port number to use for communication between the master and output node engines. The default is 7575.
Broadcast IP

If using the **Broadcast IP** option, do the following:

**a.** Use the **IP Address** box to enter the IP address of the broadcast network.

This address is used as an IP filter. For example, if the system is set up to function in a 192.168.1.XXX space, use 192.168.1.255 as the IP address to indicate that devices could be located anywhere between 192.168.1.1 and 192.168.1.254. This also ensures that if dual network cards are used, and one of the cards is on a different network address range, Tessera synchronization traffic will not be broadcast to the public side of the network.

Click **Retrieve** to have XPression determine the most likely subsection to use for broadcasting.

**b.** Use the **Port** box to enter the port number to use for communication between the master and output node engines. The default is 7575.

8. Click **OK**.

The master engine settings are applied and the dialog box closes.

**Tessera Output Nodes**

Use the **XPression Tessera Output Nodes** dialog box to direct the master device to the XPression output engines (configured as output nodes). Output nodes are only configurable in Studio versions.

**To configure the output nodes:**

1. In **XPression** on the master device, select **Edit > Tessera > Output Nodes**.

   The **XPression Tessera Output Nodes** dialog box opens.

2. Click **Add** to add a network node to the **Network Nodes** list.

   The **XPression Tessera Output Node** dialog box opens.

3. Use the **Engine ID** list to select the output node engine ID for the output node.
4. Use the **Host Name** box to enter the UNC or IP address of the network to connect the output engines.

5. Use the **Name** box to enter a custom name for the output node if necessary.

6. Use the **Description** box to enter a brief description for the output node if necessary.

7. Use the **Location** box to define the physical location of the engine if necessary.

8. Use the **Type** list to select the engine type. The options are:
   - **Primary Engine** — select this option to use the output node as a primary engine. The primary engine is used to direct the master device to the XPression output engines (configured as output nodes).
   - **Backup Engine** — select this option to use the output node as a backup engine. In the event that a primary engine is unavailable, the backup engine is used to direct the master device to the XPression output engines (configured as output nodes). The engine ID of the backup engine should be matched with a primary engine that uses the same engine ID.

9. Click OK.

   Primary engines are added to the **Primary Engines** list and backup engines are added to the **Backup Engines** list.

10. Repeat steps 1 to 9 for any other output engines.

**For More Information on...**
   - the XPression Tessera backup system, refer to "**Tessera Backup System**" on page 29–21.

**Using Clips with Tessera Multiple Engine Mode**

When using Clips with Tessera multiple engine mode, ensure that the XPression Clip Store Manager is running on all engines. The master engine then needs to sync its contents to the Clip Stores on all the other engines so that they all have the same clip assets available.

**Using DataLinq with Tessera Multiple Engine Mode**

When using DataLinq with Tessera multiple engine mode, the XPression DataLinq Server only needs to run on the master engine.
**Tessera Single Engine Mode**

Use the Tessera single engine option to enable local area mapping within an XPression system.

**To set up a single engine system:**

1. In **XPression** on the master engine, select **Edit > Tessera > Settings**.
   
   The **Tessera Settings** dialog box opens.

2. In the **General** section, use the **Mode** list to select **Single Engine**.

3. In the **Region Map Selection** section, select one of the following:
   
   - **Use Global Region Map** — select this option to use region maps saved globally on the engine.
   - **Use Region Maps from Projects** — select this option to use region maps stored in a project file.

   Using region maps from projects requires a project server.
4. Click **OK**.

   The **Tessera Settings** dialog box closes.

   In single engine mode, there are no output nodes to configure.
Region Mapping

Use the XPression Tessera Region Mapper to map the sources, destinations, and regions. Region mapping is only configurable in Studio versions.

To map the sources, destinations, and regions:

1. In XPression on the master device, select Edit > Tessera > Region Mapping (or press Shift+Ctrl+Alt+R). The XPression Tessera Region Mapper opens.

2. In the Destination Region Layouts section, right-click and select Add Destination from the shortcut menu. A new destination is added to the Destination Region Layouts list.
3. In the **Destination Region Layout Settings** section, configure the source ID, output node, output resolution, and regions.

The destination is the playback channel.

**ID**

Create a name and description for the destination as required.

a. In the **ID** section, use the **Name** box to enter a custom name for the destination. Assuming the output resolution is the same as what is displayed, it is recommended to give it a name. Enter a name that makes sense within the system (for example, CG 1-1, which might indicate output node 1-first output channel, etc.).

b. Use the **Description** box to enter a custom description about the destination.

**Output Node**

Configure the display output for the destination.

a. In the **Output Node** section, use the **Node** list to select the output node of the output engine to be used to output the destination. The list is populated by the output nodes previously configured in the **XPression Tessera Output Nodes** dialog box, or if using Tessera in single engine mode, is restricted to <local engine>.

b. Use the **Channel** list to select a playback channel on the output engine for outputting the destination region. Although there are 12 channels in the list, the amount of usable channels is dependent on the amount of channels available on the output engine.

c. If using multiple Tessera SE or Tessera Master systems in a MOS workflow, use the **Net ID** list to select a net ID to indicate to which Tessera system the MOS object should be sent.

**Output Resolution**

Configure the resolution in pixels for the destination.

a. In the **Output Resolution** section, use the **Standard** list to select a standard pixel dimension or select **Custom** to use a custom resolution.

   If using a custom resolution, use the **Horizontal** and **Vertical** boxes to enter or select the dimensions for the custom resolution. Also, simply entering or selecting a different value will automatically select **Custom** from the **Standard** list.

b. Use the two **Aspect** boxes to enter or select the aspect ratio for the destination. This is automatically entered if the **Standard** output resolution is selected.

c. Use the **Opacity** box to enter or select the transparency value for the background image.

d. Click **Browse (...)** to open a file browser to locate a file to use as the background in the destination, or enter a file path in the **Background** box.

   Backgrounds are used as a reference to clearly delineate between regions and color code them as desired (for example, red regions can represent advertisements, blue regions can represent stats, etc.). Do this by creating an image file that fits the canvas and is representative of the regions.

**Region Editor**

Set the region(s) for the destination region layout. A destination region is used to display a source that is mapped to it once the sources have been configured. Multiple sources can be mapped to multiple regions within the destination, which is then outputted to a channel on the output engine.

For example, to stitch together multiple full resolution channels into one logical channel, create a region of the full resolution of the output channel, starting it at pixel coordinate width 0, height 0.

Use the **Zoom** list to select a percentage size of the destination canvas to display in the **Region Editor** display. Selecting **To Fit** will size the canvas to fit the size of the **Region Editor** display.
a. In the Region Editor section, click **Add** to create a destination region. The **New Region** dialog box opens.

![Region Editor](image)

b. Use the **Width** and **Height** boxes to enter or select a size in for the new region.

c. Click **OK**.

A region is added to the destination canvas in the Region Editor display and the thumbnail in the Destination Region Layouts list.

d. Use the **Position X** and **Y** boxes to adjust the location of the region along the X-axis and Y-axis within the destination canvas.

e. Use the **Width** and **Height** boxes to adjust the size of the region.

f. Use the **Rotation** list to select a degree of rotation for the region. The options are:
   - **<none>** — apply no degree of rotation to the selected region.
   - 90 degrees
   - 180 degrees
   - 270 degrees

   The rotation is only visible on the output and not in the region editor.

g. Use the **Name** box to enter a custom name for the region.

h. Use the **Description** box to enter a custom description about the region.

i. Repeat steps a to h to add more regions to the destination as necessary.

🌟 Regions can be copied by right-clicking on the region in the Region Editor and selecting **Copy Region** from the shortcut menu. Paste a copied region in the same or a different Region Editor by right-clicking in a Region Editor and selecting **Paste Region** from the shortcut menu.
4. Repeat steps 2 to 3 to add more destinations as necessary.

5. In the **Source Region Layouts** section, right-click and select **Add Source** from the shortcut menu. A new source is added to the **Source Region Layouts** list. Sources in the list can be dragged and dropped into a different order.

6. In the **Source Region Layout Settings** section, configure the source ID, virtual dimensions, regions, and mapping.

   Because Tessera renders one single scene to multiple output channels, there is no single channel in which to render. So a virtual channel must be created, and that is called a source.

   **ID**
   Create a name and description for the source as required.
   a. In the **ID** section, use the **Name** box to enter a custom name for the source.
   b. Use the **Description** box to enter a custom description about the source.
   c. Select the **Optimize Rendering for large number of destination regions** check box for high performance rendering when a source is mapped to many destination regions and the scene size is extremely wide or tall. This useful in ribbon board workflows, etc.

   **Virtual Dimension**
   Set the dimensions of the virtual source channel template.
   a. In the **Virtual Dimension** section, use the **Horizontal** and **Vertical** boxes to enter or select the horizontal and vertical resolution for the source.
   b. Use the two **Aspect** boxes to enter or select the aspect ratio for the source.

   The **Virtual Dimension** and **Aspect** fields automatically data-fill depending on which is configured first. For example, aspect ratios do not need to be manually calculated if the dimensions have been entered.
   c. Use the **Opacity** box to enter or select the percentage of opacity for the selected background.
   d. Click **Browse** (…) to open a file browser to locate a file to use as the background in the source, or enter a file path in the **Background** box.

   Backgrounds are used as a reference to clearly delineate between regions and color code them as desired (for example, red regions can represent advertisements, blue regions can represent stats, etc.). Do this by creating an image file that fits the canvas and is representative of the regions.
Region Editor

Set the region(s) for the source region layout. Source regions are used to select specific sections or portions of a source in order to add them to a specific playback destination.

Use the Zoom list to select a percentage size of the region dimension to display in the Region Editor display. Selecting To Fit will size the source to fit the size of the Region Editor display.

a. In the Region Editor section, click Add to create a source region.

   The New Region dialog box opens.

b. Use the Width and Height boxes to enter or select a size in for the new region.

c. Click OK.

A region is added to the source canvas in the Region Editor display, the Source To Destination Mapping list, and the thumbnail in the Sources list.

d. Use the Position X and Y boxes to adjust the location of the region along the X-axis and Y-axis within the source canvas.

e. Use the Width and Height boxes to adjust the size of the region.

f. Use the Name box to enter a custom name for the region.

g. Use the Description box to enter a custom description about the region.

h. Repeat steps a to g for any other source region layouts as necessary.

   Source region layouts can also be duplicated by right-clicking a source and selecting Duplicate Source from the shortcut menu.
Source To Destination Mapping

Once source regions are configured, they need to be mapped to a destination. Mapping indicates to each engine what area of the overall scene is to be rendered.

a. In the Source To Destination Mapping table, click <none> under a source Region and use the list to select the desired playback destination or destination region for the source region.

If mapping the source to the entire destination canvas, select the destination. If mapping the source to a region within the destination canvas, select the specific region within the destination.

b. Repeat step a for all regions in the table.

* Regions can be copied by right-clicking on the region in the Region Editor and selecting Copy Region from the shortcut menu. Paste a copied region in the same or a different Region Editor by right-clicking in a Region Editor and selecting Paste Region from the shortcut menu.

7. Click File > Save To File to save the region mapping to a .xprgm file.
Using a Preview Output On a Tessera Master

The Tessera master can use local framebuffers as a preview output.

To setup a preview output:

1. On the Tessera master, click Edit > Hardware Setup.
   The Hardware Setup dialog box opens.

2. Configure an output.
   The output is added to the Inputs / Outputs list.
3. Click the **Preview & Monitor** tab.
   
The **Preview & Monitor** tab opens.

4. In the **Video Preview Output** section, use the **Up Next Preview Output** list to select the output to use for the Tessera master preview.

   **For More Information on...**
   
   • configuring a framebuffer output, refer to “**System Setup**” on page 3–1.

**Scenes**

Projects can be designed as they are always designed in XPression, with a couple of caveats:

• Orthogonal cameras cannot be used in combination with Tessera.
• Background objects cannot be used in combination with Tessera.

These objects are not compatible with how Tessera renders the scene.

Any size of scene can be used. It typically makes sense to have the aspect of the source scenes match the aspect of the destination.

**To create a custom size scene:**

1. Right-click inside the **Scene Manager** and select **New > Custom Size Scene** from the shortcut menu.
   
The **New Scene** dialog box opens.

2. In the **Virtual Dimensions** section, use the **Width** box to enter or select the width in pixels of the new scene.
3. In the **Height** box, enter or select the height in pixels for the new scene.

   The **Area Mapping** table is not applicable in the Tessera workflow.
4. Click **OK** to create the new scene with the defined settings.

   The **New Scene** dialog box closes and the new scene is added to the **Scene Manager** window below the scene or scene group selected in the scene list.
Saving a Project

Saving projects varies depending on whether Tessera uses multiple engines (master and output nodes) or a single engine.

Multiple Engines

Tessera using multiple engines uses the Project Server to automatically sync the project amongst the render engines (output nodes). To enable this mechanism it is required that certain steps are completed.

To enable the Save Project and Publish To Project Server button:

1. Save the project to disk.
2. Save the project to the project server.
3. Deploy the project in XPression.
4. Click the **Save Project and Publish To Project Server** button ( ) to save the project and ensures all systems are queued to sync.

Single Engine

If using Tessera with a single engine, the Project Server is not required and saving the project to disk is sufficient.

To save a project using a single engine:

1. Save the project to disk.

Saving Region Mappings

Individual region mappings can be saved and loaded in the XPression Tessera Region Mapper.

To save a region mapping:

1. In the **XPression Tessera Region Mapper**, click **File > Save To File**. The **Save As** file browser opens.
2. Select a folder for the file and click **Save** to save the region mapping to a .xprgm region mapper file.

Saved files can be loaded by clicking **File > Load From File**.

Tessera Backup System

This section describes the XPression Tessera Output Nodes status list and its use in monitoring the status of the Tessera Primary and Backup Nodes and assigning a Backup Node to act as a Primary Node.

The Backup Clock Node and Backup Tessera Master methods and maintaining the backup system are also described.

The following topics are discussed:

- Tessera Output Nodes Status List
- Using a Backup Node
- Using the Keyboard/GPI Map to Assign Backup Nodes
- Video Routing
- Backup Tessera Output Node Maintenance
- Backup Clock Node
- Using a Backup Tessera Master
- Backup Tessera Master Maintenance
Tessera Output Nodes Status List

Open the XPression Tessera Output Nodes window and access the Tessera output nodes status list on the master engine by clicking Edit > Tessera > Output Nodes.

This window lists all the primary and backup output nodes to which the Tessera master is connected. The output nodes are divided by Primary Engines and Backup Engines. Primary engines are actively being used by the Tessera master and the backup engines can be assigned a backup state at any time. By default, backup engines will be in the <standby> state.

**Primary & Backup Nodes**

In the Primary Engines and Backup Engines lists are the configured primary and backup nodes respectively.

- **Name** — the name of the node. Does not affect operation. For example, Left Mainboard Engine.
- **Engine ID** — the Tessera output node engine ID set in the Tessera output node configuration on each node (Primary or Backup).
- **Location** — the location of the node. Does not affect operation. For example, Rack 10 Row 20.
- **Description** — a description of the node. Does not affect operation. For example, node used for interior boards.
- **Host Name** — the IP address or host name of the Tessera node running XPression Studio or BlueBox.
- **Status** — displays the status of the node. See Node Status below for more information.
Node Status

Tessera primary and output nodes will continuously send the Tessera master a status message when running.

There are four possible statuses that can be shown in the XPression Tessera Output Nodes status list:

- **Output Node Running** — the output node is running XPression Studio or BlueBox and is sending status packets.
  - **Projects Loaded** — number of projects loaded in the output node.
  - **Memory Fragmentation** — memory usage of XPression on the output node.
  - **Rendering Time** — uptime of the output node XPression Studio or BlueBox software application.
- **Output Node Timed Out** — the output node has stopped sending status messages. If an output node enters this state, the Tessera master will stop waiting for this node to respond to commands. Possible cause: XPression Studio or BlueBox is in a non-responsive state.
- **No Communication** — the Tessera master has not received status packets from the node in 15 seconds or more. Possible causes:
  - Network communication lost.
  - XPression Studio or BlueBox has not been closed since being launched.
- **Unknown** — the Tessera master has not yet received any status packets from the output node. Possible cause: XPression Studio or BlueBox has not been launched on that output node since the Tessera master has been active.

Using the Status List

The XPression Tessera Output Node status list can be used to determine if a Tessera system is active and ready to be used. To determine if a system is ready, confirm that all output nodes show a status of **Output Node Running** and display the correct number of **Projects Loaded**. If a primary or backup node shows **Output Node Running** and has the correct number of projects loaded, it is ready to receive commands from the Tessera master.
Using a Backup Node

Backup Engines can be activated without interrupting or changing the behavior of the Tessera system. Backup Engines can be used as warm or hot backups. A warm backup can be assigned any Primary Engine ID and a hot backup can be left running in parallel with any Primary Engine ID.

1. On the XPression Tessera master, click Edit > Tessera > Output Nodes.
   The XPression Tessera Output Nodes window opens.

2. In the Backup Engines list, select a backup engine.
   a. Click the Backup State column.
      The Backup State column displays a drop-down menu that lists all the primary engines from the Primary Engines list by name and engine ID.
   b. Select a primary engine for the backup state.

   ![Backup Engine Selection](image)

The backup engine will now respond to all commands from the Tessera master that are assigned to that engine ID.

- If the primary engine is in Output Node Running status, both the primary engine and backup engine assigned to it will run in parallel (hot backup).
- If the primary engine is in Output Node Timed Out/No Communication or Unknown the Tessera master will only wait for the backup engine for playout.

A backup engine will only respond to commands sent from the Tessera master after it has been assigned a Primary Engine ID. It will not retroactively engage commands that were sent before it was assigned a Primary Engine ID or bring online take items that were already online on the primary engine.
Using the Keyboard/GPI Map to Assign Backup Nodes

XPression Keyboard and GPI mapping can also be used to assign a backup engine and primary engine node ID.


2. In the Available Global Functions section, expand the Tessera menu and select Tessera Backup.

3. Drag the Tessera Backup function and drop it on an available Global Shortcut.

4. In the Tessera Backup Options section, use the Backup Node ID list to select the backup node.

5. Use the Assign as backup of list to select the node to backup using the selected backup node ID.

6. Click OK. The Keyboard / GPI Mapping dialog box closes.

Video Routing

Once a backup engine has been assigned as a primary engine, the video feed from the backup engine will need to be routed to the same destination that the Primary Engine had been. For example, this could be done as a router save/macro or a video switcher custom control. Ensure that macros for every combination of backup engine replacing a primary engine are accounted for.

For example, Backup Node 4 replacing Primary Node 1, 2, and 3.

Backup Node 5 replacing Primary Node 1, 2, and 3.
Backup Tessera Output Node Maintenance

Include the backup Tessera output node engines in the regular system maintenance schedule.

If using XPression Clip Store, verify that the Clip Stores on the Tessera backup engines are all being synced with the master Clip Store.

For More Information on...

• setting up Clip Store sync, refer to the XPression Clips Workflow User Guide.

Backup Clock Node

Tessera uses one of the outputs nodes as a clock node. The clock node is used as the clock generator (timer) by the Tessera master for triggering Tessera commands synchronously across all nodes. A backup clock node can also be configured, and this node will be used by the Tessera master if the primary clock node enters the Output Node Timed Out, No Communication, or Unknown states.

To configure a backup clock node:

1. On the XPression Tessera master, click Edit > Tessera > Settings. The Tessera Settings dialog box opens.
2. Ensure that the Mode in the General section is set to Master.

![Tessera Settings dialog box]

3. In the Master section, use the Primary Clock Node ID box to enter or select the primary engine node ID to set the clock for all the engines.
4. Use the Backup Clock Node ID box to enter or select an output node engine ID as the backup for the Tessera master should the Primary Clock Node ID enter a non-responsive state (Output Node Timed Out, No Communication, or Unknown).
5. Click OK. The Tessera Settings dialog box closes.

Using a Backup Tessera Master

Using a backup Tessera master requires system changes to allow a backup master to replace the primary master. Because the primary master receives commands from control systems like DashBoard or OverDrive and triggers from video switchers, the IP address of the backup master must be changed to the IP address of the primary master (and the primary taken offline).
To use a backup Tessera master:

1. Ensure that the primary Tessera master system is offline by running the Deactivate Primary.bat batch file.
   Running this batch file:
   • Closes XPression Studio/Designer.
   • Changes the IP to a placeholder IP.

2. Turn on the Backup master.
   a. Ensure that XPression is closed.
   b. Run the Activate Backup.bat batch file.
      Running this batch file:
      • Changes the IP to the primary master IP.
      • Launches XPression.

3. In XPression, click File > Load Project > Tessera Project Server Deploy to load a Tessera project.

4. Once the project has loaded, click Edit > Tessera > Output Nodes to open the XPression Tessera Output Nodes status list.

5. Verify that the each output node status shows that all project(s) are loaded.

Backup Tessera Master Maintenance

Include the backup Tessera master in the regular system maintenance schedule.

Keep the backup master Tessera deploy folder up to date by deploying the latest revision of the Tessera project(s) from the XPression Project Server by clicking File > Project Server > Deploy on the XPression Tessera master. To save updated sequencer list Take Items on the backup, the project needs to be saved on the primary.

If using DashBoard, keep the backup Tessera master DashBoard up to date with the latest Dashboard .grid files.

If using XPression Clip Store, check that the XPression Clip Stores on the Tessera backup master are being synced with the master Clip Store.

For More Information on...
• setting up Clip Store sync, refer to the XPression Clips Workflow User Guide.
Assigning a Source Output to a Scene or Scene Group in the Object Inspector

Tessera source outputs can be assigned to a scene or scene group using the Tessera tab in the Object Inspector of the selected scene or scene group.

To assign a source output:

1. In the XPression Editor, select a scene or scene group.
2. In the Object Inspector, select the Tessera tab.
   
The Tessera tab opens.

3. In the Source Template section, use the Source list to select a source output for the scene object.
   
The selected source output is assigned to the scene object and a preview of the layout is displayed in the Source Layout section.
**Tessera Playback**

Once the correct setup has been implemented for the Tessera workflow, use the XPression Sequencer in the master for playback. No outputs will be listed in the **Output** list in the Sequencer. The Tessera source regions previously created, which serve as an overlay for the current scene targeting the destination regions, are listed by name instead. Any scene or scene size can be sent to any channel, but sending the appropriate scene for the appropriate source will avoid distorting the output.

![Sequencer screenshot](image.png)

Taking elements to air is the same as it is in a regular XPression workflow.

- Source outputs can also be assigned using the Tessera tab in the Object Inspector of a scene or scene group. For more information on assigning source outputs in the Object Inspector, refer to "Assigning a Source Output to a Scene or Scene Group in the Object Inspector" on page 29–28.
Appendix A: Keyboard Shortcuts

Use the keyboard shortcuts to perform various functions in XPression.

The following topics are discussed in this section:

- Menu Shortcuts
- Toolbar Shortcuts
- Scene Manager Shortcuts
- Object Manager Shortcuts
- Text Objects Shortcuts
- Keyframe Editor Shortcuts
- Sequencer Shortcuts
- Material Manager Shortcuts
- Main Viewport Shortcuts
- Clip Browser
- Server Channels
- Visual Logic
## Menu Shortcuts

<table>
<thead>
<tr>
<th>Menu</th>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + N</td>
<td>New project</td>
</tr>
<tr>
<td></td>
<td>CTRL + O</td>
<td>Open project</td>
</tr>
<tr>
<td></td>
<td>F9</td>
<td>Revert project</td>
</tr>
<tr>
<td></td>
<td>CTRL + S</td>
<td>Save project</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + S</td>
<td>Save project as...</td>
</tr>
<tr>
<td></td>
<td>CTRL + SHIFT + ALT + S</td>
<td>Increment and save project</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CTRL + Z</td>
<td>Undo</td>
</tr>
<tr>
<td></td>
<td>CTRL + SHIFT + Z</td>
<td>Redo</td>
</tr>
<tr>
<td></td>
<td>CTRL + Q</td>
<td>Select object tool</td>
</tr>
<tr>
<td></td>
<td>CTRL + W</td>
<td>Move object tool</td>
</tr>
<tr>
<td></td>
<td>CTRL + E</td>
<td>Rotate object tool</td>
</tr>
<tr>
<td></td>
<td>CTRL + R</td>
<td>Scale object tool</td>
</tr>
<tr>
<td></td>
<td>CTRL + T</td>
<td>Pivot object tool</td>
</tr>
<tr>
<td></td>
<td>SHIFT + CTRL + ALT + R</td>
<td>Open the XPression Tessera Region Mapper</td>
</tr>
<tr>
<td><strong>Windows</strong></td>
<td>F12</td>
<td>Set main viewport as active</td>
</tr>
<tr>
<td><strong>Project</strong></td>
<td>CTRL + ALT + E</td>
<td>Display project path in Windows Explorer</td>
</tr>
<tr>
<td><strong>Animation</strong></td>
<td>CTRL + SHIFT + C</td>
<td>Open Animation Controller</td>
</tr>
<tr>
<td></td>
<td>CTRL + D</td>
<td>Open Scene Director</td>
</tr>
<tr>
<td></td>
<td>CTRL + SHIFT + K</td>
<td>Open Keyframe Editor</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + L</td>
<td>Open Clip Info window</td>
</tr>
<tr>
<td></td>
<td>CTRL + K</td>
<td>Open Set Keyframe window</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>CTRL + M</td>
<td>Display Material Manager</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + W</td>
<td>Display Widgets pane</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + O</td>
<td>Display Object Library</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + A</td>
<td>Display Audio Files pane</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + B</td>
<td>Display Object toolbar</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + F</td>
<td>Display Font Manager</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td>CTRL + SHIFT + U</td>
<td>Force engine unlock</td>
</tr>
<tr>
<td></td>
<td>CTRL + ALT + I</td>
<td>Display Input Grabber</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>F1</td>
<td>Display Online Help</td>
</tr>
</tbody>
</table>

## Toolbar Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + ALT + M</td>
<td>Display DataLinq Manager</td>
</tr>
</tbody>
</table>
### Scene Manager Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + N</td>
<td>Create new scene</td>
</tr>
<tr>
<td>CTRL + ALT + NUMPAD +/-</td>
<td>Increase/decrease the speed of a scene group roll/crawl during playout (Layout mode only)</td>
</tr>
<tr>
<td>CTRL + SHIFT + +/-</td>
<td>Increase/decrease the speed of a scene group roll/crawl during playout (Sequence mode only)</td>
</tr>
<tr>
<td>CTRL + ALT + RIGHT ARROW</td>
<td>Add a selected scene or scene group to the sequencer (Sequence mode only)</td>
</tr>
</tbody>
</table>

### Object Manager Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + SHIFT + E</td>
<td>Edit script events</td>
</tr>
<tr>
<td>CTRL + SHIFT + G</td>
<td>Insert new group object</td>
</tr>
<tr>
<td>CTRL + UP ARROW</td>
<td>Move object up in object tree</td>
</tr>
<tr>
<td>CTRL + DOWN ARROW</td>
<td>Move object down in object tree</td>
</tr>
<tr>
<td>CTRL + LEFT ARROW</td>
<td>Move object left in object tree</td>
</tr>
<tr>
<td>CTRL + RIGHT ARROW</td>
<td>Move object right in object tree</td>
</tr>
<tr>
<td>CTRL + ALT + UP ARROW</td>
<td>Move selected object(s) up in the main viewport</td>
</tr>
<tr>
<td>CTRL + ALT + DOWN ARROW</td>
<td>Move selected object(s) down in the main viewport</td>
</tr>
<tr>
<td>CTRL + ALT + LEFT ARROW</td>
<td>Move selected object(s) left in the main viewport</td>
</tr>
<tr>
<td>CTRL + ALT + RIGHT ARROW</td>
<td>Move selected object(s) right in the main viewport</td>
</tr>
<tr>
<td>CTRL + F</td>
<td>Make the active camera frame a selected object into view</td>
</tr>
<tr>
<td>CTRL + I</td>
<td>Toggle object visibility</td>
</tr>
<tr>
<td>CTRL + L</td>
<td>Lock object</td>
</tr>
<tr>
<td>F2</td>
<td>Rename object</td>
</tr>
<tr>
<td>DEL</td>
<td>Delete object</td>
</tr>
<tr>
<td>TAB</td>
<td>Move between editing values</td>
</tr>
</tbody>
</table>

### Object Inspector Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAB</td>
<td>Move between editing values</td>
</tr>
</tbody>
</table>
## Text Objects Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + ALT + W</td>
<td>Word wrap</td>
</tr>
<tr>
<td>CTRL + ALT + L</td>
<td>Locked lines</td>
</tr>
<tr>
<td>CTRL + ALT + V</td>
<td>Vertical text layout</td>
</tr>
<tr>
<td>CTRL + NUMPAD +/-</td>
<td>Adjust kerning for a selected text object</td>
</tr>
<tr>
<td>CTRL + ALT + UP ARROW</td>
<td>Move line up (moves single character if one is selected)</td>
</tr>
<tr>
<td>CTRL + ALT + DOWN ARROW</td>
<td>Move line down (moves single character if one is selected)</td>
</tr>
<tr>
<td>CTRL + ALT + LEFT ARROW</td>
<td>Move line left (moves single character if one is selected)</td>
</tr>
<tr>
<td>CTRL + ALT + RIGHT ARROW</td>
<td>Move line right (moves single character if one is selected)</td>
</tr>
<tr>
<td>CTRL + HOME</td>
<td>Move cursor to first character of text object</td>
</tr>
<tr>
<td>CTRL + END</td>
<td>Move cursor past last character of text object</td>
</tr>
<tr>
<td>CTRL + LEFT ARROW</td>
<td>Move cursor to previous word</td>
</tr>
<tr>
<td>CTRL + RIGHT ARROW</td>
<td>Move cursor to next word</td>
</tr>
<tr>
<td>CTRL + SHIFT + LEFT ARROW</td>
<td>Select previous word</td>
</tr>
<tr>
<td>CTRL + SHIFT + RIGHT ARROW</td>
<td>Select next word</td>
</tr>
<tr>
<td>SHIFT + HOME</td>
<td>Select to beginning of line</td>
</tr>
<tr>
<td>CTRL + SHIFT + HOME</td>
<td>Select to beginning of text object</td>
</tr>
<tr>
<td>SHIFT + END</td>
<td>Select to end of line</td>
</tr>
<tr>
<td>CTRL + SHIFT + END</td>
<td>Select to end of text object</td>
</tr>
<tr>
<td>CTRL + NUMPAD KEYS</td>
<td>Set current font by ID</td>
</tr>
<tr>
<td>CTRL + TAB</td>
<td>Selects next text object</td>
</tr>
<tr>
<td>CTRL + SHIFT + TAB</td>
<td>Selects previous text object</td>
</tr>
<tr>
<td>CTRL + ALT + TAB</td>
<td>Selects next object</td>
</tr>
<tr>
<td>CTRL + SHIFT + ALT + TAB</td>
<td>Selects previous object</td>
</tr>
</tbody>
</table>

## Keyframe Editor Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPACE</td>
<td>Play animation</td>
</tr>
<tr>
<td>CTRL + A</td>
<td>Select all keyframes</td>
</tr>
<tr>
<td>RIGHT ARROW</td>
<td>Move Time Locator forwards</td>
</tr>
<tr>
<td>LEFT ARROW</td>
<td>Move Time Locator backwards</td>
</tr>
<tr>
<td>HOME</td>
<td>Jump to first keyframe</td>
</tr>
<tr>
<td>END</td>
<td>Jump to end of animation</td>
</tr>
<tr>
<td>CTRL + RIGHT ARROW</td>
<td>Jump to next keyframe</td>
</tr>
<tr>
<td>CTRL + LEFT ARROW</td>
<td>Jump to previous keyframe</td>
</tr>
<tr>
<td>CTRL + HOME</td>
<td>Jump to first keyframe</td>
</tr>
<tr>
<td>CTRL + END</td>
<td>Jump to last keyframe</td>
</tr>
</tbody>
</table>
# Sequencer Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUMPAD ENTER</td>
<td>Play selected take item, or if the item is a clip/still, it will assign the item to the active server channel</td>
</tr>
<tr>
<td>LEFT ARROW</td>
<td>Collapse an expanded sequence group</td>
</tr>
<tr>
<td>RIGHT ARROW</td>
<td>Expand a collapsed sequence group</td>
</tr>
<tr>
<td>UP ARROW</td>
<td>Select previous take item</td>
</tr>
<tr>
<td>DOWN ARROW</td>
<td>Select next take item</td>
</tr>
<tr>
<td>CTRL + UP ARROW</td>
<td>Move selected take item up the list</td>
</tr>
<tr>
<td>CTRL + DOWN ARROW</td>
<td>Move selected take item down the list</td>
</tr>
<tr>
<td>HOME</td>
<td>Select first take item</td>
</tr>
<tr>
<td>END</td>
<td>Select last take item</td>
</tr>
<tr>
<td>CTRL + SHIFT + PAGE UP</td>
<td>Select previous scene template</td>
</tr>
<tr>
<td>CTRL + SHIFT + PAGE DOWN</td>
<td>Select next scene template</td>
</tr>
<tr>
<td>CTRL + PAGE UP</td>
<td>Select previous template data field</td>
</tr>
<tr>
<td>CTRL + PAGE DOWN</td>
<td>Select next template data field</td>
</tr>
<tr>
<td>ALT + INSERT</td>
<td>Transfers scene from take item list</td>
</tr>
<tr>
<td>ALT + DELETE</td>
<td>Removes scene from take item list</td>
</tr>
<tr>
<td>CTRL + F&lt;KEY&gt;</td>
<td>Remove selected take item from the framebuffer represented by the F&lt;KEY&gt; key</td>
</tr>
<tr>
<td>CTRL + SHIFT + X</td>
<td>Export selected take items to XML to be imported later</td>
</tr>
<tr>
<td>NUMPAD .</td>
<td>Cue a selected take item prior to putting them online by pressing the decimal key on the number pad. Cueing them will pre-cache all video clips in the scene. Multiple items can be cued and brought to air simultaneously</td>
</tr>
<tr>
<td>NUMPAD +</td>
<td>Playout the selected take item and select the next take item in the sequence</td>
</tr>
<tr>
<td>NUMPAD -</td>
<td>Take the current take item offline if it is online</td>
</tr>
<tr>
<td>NUMPAD *</td>
<td>Scroll the Sequencer list to the currently focused item and, if applicable, expand the group containing the focused item. Requires the Fast Recall button to be enabled</td>
</tr>
<tr>
<td>NUMPAD *</td>
<td>Display a live moving preview of the selected take item. Can be disabled in the sequencer preferences.</td>
</tr>
<tr>
<td>NUMPAD ENTER</td>
<td>Playout the selected take item. This shortcut requires the Fast Recall button to be enabled</td>
</tr>
<tr>
<td>CTRL + I</td>
<td>Open the Insert New Take Item dialog box and create new take items based on the scene ID of the template</td>
</tr>
</tbody>
</table>
| TAB              | Advance through the template data fields.  
**Note:** This keyboard control needs to be enabled in the Preferences in order to be functional |
### Material Manager Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + M</td>
<td>Open Material Manager</td>
</tr>
<tr>
<td>SHIFT + DOUBLE-CLICK LEFT MOUSE BUTTON</td>
<td>Open selected material in the Material Editor</td>
</tr>
</tbody>
</table>

### Main Viewport Shortcuts

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT + LEFT MOUSE BUTTON</td>
<td>Orbit a perspective camera object</td>
</tr>
<tr>
<td>ALT + MIDDLE MOUSE BUTTON</td>
<td>Pan a perspective camera object</td>
</tr>
<tr>
<td>MOUSE WHEEL</td>
<td>Zoom a perspective camera object</td>
</tr>
<tr>
<td>CTRL + MOUSE WHEEL</td>
<td>Adjust the zoom level inside the viewport window</td>
</tr>
<tr>
<td>CTRL + ALT + UP ARROW</td>
<td>Move selected object(s) up</td>
</tr>
<tr>
<td>CTRL + ALT + DOWN ARROW</td>
<td>Move selected object(s) down</td>
</tr>
<tr>
<td>CTRL + ALT + LEFT ARROW</td>
<td>Move selected object(s) left</td>
</tr>
<tr>
<td>CTRL + ALT + RIGHT ARROW</td>
<td>Move selected object(s) right</td>
</tr>
</tbody>
</table>

### Clip Browser

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT + Q</td>
<td>Enable Quick Find</td>
</tr>
<tr>
<td>ESC</td>
<td>Clear Quick Find</td>
</tr>
<tr>
<td>ENTER</td>
<td>Cue/Play when Fast Recall is enabled</td>
</tr>
<tr>
<td>F8</td>
<td>Open the Edit Clip dialog box to edit the selected clip</td>
</tr>
<tr>
<td>SHIFT + F8</td>
<td>Open the Add Sub Clip dialog box to create a sub clip from the selected clip</td>
</tr>
<tr>
<td>CTRL + ALT + RIGHT ARROW</td>
<td>Add selected clip to Sequencer</td>
</tr>
</tbody>
</table>

### Server Channels

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT + #</td>
<td>Select a Server Channel number as the focused Server Channel</td>
</tr>
</tbody>
</table>

### Visual Logic

<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + C</td>
<td>Copy a selected block or blocks</td>
</tr>
<tr>
<td>CTRL + V</td>
<td>Paste a copied block or blocks</td>
</tr>
<tr>
<td>DEL</td>
<td>Delete a selected block or blocks</td>
</tr>
<tr>
<td>SHIFT + CTRL + V</td>
<td>Open the Paste Visual Logic Properties window to assign object attributes of copied objects to other objects in the scene.</td>
</tr>
<tr>
<td>ALT + V</td>
<td>Display the current values of visual logic blocks below each of the blocks</td>
</tr>
</tbody>
</table>
Notes:
Notes:
Notes:
Contact Us

Contact our friendly and professional support representatives for the following:

- Name and address of your local dealer
- Product information and pricing
- Technical support
- Upcoming trade show information

### Technical Support

<table>
<thead>
<tr>
<th>Service</th>
<th>Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>+1-844-652-0645</td>
</tr>
<tr>
<td></td>
<td>(North America)</td>
</tr>
<tr>
<td></td>
<td>+800 1005 0100</td>
</tr>
<tr>
<td></td>
<td>(International)</td>
</tr>
<tr>
<td>After Hours Emergency</td>
<td>+1 613 • 349 • 0006</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:techsupport@rossvideo.com">techsupport@rossvideo.com</a></td>
</tr>
</tbody>
</table>

### General Information

<table>
<thead>
<tr>
<th>Service</th>
<th>Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>+1 613 • 652 • 4886</td>
</tr>
<tr>
<td>Fax</td>
<td>+1 613 • 652 • 4425</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:solutions@rossvideo.com">solutions@rossvideo.com</a></td>
</tr>
<tr>
<td>Website</td>
<td><a href="http://www.rossvideo.com">http://www.rossvideo.com</a></td>
</tr>
</tbody>
</table>

Visit Us

Visit our website for:

- Company information and news
- Related products and full product lines
- Online catalog
- Testimonials